# Contents

## Send Us Your Comments

## Preface

### 1 Introduction to Oracle Scripting

- Overview of Oracle Scripting.......................................................... 1-1
- Components...................................................................................... 1-1
- How Scripts Are Used...................................................................... 1-3

### 2 Dependencies and Integration Points

- Conditional Dependencies............................................................. 2-1
  - Survey Component Dependencies.............................................. 2-1
- Minimum Software Requirements................................................ 2-2
- Minimum Hardware Requirements............................................... 2-2
- Scalability and Performance Guidelines....................................... 2-2
- Installing Oracle Scripting............................................................. 2-3

### 3 Implementation Overview

- Implementation Task Sequence.................................................. 3-1

### 4 Implementation Tasks

- Understanding Users Required for Implementation...................... 4-2
- SYSADMIN Versus Explicitly Created Administrator User Account ......................................................... 4-2
- JTF Role Requirements................................................................. 4-3
- Administrator Super Users.............................................................. 4-3
- Implementation Responsibility Matrix......................................... 4-4
5 Implementation Administration Tasks

Creating and Administering Users................................................................. 5-1
Creating an Employee in the Enterprise Database........................................ 5-2
Creating a Resource Group........................................................................... 5-4
Importing a CRM Resource........................................................................ 5-5
Defining Oracle Applications Users............................................................... 5-7
Setting Up Debugging and Message Logging in Oracle Scripting.................. 5-9
Setting Up Applications Common Logging.................................................... 5-10
Enabling Logging for the Guest User.............................................................. 5-11
Enabling the Oracle JInitiator Java Console.................................................. 5-12
Bypassing the Sales Resource Group Membership Requirement.................. 5-13
Granting JTF Roles....................................................................................... 5-14
Setting System Profile Values....................................................................... 5-16
Finding Application and Responsibility ID Values......................................... 5-18
Finding Default Application from a Responsibility ID Value........................ 5-19
Finding the FND User ID Value of a Defined User........................................ 5-20
Obtaining the FND USER_ID Value Using SQL............................................ 5-21
Obtaining the FND USER_ID Value from the Users Window......................... 5-22
6 Scripting Administration Tasks

Overview of Scripting Administration Tasks .................................................. 6-1
Scripting Home ......................................................................................... 6-2
Launching the Script Author Java Applet ...................................................... 6-2
Administering Oracle Scripting Files ........................................................... 6-3
Viewing and Removing Deployed Scripts ..................................................... 6-3
Viewing and Administering Custom Java Archive Files ................................. 6-5
Viewing and Removing Uploaded Java Archive Files .................................... 6-6
Uploading New Java Archive Files ................................................................. 6-7
Overwriting Existing Java Archive Files with Updated Archives .................. 6-10
Changing the Global Property of Uploaded Java Archive Files ..................... 6-11
Creating, Removing, and Viewing Java Archive Mapping Definitions .......... 6-13
Specifying Load Order of Java Archives Files .............................................. 6-15
Generating and Viewing Panel Footprint Reports ........................................ 6-16

7 Survey Resource Administration Tasks

Administering Survey Resources .................................................................. 7-1
Creating Survey Resources ......................................................................... 7-5
Creating Survey Resource Definitions ......................................................... 7-6
Viewing or Deleting Survey Resource Definitions ....................................... 7-9
Uploading JSP Survey Resources .................................................................. 7-10

8 Survey Campaign Administration Tasks

Overview of Survey Campaign Administration .............................................. 8-2
Setting Survey Administration Preferences ................................................. 8-4
Survey Administration Console Tabs ............................................................ 8-6
Administering Survey Campaigns ................................................................. 8-7
Performing Survey Campaign and Survey Resource Searches ..................... 8-9
  Survey Campaign and Survey Resource Search Overview ........................... 8-9
  Performing Simple Searches ..................................................................... 8-11
  Performing Advanced Searches ............................................................... 8-12
  Creating and Personalizing Views ............................................................. 8-13
  Using Views ............................................................................................. 8-15
Creating Survey Campaigns and Cycles .................................................... 8-15
Viewing or Modifying Survey Campaign and Cycle Details ......................... 8-21
Cancelling a Survey Campaign from the Survey Campaigns List ................ 8-22
Deleting Survey Campaigns and Cycles ..................................................... 8-23
Adding or Modifying a Cycle for an Existing Survey Campaign ................... 8-24
9 Campaign and List Administration Tasks

Introduction.................................................................................. 9-2
Administering Campaigns in Oracle Marketing................................. 9-2
Creating a Campaign.................................................................... 9-3
Creating a Campaign Schedule...................................................... 9-6
Associating a Script to a Campaign Schedule.................................. 9-9
Associating a Script to a Campaign................................................ 9-10
Administering Campaigns in Oracle Sales Online.............................. 9-11
Assigning Agents to a Campaign Schedule..................................... 9-12
Assigning Campaign Schedules to Agents....................................... 9-13
Administering Lists in Oracle Marketing......................................... 9-15
List Creation Overview................................................................... 9-16
Creating a List.............................................................................. 9-17
Identifying Record Sources for a List.............................................. 9-19
Importing Record Sources.............................................................. 9-19
Manually Selecting List Entries as Record Sources............................ 9-25
Using Oracle Discoverer Workbook to Define Record Sources........... 9-26
Adding Records to a List.............................................................. 9-30
Generating a List........................................................................... 9-32
Marketing Campaigns as an Oracle Applications Dependency............ 9-34
10 Implementation Verification

Overview of Verification............................................................................................................. 10-1
Script Author Tasks.................................................................................................................. 10-2
Creating a Hello World Graphical Test Script........................................................................ 10-3
Oracle Creating a Hello World Wizard Test Script................................................................. 10-22
Using the Regression Test Script........................................................................................... 10-35
Survey Administration Console Tasks..................................................................................... 10-36
Scripting Engine Tasks.......................................................................................................... 10-38
Apache Web Server Servlet Verification URLs....................................................................... 10-39
Scripting Engine Agent Interface Verification ...................................................................... 10-40
Scripting Engine Web Interface Verification Tasks............................................................... 10-41
Executing a Script in the Web Interface.................................................................................. 10-41
Testing Display Server for UNIX Environments................................................................... 10-42
Viewing Server Message Logs.............................................................................................. 10-42

11 Integrating Oracle Scripting

Introduction.................................................................................................................................. 11-1
Integration by Component......................................................................................................... 11-2
Script Author............................................................................................................................ 11-2
Scripting Engine...................................................................................................................... 11-3
  Scripting Engine Agent Interface......................................................................................... 11-3
  Scripting Engine Web Interface........................................................................................... 11-4
Survey Administration Console............................................................................................... 11-6
Integration by Technology Stack.............................................................................................. 11-7
  HTML-Based Integrated Applications................................................................................... 11-7
    Oracle Self-Service Web Applications................................................................................ 11-7
    Oracle One-to-One Fulfillment............................................................................................ 11-10
    Oracle Marketing................................................................................................................ 11-10
  Forms-Based Integrated Applications..................................................................................... 11-11
Prebuilt Integration with Oracle Applications.......................................................................... 11-13
Integrating with Oracle TeleSales............................................................................................ 11-13
Launching Any Deployed Script from Oracle TeleSales......................................................... 11-14
Launching a Specific Script from Oracle TeleSales............................................................... 11-14
Effects of OTS Profile Settings for Oracle Scripting.............................................................. 11-16
Parameters Passed to the Scripting Blackboard..................................................................... 11-18
Integrating with Oracle TeleService...................................................................................... 11-22
Launching Any Deployed Script from Oracle TeleService.................................................... 11-22
Launching a Specific Script from Oracle TeleService........................................................... 11-23
12 Troubleshooting Oracle Scripting

Common Implementation Errors................................................................. 12-1
  Responsibility Names Can Differ............................................................ 12-1
Survey Implementation Errors.................................................................. 12-2
  General Implementation Errors............................................................. 12-2
If You Cannot See the Survey Administration Console......................... 12-2
Troubleshooting Fulfillment Administrator Role Assignment.................. 12-3

Common Verification or Execution Errors ................................................. 12-3
Script Author Errors.................................................................................. 12-4
  Script Author Deployment Errors.......................................................... 12-4
Script Author Script Verification.............................................................. 12-4
Scripting Engine Agent Interface Errors.................................................. 12-5
  Troubleshooting Applet Security and Signing........................................ 12-5
Load Balancing Environments with Multiple Apache JServ Instances........ 12-5
Session Timeout Issues............................................................................ 12-7
Panel Text Errors...................................................................................... 12-7
  Cascading Style Sheet Information Ignored at Runtime......................... 12-7
  JavaScript Imported into Panel Text Ignored or Displaying Incorrectly.... 12-8
  Debug Statements Not Appearing from Custom Java Code...................... 12-9

Survey Deployment and Fulfillment Troubleshooting............................... 12-9
User Interface Discrepancies................................................................. 12-12
Log Files and Error Messages.................................................................. 12-13
  Oracle Scripting Execution Errors and Error Logging......................... 12-15
    Errors in the Scripting Engine Agent Interface.................................. 12-15
    Errors in the Scripting Engine Web Interface.................................... 12-16
Unsupported Functions............................................................................ 12-17
  Panel Layout Editor Formatting Limitations........................................... 12-17

A Oracle Scripting Profile Options

Setting Profile Options........................................................................... A-1
Finding Responsibility ID Values............................................................. A-2
Oracle CRM Technology Foundation (JTT) Profile Options....................... A-3
Current IES Profile Options..................................................................... A-4
Information, Error and Debug Logging Profile Options.......................... A-8
Additional Required Profile Options....................................................... A-11
B Oracle Discoverer Workbooks

Introduction........................................................................................................................................ B-1
Implementing Survey Analysis Discoverer Workbooks.......................................................... B-3
  Staging Oracle Discoverer EEX Files for Import................................................................. B-4
  Creating an End User Layer............................................................................................... B-6
  Assigning End User Layer Implementation Privileges....................................................... B-8
  Importing Oracle Discoverer Objects into an End User Layer........................................... B-10
  Assigning Responsibility and Business Area Privileges..................................................... B-12
  Assigning Workbook Privileges......................................................................................... B-14
  Verifying the End User Layer............................................................................................ B-16
  Viewing Oracle Scripting Survey Reports........................................................................... B-17
Survey Workbook Descriptions.............................................................................................. B-19
  Survey Question Frequency Workbook............................................................................ B-22
  Survey Question Detail Workbook..................................................................................... B-24
  Survey Question Text Workbook....................................................................................... B-25
  Survey Campaign Summary Workbook............................................................................. B-26
  Survey Deployment Detail Workbook................................................................................ B-28
  Survey Cross Tabulation Workbook................................................................................ B-30

Glossary
Send Us Your Comments

Oracle Scripting Implementation Guide, Release 12.2
Part No. E49093-01

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience


This guide is intended for personnel who are responsible for implementing and administering Oracle Scripting.

This guide assumes that you have a working knowledge of the following:

- The principles and customary practices of your business area
- Oracle Scripting
- The Oracle Applications graphical user interface

To learn more about the Oracle Applications graphical user interface, read the Oracle E-Business Suite User’s Guide.

See Related Information Sources on page xiv for more Oracle E-Business Suite product information.

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
Structure

1 Introduction to Oracle Scripting
2 Dependencies and Integration Points
3 Implementation Overview
4 Implementation Tasks
5 Implementation Administration Tasks
6 Scripting Administration Tasks
7 Survey Resource Administration Tasks
8 Survey Campaign Administration Tasks
9 Campaign and List Administration Tasks
10 Implementation Verification
11 Integrating Oracle Scripting
12 Troubleshooting Oracle Scripting
A Oracle Scripting Profile Options
B Oracle Discoverer Workbooks
Glossary

Related Information Sources

You can choose from many sources of information, including online documentation, training, and support services, to increase your knowledge and understanding of Oracle Scripting.

Integration Repository

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

You can navigate to the Oracle Integration Repository through Oracle E-Business Suite Integrated SOA Gateway.

Online Documentation

All Oracle E-Business Suite documentation is available online (HTML or PDF).

- PDF - See the Oracle E-Business Suite Documentation Library for current PDF documentation for your product with each release. The Oracle E-Business Suite Documentation Library is also available on My Oracle Support and is updated frequently
• **Online Help** - Online help patches (HTML) are available on My Oracle Support.

• **Release Notes** - For information about changes in this release, including new features, known issues, and other details, see the release notes for the relevant product, available on My Oracle Support.


**Guides Related to All Products**


This guide explains how to navigate, enter data, query, and run reports using the user interface (UI) of Oracle E-Business Suite. This guide also includes information on setting user profiles, as well as running and reviewing concurrent programs.

You can access this guide online by choosing "Getting Started with Oracle Applications" from any Oracle E-Business Suite product help file.

**Guides Related to This Product**

**Oracle Scripting User Guide**

Oracle Scripting provides enterprises with scripts of questions and answers to help agents gather data, provide information to customers, conduct web-based marketing research surveys, and help web customers make a decision. You use the Script Author to build a script for execution, the Scripting Administration console to manage scripting files, the Survey Administration console to administer survey campaigns, and the Scripting Engine to execute scripts.

**Oracle Scripting Developer's Guide**

This guide enables you to understand commands and building blocks in order to customize Oracle Scripting. You can associate commands with action types, questions, panel text, and shortcut buttons. You can set up building blocks for a script or survey to either hard code all of the parameter values for a reusable command, or to interactively prompt the end user to choose the required values from a drop down menu of fulfillment items at runtime. You can also use the panel layout editor of the Script Author to create, edit, and format spoken and instructional text that forms the HTML output content of the script without writing HTML code.
Installation and System Administration

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of your Oracle E-Business Suite data.

Oracle E-Business Suite Concepts
This book is intended for all those planning to deploy Oracle E-Business Suite Release 12.2, or contemplating significant changes to a configuration. After describing the Oracle E-Business Suite architecture and technology stack, it focuses on strategic topics, giving a broad outline of the actions needed to achieve a particular goal, plus the installation and configuration choices that may be available.

Oracle E-Business Suite CRM System Administrator’s Guide
This manual describes how to implement the CRM Technology Foundation (JTT) and use its System Administrator Console.

Oracle E-Business Suite Developer’s Guide
This guide contains the coding standards followed by the Oracle E-Business Suite development staff. It describes the Oracle Application Object Library components needed to implement the Oracle E-Business Suite user interface described in the Oracle E-Business Suite User Interface Standards for Forms-Based Products. It also provides information to help you build your custom Oracle Forms Developer forms so that they integrate with Oracle E-Business Suite. In addition, this guide has information for customizations in features such as concurrent programs, flexfields, messages, and logging.

Oracle E-Business Suite Installation Guide: Using Rapid Install
This book is intended for use by anyone who is responsible for installing or upgrading Oracle E-Business Suite. It provides instructions for running Rapid Install either to carry out a fresh installation of Oracle E-Business Suite Release 12.2, or as part of an upgrade to Release 12.2.

Oracle E-Business Suite Maintenance Guide
This guide contains information about the strategies, tasks, and troubleshooting activities that can be used to help ensure an Oracle E-Business Suite system keeps running smoothly, together with a comprehensive description of the relevant tools and utilities. It also describes how to patch a system, with recommendations for optimizing typical patching operations and reducing downtime.
Oracle E-Business Suite Security Guide

This guide contains information on a comprehensive range of security-related topics, including access control, user management, function security, data security, and auditing. It also describes how Oracle E-Business Suite can be integrated into a single sign-on environment.

Oracle E-Business Suite Setup Guide

This guide contains information on system configuration tasks that are carried out either after installation or whenever there is a significant change to the system. The activities described include defining concurrent programs and managers, enabling Oracle Applications Manager features, and setting up printers and online help.

Oracle E-Business Suite User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle E-Business Suite development staff. It describes the UI for the Oracle E-Business Suite products and tells you how to apply this UI to the design of an application built by using Oracle Forms.

Other Implementation Documentation

Oracle Approvals Management Implementation Guide

This guide describes transaction attributes, conditions, actions, and approver groups that you can use to define approval rules for your business. These rules govern the process for approving transactions in an integrated Oracle application. You can define approvals by job, supervisor hierarchy, positions, or by lists of individuals created either at the time you set up the approval rule or generated dynamically when the rule is invoked. You can learn how to link different approval methods together and how to run approval processes in parallel to shorten transaction approval process time.

Oracle Diagnostics Framework User's Guide

This guide contains information on implementing, administering, and developing diagnostics tests for Oracle E-Business Suite using the Oracle Diagnostics Framework.

Oracle E-Business Suite Flexfields Guide

This guide provides flexfields planning, setup and reference information for the Oracle E-Business Suite implementation team, as well as for users responsible for the ongoing maintenance of Oracle E-Business Suite product data. This guide also provides information on creating custom reports on flexfields data.
Oracle E-Business Suite Integrated SOA Gateway Implementation Guide

This guide explains the details of how integration repository administrators can manage and administer the entire service enablement process based on the service-oriented architecture (SOA) for both native packaged public integration interfaces and composite services - BPEL type. It also describes how to invoke Web services from Oracle E-Business Suite by working with Oracle Workflow Business Event System, manage Web service security, and monitor SOAP messages.


This guide describes how users can browse and view the integration interface definitions and services that reside in Oracle Integration Repository.

Oracle E-Business Suite Multiple Organizations Implementation Guide

This guide describes how to set up multiple organizations and the relationships among them in a single installation of an Oracle E-Business Suite product such that transactions flow smoothly through and among organizations that can be ledgers, business groups, legal entities, operating units, or inventory organizations. You can use this guide to assign operating units to a security profile and assign this profile to responsibilities such that a user can access data for multiple operating units from a single responsibility. In addition, this guide describes how to set up reporting to generate reports at different levels and for different contexts. Reporting levels can be ledger or operating unit while reporting context is a named entity in the selected reporting level.

Oracle e-Commerce Gateway Implementation Guide

This guide describes implementation details, highlighting additional setup steps needed for trading partners, code conversion, and Oracle E-Business Suite. It also provides architecture guidelines for transaction interface files, troubleshooting information, and a description of how to customize EDI transactions.

Oracle e-Commerce Gateway User's Guide

This guide describes the functionality of Oracle e-Commerce Gateway and the necessary setup steps in order for Oracle E-Business Suite to conduct business with trading partners through Electronic Data Interchange (EDI). It also describes how to run extract programs for outbound transactions, import programs for inbound transactions, and the relevant reports.

Oracle iSetup User's Guide

This guide describes how to use Oracle iSetup to migrate data between different instances of the Oracle E-Business Suite and generate reports. It also includes configuration information, instance mapping, and seeded templates used for data migration.
Oracle Product Hub Implementation Guide

This guide explains how to set up hierarchies of items using catalogs and catalog categories and then to create user-defined attributes to capture all of the detailed information (such as cost information) about an object (such as an item or change order). It also explains how to set up optional features used in specific business cases; choose which features meet your business' needs. Finally, the guide explains the set up steps required to link to third party and legacy applications, then synchronize and enrich the data in a master product information repository.

Oracle Product Hub User's Guide

This guide explains how to centrally manage item information across an enterprise, focusing on product data consolidation and quality. The item information managed includes item attributes, categorization, organizations, suppliers, multilevel structures/bills of material, packaging, changes, attachments, and reporting.

Oracle Web Applications Desktop Integrator Implementation and Administration Guide

Oracle Web Applications Desktop Integrator brings Oracle E-Business Suite functionality to a spreadsheet, where familiar data entry and modeling techniques can be used to complete Oracle E-Business Suite tasks. You can create formatted spreadsheets on your desktop that allow you to download, view, edit, and create Oracle E-Business Suite data, which you can then upload. This guide describes how to implement Oracle Web Applications Desktop Integrator and how to define mappings, layouts, style sheets, and other setup options.

Oracle Workflow Administrator's Guide

This guide explains how to complete the setup steps necessary for any Oracle E-Business Suite product that includes workflow-enabled processes. It also describes how to manage workflow processes and business events using Oracle Applications Manager, how to monitor the progress of runtime workflow processes, and how to administer notifications sent to workflow users.

Oracle Workflow Developer's Guide

This guide explains how to define new workflow business processes and customize existing workflow processes embedded in Oracle E-Business Suite. It also describes how to define and customize business events and event subscriptions.

Oracle Workflow User's Guide

This guide describes how Oracle E-Business Suite users can view and respond to workflow notifications and monitor the progress of their workflow processes.
Oracle XML Gateway User's Guide

This guide describes Oracle XML Gateway functionality and each component of the Oracle XML Gateway architecture, including Message Designer, Oracle XML Gateway Setup, Execution Engine, Message Queues, and Oracle Transport Agent. It also explains how to use Collaboration History that records all business transactions and messages exchanged with trading partners.

The integrations with Oracle Workflow Business Event System, and the Business-to-Business transactions are also addressed in this guide.

Oracle XML Publisher Administration and Developer's Guide

Oracle XML Publisher is a template-based reporting solution that merges XML data with templates in RTF or PDF format to produce outputs to meet a variety of business needs. Outputs include: PDF, HTML, Excel, RTF, and eText (for EDI and EFT transactions). Oracle XML Publisher can be used to generate reports based on existing Oracle E-Business Suite report data, or you can use Oracle XML Publisher's data extraction engine to build your own queries. Oracle XML Publisher also provides a robust set of APIs to manage delivery of your reports via e-mail, fax, secure FTP, printer, WebDav, and more. This guide describes how to set up and administer Oracle XML Publisher as well as how to use the Application Programming Interface to build custom solutions. This guide is available through the Oracle E-Business Suite online help.

Oracle XML Publisher Report Designer's Guide

Oracle XML Publisher is a template-based reporting solution that merges XML data with templates in RTF or PDF format to produce a variety of outputs to meet a variety of business needs. Using Microsoft Word or Adobe Acrobat as the design tool, you can create pixel-perfect reports from the Oracle E-Business Suite. Use this guide to design your report layouts. This guide is available through the Oracle E-Business Suite online help.

Training and Support

Training

Oracle offers a complete set of training courses to help you master your product and reach full productivity quickly. These courses are organized into functional learning paths, so you take only those courses appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by Oracle University at any of our many Education Centers, you can arrange for our trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle University's online education utility. In addition, Oracle training professionals can tailor standard courses or develop custom courses to meet your needs. For example, you may
want to use your organization structure, terminology, and data as examples in a customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals provides the help and information you need to keep your product working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Introduction to Oracle Scripting

This chapter covers the following topics:

- Overview of Oracle Scripting
- Components
- How Scripts Are Used

Overview of Oracle Scripting

Oracle Scripting is a set of tools that provides enterprises with scripts, which guide customers, agents, and employees through decision flows based on a series of questions and answers. Through branching logic built into the product, script flow is determined both by customer answers and by data stored in the customer tables.

Scripts can be used for a variety of purposes:

- To assist enterprise agents in gathering data from or providing information to customers and prospects
- As Web-based surveys to solicit information from a sample or target population
- As self-service Web scripts that integrate with enterprise Web pages and provide a mechanism to guide Web customers through decision processes

Components

Oracle Scripting is composed of four components: Script Author, the Scripting Engine, the Scripting Administration console, and the Survey Administration console.

1. Using Script Author, trained script developers translate business requirements into miniature programs called scripts. Script Author supports two methods to create a script: using graphical layout tools to create graphical scripts, and using a Script Wizard feature to create wizard scripts. Both script types can be executed in either
of the two Scripting Engine interfaces.

2. Using the Scripting Engine component, script end users execute the script in one of two runtime interfaces:
   • The Scripting Engine agent interface is used in combination with Oracle business applications. Users of the agent interface are interaction center agents; they launch each script - which executes as a Java applet - from an Oracle business application form.
   • Using the Scripting Engine Web interface, scripts execute in any Oracle Applications 12 certified Web browser. These can be used as survey questionnaires, or as Web scripts launched from an integrated Oracle self-service Web application such as Oracle iSupport.
     Note: Any script executed in the Scripting Engine Web interface, either as a survey questionnaire or as a Web script, requires a survey campaign to be defined and one of its deployments activated.

3. Using the Scripting Administration console, script administrators can launch Script Author as a Java applet, administer Oracle Scripting script files and custom Java archive files, and view panel footprint summary reports.

4. Using the Survey Administration console, you administer survey campaigns and associated survey resources.
   Survey resources can include header and footer sections, error pages and final pages. For each script executed in the Web interface, the appropriate survey resources display.

The following summarizes the main usages of each component:
   • Use Script Author to build a script for execution in either Scripting Engine interface.
   • Use the Scripting Administration console to access Script Author (as a Java applet), to manage scripting files or custom Java archives, or to view panel footprint summary reports.
   • Use the Survey Administration console to administer survey campaigns, which is prerequisite to executing any script in a Web browser.
   • Use Scripting Engine to execute any script. The two interfaces include the agent interface (a Forms client) or the Web interface (a Web browser).
How Scripts Are Used

There are various ways in which scripts can be employed to gather or distribute data for an enterprise. For example:

- Scripts in the Scripting Engine agent interface can be launched from Oracle TeleSales and the Customer Support component of Oracle TeleService.

  Note: Use of the Scripting Engine agent interface in standalone mode (without other business applications) is not supported by Oracle except for script testing and validation.

- A script can serve as a survey questionnaire to solicit specific information from the sample or target population. Such a questionnaire can be executed in the Scripting Engine agent interface, or set up as a survey campaign and executed in a Web browser in the Scripting Engine Web interface.

- Scripts or surveys can be executed in the Web interface as follows:
  - An active survey deployment URL can be embedded as a hyperlink in an enterprise Web site pointing to a survey deployment.
  - An active survey deployment URL can be embedded as a hyperlink in an Oracle self-service Web application (e.g., Oracle iSupport or Oracle iStore). Users of the Web application can launch a script in the browser. When executed in this manner, the script is referred to as a Web script. Web scripts are a valuable resource to provide scripted information to Web application users or to solicit feedback to the enterprise regarding the application user’s experience.
  - By leveraging other Oracle Applications (Oracle One-to-One Fulfillment and Oracle Marketing Online), you can send e-mail invitations and reminders to participate in a survey questionnaire to members of a defined population or sample, as set up on an Oracle Marketing list. The list includes a link to an active survey deployment.
Dependencies and Integration Points

This chapter covers the following topics:

• Conditional Dependencies
• Minimum Software Requirements
• Minimum Hardware Requirements
• Scalability and Performance Guidelines
• Installing Oracle Scripting

Conditional Dependencies

The following conditional dependencies may apply:

• Survey Component Dependencies, page 2-1

Survey Component Dependencies

Targeted Survey Deployment Dependencies

If your implementation requires the use of targeted survey deployments, the following are dependencies:

• You must have Oracle One-to-One Fulfillment installed and implemented.

• You must have an appropriately configured fulfillment server.

• You must have Oracle Marketing installed and implemented.

• You must have access to a user with the Survey Administrator responsibility.
References

- For information on Oracle One-to-One Fulfillment requirements, use, and implementation, see Oracle One-to-One Fulfillment Implementation Guide.

- For information on Oracle Marketing requirements, usage, and implementation, see Oracle Marketing Implementation and Administration Guide and Oracle Marketing User Guide.

Minimum Software Requirements

The minimum software requirements are that you must have Oracle Applications release 12 installed or updated to the appropriate patch level.

Minimum Hardware Requirements

Oracle Applications must be installed (using a Rapid Install) on an appropriate server-class UNIX or Windows NT server. The server must have suitable memory (RAM) and storage (hard drive space) for enterprise-specific tasks, as determined by enterprise system administrators. Guidance can be found for minimum requirements in Oracle E-Business Suite Installation Guide: Using Rapid Install.

Scalability and Performance Guidelines

Oracle Scripting has the same scalability and performance guidelines as other Oracle Applications CRM release 12 products. For other scalability and performance guidelines, refer to Oracle E-Business Suite Installation Guide: Using Rapid Install.

Some implementations install the database tier of Oracle Applications on a separate physical host machine to improve performance. Technically, each tier in a Rapid Install may be installed on a separate host machine for additional performance gains, although this is a rare occurrence. Detectable performance gains for multi-server implementations are likely if load on the applications database is heavy. For medium to light load there should be little appreciable gain. Regardless of whether you have a single or multiple configuration, Rapid Install is a prerequisite. Consult with your systems administrator for more information.

Installation and Dependency Verification

You must verify an implementation using the procedures described in the chapter Implementation Verification, page 10-1. This includes:

For All Implementations

- Obtaining the regression test script from Oracle to perform Scripting Engine testing in standalone mode.
• Opening, compiling, and deploying the regression test script to your applications database.

• Uploading custom JAR file to the database using the Scripting Administration console.

• For testing scripts in the agent interface, assigning the Scripting User or Scripting Agent responsibility to an existing or new Oracle Applications user.

• Successfully launching and executing the regression test script in the Scripting Engine.

**For Survey Implementations**

• Assigning the Survey Administrator responsibility to an existing or new Oracle Applications user.

• Creating or modifying survey resources.

• Defining survey resources, a survey campaign, cycle, and deployment in the Survey Administration console.

• Activating a deployment.

• Ensuring you can participate in a survey using a Web browser.

• If viewing responses, ensure answer collection is enabled in the appropriate script to ensure survey response data is collected for viewing.

• Assigning the iSurvey User responsibility to an existing or new Oracle Applications user, to administer concurrent programs.

• Ensuring you can schedule or perform concurrent programs to update deployment status and move survey data to survey summary tables.

• If using reporting, perform the Oracle Discoverer implementation steps described in Oracle Discoverer Workbooks.

**Installing Oracle Scripting**

To install Oracle Release 12, you must use Oracle Applications Rapid Install.

The Rapid Install is intended for customers who are installing Oracle Applications for the first time or upgrading to Release 12.

The Rapid Install is provided on CD-ROMs and is available from Oracle Store at http://oracleteststore.oracle.com. For information about installing Oracle Applications using Rapid Install, see *Oracle E-Business Suite Installation Guide: Using Rapid Install*. For
This chapter covers the following topics:

- Implementation Task Sequence

**Implementation Task Sequence**

To implement Oracle Scripting, you must set up the following elements:

- The users to set up and use Oracle Scripting facilities
- The interfaces that you require to run Oracle Scripting scripts
- The administrative consoles that you require to manage and control your scripts

Two types of Oracle Scripting user are required for your implementation:

- Administrative
  All implementations require one or more administrative users which may have varying attributes.

- End user
  Most end user setup is performed outside of Oracle Scripting, and depends on the Oracle Scripting interface that the end users will use to run the scripts.

For detailed information, see Understanding Users Required for Implementation, page 4-2.

You must have an understanding of which Oracle Scripting components, functions, and interfaces are required at your enterprise. Scripting components include Script Author, the Scripting Engine (which includes a Web interface and an agent interface), and two HTML user interfaces for administration: the Scripting Administration console and the Survey Administration console.

The table below outlines the tasks and sequence required to implement Oracle Scripting...
to meet your requirements.

<table>
<thead>
<tr>
<th>Task</th>
<th>Task Description</th>
<th>Required for</th>
<th>Consult documented tasks...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create and administer Oracle Scripting administrators.</td>
<td>All</td>
<td>Creating an Administrator for Oracle Scripting, page 4-9</td>
</tr>
<tr>
<td>2</td>
<td>Create and administer Oracle Scripting end users.</td>
<td>All</td>
<td>Creating an Agent, page 4-16</td>
</tr>
<tr>
<td>3</td>
<td>Implement the Scripting Engine agent interface.</td>
<td>Agent UI</td>
<td>Implementing the Scripting Engine Agent Interface, page 4-18</td>
</tr>
<tr>
<td>4</td>
<td>Implement the Scripting Engine Web interface.</td>
<td>Web UI</td>
<td>Implementing the Scripting Engine Web Interface, page 4-25</td>
</tr>
<tr>
<td>5</td>
<td>Implement the Oracle Scripting administrative interface.</td>
<td>All</td>
<td>Implementing Administrative Interfaces, page 4-27</td>
</tr>
<tr>
<td>6</td>
<td>Implement the Survey administrative interface.</td>
<td>Web UI</td>
<td>Implementing Administrative Interfaces, page 4-27</td>
</tr>
</tbody>
</table>

Details of the tasks outlined in the preceding table - the tasks that are required to implement Oracle Scripting - appear in the chapter Implementation Tasks.

Extra administrative tasks and further information about administering Oracle Scripting are described in the chapter Implementation Administration Tasks.
This chapter covers the following topics:

- Understanding Users Required for Implementation
- SYSADMIN Versus Explicitly Created Administrator User Account
- JTF Role Requirements
- Administrator Super Users
- Implementation Responsibility Matrix
- Road Map to User Creation and Administration
- Creating Administrators for Oracle Scripting
- Performing Further Administration Setups
- Creating Oracle Scripting Agents
- Implementing the Scripting Engine Agent Interface
- Assigning Scripting Engine-Related Responsibilities to a User
- Establishing Profile Settings for the Agent Interface
- Setting Session Idle Timeout Values for Apache JServ
- Implementing the Scripting Engine Web Interface
- Implementation Considerations
- Assigning Web Interface Responsibilities to a User
- Implementing Administrative Interfaces
- Establishing Profile Settings
- Setting Up the Scripting Administrative Interface
- Setting Up the Survey Administrative Interface
- Configuring the Oracle XML SQL Utility
- Setting Display Server for UNIX Environments
Understanding Users Required for Implementation

Before creating and administering users for Oracle Scripting, you must understand the types of users required, the applicable responsibilities to assign to the appropriate Oracle Applications login, and the specific tasks to accomplish.

From an implementation perspective, you need to create administrator users and agent users. The responsibilities that must be associated with each user type depends on how Oracle Scripting will be implemented at the enterprise, and which Oracle Applications functions will be required.

This section addresses which user account to use to create other users, and possible requirements for JTF roles for a specific user. It also describes a rationale for creating a super user for implementation purposes. This section then includes an implementation responsibility matrix, and a discussion regarding the approach to creating users for your Oracle Scripting implementation.

This section includes the following topics:

- SYSADMIN Versus Explicitly Created Administrator User Account, page 4-2
- JTF Role Requirements, page 4-3
- Administrator Super Users, page 4-3
- Implementation Responsibility Matrix, page 4-4
- Road Map to User Creation and Administration, page 4-8

References

- Additional specific information for creating administrators and for creating agents can be found, respectively, at Creating Administrators for Oracle Scripting, page 4-9 and Creating Oracle Scripting Agents, page 4-16.
- Step-by-step procedures to accomplish user creation tasks are described in Creating and Administering Users, page 5-1.

SYSADMIN Versus Explicitly Created Administrator User Account

Implementors often access the seeded SYSADMIN Oracle Applications user account when administering or configuring Oracle Applications. For security purposes, some enterprises restrict access to this account. For this reason, this document assumes you will create (or have created for you) at least one distinct Oracle Applications user account, and provide this new account with all of the required roles, responsibilities and privileges required for implementation, administration, and testing. For planning
purposes, if an enterprise has the SYSADMIN account locked down, you may need to request in advance that an administrator user account be created for you.

To create an administrator for Oracle Scripting, you must know all of the tasks the administrator will perform, and how Oracle Scripting will be used at the enterprise.

**JTF Role Requirements**

Some implementation or administration tasks require the administrator user to be granted JTF roles before you log into Oracle Applications.

For example:

- A Survey Administrator user must be granted the JTF_FM_ADMIN role in order to access the Invitations tab on the Survey Administration console, or to access any tab on the Fulfillment Administration console.

- If performing tasks involving modification of JTF advanced system properties (for example, removing the Quick Find menu from the Scripting Administration console), your Oracle Applications user account must be granted the JTF_SYSTEM_ADMIN_ROLE role.

- If using an administrator user to create other users with roles (such as the JTF_SYSTEM_ADMIN_ROLE or the JTF_FM_ADMIN role), the user account accessed to assign JTF roles to another user must already be granted those JTF roles.

If required, you can use the seeded SYSADMIN Oracle Applications user account. If you do not have access to this account, request that the specific JTF roles needed are assigned to your administrator user.

**Administrator Super Users**

Your implementation may require you to define an administrator in the enterprise who is also a "superuser" (a user with administrator and agent privileges). This superuser not only administers users and system profiles, but also performs work in CRM applications. To achieve this, you must give this superuser the appropriate end user privileges and responsibilities, as described in the topic Creating Oracle Scripting Review the information below to determine which requirements apply to your administrator user(s). Then define users, assign responsibilities, and otherwise perform all steps as applicable.

**Note:** Some tasks (such as granting roles for list and fulfillment administration, or adding JTF system-level properties) require existing JTF roles such as JTF_SYSTEM_ADMIN_ROLE and JTF_FM_ADMIN role. Your Oracle Applications login must already be granted JTF roles.
in order to assign them or to administer advanced system-level properties. For this purpose, if required, you can use the seeded SYSADMIN Oracle Applications user account.

Implementation Responsibility Matrix

A matrix of responsibilities that may be required for various users is included below. The matrix includes user type (administrator or agent), responsibility name, the function provided by the responsibility, and the specific component that may require the responsibility.

Not all responsibilities listed in the matrix for each user type is necessarily required. For example, if Oracle Human Resource Management Systems is not installed, the HRMS Manager responsibility is not required. Similarly, for survey implementations, Oracle Marketing and Oracle One-to-One Fulfillment administration responsibilities are only required for list-based survey implementations.

Review the specific requirements for your implementation. Each implementation or administration task in this document lists the responsibility required to perform that task.

<table>
<thead>
<tr>
<th>User Type</th>
<th>Responsibility</th>
<th>Function</th>
<th>For Component(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>System Administrator</td>
<td>• Create and administer Oracle Applications users</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Establish or modify system profile settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Establish the link between Oracle Applications user and an employee in the database</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>HRMS Manager</td>
<td>• Create employees in the enterprise human resources database, if Oracle Human Resource Management Systems (HRMS) is licensed and installed at the enterprise.</td>
<td>All</td>
</tr>
<tr>
<td>User Type</td>
<td>Responsibility</td>
<td>Function</td>
<td>For Component(s)</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Administrator</td>
<td>CRM Resource Manager</td>
<td>• Create employees in the enterprise human resources database, if HRMS is not installed at the enterprise.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Import employees from the enterprise human resources database as CRM resources.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and manage resource groups.</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>Scripting Administrator</td>
<td>Access the Scripting Administration console. This is required to:</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Launch Script Author Java applet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Deploy scripts associated with an Oracle Applications user name, so the script can be mapped to specific custom Java archives</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View or remove scripts deployed using the Script Author Java applet</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View, upload, update, or remove custom Java archives to the database</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Map custom Java archives to specific scripts</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Categorize custom Java archives as global to apply to all deployed scripts</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Generate and view panel footprint reports</td>
<td></td>
</tr>
<tr>
<td>User Type</td>
<td>Responsibility</td>
<td>Function</td>
<td>For Component(s)</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Administrator</td>
<td>Survey Administrator</td>
<td>Access the Survey Administration console. This is required to:</td>
<td>Survey</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define survey resources (header and footer sections, final pages, and error pages in JSP format)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create survey campaigns</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define survey cycles</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define or deploy survey deployments</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View specific responses provided by survey respondents to a previously or currently active deployment</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>iSurvey User</td>
<td>Schedule or run concurrent programs.</td>
<td>Survey</td>
</tr>
<tr>
<td>Administrator</td>
<td>One-to-One Fulfillment Administrator</td>
<td>Access the Fulfillment Administration console.</td>
<td>Survey</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set up or change Fulfillment groups</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set up or change mail servers associated with Fulfillment groups</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View failed Fulfillment requests after concurrent programs succeed in passing requests to the Fulfillment server.</td>
<td></td>
</tr>
</tbody>
</table>

These fulfillment administration tasks are required for implementations using targeted (list-based) survey campaigns.
<table>
<thead>
<tr>
<th>User Type</th>
<th>Responsibility</th>
<th>Function</th>
<th>For Component(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Oracle Marketing Super User</td>
<td>• Access the Marketing Administration console.</td>
<td>Scripting Engine for agent application</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Establish campaigns</td>
<td>If Oracle TeleSales agents must launch a specific script, the script must be associated with a campaign or campaign schedule.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign scripts to agents or scripts to campaigns</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create, import, modify lists</td>
<td>Survey</td>
</tr>
<tr>
<td></td>
<td>Survey</td>
<td></td>
<td>For list-based survey campaigns, lists must be created and administered.</td>
</tr>
<tr>
<td>Administrator</td>
<td>Sales Online Super User</td>
<td>• Access the Sales Online Administration console to:</td>
<td>Scripting Engine for agent application</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign agents to campaign schedules</td>
<td>If Oracle TeleSales agents must launch a specific script, the script must be associated with a campaign or campaign schedule.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assign campaign schedules to agents</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>CRM HTML Administration</td>
<td>Administer Oracle CRM HTML applications, including verifying or adding Guest User JTF system-level properties so that survey respondents using the non-hosted IESSVYMAIN.JSP template can start an Oracle applications session.</td>
<td>Survey</td>
</tr>
<tr>
<td>Agent</td>
<td>Scripting User or Scripting Agent</td>
<td>Launch scripts in &quot;standalone mode&quot; from Oracle Forms, typically to test deployed scripts.</td>
<td>Scripting Engine for agent interface</td>
</tr>
<tr>
<td>Agent</td>
<td>Customer Support</td>
<td>For agents accessing Oracle Scripting from within the integrated Oracle TeleService application.</td>
<td>Scripting Engine for agent application</td>
</tr>
</tbody>
</table>
User Type | Responsibility | Function | For Component(s)
---|---|---|---
Agent TeleSales Agent | For agents accessing Oracle Scripting from within the integrated Oracle TeleSales application. | Scripting Engine for agent application |

Road Map to User Creation and Administration

Order and Timing of User Type Creation

1. Create and administer one or more administrator user with the appropriate responsibilities for your implementation.

   Administrator users must be created first, and are used to accomplish all other implementation and administration steps. Use the Implementation Responsibility Matrix, page 4-4 as a guideline.

   Note that at least one administrator user requires the JTF_SYSTEM_ADMIN_ROLE to perform some implementation administration steps. Any administrator user that requires access to Oracle One-to-One Fulfillment also requires the JTF_FM_ADMIN role. Any user that must grant roles to other users must also already possess the role in question. For more information, see Granting JTF Roles, page 5-14.

2. Optionally, create and administer one or more agent user with the appropriate responsibilities for your implementation.

   The order in which agent users are created is at your discretion. You may choose to create Oracle Applications users for each agent immediately following the creation of an administrative user, assuming you have all information required. Alternatively, agent users can be created immediately prior to use of an agent login for administration or testing purposes.

   Use the Implementation Responsibility Matrix, page 4-4 as a guideline. Specific steps are detailed in Oracle Interaction Center Server Manager Implementation Guide.

Method of Creating and Administering Users

1. The first task for user creation and administration is to create employees in the employee database.

   1. If HRMS is installed, you must use Oracle HRMS to create and administer employees. This requires the HRMS Manager responsibility.

   2. If HRMS is not installed, you must use Oracle CRM Resource Manager to create and administer employees. This requires the CRM Resource Manager.
2. After creating employees in the database, import each employee as a CRM resource. This requires the CRM Resource Manager responsibility.

   1. If resource group membership is required for the user, create and administer groups first. Ensure you provide the appropriate role types, roles, and usages to the group. If the appropriate group already exists and has the appropriate attributes, skip this step.

   2. After resource group creation (if applicable), import the employee as a CRM resource. Ensure you provide the appropriate role type and role for the employee. Employees do not have usages.

   3. If required, query the appropriate group and associate the employee from within the group. Verify that the person has the appropriate role types and roles.

3. Define Oracle Applications users. This requires the System Administrator responsibility.

   1. First select the user name and password. Verify the password.

   2. Assign the appropriate responsibilities for this user. Use the Implementation Responsibility Matrix, page 4-4 as a guideline.

   3. If an employee in the database, associate this Oracle Applications user account with the employee in the enterprise database.

Creating Administrators for Oracle Scripting

For the purposes of Oracle Scripting implementation and use, administrators fall into three categories: system administrators, script administrators, and survey campaign administrators. The first two categories are required for all implementations. Survey administrators are required for any implementation in which scripts are intended to be executed in a Web browser. You can establish the same individual with all administration privileges, or you can create two or more administrative users.

System Administrators

System administrators have the System Administrator responsibility, and administer users and applications across the broad spectrum.

One task of a system administrator is to create users. To start the process of creating users for Oracle Scripting, you can either use SYSADMIN or you can create your own system administrator user.
Script Administrators

Script administrators access the Scripting Administration console, an HTML user interface that provides access to the Script Author Java applet, allows administration of Oracle Scripting files, and provides access to agent interface report generation and analysis. Individuals who develop scripts using the Script Author component require access to this administrative UI.

Survey Administrators

Survey administrators access the Survey Administration console, an HTML user interface that provides the ability to establish survey campaigns and to administer targeted survey campaign deployments using Oracle One-to-One Fulfillment and Oracle Marketing functionality. This console also provides access to view individual responses to a Web-enabled survey campaign: individuals who monitor campaign status for ongoing active survey campaigns or who analyze past campaigns require access to this administrative UI.

Note: Administrator users can be created by any Oracle Applications user account with the System Administrator responsibility, with one exception. If implementing the survey component, the administrator user must be granted the JTF_SYSTEM_ADMIN_ROLE and may require the JTF_FM_ADMIN role. Your Oracle Applications login must already be granted JTF roles in order to assign them. For this purpose, you can use the seeded SYSADMIN Oracle Applications user account.

Fulfillment and List Management Administrators

Implementations requiring execution of targeted survey deployments require additional roles, responsibilities, and must meet or bypass sales group membership requirements. See the following sections:

- Assigning Fulfillment Administrator Role to Survey Administrator, page 4-31
- Granting JTF Roles, page 5-14
- Bypassing the Sales Resource Group Membership Requirement, page 5-13
- Administering Lists in Oracle Marketing, page 9-15

Administration User Setup Steps

Consult the table below to determine which administrator user setup steps are required for your implementation.
**Note:** If your administrator also needs agent functions, see Creating Oracle Scripting Agents, page 4-16.

Then perform all steps as applicable.

<table>
<thead>
<tr>
<th>If administrator needs to do this...</th>
<th>Perform these steps...</th>
<th>Consult these documented tasks...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create or modify Oracle Applications users</td>
<td>• Assign System Administrator responsibility</td>
<td>Creating and Administering Users, page 5-1</td>
</tr>
<tr>
<td></td>
<td>• Access Forms-based applications as a system administrator</td>
<td></td>
</tr>
<tr>
<td>Create or modify an employee in the enterprise database</td>
<td>• Assign appropriate HRMS responsibility (based on country) or CRM Resource Manager responsibility (if HRMS not installed)</td>
<td>Creating an Employee in the Enterprise Database, page 5-2</td>
</tr>
<tr>
<td></td>
<td>• Access HRMS or CRM Resource Manager as appropriate</td>
<td></td>
</tr>
<tr>
<td>Create a resource group in CRM Resource Manager</td>
<td>• Assign CRM Resource Manager responsibility</td>
<td>Creating a Resource Group, page 5-4</td>
</tr>
<tr>
<td></td>
<td>• Access CRM Resource Manager to create group and assign membership roles and members</td>
<td></td>
</tr>
<tr>
<td>Import an employee as a CRM resource</td>
<td>• Assign CRM Resource Manager responsibility</td>
<td>Importing a CRM Resource, page 5-5</td>
</tr>
<tr>
<td></td>
<td>• Access CRM Resource Manager to import employee</td>
<td></td>
</tr>
<tr>
<td>If administrator needs to do this...</td>
<td>Perform these steps...</td>
<td>Consult these documented tasks...</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Access the Scripting Administration console to perform any of the following:</td>
<td>• Assign Scripting Administrator responsibility</td>
<td>Assigning Scripting Administrative Responsibilities to Users, page 4-15</td>
</tr>
<tr>
<td>• Launch the Script Author Java applet.</td>
<td>• Ensure prerequisite JTT system profiles are established.</td>
<td></td>
</tr>
<tr>
<td>• Create, modify, or deploy custom scripts using Script Author Java applet.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• View or remove deployed scripts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Deploy, update, or remove custom Java archives to the Applications database.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Define uploaded Java archives as global to apply to all deployed scripts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Map uploaded Java archives to one or more specific scripts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• View and generate panel footprint reports.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access the Survey Administration console to administer survey resources</td>
<td>• Assign Survey Administrator responsibility</td>
<td>Assigning Survey-Related Administrative Responsibilities to Users, page 4-15</td>
</tr>
<tr>
<td>• Provide FTP access to applications server to deploy JSP resources to $OA_HTML and images to $OA_MEDIA as appropriate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If administrator needs to do this...</td>
<td>Perform these steps...</td>
<td>Consult these documented tasks...</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Access the Survey Administration console to perform any of the following:</td>
<td>• Assign Survey Administrator responsibility</td>
<td>Assigning Survey-Related Administrative Responsibilities to Users, page 4-15</td>
</tr>
<tr>
<td>• Create survey campaigns and cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• View or modify survey campaign details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Create additional cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Rename cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Define deployments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• View or modify deployment details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Change or view deployment status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage survey campaign responses, including:</td>
<td>• Assign Survey Administrator responsibility</td>
<td>Assigning Survey-Related Administrative Responsibilities to Users, page 4-15</td>
</tr>
<tr>
<td>• View individual Web interface responses</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Send reminders manually to list members</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate summarized Web interface reports or panel footprint reports</td>
<td>• Assigning iSurvey User responsibility to access Concurrent Manager</td>
<td>Assigning iSurvey User Responsibility for Administering Concurrent Programs for Survey Execution</td>
</tr>
<tr>
<td>If administrator needs to do this...</td>
<td>Perform these steps...</td>
<td>Consult these documented tasks...</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>View, generate, or modify lists for list-based survey campaigns</td>
<td>• Assign Oracle Marketing Super User responsibility</td>
<td>• Assigning Oracle Marketing Responsibilities to a User</td>
</tr>
<tr>
<td></td>
<td>• Assign sales group membership and roles or bypass group membership requirements</td>
<td>• Assigning Sales Group Membership and Roles to a User or Bypassing the Sales Resource Group Requirement, page 5-13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Administering Lists in Oracle Marketing, page 9-15</td>
</tr>
<tr>
<td>Access the Invitations tab from the Survey Administration console to administer fulfillment documents for list-based survey campaigns</td>
<td>• Assign JTF_SYSTEM_ADMIN_ROLE role</td>
<td>• Assigning Fulfillment Administrator Role to Survey Administrators, page 4-31</td>
</tr>
<tr>
<td></td>
<td>• Assign JTF_FM_ADMIN role</td>
<td>• Granting JTF Roles, page 5-14</td>
</tr>
</tbody>
</table>

See Also

- Implementation Task Sequence, page 3-1

Performing Further Administration Setups

Oracle Scripting has varying requirements for administration, based on the components required for your implementation.

- All new or upgraded implementations require a Scripting administrator.

- Implementations requiring execution of a script in a Web browser require a survey administrator.

- Implementations requiring execution of list-based surveys require additional roles, responsibilities, and group membership requirements.

- Implementations requiring customization of self-service Web applications need
administrators of the appropriate application to customize the JSP pages to include survey URL links.

- Implementations using Oracle Applications on the UNIX platform have additional configuration steps based on platform and patch level.

- Implementations requiring multiple Apache listeners require Apache Web server administrators intimately familiar with Oracle Applications administration.

This section includes the following topics:

- Assigning Scripting Administrative Responsibilities to Users, page 4-15

- Assigning Survey-Related Administrative Responsibilities to Users, page 4-15

**Assigning Scripting Administrative Responsibilities to Users**

The Scripting Administrator responsibility is required for a user to log into the Scripting Administration console, from which the Script Author Java applet can be launched, deployed scripts can be viewed and deleted, Java archives can be viewed, deleted, or mapped to deployed scripts, and agent interface reports can be generated and analyzed.

Assign the Scripting Administrator responsibility to users of the Scripting Administration console, as described in Defining Oracle Applications Users, page 5-7.

For testing purposes, you may want to test scripts by executing them after they are created and deployed. In this case, you will also want the Scripting Agent, Vision Enterprises, or Scripting User responsibility as well.

You can provide the Scripting administrator with a responsibility to launch a business application such as Oracle TeleSales or the Customer Care component of Oracle TeleService.

To allow the user to manage and control scripts to be executed in the Scripting Engine Web interface, you must enable the same administrator user to perform survey administration tasks. In this case, follow all additional recommendations in Assigning Survey-Related Administrative Responsibilities to Users, page 4-15.

For a full list of responsibilities that may be required for Oracle Scripting, see Implementation Responsibility Matrix, page 4-4.

**Assigning Survey-Related Administrative Responsibilities to Users**

Assign the appropriate Survey-related responsibilities to appropriate administrator users as described in Defining Oracle Applications Users, page 5-7.

The following is a summary of Oracle Applications responsibilities for using Survey:

- The Survey Administrator responsibility is required for a user to log into the Survey Administration console, from which survey campaigns are created, deployed, and
The iSurvey User responsibility is required to run Concurrent Manager for processing and scheduling of concurrent programs required to support survey operations.

- Optionally, you can assign the One-to-One Fulfillment Administrator responsibility, required to access Oracle One-to-One Fulfillment, to an Oracle Applications user with the Survey Administrator responsibility. In this way, the same user would have the ability to administer all aspects of Oracle One-to-One Fulfillment required for list-based survey operations.

**Note:** While assigning the One-to-One Fulfillment Administrator to a survey administrator user is not required, logging into Oracle Applications as a fulfillment administrator is required in order to perform the implementation step described in Adding Survey Administrator User to a Fulfillment Group, page 4-32.

For a full list of responsibilities that may be required for Oracle Scripting, see the Implementation Responsibility Matrix, page 4-4.

### Creating Oracle Scripting Agents

Many CRM applications require users to be associated with CRM resource identification codes. This requires users to be defined as employees in the enterprise database, and to be imported as CRM resources. Oracle recommends that these steps be performed for all agent users as the first steps in agent creation.

You must define agent users that can log into an Oracle Applications session. Each agent user must be assigned the appropriate responsibilities to perform a particular set of functions. To define an agent for Oracle Scripting, you must know all tasks the agent will perform, and how Oracle Scripting will be used at the enterprise.

Additionally, applications that rely on campaign information (such as Oracle TeleSales and Oracle Marketing) may require agents to have specific group membership and roles assigned to them, and also for the script to be explicitly associated with a campaign.

Review the information below to determine which requirements apply to your agent users. Then define users, assign responsibilities, and otherwise perform all steps as applicable.

### Agent User Setup Steps

Consult the table below to determine which agent user setup steps are required for your implementation. Then perform all steps as applicable.
<table>
<thead>
<tr>
<th>If agent needs to do this...</th>
<th>Perform these steps...</th>
<th>Consult these tasks...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Agent interface to execute scripts in standalone mode</td>
<td>• Assign Scripting Agent or Scripting User responsibility</td>
<td>• Defining Oracle Applications Users, page 5-7</td>
</tr>
<tr>
<td>Use the Agent interface to execute scripts from Customer Support component of Oracle TeleService</td>
<td>• Assign Customer Support responsibility</td>
<td>• Defining Oracle Applications Users, page 5-7</td>
</tr>
<tr>
<td>Use the Agent interface to execute scripts from business applications requiring campaign information (Oracle TeleSales)</td>
<td>• Assign Scripting Administrator responsibility</td>
<td>• Assigning Scripting Administrative Responsibilities to Users, page 4-15</td>
</tr>
<tr>
<td></td>
<td>• Access CRM Resource Manager to provide agent with Sales and TeleSales roles</td>
<td>• Creating a Campaign, page 9-3</td>
</tr>
<tr>
<td></td>
<td>• Access CRM Resource Manager to add agent to sales group</td>
<td>• Creating a Campaign Schedule, page 9-6</td>
</tr>
<tr>
<td></td>
<td>• Access Oracle Marketing to create a campaign and a campaign schedule, associate a script to a campaign schedule, assign agents to a campaign schedule or vice versa</td>
<td>• Associating a Script to a Campaign Schedule, page 9-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Associating a Script to a Campaign, page 9-10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assigning Agents to a Campaign Schedule, page 9-12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Assigning Campaign Schedules to Agents, page 9-13</td>
</tr>
<tr>
<td>Use the Web interface to execute scripts from a self-service Web application in a Web browser</td>
<td>• Assign self-service Web application responsibility</td>
<td>• The topic Scripting Engine Users in the Oracle Scripting User Guide</td>
</tr>
</tbody>
</table>
### If agent needs to do this... | Perform these steps... | Consult these tasks...
---|---|---
Use the Web interface to execute surveys in a Web browser | • Access an active survey URL | • The topic Scripting Engine Users in the Oracle Scripting User Guide
Use the Web interface to execute list-based surveys in a Web browser | • Access an active survey URL from an e-mail message invitation or reminder | • The topic Scripting Engine Users in the Oracle Scripting User Guide

**See Also**

- Implementation Task Sequence, page 3-1

**Implementing the Scripting Engine Agent Interface**

The implementation tasks detailed in this section are required only for Scripting Engine operations for the Java-based interaction center agent application.

In addition to these tasks, you will also need to set up the Scripting Administration console as described in Setting Up the Scripting Administrative Interface, page 4-30.

This section includes the following topics:

- Assigning Scripting Engine-Related Responsibilities to a User, page 4-18
- Establishing Profile Settings for the Agent Interface, page 4-19
- Setting Session Idle Timeout Values for Apache JServ, page 4-22

**Assigning Scripting Engine-Related Responsibilities to a User**

Assign the appropriate Scripting Engine-related responsibilities to appropriate agent and administrator users as described in Defining Oracle Applications Users, page 5-7.

The agent interface for the Scripting Engine is a Java bean that runs in an Oracle form. A script can be executed in the agent application by any Oracle Applications user with the appropriate responsibility.

Scripts can be launched in the agent application either in standalone mode (recommended for testing), or from an integrated application. In either case, you must have the appropriate responsibility for that application assigned to your Oracle...
Applications login.

Following is a summary of Oracle Applications responsibilities for using the Scripting Engine in the agent application:

- The **Scripting User** or **Scripting Agent** responsibility is required for a user to launch scripts in standalone mode.

- The **Customer Support** responsibility is required to run the Oracle Support component of Oracle TeleService, from which a user can launch a script in the agent interface.

- The **TeleSales Agent** responsibility is required to run Oracle TeleSales, from which a user can launch a script in the agent interface.

For a full list of responsibilities that may be required for Oracle Scripting, see the Implementation Responsibility Matrix, page 4-4.

### Establishing Profile Settings for the Agent Interface

Setting system profiles determines the behavior of Oracle Applications. To implement the Scripting Engine agent interface, follow the procedure described in Setting System Profile Values, page 5-16 for the following system profile options.

See the Guidelines, page 4-20 for information on these settings.

**Note:** If your implementation requires a separate Apache JServ listener established for Oracle Scripting, select the Application option. This may be required to avoid session timeout errors, as described in Setting Session Idle Timeout Values for Apache JServ, page 4-22.

<table>
<thead>
<tr>
<th>Step</th>
<th>Option</th>
<th>Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IES : Architecture Type</td>
<td>Site</td>
<td>Apache Mid Tier/Servlet Architecture</td>
</tr>
<tr>
<td>2</td>
<td>IES : Debug Mode</td>
<td>Site, Application, Responsibility, or User</td>
<td>Debug off or Debug on</td>
</tr>
<tr>
<td>3</td>
<td>IES : Display Suspend Button on Script Frame</td>
<td>Site, Application, Responsibility, or User</td>
<td>False or True</td>
</tr>
<tr>
<td>Step</td>
<td>Option</td>
<td>Level</td>
<td>Value</td>
</tr>
<tr>
<td>------</td>
<td>-------------------------</td>
<td>---------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>4</td>
<td>IES: Initial Script</td>
<td>Site, Application,</td>
<td>&lt;Desired frame size, based on agent desktop resolution or overall</td>
</tr>
<tr>
<td></td>
<td>Frame Size</td>
<td>Responsibility, or User</td>
<td>requirements&gt;</td>
</tr>
<tr>
<td>5</td>
<td>IES: Scripting Panel</td>
<td>Site</td>
<td>Display Multiple Panels at a time in Scripting window or Display</td>
</tr>
<tr>
<td></td>
<td>Display Mode</td>
<td>Single Panel at a time in</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scripting window</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>IES: Proxy Server Name</td>
<td>Site or Application</td>
<td>&lt;Name of Proxy server if used for Scripting Engine agent UI&gt;</td>
</tr>
<tr>
<td>7</td>
<td>IES: Proxy Server Port</td>
<td>Site or Application</td>
<td>&lt;Port of Proxy server if used for Scripting Engine agent UI&gt;</td>
</tr>
<tr>
<td>8</td>
<td>Apps Servlt Agent</td>
<td>Site or Application</td>
<td>&lt;URL for the Servlet zone of the enterprise Apache Web server&gt;</td>
</tr>
</tbody>
</table>

A full list of profile option settings required to implement Oracle Scripting is included in Oracle Scripting Profile Options, page A-1.

**Guidelines**

**Author Debug**: Turning Author Debug Mode on will log additional informational messages regarding Script Author operations. When enabled, this profile option provides additional informational and error messages for Script Author debugging, generated in the Apache server logs. Note that you must administer (configure) your Apache Jserv to send console output to the Apache error log.

**Architecture Type**: The only supported architecture type is the Apache Mid-Tier/Servlet Architecture.

**Note**: If Apache Mid Tier/Servlet Architecture value is not in the list of values, and instead you see Two Tier Mode and Three Tier Mode, stop your work and see your systems administrator. This means your environment has not been upgraded beyond Oracle Applications 11.5.5.
Do not select Three Tier Mode.

Note: New Scripting Engine implementations with this profile option configured for the Caching Architecture will not be supported.

Debug Mode: Turning Debug Mode on will log additional informational messages regarding Scripting Engine execution and other operations. Message logs for debugging or informational purposes are accessible from OAF technology stack applications such as the Survey Administration console in which the Diagnostics global button appears. This button is displayed in the UI only when the FND: Diagnostics button is set to Yes at the site, application, responsibility, or user level.

Display Suspend Button on Script Frame: Deployed scripts which have the global Suspendable script property option checked (set to True) can suspend Oracle Scripting transactions when this option is set to True. If enabled, a Suspend button displays on the bottom of the script frame (next to the Disconnect button). This button is hidden if the profile is set to False (or remains null). Oracle recommends setting this option to True only (a) if the agent interface is used in standalone mode, or (b) when applications integrated with Oracle Scripting are updated to include the ability to resume the script from the business application. This can be set at the site, application, responsibility, or user level, as required.

Initial Script Frame Size: This profile option controls the initial size of the Scripting Engine frame window in the Forms/Java agent user interface. Default size is 800 pixels in width and 600 pixels in height. Administrators can now select other options including 1024 X 768, 1280 X 1024, or Maximized. This can be set at the site, application, responsibility, or user level, as required.

Scripting Panel Display Mode: There are two lookup values from which to choose: Display Multiple Panels at a time in Scripting window and Display Single Panel at a time in Scripting window. Using single-panel mode, only the current (active) panel will appear on the screen at any given time in the agent UI. Under multi-panel display mode, the active panel will have focus, but panels previously visited will appear in the UI, scrolling out of site. Panels that are not active are de-emphasized (they appear smaller and gray). Active panels display unformatted, spoken, instructional, and custom text in black, blue, magenta, and custom colors as designed. For more information, see the topic "The Panel Display Area" in the section "Understanding the Scripting Engine" of the Oracle Scripting User Guide and online documentation.

Proxy Server Name: This references the name of any proxy server required for using Oracle Scripting, and enables the use of HTTPS. This is only required for Scripting Engine agent UI implementations using a Proxy server.

Proxy Server Port: This references the port number of the appropriate proxy server required for using Oracle Scripting, and enables the use of HTTPS. This is only required for Scripting Engine agent UI implementations using a Proxy server.

Apps Servlet Agent: Type the URL for the Servlet zone of the Apache JServ listener
intended for Oracle Scripting in this field.

Syntax:

http://<servername>.<domain>:<Apache Web server port>/<servlet_zone>

Example:

http://server1.yourcompany.com:7777/oa_servlets

This setting is required for Apache mid-tier architecture implementations of Oracle Scripting. This profile is populated with the servlet zone of the Apache Web server. If your implementation requires only one Apache Web server listener, this profile is set at the site level and is used for all applications. Some environments require multiple Apache Web server listeners. For example, if some applications require short session idle timeout settings and others (like Oracle Scripting) require longer idle timeout settings, additional listeners may be configured. In such cases, the URL of the alternate listener is set at the application level for this profile. The specified applications will then reference the alternate Apache JServ instance.

References

- Oracle Scripting Profile Options, page A-1
- Setting System Profile Values, page 5-16

Setting Session Idle Timeout Values for Apache JServ

In the Oracle Scripting Apache mid-tier architecture, the Scripting servlet runs in an Apache JServ. Every Apache JServ has a session idle timeout setting that controls how long a servlet session can be idle before it is automatically timed out (expired and terminated) by the Apache JServ. This behavior ensures that abandoned sessions in the servlet are not left to consume resources unnecessarily. Sessions in the Apache JServ can be abandoned due to a variety of causes (end user walked away from the computer without logging out, network failure, etc.).

When a servlet session is active in the JServ, but is idle (has received no client requests) for longer than the specified idle timeout setting, the JServ will automatically time out or expire the session. In Scripting, the servlet session stores all of the state information of a running script (panels accessed, answers given, etc.). Therefore, a timeout of a Scripting servlet session while an agent is running a script is a fatal error, causing the agent to lose all data that was collected in that session of the script. When this occurs, the agent must close the Scripting window and start a new session of the script, recapturing all information. To avoid this problem, you should verify that the ZONE.PROPERTIES file for the appropriate Apache JServ instance configured for Oracle Scripting has an appropriate timeout setting, and modify this setting if required.
Oracle Scripting Timeout Requirements

Oracle Scripting requires longer Apache JServ session idle timeout settings than other types of applications using Apache JServ. Interaction centers generally use a relatively small number of dedicated Oracle Scripting agents, who will typically remain logged in throughout the course of the day. In between script transactions, Scripting agents may be idle (from an application perspective) for long periods of time (possibly hours). During an active script transaction, when the agent is conversing on the telephone with customers, agents will be generally more active, but will still have some idle periods, possibly lasting several minutes. It is critical to ensure the Scripting session does not expire during a script transaction, as all data and history collected during the script transaction is lost when a session times out. Due to the usage pattern for Scripting and the importance of keeping the session intact throughout an active script transaction, session timeout values for an Apache JServ instance that is running Scripting sessions should be verified and may need to be extended.

The session idle timeout setting for Apache JServ must be set to a large enough value that it will not cause session time-outs during a script transaction. Naturally, this value will vary based on your specific business needs, as well as agent behavior and training, and the use of other applications relying on Apache JServ. In general, a value of 30 minutes is reasonable for typical Oracle Scripting configurations.

Oracle iStore Timeout Requirements

Oracle applications using Apache JServ that have many users and who log in for short periods of time throughout the day have different idle timeout requirements. For applications that follow this model (for example, Oracle iStore), the JServ should time-out idle sessions quickly (after a few minutes) so that resources are freed and available for other users.

Single Apache JServ Listeners Serving Multiple Application Types

Generally, it is not recommended to have the Apache JServ session idle timeout value set longer than 30 minutes if you have an application using the Apache JServ in which many users log in for short periods of time throughout the day, as well as other users who log in for extensive periods of time and have long idle periods.

Multiple Apache JServ Listeners

If your Apache is currently serving both types of applications, Oracle recommends configuring one Apache listener for each application type. Each Apache port/listener will have its own respective ZONE.PROPERTIES file, and can therefore support different session idle timeout settings per Apache listener. Thus, for example, if using Oracle iStore and Oracle Scripting, the ZONE.PROPERTIES file for the Apache listener configured for Oracle iStore should be set for a short session idle timeout, whereas the other should be set for a longer timeout for Scripting operations.

Using multiple Apache listeners may require changing the Apps Servlet Agent profile.
to specify a different Apache servlet zone at the Application level specifically for Oracle Scripting.

Use the following guidance to verify or set the session idle timeout to a value that will prevent any Scripting servlet session from timing out while an agent is in the middle of a script transaction.

Prerequisites

- This procedure is only required for Oracle Scripting release 11.5.6 or later implementations using the Scripting Engine agent interface in the Apache mid-tier architecture. This problem does not affect the Survey component of Oracle Scripting.

- At least one ZONE.PROPERTIES file must exist from appropriate installation of Apache Web server software installed during Oracle Applications implementation.

- As with all customization, you should back up the ZONE.PROPERTIES file before modification in the event of data failure.

- Modifications should occur at low-traffic times so the Web server can be taken offline momentarily.

- Stop the Apache Web server prior to modification.

Steps

1. Change to the directory where your Apache Web server is installed.
   Refer to Apache documentation or consult your Apache Web server administrator if you are not sure where to find this.

2. Change to the directory in which the ZONE.PROPERTIES file resides.
   This file is generally in the location <ORAHTTP_TOP>/Jserv/etc/ but may vary, depending on your specific Apache JServ configuration.

3. Open the ZONE.PROPERTIES file and locate the section of the file containing the session.timeout parameter.
   This is preceded by several commented lines (prepended with "#"). The section of the ZONE.PROPERTIES file should appear similar to the following:

   ```
   # Set the number of milliseconds to wait before invalidating an unused session.
   # Syntax: session.timeout=(long)>0
   # Default: 1800000 (30 mins)
   session.timeout=1800000
   ```
1. Verify that the value (in milliseconds) meets requirements for this Apache listener. If not, change the value after "session.timeout=" (adjust it higher or lower accordingly).

   Note: There are 60,000 milliseconds in one minute.

2. Save your work.

3. Restart the Web server.

Implementing the Scripting Engine Web Interface

Using the Scripting Engine Web interface, you can execute scripts in an Oracle Applications 12-certified Web browser, either from a self-service Web application, or as an information-gathering survey.

This section includes the following topics:

- Implementation Considerations, page 4-25
- Assigning Web Interface Responsibilities to a User, page 4-27

See Also

- Implementation Task Sequence, page 3-1

Implementation Considerations

The following requirements are all factors in implementing the Scripting Engine Web interface:

- Active survey campaign requirements corresponding to a survey URL
- Appropriate survey administrator responsibilities, roles and requirements
- A valid Oracle Applications session
- Appropriate script end-user responsibility
- Oracle Applications platform and patch level

Active Survey Campaign and Survey URL Requirements

Executing a script using the Scripting Engine Web interface requires appropriate survey campaign information, which must be administered in the Survey Administration
To execute a script in a Web browser or to participate in a Web-based survey, the Scripting Engine Web interface end user typically clicks a hyperlink to access a survey URL. The survey URL references a specific active survey deployment (identified by the dID parameter) on the surveying enterprise’s Apache Web server listener port. This may be the same Apache listener port established for all Oracle Applications at the enterprise, or it may reference an Apache JServ instance specifically set up for Oracle Scripting operations.

**Survey Administration Responsibility, Roles and Requirements**

The survey URL accessed by the script end user in the Web interface is generated when a survey administrator completes all requirements for a survey campaign in the Survey Administration console and makes the deployment active.

Administering survey campaign information is performed by an Oracle Applications user with the Survey Administrator responsibility. This administrator must have access to existing survey resources, survey campaign requirements (including start and end dates), and a valid, tested deployed script.

This administrator must have access to Oracle One-to-One Fulfillment master documents and lists created with Oracle Marketing. To access the Invitations tab from the Survey Administration console, this administrator user must be added to the appropriate fulfillment group, and requires two JTF roles (JTF_SYSTEM_ADMIN_ROLE and JTF_FM_ADMIN). This user will also require the One-to-One Fulfillment Administrator responsibility if the same Oracle Applications user will also be the administrator for Oracle One-to-One Fulfillment.

**Valid Oracle Applications Sessions**

Accessing the script or survey in a Web browser associated with the survey URL requires a valid, authenticated Oracle Applications session by an Oracle Applications user typically associated with one or more responsibilities.

For individuals executing a script in a Web browser from an integrated application such as Oracle iSupport, the Oracle Applications login information for the current valid Oracle Applications session is used. The individual selects a link from the customized self-service Web application interface (e.g., Oracle iSupport) to take the survey, which starts immediately using current login authentication.

For individuals executing a script in a Web browser who are not authenticated users of Oracle Application session, a guest user Oracle Applications account is accessed behind the scenes. This guest user account (seeded with Oracle Applications) provides access to an Oracle Applications session with privileges only to execute the designated script. The session starts upon accessing the survey URL, and is terminated upon completion of the script.
Script End User Responsibilities

Individuals executing a script in a Web browser from a self-service Web application such as Oracle iSupport will use the appropriate responsibility for that application.

Individuals executing a script in a Web browser as a survey use a guest user login. No responsibilities are typically associated with a guest user. As of this release, there are no setup steps required for the guest user (a common Oracle Applications guest user is now used; in previous releases, a guest user for the JTT technology stack was used and sometimes required administration).

Oracle Applications Platform and Patch-Level Requirements

- Display server setup for UNIX servers
- Manual configuration of XML SQL utility

Assigning Web Interface Responsibilities to a User

Accessing the script or survey in a Web browser associated with the survey URL requires a valid, authenticated Oracle Applications session by an Oracle Applications user typically associated with one or more responsibilities.

For individuals executing a script in a Web browser from an integrated application such as Oracle iSupport, the Oracle Applications login information for the current valid Oracle Applications session is used, including appropriate iSupport responsibility. The individual selects a link from iSupport to take the survey, which starts immediately using current login authentication.

For individuals executing a script in a Web browser as a survey, an Oracle Applications session is initiated using the Oracle Applications guest user login. No responsibilities are typically associated with a guest user.

See Also

- Implementation Considerations, page 4-25

Implementing Administrative Interfaces

Oracle Scripting has two administrative interfaces: the Scripting Administration console and the Survey Administration console. While both are HTML consoles accessed by administrators, they are built on different Oracle Applications technology stacks.

Some setup steps common to both administrator interfaces, some are specific to one interface, and others relate to the installation, patch level, or platform for Oracle Applications.

The Scripting Administration console is built on the JTT technology stack. This console
provides the user interface with which script developers can launch Script Author as a Java applet, and script administrators can administer Oracle Scripting files (deployed scripts and Java archives), as well as generate, view and analyze agent interface reports.

The Survey Administration console is built on the Oracle Applications framework. This console provides the user interface with which survey campaign administrators can administer survey resources, create and administer standard and targeted (list-based) survey campaign requirements, and monitor individual responses.

**Which Interfaces Do You Need?**

- As of Oracle Scripting release 11.5.8 (Interaction Center Family Pack P and later), all implementations require the Scripting Administration console.

- Any implementation making use of the Scripting Engine Web interface to execute a script in a Web browser will also require the Survey Administration console.

**System Profile Settings**

Users of either administrative interface must have Oracle Applications profile settings appropriately established. The Scripting Administration console additionally requires the administration of some system profiles used by that technology stack. While not required by the Survey Administration console, all implementations inherit the requirement to establish or verify JTF system profiles, as described below.

**Reporting Implementation Requirements**

- To generate and view reports for analysis of survey information using Oracle Discoverer, you must perform certain post-installation implementation and administration steps, as outlined in Oracle Discoverer Workbooks, page B-1.

Additionally, to generate and view the panel footprint report accessible from the Oracle Scripting Administration console, the following apply:

- Users of Oracle Applications installed between releases 11.5.1 and 11.5.4 must configure the Oracle XML SQL utility if this is not already configured.

- Users of Oracle Applications installed on a UNIX platform must set up a display X server.

Follow the procedures below to implement one or more administrative interfaces to meet the requirements of your implementation.

This section includes the following topics:

- Establishing Profile Settings, page 4-29

- Setting Up the Scripting Administrative Interface, page 4-30
• Setting Up the Survey Administrative Interface, page 4-31
• Configuring the Oracle XML SQL Utility, page 4-35
• Setting Display Server for UNIX Environments, page 4-38

See Also

• Implementation Task Sequence, page 3-1

Establishing Profile Settings

Setting system profiles determines the behavior of Oracle Applications. When implementing Oracle Scripting, follow the procedure described in Setting System Profile Values, page 5-16 for the following system profile options. These include six JTF profiles establishing default behavior of JTT HTML-based applications and one ICX profile establishing the default language.

See the Guidelines, page 4-30 below for information on these settings. Set the following profiles as indicated. Order below is recommended only; you can set these options in any sequence.

The settings below are provided as recommendations. Some may not apply; for example, you may not wish for Oracle Scripting to be established as the default for JTT applications, or you may wish to display a different number of rows. If there are business rules or requirements in your environment for other settings, let those requirements take precedence, or set profile settings at lower levels for the specified users.

<table>
<thead>
<tr>
<th>Step</th>
<th>Option</th>
<th>Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>JTF_PROFILE_DEFAULT_APPLICATION</td>
<td>Site or User</td>
<td>519 (see Guidelines, page 4-30 below)</td>
</tr>
<tr>
<td>2</td>
<td>JTF_PROFILE_DEFAULT_BLANK_ROWS</td>
<td>Site</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>JTF_PROFILE_DEFAULT_CSS</td>
<td>Site</td>
<td>JTFUCSS.CSS</td>
</tr>
<tr>
<td>4</td>
<td>JTF_PROFILE_DEFAULT_CURRENCY</td>
<td>Site</td>
<td>&lt;Applicable currency. For example, USD for U.S. Dollars&gt;</td>
</tr>
</tbody>
</table>
### Guidelines

**Default Application:** This setting assumes this Survey administrator user does not already have other functions in Oracle CRM technology foundation (JTT) HTML-based applications. Should other responsibilities exist for this user, confer with your systems administrator or the specific user to determine whether to modify the existing setting, or set this at the user level. As indicated in the preceding table, 519 is the product code for Oracle Scripting. *This setting is not environment-specific.*

**Default Responsibility:** This setting determines the responsibility that is displayed when a user logs into CRM HTML-based applications. If no other responsibilities existed for this user, select Survey Administrator or Scripting Administrator, based on the requirements of your administrative users. If this user already has other responsibilities, it may be a requirement to leave this setting, or set this at the user level. The value for this setting may be specific to each environment. For more information, see Oracle CRM Technology Foundation (JTT) Profile Options, page A-3.

**ICX Language:** This setting establishes language for the Internet Cartridge Exchange for Web-based transaction settings. This value is selected from the appropriate language from the FND_LANGUAGES table, and is typically set at the user level.

### References

- Oracle CRM Technology Foundation (JTT) Profile Options, page A-3
- Setting System Profile Values, page 5-16

### Setting Up the Scripting Administrative Interface

The Scripting Administration console provides users who are assigned the Scripting Administration responsibility with the user interface from which Script Author can be launched as a Java applet. Additionally, from this user interface, you can view and
remove scripts deployed to the database; you can view, upload, and map custom Java archives to any script deployed to the database; and you can generate, view and analyze panel footprint reports.

In earlier releases, the Survey Administration console included a Quick Find menu feature to locate survey campaigns, cycles, or deployments. For certain users upgrading Oracle Applications, this menu continues to display in any CRM Technology Foundation (JTT technology stack) application associated with product code IES (Oracle Scripting), even though it is obsolete. (This menu will not appear in new implementations.) For upgrading implementations prior to Interaction Center Family Pack Q or release 11.5.9, this menu will appear in the Scripting Administration console. You can remove the Quick Find menu from Scripting applications manually, after which it will not appear. See Removing the Quick Find Menu, page 5-23.

Other than performing installation, patch level, or platform-specific setup steps, no other tasks are required to implement the Scripting Administrative Interface.

Setting Up the Survey Administrative Interface

The Survey Administration console provides users assigned the Survey Administration responsibility with the user interface from which survey campaigns are created and administered. Active survey campaigns are required in order to execute a script in a Web browser using the Scripting Engine Web interface.

From this user interface, you can administer survey resources, define or change survey campaign information and status, access Oracle Marketing and Oracle One-to-One Fulfillment functionality required for targeted (list-based) survey deployments, and view responses received from users who executed the survey campaign script in a Web browser.

Other than performing installation, patch level, or platform-specific setup steps, no other tasks are required to implement the Survey Administrative interface for use with standard (non-list-based) survey campaigns.

Implementations using targeted deployments require the fulfillment administrator role to be assigned to the survey administrator, and require the survey administrator to be a member of a fulfillment group.

Tasks

Tasks include:

- Assigning Fulfillment Administrator Role to Survey Administrators, page 4-31
- Adding Survey Administrator User to a Fulfillment Group, page 4-32

Assigning Fulfillment Administrator Role to Survey Administrators

For list-based survey implementations, a user with the One-to-One Fulfillment
Administrator and Survey Administrator responsibilities must also be assigned the Fulfillment Administrative role (JTF_FM_ADMIN). This role provides access to Oracle One-to-One Fulfillment's user interface from within the Survey Administration console.

To perform some Oracle HTML-based applications administration, including this task, your Oracle Applications user must be granted the JTF_SYSTEM_ADMIN_ROLE. If required, you can use the seeded SYSADMIN Oracle Applications user account. For more information, see Granting JTF Roles, page 5-14.

This step is only required for implementations requiring targeted (list-based) survey deployments, to allow access to the Invitations tab. If you only wish to access Oracle One-to-One Fulfillment from within that application's user interface (and not from the Invitations tab in the Survey Administration console), then perform this step for the Oracle Applications user assigned the One-to-One Fulfillment Administrator responsibility.

**Note:** This step is not required for standard (non-list-based) survey campaign implementations, which will not be leveraging Oracle One-to-One Fulfillment capabilities.

**Guidelines**

- The user with the Survey Administrator and One-to-One Fulfillment Administrator responsibilities must be an employee in the enterprise database, must be available as a CRM resource, and must be associated with an Oracle Applications login.

- The Oracle Applications login must have the CRM HTML Administrator responsibility assigned to provide access to CRM HTML-based applications as an administrator with full privileges. This includes establishing the appropriate set of system profiles for site and user levels as discussed in previous implementation tasks.

- Oracle One-to-One Fulfillment does not need to be implemented at the enterprise to perform this step. Note, however, that Oracle One-to-One Fulfillment must be implemented in order to use the survey administration component of Oracle Scripting for list-based implementations, including for testing.

**See Also**

- Adding Survey Administrator User to a Fulfillment Group, page 4-32

**Assigning Survey Administrator User to a Fulfillment Group**

This task is only required for list-based implementations, and should be performed once per Survey administrator user. However, this step is not required for non-list-based survey campaign implementations, which will not be leveraging Oracle
One-to-One Fulfillment capabilities.
Use this procedure to add the Survey Administrator user to a Fulfillment group.

Prerequisites

- An Oracle HRMS employee must already exist in the enterprise, must be available as a CRM resource, and must be associated with an Oracle Applications login.

- An Oracle Applications user account must already be assigned both the Survey Administrator responsibility and the One-to-One Fulfillment Administrator responsibility.

- An Oracle One-to-One Fulfillment group must exist in order to perform this step.

- Oracle One-to-One Fulfillment does not need to be fully implemented at the enterprise to perform this step, as long as a Fulfillment group has been created. Note, however, that must be implemented in order to use the survey component of Oracle Scripting for list-based implementations, including for testing.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

One-to-One Fulfillment Administrator

Steps

1. From the Fulfillment Administration console, click the Group tab.

   The Groups page appears. A hyperlinked list of defined group names (if any) appear in a table.

   **Note**: If no group names appear in the list, you must first create a valid Fulfillment group as documented in Oracle Oracle One-to-One Fulfillment Implementation Guide.

2. To add the survey administrator user to an existing fulfillment group, do the following:

   1. Click on the appropriate Group Name hyperlink.
      
      The Group Detail page appears.

   2. In the Name text field of the Agents table, add the Oracle Applications user name of the agent (survey administrator) whom you wish to add to the
Fulfillment group, and click **Go**.

The Select Agent page appears.

3. Click the appropriate hyperlinked user name in the Agent User Name column.

If necessary, refine your search for the appropriate user name in the Select Agent text field and click **Search**. You can narrow your criteria using the % wildcard character.

The Group Detail page refreshes. The user name you selected now appears in the Agents list.

4. Click **Update** to confirm your selection.

The Groups page refreshes.

Perform the remaining steps to verify that this implementation task was successful.

5. Select the same Group Name hyperlink from the Groups page.

The Group Detail page appears.

6. Verify that the survey administrator user name appears in the list of agents.

3. To add the survey administrator user to a new fulfillment group, do the following:

   1. Click **Create**.

      The Create Group page appears.

   2. In the Group Name text field, enter an appropriate unique group name.

   3. Optionally, in the Description text area, enter a description of this group.

   4. From the Server Name list, select an appropriate server on which this Fulfillment group will be created.

   5. In the Name field under the Agents area, enter search criteria for the first agent whom you wish to add to this Fulfillment group and click **Go**.

      **Note:** The name criteria should specify the Oracle Applications user name.

      Search criteria is case-sensitive.

      You can use the % wildcard character.

      The Select Agent page appears.
6. Click the appropriate hyperlinked user name in the Agent User Name column. If necessary, refine your search for the appropriate user name in the Select Agent text field and click Search. You can narrow your criteria using the % wildcard character.

The Create Group page refreshes. The user name you selected now appears in the Agents list.

7. Repeat steps 3.5 and 3.6 until you have added all agents whom you wish to add to this Fulfillment group.

8. Click Create to save this group definition with the group members specified. Perform the remaining steps to verify that this implementation task was successful.

9. Select the same Group Name hyperlink from the Groups page. The Group Detail page appears.

10. Verify that the specified user names appear in the list of agents.

4. Continue your work, or click Sign Out to exit Oracle Applications.

See Also

• Assigning Fulfillment Administrator Role to Survey Administrators, page 4-31

Configuring the Oracle XML SQL Utility

Enterprises that implemented Oracle Applications using Rapid Install 11.5.1 through 11.5.6 that wish to use reporting in the Scripting or Survey Administration consoles must manually configure the Oracle XML SQL utility.

Oracle Applications implementations using Rapid Install 11.5.7 or later include automatic configuration of the Oracle XML SQL utility and do not require this task to be performed.

Use this procedure to obtain the appropriate files from your Web server, locate them appropriately, and modify the classpath in the JSERV.PROPERTIES file used by the servlet engine in Oracle HTTP Server.

Note: There is more than one way to specify a class path. If the method described below is not supported by your enterprise implementation, consult with your Apache Web server administrator to determine the appropriate method for your environment. This may include identifying the classpath in a control file or another configuration.
Login and Responsibility

You must have physical or Telnet access to the Web server, and have applmgr or sysadmin privileges. Use the appropriate login for these privileges in your environment.

Prerequisites

- Your Web server must be configured to use JDK 1.2.2 or above. If you are using a JDK version below JDK 1.2.2, you can upgrade to the most recently certified JDK version with Oracle Applications using My Oracle Support Note 130091.1, titled Upgrading to JDK 1.3 with Oracle Applications 11i; this Note also applies to Release 12 sites that have a JDK version below 1.2.2.

- You must retrieve the necessary Java libraries from the $COMMON_TOP/util directory of your Web server to configure your Web server properly. Obtain Xsu12.zip (for 11.5.1 installations) or XSU12_ver1_2_1.zip (for 11.5.2 through 11.5.5 installations).

Steps

1. Connect using Telnet to the enterprise system.

2. Change to the directory where your Oracle HTTP Server is installed. Refer to the Appendix of your Oracle Applications Installation manual if you are not sure where to find this.

3. Create a directory called xsu.

4. If the Java library you obtained is xsu12.zip, extract this file using the command:
   
   `unzip $COMMON_TOP/util/Xsu12.zip OracleXSU/lib/oraclexmlsql.jar`

   If the Java library you obtained is XSU12_ver1_2_1.zip, extract this file using the command:

   `unzip $COMMON_TOP/XSU12_ver1_2_1.zip OracleXSU12/lib/xsu12.jar`

5. Copy the file you just extracted to the new xsu directory.
   
   For example, on UNIX, you would execute one of the following commands:

   `cp OracleXSU/lib/oraclexmlsql.jar xsu/`

   or

   `cp OracleXSU12/lib/xsu12.jar xsu/`

6. Remove the OracleXSU or OracleXSU12 directory created by the unzip command.
7. Change to the directory in which the JSERV.PROPERTIES file resides.

   **Note:** The actual name of this file may include an underscore and the Apache JServ port (for example, JSERV.PROPERTIES_9404). For the purposes of this document, the Apache Web server configuration file will be referred to generically as the JSERV.PROPERTIES file. If you have any difficulties locating the file, consult with your Apache Web server administrator.

   The location of this file is environmentally dependent. It may be in one of the following paths:
   - `<ORAHTTP_TOP>/Jserv/etc/jserv.properties`
   - `<ORAHTTP_TOP>/apache39/conf`

   The ORAHTTP_TOP variable may not be set for your environment, in which case the path will be fully qualified to identify the entire physical path in the file system. If your configuration is different, consult with your Apache Web administrator to locate this directory.

8. Load the JSERV.PROPERTIES file into a text editor.

9. Look in the JSERV.PROPERTIES file for several lines beginning with `wrapper.classpath=`.

   This is the section in the file that sets the CLASSPATH used by the Web server.

10. If the Java library you obtained is `xsu12.zip`, add the following line to the JSERV.PROPERTIES file to include the XML SQL Utility libraries in your CLASSPATH:

    ```java
    wrapper.classpath=[ORAHTTP_TOP]/xsu/oraclexmssql.jar
    ```

    If the Java library you obtained is `XSU12_ver1_2_1.zip`, add the following line to the JSERV.PROPERTIES file to include the XML SQL Utility libraries in your CLASSPATH:

    ```java
    wrapper.classpath=[ORAHTTP_TOP]/xsu/xsu12.jar
    ```

   **Note:** Replace [ORAHTTP_TOP] with the physical path where your Oracle HTTP Server is installed.

11. Save the JSERV.PROPERTIES file, and exit the text editor.

    Your Web server is now configured to use the Oracle XML SQL Utility.
Guidelines

- Back up your JSERV.PROPERTIES file prior to customization. After configuring and testing, also back up your customized JSERV.PROPERTIES file in a separate location.

  **Note:** When you apply a patch, any customizations you have made to the JSERV.PROPERTIES file may be lost. In this case you will need to restore customizations to this file after patching.

Setting Display Server for UNIX Environments

This procedure applies to Oracle Applications built on the Oracle CRM Data Model (JTF) technology stack using Unix operating systems on the applications tier. From an Oracle Scripting perspective, this applies to Oracle Scripting implementations (on the Unix platform) that require generation and analysis of panel footprint reports from the Scripting Administration console.

Oracle Applications can dynamically generate and cache images with embedded text at runtime. These dynamic images are used, for example, to create buttons and tab menu bars displayed throughout various HTML-based transaction pages.

JFC/SWING and AWT (graphics libraries that are standard components within Java) require access to the native library of the operating system to process graphics (e.g., to display a window, paint a picture, generate a GIF image, and so on).

The reporting functionality for Oracle Scripting (the panel footprint report available from the Reports tab of the Scripting Administration console) employs JFC/SWING and AWT on the middle tier, where GIF images are processed in support of dynamically generated reports with graphics, and to render a script in a Web browser using HTTP.

Java AWT on Windows servers (Windows NT, Windows 2000) does not need a display server to render the graphics dynamically. However, in order for Java AWT to perform dynamic image generation on UNIX, you must specify an X Server that will be used as a display server to generate dynamic images. Images are generated and cached on the file system. Once these images have been cached, they need not be generated again. For this reason, the display server does not need to be a high-powered machine, nor is it required to be a dedicated server. However, it must be accessible by the Apache server that will call it.

To ensure graphics display functions in all UNIX environments, there are two processes you should perform in a UNIX environment:

- Modify JSERV.PROPERTIES to implement the Display Server identifier

- Reference the X Server in the apachectl or jservctl file (whichever is used in your environment to start the JServ).
Prerequisites
You must have an X Server up and running, on the network and accessible from the Apache JServ machine.

Steps

1. Access the JSERV.PROPERTIES file.
   This is typically located at <ORAHTTP_TOP>/Jserv/etc/jserv.properties on the Web server.

2. Make the following changes to implement the Display Server identifier.
   This can be done through xhost +, or through a more secure xauth UNIX command.

3. Add the following DISPLAY parameter immediately below the wrapper.bin variable.

   ```
   wrapper.env=DISPLAY=<xserver-hostname> <xserver-displayport>
   ```

4. Replace <xserver-hostname> and <xserver-displayport> with the machine name and port number where the X Server is running.

   **Example:**
   ```
   wrapper.env=DISPLAY=myxserver.mycorp.com:0.0
   ```

   **Note:** You can also reference a Windows NT machine that is running a UNIX emulator such as Exceed. See the man (UNIX manual) pages for xhost and xauth for more information.

5. Reference the X Server in the apachectl or jservctl file:

   **Example:**
   ```
   export DISPLAY=myxserver.mycorp.com:0.0
   ```

   **Note:** Whichever file is used to start the JServ for your environment (apachectl or jservctl) should be modified to reference the X server.

6. For your changes to take effect, fully stop and then restart the Apache Web server services.
Guidelines

- Establishing an X Server as a display server is no longer required for UNIX systems in order for survey respondents or self-service Web application users to participate in a survey or script using a Web browser.

- Establishing an X Server as a display server is no longer required for UNIX systems using the Survey Administration console.

- This step is still required in order to view reports from the Scripting Administration console.

References

- Testing Display Server for UNIX Environments, page 10-42
This chapter covers the following topics:

- Creating and Administering Users
- Creating an Employee in the Enterprise Database
- Creating a Resource Group
- Importing a CRM Resource
- Defining Oracle Applications Users
- Setting Up Debugging and Message Logging in Oracle Scripting
- Setting Up Applications Common Logging
- Enabling Logging for the Guest User
- Enabling the Oracle JInitiator Java Console
- Bypassing the Sales Resource Group Membership Requirement
- Granting JTF Roles
- Setting System Profile Values
- Finding Application and Responsibility ID Values
- Finding Default Application from a Responsibility ID Value
- Finding the FND User ID Value of a Defined User
- Obtaining the FND USER_ID Value Using SQL
- Obtaining the FND USER_ID Value from the Users Window
- Removing the Quick Find Menu

Creating and Administering Users

This section discusses the tasks required to create and administer Oracle Applications users.
This section includes the following topics:

- Creating an Employee in the Enterprise Database, page 5-2
- Creating a Resource Group, page 5-4
- Importing a CRM Resource, page 5-5
- Defining Oracle Applications Users, page 5-7

Creating an Employee in the Enterprise Database

Enterprises using Oracle Human Resource Management Systems (HRMS) must create employees with this application. For enterprises not using HRMS as their human resources application, employees must be created using CRM Resource Manager.

Use this procedure to create an employee in Oracle Human Resource Management Systems.

Prerequisites

None

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

HRMS Manager or CRM Resource Manager

Guidelines

In a test environment, the Survey Administrator responsibility can be assigned to any Oracle Applications user. In a production environment, however, this user must be an existing HRMS employee. This employee must also be designated as a CRM Resource. Steps to create employees in the enterprise database, import them as CRM resources, define Oracle Applications users, assign them responsibilities, and associate them with employees in the enterprise database are discussed in Creating and Administering Users, page 5-1.

HRMS Employee

The HRMS employee is typically created in Oracle Human Resource Management Systems (HRMS), if licensed by an enterprise. For enterprises that have **not** licensed
HRMS, the ability to create employees is also a scaled-down function of Oracle CRM Resource Manager.

If HRMS is installed, Oracle Applications enforces the business rule of requiring the user to create a person and designate them as the person type "employee" within HRMS. If you attempt to create an employee using CRM Resource Manager while HRMS is installed, you will experience an error.

Creating an employee in HRMS is accomplished by a user that has been assigned the appropriate HRMS responsibility (in the United States, for example, the US HRMS Manager responsibility).

If HRMS is not installed and licensed by an enterprise, the employee must be created using the CRM Resource Manager responsibility.

**CRM Resource**

After an employee is created, additional information (not required by HRMS) is required in order for CRM applications at the enterprise to appropriately reference this individual. If the employee is created using CRM Resource Manager, this information is part of the definition process.

If the employee is created using HRMS, employee information must subsequently be identified as a CRM resource. (By "resource," the concept of a person in the enterprise is inferred.) To do so, import the HRMS employee into CRM Resource Manager using the CRM Resource Manager responsibility. This process includes creation of a Resource Number and a corresponding Resource ID for this individual which is required by CRM applications.

Regardless of which method is used to create the employee (using HRMS or CRM Resource Manager), this document refers to this employee as an HRMS employee.

The other assumption that is a prerequisite for all Survey implementation steps is that this employee is identified as a CRM resource.

**Steps:**

1. If using HRMS, from the Navigator, select People > Enter and Maintain and click Open.
   The Find Person window appears.

2. If using CRM Resource Manager, from the Navigator, select Maintain Employee > Employee > Enter Person and click Open.

3. Click New.

4. In the People window, enter the following information for the new person.
   - Last (Name)
- Gender
- Type (select Employee)
- Date of Birth (if using Payroll)
- Social Security Number (if using US HRMS)
- Employee (Number) - If the Employee field is inactive, then Oracle HRMS is set up to automatically generate the employee number when the record is saved.

Other fields may be required depending on how your enterprise has set up Oracle HRMS or CRM Resource Manager. In addition, when you save the record, you may receive one or more messages that explain the consequences of leaving certain fields blank.

5. From the File menu, click Save.

In the status line, confirmation appears that a record has been applied and saved.

### Creating a Resource Group

Use this procedure to set up resource groups in CRM Resource Manager. Resource groups allow the assignment of role types, roles, and usages to one group that may contain one or many members.

An employee in a group with the role of manager automatically becomes the manager of the other employees in that group and of the employees in the groups below in the hierarchy.

**Note:** You must not assign more than one employee with the role of Manager per group. Doing so will impact reporting accuracy.

Use this procedure to create a resource group.

### Prerequisites

None

### Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.
Responsibility

CRM Resource Manager

Steps:
1. From the Navigator, select Maintain Resources > Groups and click Open. The Define Groups page appears.
2. In the Group Name field, type a name for your resource group.
3. Click the Roles tab.
4. From the list in the Role Type field, select the appropriate role type. For example, select TeleSales if this is a resource group for Oracle TeleSales agents.
5. From the list in the Role field, select the appropriate role for the selected role type. For example, select TeleSales Agent for use with Oracle TeleSales.
6. Click the Usages tab.
7. From the list in the Usage field, select the appropriate usages for the group. For example, select Sales and TeleSales if this is a resource group for Oracle TeleSales agents.
8. Click the Save icon.

Importing a CRM Resource

Use the following procedure to import a CRM resource.

Prerequisites

None

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

CRM Resource Manager
Steps:
1. From the Navigator, select Maintain Resources > Import Resources and click Open.
   The Selection Criteria window appears.
2. In the Resource Category field, select Employee.
3. Enter any additional selection criteria.
   For example, in the Name field, select the name of an employee.
4. Click Search.
   Employees that meet the search criteria are listed in the Search Results area.
5. Refine your search if necessary. Select the appropriate employee and click OK.
   The Selection Criteria window refreshes with the criteria you confirmed.
6. When satisfied with your selection criteria, click Search.
   The Selection Criteria window refreshes. Employees that meet the specified search criteria are listed in the Search Results area. The Select checkbox for the matching employees are automatically selected.
7. Clear the Select checkbox for each employee for whom you do not want to create a CRM resource.
8. Click Create Resource.
   The Default Values window appears.
   **Note:** Do not make any changes or add roles from this window.
   You can add or modify this information in the resource details later.
9. Click Ok to accept the defaults.
   The Selected Resources window appears. The Comments field indicates whether the resource is a new record, a duplicate record, or a duplicate record with a new role definition. The Select checkbox is automatically selected.
10. Clear the Select checkbox for each employee for whom you do not want to save as a resource.
11. To save the resources, click Save Resource.
    A transaction number appears in the Transaction Number field. The transaction number is associated with each resource created during this transaction. More than
Implementation Administration Tasks

one resource can have the same transaction number.

12. Click Details.

The Resource window appears. Verify the name of the resource (Name), the name of the employee (Source Name), and the user name (User Name) and note the resource number (Number).

13. From the Resource window, click the Roles tab (if it is not already displayed).

14. In the Role Type field, select the appropriate roles for this imported resource.

For example, if you want this user to access the Administration tab in Oracle Marketing, select Sales from the list of values. If you want this user to access Oracle TeleSales, select Telesales from the list of values.

15. In the Role field, select the appropriate role for each role type.

For example, if you want this user to access the Administration tab in Oracle Marketing, select Sales Manager from the list of values. If you want this user to access Oracle TeleSales, select Telesales Agent from the list of values.

16. Click the Save icon.

17. From the Resource window, click the Groups tab.

18. In the Name field under Groups, select the group name you created in the topic Creating a Resource Group, page 5-4.

19. In the Group Member Roles area, click in the Name field.

This field auto-populates with the appropriate role.

20. Click the Save icon.

Defining Oracle Applications Users

Use the following procedure to define Oracle Applications user accounts (user name and password), assign responsibilities to users, and associate an Oracle Applications user with an employee in the enterprise database.

Prerequisites

None

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On
login if implemented.

**Responsibility**

System Administrator

**Steps:**

1. From the Navigator, select Security > User > Define and click Open.
   
The Users window appears.

2. In the User Name field, type the user name you want to define and press the tab key.
   
   User names should be between 6 and 64 characters in length and should not contain spaces. Avoid using special characters such as %, slash, or backslash. Hyphen and underscore characters are supported.

3. Optionally, in the Description field, type a description of this user.

4. In the Password field, type the password for this user and press the tab key.
   
The first time the user logs in, this password must be changed.

   Passwords should be between 5 and 64 characters in length and should not contain spaces. Avoid using special characters such as %, slash, or backslash. Hyphen and underscore characters are supported.

5. In the Password field, retype the same password for confirmation, and press the tab key.

6. Optionally, in the Password Expiration area, select criteria for the expiration of this password.

7. In the Responsibilities tab, click in the first row of the Responsibility column.

8. Type the appropriate responsibility name and press the Tab key. Optionally, you can search for the appropriate responsibility name by selecting the ellipses points (...

   - You can enter the full responsibility name, or you can enter partial criteria followed by the percent wildcard. Oracle Applications will attempt to automatically validate and autofill based on the criteria you entered. If an exact match results, the remaining columns will be populated.

   - If an exact match cannot be determined, a Responsibilities window appears on top of the Users window. Your search criteria appears in the Find tab field, with all results that meet your criteria appearing in a list below.
• If many choices appear in the list, you may scroll through the list to find the appropriate responsibility. You may also refine your search criteria in the Find field and click Find. Highlight the appropriate choice in the list, and click OK. The Find window closes, and the appropriate criteria for all columns populates in the current row.

Responsibility information appears for the selected responsibility. By default, the Effective Date (From field) is populated with the SYSDATE.

9. Change the date in the Effective Date From field to a prior date (yesterday’s date, the beginning of the current month, or other appropriate choice).

While an effective date starting with the SYSDATE may be effective immediately in some environments, best practices dictate that you ensure that the effective date you designate will take effect immediately in all environments.

10. Optionally, enter a date beyond which the responsibility will no longer be effective in the To field. This date must be later than the SYSDATE.

11. Select File > Save and Proceed to save your work.

12. In a new row in the Responsibility table, repeat steps 8 through 11 for each responsibility that you want to assign to this user.

13. In the Person field, search for the name of the person (employee in the enterprise database) with whom you want to associate this user account.
• Enter full or partial criteria, in syntax Last Name, Title, First Name.
• You can use the % wildcard character.

If an exact match is found, the employee name will populate in this field. Otherwise, the Person Names window results.

14. If required, refine your search in the Person Names window and click OK.

15. Select File > Save and Proceed to save your work.

Setting Up Debugging and Message Logging in Oracle Scripting

There are various methods to debug problems or view informational or error messages when using Oracle Scripting. Each method provides information for functionality or problems with different components.

• Problems with Script Author graphical scripts are displayed in the Syntax tab of the Script Author Java applet. Clicking on any specific error displays an error message in the Debug pane, which appears immediately below the graphical Script Author canvas (the visual work area). This is accessed by a user with the Scripting
Administration responsibility. No setup is required to view Script Author errors in the Debug pane.

- When launching Script Author from the Scripting Administration console, status messages regarding the launching of the Java applet are visible in the Java console. If any errors in communication with the mid-tier occur, these are displayed in the Oracle JInitiator Java console. See Enabling the Oracle JInitiator Java Console, page 5-12. No other setup steps are required.

- Client-side message logs for scripts executed using the Scripting Engine component of Oracle Scripting are controlled by the IES : Debug Mode profile. The default setting for this is Debug off, and this is generally the recommended setting. Set this profile to Debug on at the user level only when remediating problems. When debug mode is enabled, these messages are written to the Oracle JInitiator Java console. See Enabling the Oracle JInitiator Java Console, page 5-12 and Current IES Profile Options, page A-4.

- Server-side message logs are controlled by FND profiles. FND system profile settings are detailed in Information, Error and Debug Logging Profile Options, page A-8. These logs are accessed when the user selects the Diagnostics global button or link from an OAF application. The FND: Diagnostics profile must be set to Yes for the logged-in user to display this control. To view message logs, see Viewing Message Server Logs, page 10-42.

This section includes the following topics:

- Setting Up Applications Common Logging, page 5-10
- Enabling Logging for the Guest User, page 5-11

### Setting Up Applications Common Logging

Oracle Scripting has migrated to the Applications Common Logging Infrastructure for those aspects of error and informational message logging supported by that technology stack. Those aspects include:

- Status and error information about Scripting Engine mid-tier operations
- The Scripting Engine HTML client
- PL/SQL information passed between the database and the Scripting Engine
- Scripts executed in the Scripting Engine Web interface
- Transactions in the Scripting Administration console and the Survey Administration console
To record errors or informational messages, set the FND system profile options. These profile options, the seeded lookup values for each, the recommended level to set each, and a detailed description of each profile is included in Information, Error and Debug Logging Profile Options, page A-8.

In brief, the following profile options are relevant:

- **FND: Diagnostics** must be set to Yes for an administrator to view message logs. This enables the Diagnostics global link and icon, which appears at the top right side of the HTML user interface for Oracle HTML-based applications using the Oracle Applications Framework. Oracle recommends setting this at the user level to provide access to information in logs only to appropriate trusted individuals.

- **FND: Debug Log Enabled** must be set to Yes in order to capture information.

- **FND: Debug Log Level** determines the amount and type of information captured.

- **FND: Debug Log Module** specifies the module for which messages are logged.

**References**

To view message logs, see Viewing Server Message Logs, page 10-42.

**Enabling Logging for the Guest User**

For implementations using guest user authentication for scripts executed in the Scripting Engine Web interface, you must explicitly enable message logging if you want to view logs generated for this user.

For example, perform this task if you want to view message logs for users of the Scripting Engine Web interface who execute scripts in a Web browser through targeted surveys and Web scripts that are not hosted in Oracle self-service Web applications.

As a prerequisite, set the profiles as detailed in Information, Error and Debug Logging Profile Options, page A-8.

At the User level, for the guest user, establish system profile options accordingly. You must ensure that the guest user name and password are registered in the system profile option value for the Guest User Password profile.

For example, for a guest user named GUEST with a password of ORACLE, set the Guest User Password profile to GUEST/ORACLE.

**Note:** The applications-level guest user is seeded with Oracle Applications. For security purposes, you may want to establish a more secure password for this account.
References

To view message logs, see Viewing Server Message Logs, page 10-42.

Enabling the Oracle JInitiator Java Console

Oracle JInitiator is a Java applet used for Oracle Applications. It serves many purposes, including ensuring that the correct version of Java is executed on the client desktop. This applet launches when an Oracle Applications session is started.

The Oracle JInitiator Java applet includes the ability to view status messages using a Java console. From an Oracle Scripting perspective, you may want to view the Oracle JInitiator Java console for this applet to determine the outcome of certain events or monitor status.

For example, if debug mode is enabled for client-side message logs, the logs are sent to this console.

Also, when launching Script Author, status messages regarding the launching of the Java applet are visible in the Java console. If any errors in communication with the mid-tier occur, these are displayed in the Oracle JInitiator Java console.

Use this procedure to enable the Oracle JInitiator Java console.

Prerequisites

Oracle JInitiator must be installed on your client workstation.

Login

None

Responsibility

None

Steps:

1. From the Start menu, select Programs > JInitiator Control Panel.
   The Oracle JInitiator Properties window appears.

2. In the Basic tab, select Show Java Console.

3. Click Apply.

4. Close the Oracle JInitiator Properties window.
Bypassing the Sales Resource Group Membership Requirement

To access the Audience tab in the Survey Administration Console, the Oracle Applications user account must generally have a sales group ID or a sales role. Administration of resource groups is accomplished in Oracle CRM Resource Manager.

By setting a profile option, you can bypass this requirement for the Survey Administrator responsibility as described below. This profile can also be set at the application level.

Sales Groups, Roles and Usages

Sales groups, roles and usages are administered in Oracle CRM Resource Manager. These are used by various applications, including Oracle Marketing and Oracle TeleSales.

You must define a sales group and assign the group roles and usages prior to assigning any members to the group. If a sales group already exists, you can add members to the group. Each group member must have a CRM resource ID, which is created upon importing an employee into CRM Resource Manager.

Some applications (such as Oracle Marketing) require steps to be performed in a particular order. The recommended order is as follows:

- Creating an employee using Oracle HRMS (if installed) or CRM Resource Manager (if HRMS is not installed).
- Creating an Oracle Applications user account with the appropriate responsibilities.
- Associating the Oracle Applications user account with the employee.
- Creating a resource group and assigning roles and usages to the group.
- Importing a CRM resource and assigning roles and usages to the resource.
- Adding a defined resource as a member of an existing group.

Prerequisites

None

Responsibility

System Administrator
Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Steps:
1. From the Navigator, select Profile > System and click Open.
   The Find System Profile Values window appears above the unpopulated System Profile Values window. In the Display area, the Site and Profile with No Values options are selected.

2. In the Display area, select Responsibility.
   The field changes color, and a set of ellipsis points appears.
   In the Responsibility field, type the appropriate responsibility for which you want to bypass the requirement of group membership, and press the tab key.
   For example, type Survey Administrator and press the tab key.

3. Leave the Profiles with No Values option selected.
   This allows the query to return profiles that meet your search criteria but have no values associated with them yet (blank profiles).

4. In the Profile field, enter Bypass Group Validation.

5. Click Find.
   The System Profile Values window appears.

6. In the Bypass Group Validation row, click once in the Responsibility column.
   A set of ellipsis points appears.

7. Click the ellipsis points.
   The Bypass Group Validation window appears.

8. From the list of values, select Yes and click OK.

9. Save your work and exit.

Granting JTF Roles

To perform certain JTF tasks, a user must be assigned a specific JTF role. For example, the JTF_SYSTEM_ADMIN_ROLE role provides certain administrative capabilities to a user. From an Oracle Scripting perspective, survey administrators using targeted
deployments must be assigned the JTF_FM_ADMIN role to access the Invitations tab from the Survey Administration console.

Additionally, from an implementation perspective, your Oracle Applications user account must already have certain roles in order to grant those roles to other users. Use the procedure below to grant JTF roles to Oracle Applications accounts (users).

**Prerequisites**

- To perform some Oracle HTML-based applications administration, including this task, your Oracle Applications user must be granted the JTF_SYSTEM_ADMIN_ROLE. If required, you can use the seeded SYSADMIN Oracle Applications user account.

- Your Oracle Applications user must be granted a JTF role before you can assign that JTF role to another user. Thus, this user must be granted the JTF_FM_ADMIN role. This role is available to the seeded SYSADMIN Oracle Applications user account.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

**CRM HTML Administration**

**Steps**

1. From the CRM Applications Administration console, click the Users tab.

2. Click the Registration subtab.
   
   The Introduction page appears.

3. From the side panel, click User Maintenance.
   
   The Users page appears.

4. In the search criteria field, enter the appropriate search criteria to find the appropriate user name, and click Go.

   **Note:** You must enter at least three characters. In addition to those three characters, you can use the % wildcard search character in your criteria.

   The Users page refreshes, displaying a summary list table containing the set of
records matching your criteria.

5. If necessary, refine your search criteria and click Go.

6. From the resulting list of users, click the appropriate entry in the Username column. The User Details page appears.

7. In the User Details area, click Roles.
   The User-Role Mapping page appears. Two lists are displayed (Available Roles and Assigned Roles).

8. From the Available Roles list, select each role you want to assign.
   You can select multiple records from the list by pressing and holding the CTRL key (use the Option key for Macintosh computers) as you make each selection.

9. When all desired available roles are selected, click > Move to move it to the Assigned Roles list.
   For example, select JTF_SYSTEM_ADMIN_ROLE and JTF_FM_ADMIN and move them to the Assigned Roles list.

10. When satisfied, click Update.
    The User-Role Mapping page refreshes. Two lists are displayed (Available Roles and Assigned Roles). The roles you just assigned for this user should appear in the Assigned Roles list.

### Setting System Profile Values

#### Prerequisites

None

#### Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

#### Responsibility

System Administrator

#### Steps:

1. From the Navigator, select Profile > System and click Open.
The System Profile Values window appears. Above this, the Find System Profile Values window appears and has focus.

2. If you want to display and set profile options by site, in the Display area of the Find System Profile Values window, ensure Site is selected. If you do not wish to view or set profiles at the site level, clear the Site option.

3. You can display and set profile options by Application, Responsibility, or User. For each selection:
   1. Mark the appropriate option.
   2. In the text field next to the selected Application, Responsibility, or User option, type search criteria and click tab.
      If you typed full or partial search criteria with one match, the appropriate value populates the field. Otherwise, a window appears where you can narrow your search criteria.
   3. Refine your search if required, select the appropriate option, and click OK.

   **Note:** Site is the highest and broadest level of Oracle Applications profile settings, and affects all Oracle Applications users unless a specific lower level is specified. By changing the search criteria from Site to any of the other values (Application, Responsibility, or User), you can query and set profiles for lower and more granular levels. A lower level profile setting, if populated, always takes precedence and supersedes any value set at a higher level.

4. Ensure the Profiles with No Values option is selected.
   This allows the query to return profiles that meet your search criteria but have no values currently associated with them (blank profiles).

5. In the Profile field, enter your search criteria. You may include the % wildcard character.
   For example, enter IES%. IES is the product code for Oracle Scripting. Profile values associated with the survey component are included in this category.

6. Click Find.
   The System Profile Values window populates, displaying all profile values for the requested search criteria at the requested levels.

7. Set each profile option as required by your implementation task. You can set these options in any sequence.
8. Select File > Save and Proceed to save your work.
   The status line will indicate that records has been saved.
   If you do not need to set additional profile options at this time, then proceed to step 13.

9. If you want to set additional profile options with different search criteria, then from the View menu, select Find.
   The Find System Profile Values window appears.

10. Repeat steps 2 through 8 above.

11. When satisfied, select File > Save and Proceed to save your work.
    The status line will indicate that records have been saved.

12. Select File > Close Form to close this window.

13. Continue your work or log out of Oracle Applications by selecting File > Exit Oracle Applications.

Finding Application and Responsibility ID Values

You must know the APPLICATION_ID value for your application and the RESPONSIBILITY_ID value for a specified responsibility before you can set the required Oracle CRM Technology Foundation (JTT) profile options appropriately.

Based on how Oracle Applications was installed in your environment, a responsibility may have different names. For example, in a Vision Database installation, the responsibility to access the Scripting Engine agent interface in standalone mode is Scripting Agent, Vision Enterprises. In a fresh installation, this responsibility is referred to as Scripting User. Nevertheless, both will have a single responsibility identification.

Note: The APPLICATION_ID value for Oracle Scripting is typically 519. The RESPONSIBILITY_ID value for Survey Administrator is typically 21685. The RESPONSIBILITY_ID for Scripting Administrator is typically 23723. However, in some scenarios, the responsibility identification may differ, based on environmental factors.

Use the following procedure to find the APPLICATION_ID value and RESPONSIBILITY_ID value of a known responsibility.

Prerequisites

None
Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

System Administrator

Steps:
1. From the Navigator, select Security > Responsibility > Define and click Open.
   The Responsibilities form appears.

2. Choose View > Find.
   The Responsibilities search window appears.

3. Search for the appropriate responsibility, highlight it, and click OK in the search window.
   The Responsibilities form is populated with the record for the selected responsibility.

4. With your cursor in any field of the record, select Help > Diagnostics > Examine.
   If the Enable Diagnostics window appears, enter the apps level database password and click OK.
   The Examine Field and Variable Values window appears.

5. If you want to determine the Application ID, in the Examine Field and Variable Values window, from the Field list, select APPLICATION_ID and click OK.
   The Value field in the Examine Field and Variable Values window is populated with the value of APPLICATION_ID.

6. If you want to determine the Responsibility ID, in the Examine Field and Variable Values window, from the Field list, select RESPONSIBILITY_ID and click OK.
   The Value field in the Examine Field and Variable Values window is populated with the value of RESPONSIBILITY_ID.

7. If you want to determine the Responsibility Key, check the value of the selected responsibility in the Responsibility Key field.

Finding Default Application from a Responsibility ID Value

If a default application is already established for JTT applications, and you see only an
application ID number in the JTF_PROFILE_DEFAULT_APPLICATION system profile, you must know which application is assigned, to determine whether to override this value with 519 (for Oracle Scripting).

Use the following procedure to determine (from a known application ID) the name of the application.

**Prerequisites**

You must have the application ID value from the JTF_PROFILE_DEFAULT_APPLICATION system profile.

**Login**

Log into SQL*Plus or another SQL application as a user with read privileges to the apps schema

**Responsibility**

None

**Steps:**

1. Launch SQL*Plus or another SQL application.
2. Log into the appropriate applications instance.
3. Perform the following query to determine (from a known application ID) the current default HTML JTF application for this environment.

```sql
SELECT A.APPLICATION_ID, B.APPLICATION_NAME
FROM FND_APPLICATION A, FND_APPLICATION_TL B
WHERE A.APPLICATION_ID = B.APPLICATION_ID AND
  A.APPLICATION_ID = <KNOWN_APPLICATION_ID>;
```

**Note:** Replace `<KNOWN_APPLICATION_ID>` with the value of the application ID in your SQL statement.

**Finding the FND User ID Value of a Defined User**

When viewing log messages for Oracle Applications using the OA Framework, a User ID automatically populates in the User ID field, with the value applicable to the current Oracle Applications user account. This value is from the USER_ID column of the FND_USER table in the Oracle Applications schema.

If you want to view log messages for a specific user other than your current user, you must first obtain this user ID.
This section includes the following topics:

- Obtaining the FND USER_ID Value Using SQL, page 5-21
- Obtaining the FND USER_ID Value from the Users Window, page 5-22

Obtaining the FND USER_ID Value Using SQL

Use this procedure to determine the FND_USER_ID value for a defined user from a SQL application such as SQL*Plus.

Prerequisites

- You must know the Oracle Applications user account.
- You must have apps level access to the Oracle Applications database schema using a SQL application such as SQL*Plus.

Login

Log into SQL*Plus or another SQL application as a user with read privileges to the apps schema

Responsibility

None

Steps:

1. Launch SQL*Plus or another SQL application.
2. Log into the appropriate applications instance.
3. Perform the following query to determine (with a known Oracle Applications user name, in upper case) the FND USER_ID value for this user.

   ```sql
   SELECT USER_ID, USER_NAME
   FROM FND_USER
   WHERE USER_NAME = <NAME>;
   ``

   **Note:** Replace `<NAME>` in your SQL statement with the value of the Oracle Applications user name for the appropriate user.
Obtaining the FND USER_ID Value from the Users Window

Use this procedure to determine the FND_USER_ID value for a defined Oracle Applications user account from the system administrator Users window.

Prerequisites

None

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

System Administrator

Steps:
1. From the Navigator, select Security > User > Define and click Open.
   The Users window appears.
2. Place your cursor in the User Name field.
3. Enter query mode by selecting View > Query By Example > Enter or by selecting F11 on your function keys.
   For example, to search for the seeded applications guest user, type GUEST.
4. In the User Name field, type the name of the Oracle Applications user account for which you wish to obtain the FND User ID.
5. Execute the query by selecting View > Query By Example > Run or by selecting CTRL-F11 on your keyboard.
6. If the query is successful, the Users window refreshes. If the query is unsuccessful, in the User Name field, type other criteria, and run the query again.
7. With your cursor in the User Name field, select Help > Diagnostics > Examine.
   If the Enable Diagnostics window appears, enter the apps level database password and click OK.
   The Examine Field and Variable Values window appears.
8. To determine the FND user ID value for this user, then in the Examine Field and
Variable Values window, from the Field list, select USER_ID and click OK.

The Value field in the Examine Field and Variable Values window is populated with the value of the FND user ID for this user.

**Removing the Quick Find Menu**

When upgrading Oracle Applications, the obsolete Quick Find menu remains associated with product code IES, causing this menu to appear in the Scripting Administration console, where it has no function. This menu will not appear in the Scripting administrative interface for new implementations. For upgrade implementations, you must modify the JTT properties for product IES (Oracle Scripting) to remove the association between this menu and the Scripting product.

Use the procedure below to remove the Quick Find menu from its association with Oracle Scripting (product code IES).

**Prerequisites**

- You must log in as a user with JTF_SYSTEM_ADMIN_ROLE. For example, you can use the seeded SYSADMIN Oracle Applications user account.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

CRM HTML Administration

**Steps:**

1. From the CRM Applications Administration console, click the Settings tab.

2. Click the System subtab.
   
   The Introduction page appears.

3. From the side panel, select Properties > Advanced.
   
   The Advanced - Properties page appears.

   **Note:** If this page does not appear, your login does not have the JTF_SYSTEM_ADMIN_ROLE role. Log out and log in with an appropriate user.
4. From the View menu, select IES.

The Advanced - Properties page refreshes. The records displayed show advanced properties for product code IES (Oracle Scripting).

The following keys for IES advanced properties must be modified:

1. search.factories
2. service.oracle.apps.ies.survey.search.server.IESSurveySearchFactory.categories
3. service.oracle.apps.ies.survey.search.server.IESSurveySearchFactory.desc

5. For each of the keys listed above, append a period and the responsibility ID for the Survey Administrator responsibility, as indicated below:

   **Note:** The responsibility ID for the Survey Administrator is typically 21685, but this may differ in your environment. To determine the appropriate ID for your environment, see Finding Application and Responsibility ID Values, page 5-18.

1. In the Advanced - Properties table, from the Key column, click on the appropriate property.
   
   The Key Details page appears.

2. In the Key field, append a period and the responsibility ID.
   
   For example, for the search.factories key, modify the entry to read:
   
   `search.factories.21685`

3. Click Update.
   
   The Advanced - Properties page refreshes. The modified key is displayed.

4. Repeat steps 5.1 through 5.3 for the remaining keys to be modified.

5. In the Key field, append a period and the responsibility ID.

6. If the changes do not immediately result in the removal of the Quick Find menu in the Scripting Administration console, stop and restart the Apache Web server to see the changes take effect.

7. Continue your work or log out of Oracle Applications by selecting Sign Out.
This chapter covers the following topics:

- Overview of Scripting Administration Tasks
- Scripting Home
- Launching the Script Author Java Applet
- Administering Oracle Scripting Files
- Viewing and Removing Deployed Scripts
- Viewing and Administering Custom Java Archive Files
- Viewing and Removing Uploaded Java Archive Files
- Uploading New Java Archive Files
- Overwriting Existing Java Archive Files with Updated Archives
- Changing the Global Property of Uploaded Java Archive Files
- Creating, Removing, and Viewing Java Archive Mapping Definitions
- Specifying Load Order of Java Archives Files
- Generating and Viewing Panel Footprint Reports

Overview of Scripting Administration Tasks

The Scripting Administration console provides the user interface with which script developers can launch Script Author as a Java applet, and script administrators can administer Oracle Scripting files, as well as generate, view and analyze agent interface reports.

This console is accessed by logging into Oracle HTML-based applications using an Oracle Applications user account with the Scripting Administrator responsibility.

This section includes the following topics:
Upon logging into the Scripting Administration console, the Home tab appears.

You can perform the following tasks:
- Launching the Script Author Java Applet, page 6-2

For more information, see the following concepts in the Oracle Scripting User Guide:
- Scripting Administration Console
- Scripting Administration Console View List
- Agent Interface Reports

Using Script Author, you can create, modify, and deploy scripts to the applications database. Use this procedure to launch Script Author as a Java applet.

None

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Scripting Administrator
Steps:
1. From the Scripting Administration console, click the Home tab.
2. Click Launch Script Author.

A separate browser window appears, in which Oracle JInitiator launches, using authentication information from the current Oracle Applications session. Presently, a separate Java applet window appears with the Script Author user interface.

Administering Oracle Scripting Files

From the Administration tab of the Scripting Administration console, you can monitor and administer files supporting Oracle Scripting, including scripts deployed with Script Author, and custom Java archive files.

Tasks

You can perform the following tasks:

• Viewing and Removing Deployed Scripts, page 6-3
• Viewing and Administering Custom Java Archive Files, page 6-5

Concepts

For more information, see the following topic in the Oracle Scripting User Guide:

• Using Custom Java

Viewing and Removing Deployed Scripts

Use the Deployed Scripts subtab to view or remove scripts deployed to the applications database from Script Author. Removing a script deletes the script and all related metadata from the database tables.

Use this procedure to view or remove deployed scripts.

Prerequisites

At least one script must be deployed to the applications database from Script Author.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.
Responsibility
Scripting Administrator

Guidelines

• The value in the Locked column is a read-only property indicating whether the listed script can be modified and deployed from Script Author (if value is No), or whether changes to the script metadata are prohibited (if value is Yes).

• Deployed scripts with ACTIVE_STATUS set to "0" are retained in IES_DEPLOYED_SCRIPTS so that existing footprinting and answer collection data can maintain valid references. Only active deployed scripts (those scripts with an ACTIVE_STATUS set to "1") can be executed.

Steps:
1. From the Scripting Administration Console, click the Administration tab.

2. From the Administration tab, click the Deployed Scripts subtab.

   The Deployed Scripts page appears. A summary list of all deployed scripts meeting the filter criteria in the View list appears in the Deployed Scripts table.

3. Optionally, to change the set of records displayed in this list, perform any of the following:
   • From the View list, select a different filter option to display more or fewer deployed scripts based on active status and which user created the script.
   • To display subsequent records in the found set, click Next or the right arrow. To view previous records in the found set, click Previous or the left arrow.
   • To navigate through the found set of records in groups of ten, from the records range list between the Previous and Next links, select the appropriate range of records (for example, select 11 to 20 of n, where n is the number of records in the found set).

   After any selection above, the page refreshes, displaying the requested records.

4. Optionally, to remove scripts from the applications database, in the Select column, mark the Select option for each record you want to delete, and click Remove.

   Note: Oracle recommends that you back up any script you may
want to reuse to a local or network file system before deleting it from the database.

### Viewing and Administering Custom Java Archive Files

At runtime, scripts that contain commands referencing custom Java methods can execute each method as specified by the Script Author command parameters. Customized scripts can also use custom user interface Java beans to provide functionality at runtime. The source code for custom Java supporting Oracle Scripting must be compiled into executable class files and packaged into Java archives as appropriate.

Using the Scripting Administration console, you can upload custom Java archive files to the IES_JARFILES table in the applications database. Management of these files is accomplished from the Jar Listings subtab of the Administration tab.

Custom code loaded from the Scripting Administration console to the applications database need not be added to the class path of any configuration file.

Conversely, for custom code that is deployed manually to the APPL_TOP (the model available before this console was available), the corresponding class path must still be specified (in the JSERV.PROPERTIES file for enterprises using the Apache mid-tier architecture, or in the APPSWEB.CFG file for enterprises using the caching architecture). Manually deployed Java archives will not appear in the list of Java archive files on the Administration > Jar Listings page, nor can they be removed using this user interface.

### Tasks

You can perform the following tasks:

- Viewing and Removing Uploaded Java Archive Files, page 6-6
- Uploading New Java Archive Files, page 6-7
- Overwriting Existing Java Archive Files with Updated Archives, page 6-10
- Changing the Global Property of Uploaded Java Archive Files, page 6-11
- Creating, Removing, and Viewing Java Archive Mapping Definitions, page 6-13
- Specifying Load Order of Java Archives Files, page 6-15
See Also

- Viewing and Removing Deployed Scripts, page 6-3

Viewing and Removing Uploaded Java Archive Files

When a Java archive is deployed to the database using the Scripting Administration console, a corresponding record is created in the IES_JARFILES table.

Use this procedure to view and remove custom Java code archives (JAR and ZIP files) uploaded to the applications database from the Scripting Administration console. Removing a Java archive deletes the JAR or ZIP file and all related metadata from the database tables.

Prerequisites

- At least one Java archive file must be uploaded to the applications database using the Scripting Administration Console.

- If a Java archive you want to remove is mapped to a script, delete the mapping prior to performing this task. You cannot remove a Java archive deployed to the database until any mappings associated with the archive are also removed.

  Note: Manually deployed Java archives will not appear in the list of JAR files on the Administration > Jar Listings page.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Scripting Administrator

Guidelines

You cannot remove a Java archive deployed to the database until any mappings associated with the archive are also removed.

Steps:

1. From the Scripting Administration Console, click the Administration tab.
2. From the Administration tab, click the Jar Listings subtab.

The Jar Files page appears. A summary list of all uploaded Java code archive files meeting the filter criteria in the View list appears in the Jar Files table.

3. If required, change the set of records displayed in the Jar Files table list as appropriate to display the desired code archives by performing any of the following:

   • From the View list, select a different filter option to display more or fewer Java archive files based on the Oracle Applications login used when the files were uploaded to the database.

   • To display subsequent records in the found set, click Next or the right arrow. To view previous records in the found set, click Previous or the left arrow.

   • To navigate through the found set of records in groups of ten, from the records range list between the Previous and Next links, select the appropriate range of records (for example, select 11 to 20 of \( n \), where \( n \) is the number of records in the found set).

   After any selection above, the page refreshes, displaying the requested records.

4. Optionally, to remove uploaded Java archive files from the server, in the Select column, mark the Select option for each Java archive you want to delete, and click Remove.

### Uploading New Java Archive Files

As discussed in the topic Using Custom Java in the Oracle Scripting User Guide, custom Java archives can be used with Oracle Scripting to support the execution of custom commands in any script, or the use of Java beans in the agent interface. Using the Scripting Administration console, you can upload Java archive files from the Jar Listings subtab of the Administration tab.

When a Java archive is deployed to the database using the Scripting Administration console, a corresponding record is created in the IES_JARFILES table.

Custom code loaded from the Scripting Administration console to the applications database need not be added to the class path of any configuration file.

Use this procedure to upload new Java archive files for execution in a script at runtime.

### Prerequisites

- Write the Java bean or Java method, compile into a class file, and package into a
Java archive file.

- Java beans deployed to the database must be for use with the Scripting Engine agent interface only. The Web interface does not support the use of Java beans.

- To execute a method, a script must appropriately reference the method using a Script Author command.

- The script must be deployed to the applications database from Script Author.

- You must compile your custom code using a JDK level compatible with the Java Runtime Environment (JRE) used for your Scripting implementation.

- For all Java archive files deployed to the applications database from the Scripting Administration console for execution in scripts, the following limitations apply:
  1. Java archive files must be created using the "jar" utility of the JDK and specifying no compression (e.g., "jar -cf0...."), or by creating a ZIP or JAR file using a compression and archiving utility such as WinZip (with or without compression).
  2. Java archive files must be smaller than 1 megabyte.
  3. JAR file format is recommended over ZIP file format.
  4. You must meet the compilation requirements discussed in the topic Using Custom Java > Java Compilation and Oracle JInitiator Dependencies in the Oracle Scripting User Guide.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Scripting Administrator

Guidelines

- You must compile your custom code using a JDK level compatible with the Java Runtime Environment (JRE) used for your Scripting implementation. For more information, see the topic Using Custom Java in the Oracle Scripting User Guide.

- JAR or ZIP files loaded from the Scripting Administration Console must be smaller than 1 megabyte.
• You cannot upload files of any type other than JAR or ZIP.

• When specifying the name of the Java archive file to upload, if you leave the Name field blank, the file name of the specified file will be used.

• Once uploaded, Java archives intended to provide custom commands to scripts must either be designated as global or must be mapped to one or more scripts to be accessible to the Scripting Engine at runtime.

• Java archives uploaded to replace panels with Java beans in the Scripting Engine agent interface do not require JAR mappings.

**Steps:**
1. From the Scripting Administration Console, click the Administration tab.

2. From the Administration tab, click the Jar Listings subtab.
   The Jar Files page appears.

3. To begin uploading a Java archive file, click Upload New Jar.
   The Upload File page appears.

4. In the Name field, type the name you want to associate with this Java archive file in the database.
   You can use any unique name to associate with this file. If you leave this field blank, the file name of the specified JAR or ZIP file will be used. You cannot use a name already assigned to another Java archive.
   If the Java archive is a Java bean, this name will be referenced by the Jar File Name field of the Script Author panel properties window.

5. Optionally, if you want this Java archive to be available globally (to all scripts deployed to this environment), select the Global flag option.

6. In the File field, click Browse... to begin locating and uploading the Java archive file you want to upload.
   The Choose File window appears.

7. Navigate to the appropriate location on your local file system or network, highlight the file you want to upload, and click Open.

   **Note**: You can only upload ZIP or JAR files. Other files will not execute appropriately using either Scripting Engine interface, and are therefore not allowed to be uploaded in this user interface.
The Choose File window closes, and the File window is populated with the path and filename for the specified Java archive file.

8. To clear this selection and specify another file, click Reset.

9. To complete uploading the selected file, click Upload.

   The Jar Files page refreshes. An informational message indicates the logical name of the file you successfully uploaded.

**Overwriting Existing Java Archive Files with Updated Archives**

When custom code supporting the use of Oracle Scripting is updated, you must recompile the code, package it appropriately as a JAR or ZIP file, and upload the modified code to the database. This overwrites the previously loaded Java archive file.

Use this procedure to overwrite an existing Java archive file.

**Prerequisites**

At least one Java archive file must be uploaded to the applications database using the Scripting Administration Console.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Scripting Administrator

**Steps:**

1. From the Scripting Administration Console, click the Administration tab.

2. From the Administration tab, click the Jar Listings subtab.

   The Jar Files page appears. A summary list of all uploaded JAR files meeting the filter criteria in the View list appears in the Jar Files table.

3. If required, change the set of records displayed in the Jar Files table list as appropriate to display the desired code archives.

4. Locate the JAR file in the Jar Files table that you wish to overwrite.
5. In the Select column, mark the Select option for the Java archive file you want to overwrite, and click Overwrite Existing Jar.

The Upload File page appears.

6. Click Browse... to identify the Java archive you wish to upload in place of the existing file.

The File Upload window appears.

7. In the File Upload window:
   1. Locate the appropriate JAR or ZIP file from your local file system or network.
   2. Highlight the file name.
   3. Click Open.

The Upload File page refreshes. The FILE field contains the path and file name of the designated file.

8. To clear this selection and specify another file, click Reset.

9. To complete uploading the selected file, click Upload.

The Jar Files page appears. An informational message indicates the logical name of the file you successfully uploaded.

**Changing the Global Property of Uploaded Java Archive Files**

Java archive files uploaded using the Scripting Administration console have a global attribute. The data type for this attribute is Boolean, and defaults to false or null. To enable or disable this attribute for a selected code archive, you must explicitly select (setting to true) or clear the selected global attribute (setting to false), respectively. Code archives specified as global are loaded into the class loader for all scripts executed in the Scripting Engine.

Java code archives designated as global are loaded into the class loader for all scripts executed in the Scripting Engine in the specified environment, regardless of whether the scripts were deployed from the Script Author applet or from a standalone version of the Script Author application (use release Script Author 11.5.6 or later for compatibility with an 11.5.6 or later Scripting Engine).

Methods referenced in a global code archive need not be mapped to a specific script in order to execute at runtime. Each method in a global code archive is automatically accessible for execution in the Scripting Engine in any interface. You can change the global property at any time from the Scripting Administration console.

Use this procedure to select or clear the global property for one or more code archives.
Prerequisites

- Each Java archive file for which you want to change the global property must be uploaded to the applications database using the Scripting Administration Console.

- Each global Java archive file for which you want to clear the global property must be set as global using the Scripting Administration Console.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Scripting Administrator

Steps:

1. From the Scripting Administration Console, click the Administration tab.

2. From the Administration tab, click the Jar Listings subtab.
   The Jar Files page appears. A summary list of all uploaded JAR files meeting the filter criteria in the View list appears in the Jar Files table.

3. If required, change the set of records displayed in the Jar Files table list as appropriate to display the desired code archives.

4. If you want to set the global property:
   1. For each Java code archive file displayed on the page that you want to set as global, in the Select column, click the Select option.

   2. For each Java code archive file displayed on the page that you want to set as global, in the Global column, select the Global option.  
      A check mark indicates that the option is selected.

5. If you want to clear the global property:
   1. For each global Java code archive file displayed on the page for which you want to clear the global property, in the Select column, click the Select option.

   2. For each appropriate global Java code archive file displayed on the page, in the Global column, clear the Global option.  
      An empty check box indicates that the option is cleared.
6. To complete the change to the global property of each selected code archive, click Update.

The Jar Files page refreshes. For each code archive you selected (and any code archive previously set as global), the Global option is selected. For each code archive previously marked as global that you cleared, the Global option is cleared.

7. To change the global property for other archives, repeat steps 3 through 6.

Creating, Removing, and Viewing Java Archive Mapping Definitions

Java archive files supporting custom Java methods can be mapped to specific scripts, or specified as applying globally to all Oracle Scripting scripts. Methods in mapped files are only loaded into the class loader by the Scripting Engine if it identifies an appropriate script mapping. Code archives specified as global are loaded into the class loader for all scripts.

An uploaded Java archive can be mapped to zero, one, or many deployed scripts. When a Java archive is mapped to one or more deployed script, a corresponding record is created in the IES_SCRIPT_JARFILES table tracking this relationship. When a mapping definition is removed, the mapping record is deleted from this database table and no longer appears in the mapping list. An existing mapping definition must be deleted before the mapped Java archive can be removed.

Java archive files supporting custom Java beans do not need to be mapped to any specific script. The Java beans will be available to run as required in each script containing Java beans.

Use the Jar Mapping subtab to map uploaded Java archive files to apply to specific scripts, to remove mapping definitions, to view defined mappings, and to specify load order.

Prerequisites

- At least one Java archive file must be uploaded to the applications database using the Scripting Administration Console.

- At least one script must be deployed to the applications database from Script Author.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.
Responsibility

Scripting Administrator

Steps:

1. From the Scripting Administration Console, click the Administration tab.

2. From the Administration tab, click the Jar Mapping subtab.

   The Script Jar Files Mapping page appears, containing a Script Jar Files Mapping area and a Create Mapping area. A summary list of all existing mappings meeting the filter criteria in the View list appears in the Script Jar Files Mapping table.

3. Optionally, request additional Java archive mappings to be listed by changing the View By selection or by clicking the First, Previous, Next, or Last navigation hyperlinks at the bottom of the page.

4. To create a new mapping, in the Create Mapping area, do the following:
   1. From the Select Script list, select a deployed script.
   2. From the Select Jar File list, select the Java archive you want to map to the designated script.
   3. In the Load Order field, enter an integer representing the load order of this Java archive.
   4. Click Create Mapping.

   The Script Jar Files Mapping page refreshes, displaying the new mapping definition in the table.

5. To remove one or more existing mappings, in the Script Jar Files Mapping area, do the following:
   1. In the Select column, select each record representing a mapping you want to delete.

   A checkmark in the Select column indicates the record is selected.

   2. Click Remove.

   The Script Jar Files Mapping page refreshes. The records you selected for deletion are no longer listed in the table, and the corresponding information has been deleted from the database.
Specifying Load Order of Java Archives Files

Load order refers to the order in which the Scripting Engine loads mapped Java archive files. If a Java method of the same name is included in two or more Java archives, and you want to control which method is used, specify the desired archive as having a higher load order. This is chiefly relevant only when methods of the same name have differences in the code.

There is currently no verification to ensure that specified load order of Java archives do not overlap; the Scripting Engine will load Java archives of the same load order level in the order they are returned to the Scripting Engine from its query of the database.

Use this procedure to create or modify the load order for uploaded Java archives mapped to specific scripts.

Prerequisites

- At least one Java archive file must be uploaded to the applications database using the Scripting Administration console.
- At least one script must be deployed to the applications database from Script Author.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Scripting Administrator

Guidelines

- Load order is only relevant for mapped Java methods.
- Load order is only relevant when Java methods of the same name may contain different code.

Steps:

1. From the Scripting Administration Console, click the Administration tab.
2. From the Administration tab, click the Jar Mapping subtab.

The Script Jar Files Mapping page appears, containing a Script Jar Files Mapping
area and a Create Mapping area.

3. To modify an existing load order, from the Script Jar Files Mapping list, change the value in the Load Order field to a different integer and click Update.

   The Script Jar Files Mapping page refreshes. The modified load order is listed accordingly.

4. To create a load order, you must first specify mapping information. In the Create Mapping area, from the Select Script list, select the Java archive file for which you want to specify load order.

5. In the Load Order field, type a whole number indicating the intended load order, where the lowest number indicates earlier load order.

6. To save this mapping, including load order, click Create Mapping.

   The Script Jar Files Mapping page refreshes. Any new mappings are included in the Script Jar Files Mapping list. The load order is a modifiable field.

---

**Generating and Viewing Panel Footprint Reports**

Use the Reports tab of the Scripting Administration console to generate, view and analyze the panel footprint report.

Other reports supporting Oracle Scripting are available through Oracle Business Intelligence.

**Tasks**

You can perform the following tasks:

- Generating a Panel Footprint Report, page 6-16

**Generating a Panel Footprint Report**

The panel footprint report indicates, by panel per script, what panels were visited and the duration of time (in milliseconds) spent in each panel. The business objective of running this report is to see how effective a script is at leading an agent through a dialog with a customer (for the interaction center) or determining which questions may have been the most confusing (for survey respondents). Essentially, this report helps in tuning a script for maximum clarity and streamlined flow. It is typically of most use in the interaction center to reduce talk time and improve a script’s efficiency. Note that if this report is not used, then footprinting should be disabled at the script level to conserve system resources.

Use this procedure to generate a panel footprint report.
Prerequisites

- You must know the script name, reporting period start date, and reporting period end date to run this report.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Scripting Administrator

Steps:

1. From the Scripting Administration console, click the Reports tab.
   The Panel Footprint Summary page appears.

2. In the Select a Script field, type search criteria for the specific script for which you want to run the report and click Go.
   - If required, then you can further refine your search and click Go.
     - You can use partial search criteria and the % wildcard character if desired.
     - To see a list of every available script, just type % and click Go.
     A hypertext linked list of records which meet the specified search criteria, if any, will appear.

3. Click the appropriate hypertext-linked script name.
   The Panel Footprint Summary page refreshes. The selected script is listed in the Select a Script field.

4. In the Start Date field, using the calendar control, select the start date of the reporting period for which you want to generate a panel footprint report.

5. In the End Date field, using the calendar control, select the end date of the reporting period for which you want to generate a panel footprint report.

6. Click Run Report.
   The report generates, appearing on the refreshed Panel Footprint Summary page. The report lists which panels were visited and the duration of time (in milliseconds) spent in each panel.
7. Exit the window or run another report as desired.

   Reports are dynamically generated. There is no need to save your work.
Survey Resource Administration Tasks

This chapter covers the following topics:
- Administering Survey Resources
- Creating Survey Resources
- Creating Survey Resource Definitions
- Viewing or Deleting Survey Resource Definitions
- Uploading JSP Survey Resources

Administering Survey Resources

Survey resources are objects defined as part of a survey campaign that display for scripts at runtime to users of the Scripting Engine Web interface.

Survey Resource Display Types

Each survey campaign can include up to four survey resources:
- Header section
- Footer section
- Error page
- Final page

Each survey resource has a display type, as shown in the following table:
When a script is executed in a Web browser, each panel is represented by a separate HTML page. For each panel at runtime, header and footer sections (if associated with a survey campaign) appear just above or below panel contents, respectively.

The page resources are the full HTML pages that display when a script is executed in a Web browser, but do not contain panel content (nor do they include header and footer sections).

Error page resources are displayed when an error condition occurs during script execution in a Web browser. (If no error occurs, this page is not displayed.)

Final page resources are displayed for every script transaction for which they are associated, after the Scripting Engine processes the last panel in the flow of a script.

### Resource Definition and Physical Resource File

Survey resources consist of two components:

- The survey resource definition
- The physical survey resource file itself

The *survey resource definition* serves as a logical pointer to the physical survey resource. Survey resources are defined (and HTML resources uploaded to the database) from the Survey Resources tab of the Survey Administration console.

As for *physical survey resources*, no provisions are made to create HTML or JSP files within the context of the Oracle Scripting product. However, in order to display survey resources when you execute a script in the Web interface, physical survey resource HTML or JSP files must be created and uploaded appropriately. Creation of survey resources is required customization. For more information on creating physical survey resources, see the topic Survey Resources in the Oracle Scripting User Guide.

### Resource Types

There are three resource types, which display in the survey administration screens as follows:

<table>
<thead>
<tr>
<th>Display Type</th>
<th>Survey Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section resource</td>
<td>Header section</td>
</tr>
<tr>
<td></td>
<td>Footer section</td>
</tr>
<tr>
<td>Page resource</td>
<td>Error page</td>
</tr>
<tr>
<td></td>
<td>Final page</td>
</tr>
<tr>
<td>Type of Resource</td>
<td>Displayed in Resource Type field as ...</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>HTML file</td>
<td>HTML File Upload</td>
</tr>
<tr>
<td>JavaServer Page (JSP)</td>
<td>Deprecated - JSP</td>
</tr>
<tr>
<td>URL</td>
<td>URL For Redirect</td>
</tr>
</tbody>
</table>

## Resource Type Usage

- HTML files can be used for any display type (section or page survey resource) in the OAF technology stack only.

- JSP survey resources must be used for any survey resource displayed in a survey campaign using the deprecated JTT base technology stack only.

- URLs can be used for page resource display types (the error page or the final page) for survey campaigns using the OAF technology stack only.

Physical HTML files corresponding to a survey resource definition are stored in the applications database. These are uploaded when defining an HTML survey resource.

JSP files must be uploaded to the $OA_HTML directory on the applications server. This is conducted manually, as you cannot do this in Oracle Scripting.

URL resources must refer to an absolute URL accessible to the Apache Web server at runtime. Assuming the page to which users are being redirected exists, there is no physical file required to be uploaded.

## Attributes of Survey Responses

Although survey resources differ in many ways based on the technology stack to be used at runtime, the following are attributes of all survey resources:

- Each survey resource you want to use in a survey campaign must first be defined in the Survey Administration console, to provide a logical pointer to its corresponding physical file or URL redirect.

- Once created, survey resource definitions persist; the same resources can be used by any number of survey campaigns (of the same technology stack) without limit.

- You can change which survey resources are associated with an open or active survey campaign after survey campaign creation.

- Physical survey resource files must be created by certified, knowledgeable HTML
Compatibility Statement
Oracle Scripting supports two technology stacks for executing a script in the Scripting Engine Web interface. These technology stacks employ different underlying technologies during the execution of a script in a Web browser at runtime. The resource types available for each stack is as follows:

<table>
<thead>
<tr>
<th>Stack</th>
<th>Survey Resources Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deprecated JTT technology stack</td>
<td>JSP survey resources</td>
</tr>
<tr>
<td>OAF technology stack</td>
<td>HTML survey resources or URLs</td>
</tr>
</tbody>
</table>

All survey resources are created and administered from the Survey Resources tab.

- After defining a base technology stack for a survey campaign, you can only assign the resources applicable to that technology stack.

- The OAF technology stack is recommended for all new survey campaigns.

- Use of the JTT technology stack for new survey campaigns is not recommended. This technology stack is deprecated in this release, and will be obsolete in a future release of Oracle Scripting. Survey operations using the JTT technology stack is extended through this release to support enterprises with ongoing survey campaigns, to provide backward compatibility and uniformity of reporting.

Tasks
You can perform the following tasks:

- Creating Survey Resources, page 7-5
- Creating Survey Resource Definitions, page 7-6
- Viewing or Deleting Survey Resource Definitions, page 7-9
- Uploading JSP Survey Resources, page 7-10

Concepts
For more information, see the topics in the Survey Resources concepts section of the
Creating Survey Resources

No provisions are made to create HTML or JSP files within Oracle Scripting. However, physical survey resource HTML or JSP files must be created and uploaded, and subsequently defined in the Survey Administration console, in order to use survey resources when you execute a script in the Web interface. Creation of survey resources is required customization.

Including Graphics in Survey Resources

Survey resources, like any other HTML or JSP page, may include images and hyperlinks. Survey resources for JTT survey campaigns must be located in the $OA.HTML directory on the applications server to use at runtime. Survey resources for OAF survey campaigns are loaded into the database when defining the survey resources.

Regardless of technology stack, any objects (such as GIF or JPG images) referenced in a survey resource page must also be available to the application server at runtime. Thus, ensure you reference these objects accordingly when creating survey resources, and ensure the graphics are loaded to the appropriate directory accessible to the Apache Web server at runtime. For more information, see Uploading JSP Survey Resources, page 7-10.

Seeded JTT Test Survey Resources

For JTT survey campaigns, test survey resource JSP files ship with Oracle Applications, seeded in the appropriate directory ($OA.HTML) on the applications server. You can use the provided test resources to test your implementation and to serve as building blocks for creating your own resources. Ensure you retain the seeded resources for testing.

No seeded footer survey resource sample is included with Oracle Applications. For test purposes, you can reference a header resource in the Footer Section field, to ensure it displays as appropriate at runtime.

For more information, see the topics "Seeded JSP Survey Resources" and "Test Survey Resources" in the Oracle Scripting User Guide.

Note: Files with a JSP file extension must be tested on an existing Web server to view appropriately.
You must have the requisite knowledge and resources to create or modify HTML and JSP files in order to administer survey resources for use with Oracle Scripting to execute scripts in a Web browser.

References

• Topics "Creating Survey Resources" and "Test Survey Resources" in the Oracle Scripting User Guide

Creating Survey Resource Definitions

A survey resource definition serves as a logical pointer to a physical survey resource file intended to display at runtime.

Survey resources must be defined before they can be associated to a survey campaign. Once defined, survey resource definitions persist; the same resources can be used by any number of survey campaigns (of the same technology stack) without limit.

Different restrictions apply to defining survey resources, based on the technology stack for which they are intended to be used, and based on the function of the resource. For more information, see the Guidelines for Entering Survey Resource Information, page 7-7.

Use the following procedure to create survey resource definitions.

Prerequisites

• To create a survey resource definition for HTML File Upload survey resource types, you must have local or network access to the corresponding physical HTML file, since these resource types are uploaded at the time of definition.

• For survey resources of the Deprecated - JSP resource type, you must know the name of the corresponding physical JSP survey resource file. This file must be uploaded to $OA_HTML on the applications server for the survey definition to function at runtime.

• For survey resources of the URL For Redirect resource type, you must know the absolute URL of an HTML page that is accessible to the Apache Web server at runtime.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.
Responsibility
Survey Administrator

Guidelines for Entering Survey Resource Information
When you select a Resource Type, you must also provide survey resource information in one of three different fields, as follows:

<table>
<thead>
<tr>
<th>Resource Type</th>
<th>Field Name</th>
<th>Notes</th>
<th>Must File Name File Exist at Definition Time?</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML File Upload</td>
<td>File to Upload</td>
<td>Select a file name after clicking Browse. You must have local or network access to the file, as the definition process includes the file upload to the applications database. The file must have an extension of HTM, HTML, or XML.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Deprecated - JSP       | Resource JSP  | Enter the file name - of the form <filename>.JSP - of the physical file containing the survey resource definition. The file name is case-sensitive for Oracle applications hosted on a LINUX server. Before the survey deployment is executed, the file must be uploaded to the $OA_HTML directory on the applications server. For survey campaigns executed using the deprecated JTT technology stack:
  • Three resources must be defined: header section, error page, and final page.
  • Footer section resources are optional. | No File must be loaded by runtime. |

Survey Resource Administration Tasks 7-7
### Resource Type | Field Name | Notes | Must Field Name File Exist at Definition Time?
---|---|---|---
URL For Redirect | Resource URL | Enter the absolute URL of an HTML page - such as http://www.oracle.com - accessible to the Apache Web server at runtime. You cannot specify a relative path. The location of the URL designates the physical file that displays upon request. | No

**Steps:**
1. Click the Survey Resources tab.
2. Click Create.
3. Enter a Resource Name.
   This serves as a logical name pointer to the physical survey resource file.
4. Optionally, enter text in the Description field.
5. From the Language list, select a language.
6. Select a Resource Type:
   - HTML File Upload
     These resource types can be designated for any survey resource of any display type (header sections, footer sections, error pages, or final pages) for survey campaigns executed using the OA Framework technology stack.
   - Deprecated - JSP
     These resource types can be designated for any survey resource of any display type (header sections, footer sections, error pages, or final pages) for survey campaigns executed using the deprecated JTT technology stack.
   - URL For Redirect
     These resource types can be designated for page display survey resources (error pages or final pages) for survey campaigns executed using the OA Framework technology stack.
7. Depending on your choice of Resource Type, a different field name appears, where
you must select or enter further survey resource information.

See the Guidelines for Entering Survey Resource Information, page 7-7.

8. Click Apply.

Viewing or Deleting Survey Resource Definitions

You can view or delete existing survey resource definitions from the Survey Resources
page of the Survey Administration console.

For more information on deleting survey resources, see the Guidelines for Deleting

Prerequisites

None

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On
login if implemented.

Responsibility

Survey Administrator

Guidelines for Deleting Survey Resource Definitions

1. To delete a survey resource definition, it must not be associated with an active
survey deployment.

   If you need to delete a survey resource that is currently in use, first define another suitable
   resource, and assign the new resource in its place for all active survey campaigns.

2. The impact on the file containing the survey resource definition depends on the
Resource Type:

   1. When you delete a survey resource definition of the HTML File Upload
      resource type, you also cause the corresponding physical survey resource file to
      be deleted from the database.

   2. Since survey resource definitions of the other types do not upload a file
      automatically, deleting these definitions causes no change to physical files. If
      you wish to remove a file uploaded to $OA_HTML (for the deprecated JTT
      technology stack), you must manually delete the corresponding physical file.
3. Deleting a survey resource definition of the URL For Redirect resource type does not affect the file located at that URL.

**Steps:**
1. Click the Survey Resources tab.
2. Search for the survey resources that you want to view or delete.
   For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.
3. For deletions, select each survey resource definition that you want to delete, click Delete, and confirm your deletion.

**Uploading JSP Survey Resources**

For HTML For Upload survey resources, the corresponding physical HTML or XML files are uploaded as part of the survey resource definition process.

For URL For Redirect survey resources, the corresponding physical HTML or XML files to which the survey resource definition points must be uploaded independently, as part of the maintenance of that Web site by its administrator.

For Deprecated - JSP survey resources, the physical JSP survey resource files must be physically uploaded to the $OA_HTML directory on the applications server. This is required to make those files accessible to the Apache Web server at runtime, so the resources can display as appropriate.

**Seeded Test JSP Survey Resources**

Test JSP survey resources are already seeded in $OA_HTML.

**Graphics and Survey Resources**

If you employ graphics in custom survey resources, the appropriate physical image files (typically in GIF or JPG file format) must be uploaded to a server location accessible to the Apache Web server at runtime.

Since images supporting Oracle Applications are stored in the $OA_MEDIA directory on the server, this is one possible location to store graphics associated with survey resources. You can reference the graphic using its relative path. For example, if you store graphics in the $OA_MEDIA directory, reference your code to the appropriate path as in the following sample image source tag:

```html
<IMG SRC="/OA_MEDIA/image_name.gif" WIDTH="50" HEIGHT="10"
ALT="image description" BORDER="0">
```

Consult with your system administrator to determine if there are different requirements
for your environment.

**Prerequisites**

- To upload a physical JSP survey resource file, the file must first be created by a certified and knowledgeable JSP developer. The file should be tested on a Web server prior to deploying for production.

- You must have local or network access to the physical JSP file, and to any associated files (such as graphics referenced by the survey resource).

- You must have access and write privileges to the $OA_HTML directory on the APPL_TOP of the applications server. Consult your Apache Web server administrator or system administrator for access.

- If the resource contains graphics, you must have access to the directory to which these are stored. This location must be accessible to the Apache Web server at runtime (for example, $OA_MEDIA). Consult your Apache Web server administrator or system administrator for access.

  **Note:** $OA_HTML and $OA_MEDIA are variables which correspond to physical file locations on the Apache Web server. The physical directory structures may differ for each environment. For more information, consult your Apache Web server administrator or system administrator.

**Login**

Not applicable

**Responsibility**

Not applicable

**Steps:**

1. On your local computer (or over a network), locate the <filename>.JSP files created for use as survey resources.

2. Connect to the applications server through an appropriate method such as TELNET.

   If you do not have permissions to access the appropriate environment, consult your system administrator.

3. Navigate to the $OA_HTML directory.
$OA_HTML is a variable to point to a physical directory. JSP resources for Oracle Scripting must physically exist in this directory path in order to execute a script in a Web browser in the deprecated JTT technology stack.

4. Using an appropriate protocol such as FTP, "put" or copy the target JSP files to the $OA_HTML directory.

Specify ASCII format for file transfer.

5. If any survey resource file includes references to graphics, navigate to the appropriate directory specified in the survey resource (for example, $OA_MEDIA).

$OA_MEDIA is a variable to point to a physical directory in which media items for Oracle Applications are stored. The physical directory path may differ based on your specific environment or enterprise requirements for storing customized images in support of Oracle Applications.

6. Using an appropriate protocol such as FTP, "put" or copy the target graphic files to the appropriate directory (for example, $OA_MEDIA).

The survey resources (and any supporting image files) are now available to Survey administrators through the Survey Administration console. Before these files can be used, resources must be defined in the Survey Administration console, and a survey campaign designated as using a base technology stack of Deprecated - JTT must be created and activated.
Survey Campaign Administration Tasks

This chapter covers the following topics:

• Overview of Survey Campaign Administration
• Setting Survey Administration Preferences
• Survey Administration Console Tabs
• Administering Survey Campaigns
• Performing Survey Campaign and Survey Resource Searches
• Creating Survey Campaigns and Cycles
• Viewing or Modifying Survey Campaign and Cycle Details
• Cancelling a Survey Campaign from the Survey Campaigns List
• Deleting Survey Campaigns and Cycles
• Adding or Modifying a Cycle for an Existing Survey Campaign
• Defining Deployments
• Viewing or Modifying Deployment Details
• Deleting Deployments
• Viewing Responses Received
• Sending Reminders Manually to List Members
• Setting Up Invitations and Reminders
• Using the Master Document Editor
• Verifying Status of a Fulfillment Request
• Administering Concurrent Programs for Survey Execution
• Scheduling or Executing Concurrent Programs
• Checking Concurrent Program Logs
Overview of Survey Campaign Administration

Survey Campaigns, Cycles, and Deployments

A survey campaign is a high-level set of instructions for executing a script in a Web browser (as a survey or Web script). All survey campaigns require, as a prerequisite, a script created using the Script Author component of Oracle Scripting. Each survey campaign has one or more processing units, called cycles. Each cycle, in turn, has one or more processing units called deployments. Deployments designate detailed execution requirements including, at minimum, start and end dates and times.

After defining a deployment, it must be explicitly activated. This generates a survey URL, a system-generated string of parameters to allow end users to execute the designated questionnaire script (a survey campaign parameter) in a Web browser.

The operations to define survey campaigns and activate deployments are performed in the Survey Administration console by Oracle Applications users with the Survey Administrator responsibility.

Standard and Targeted Survey Campaigns

The amount and depth of information required to administer survey campaigns, and the application tasks that are prerequisite, depend on which of two types of survey campaigns are required.

Standard survey campaigns are quick and easy to administer. Once a deployment for a standard survey campaign is activated, it is executed when end users click a specified, static URL in a Web browser. There are no dependencies on other applications (other than the script). Standard survey campaigns are typically administered and deployed for use as surveys linked from a Web site, or for Web scripts (in which self-service Web application users click a customized link in the application to execute the script in a Web browser).

Targeted survey campaigns are executed from an e-mail message. The recipients of the e-mail message are members of an Oracle Marketing list. The e-mail distribution (sometimes referred to as a marketing blast) is handled using Oracle One-to-One Fulfillment. The list members that respond to the e-mail message by participating in the execution of the script are referred to as respondents.

Special Administration for Targeted Campaigns

Targeted survey campaigns take advantage of application integration, and require substantial planning. Administration using Oracle Marketing and Oracle One-to-One Fulfillment is required prior to defining a deployment for a targeted survey campaign.

To simplify administration for creating targeted deployments, the Survey Administration console hosts functionality from Oracle Marketing in the Audience tab.
(for list management functions) and functionality from Oracle One-to-One Fulfillment in the Invitations tab (to create invitations, reminders, and queries, and associate them with a template). These functions can also be performed from within each application's own UI. The Audience and Invitation tabs are not required for administrators of standard survey campaigns.

Once lists are created and invitations and reminders are suitably administered, survey administrators can define deployment details for a targeted survey campaign, which requires list and template information to be specified.

This document includes some task-based steps for setting up lists and templates in support of administering and executing targeted survey campaigns. For detailed information on the use of these applications, refer to the respective product documentation.

**General Survey Campaign Administration Tasks**

Tasks for administering Oracle Scripting survey campaigns, cycles, and deployments can be accomplished using the Survey Campaigns tab of the Survey Administration console.

*Responses to an active survey campaign* (saved when scripts are executed in a Web browser) can be viewed from the Survey Administration console. This information is accessible (by cycle and deployment) by selecting the Response View option from either the Update Survey Campaign page or the Update Deployment page.

*Tasks for administering list management* are considered Oracle Marketing functionality. These tasks can be accomplished using the Audience tab of the Survey Administration console, or from the Oracle Marketing user interface. For more information, refer to Oracle Marketing product documentation.

*Tasks for administering master documents (HTML invitations and reminders) and their associated queries, and the template objects with which they are associated, are considered Oracle One-to-One Fulfillment functionality. These tasks can be accessed using the Audience tab of the Survey Administration console, or from the Oracle One-to-One Fulfillment user interface.*

*Tasks for administering concurrent programs supporting the Scripting Engine Web interface provide the most recent information for survey administration, targeted deployments, and reporting. These tasks are performed from Oracle Forms-based applications as an Oracle Applications user with the iSurvey User responsibility.*

This section includes the following topics:

- Setting Survey Administration Preferences, page 8-4
- Survey Administration Console Tabs, page 8-6
- Administering Survey Campaigns, page 8-7
• Setting Up Invitations and Reminders, page 8-36
• Administering Concurrent Programs for Survey Execution, page 8-52

Setting Survey Administration Preferences

You can access the General Preferences page either from the Navigator page or from any page of the Survey Administrator console.

On this page, you can change the following preferences:

<table>
<thead>
<tr>
<th>General Preference Category</th>
<th>General Preference</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Languages</td>
<td>Current Session Language</td>
<td>Language used in current application session.</td>
<td>American English</td>
</tr>
<tr>
<td>Languages</td>
<td>Default Application Language</td>
<td>Language used in application pages if no language selected at login. Also, language in which e-mail notifications are received.</td>
<td>American English</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Accessibility Features</td>
<td>To provide additional accessibility to users of assisted technologies.</td>
<td>No</td>
</tr>
<tr>
<td>Regional</td>
<td>Territory</td>
<td>Country in which Oracle Applications is in operation.</td>
<td>United States</td>
</tr>
<tr>
<td>Regional</td>
<td>Date Format</td>
<td>Defines date format for table listings, database queries, etc.</td>
<td>DD-MON-RRRRR (displays as 20-APR-2004)</td>
</tr>
<tr>
<td>Regional</td>
<td>Timezone</td>
<td>Timezone, based in hours before or after Greenwich Mean Time (GMT)</td>
<td>(GMT -08:00) Pacific Time</td>
</tr>
<tr>
<td>General Preference Category</td>
<td>General Preference</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Regional</td>
<td>Number Format</td>
<td>Determines placeholder usage for thousands place based on standard country usage.</td>
<td>10,000.00</td>
</tr>
<tr>
<td>Regional</td>
<td>Client Character Encoding</td>
<td>Appropriate character encoding for the client computer workstation of logged-in user.</td>
<td>Western European (Windows)</td>
</tr>
<tr>
<td>Change Password</td>
<td>Known As</td>
<td>First and last name of logged-in user, derived from Known As field from HRMS database.</td>
<td>For user Michael Smith, Mike Smith.</td>
</tr>
<tr>
<td>Change Password</td>
<td>Old Password</td>
<td>Password used to log into current session.</td>
<td>OLDPASSWORD</td>
</tr>
<tr>
<td>Change Password</td>
<td>New Password and Repeat Password</td>
<td>New password intended to govern the remainder of this session and all future sessions until changed again.</td>
<td>NEWPASSWORD</td>
</tr>
<tr>
<td>Start Page</td>
<td>Responsibility</td>
<td>Default responsibility for user at login.</td>
<td>Survey Administrator</td>
</tr>
<tr>
<td>Start Page</td>
<td>Page</td>
<td>Default start page at login.</td>
<td>Survey Launch Page</td>
</tr>
<tr>
<td>Notifications</td>
<td>Email Style</td>
<td>Electronic mail settings, enabled if logged-in user has default e-mail address defined.</td>
<td>Do not send me mail.</td>
</tr>
</tbody>
</table>

**Note:** You can click Reset to Default to reset default preference values.
### Survey Administration Console Tabs

Each of the Survey Administration console pages contains four tabs. These tabs provide access to the following functions:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Scripting Function</th>
<th>Tasks You Can Accomplish</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey Campaigns</td>
<td>Administer survey campaigns</td>
<td>• Create survey campaigns and cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View and modify survey campaign details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add additional cycles to existing survey campaigns or modify cycle details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete survey campaigns and cycles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define deployments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View and modify deployment details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Activate deployments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete deployments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View responses (for deployments for which responses have been received)</td>
</tr>
<tr>
<td>Survey Resources</td>
<td>Administer survey resources</td>
<td>• Create survey resource definitions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View and modify survey resource definitions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Upload HTML files for use as OA Framework survey resources</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete survey resource definitions</td>
</tr>
<tr>
<td>Tab</td>
<td>Scripting Function</td>
<td>Tasks You Can Accomplish</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Audience</td>
<td>Administer Oracle Marketing lists for targeted survey deployments</td>
<td>• Create, import, or segment a list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use Oracle Discoverer to build a list using the Discoverer workbook</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Search lists</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Administer the organization or person for list members</td>
</tr>
<tr>
<td>Invitations</td>
<td>Administer Oracle One-to-One Fulfillment invitations and reminders for targeted survey deployments</td>
<td>• List Oracle One-to-One Fulfillment invitation and reminder master document details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and upload new master documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Upload existing master documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create queries for master documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create a template identifying master documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify the status of a fulfillment request</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check fulfillment request history.</td>
</tr>
</tbody>
</table>

The Audience and Invitations tabs provide access to user interfaces owned by other Oracle applications: Oracle Marketing and Oracle One-to-One Fulfillment, respectively:

- Oracle Marketing provides list management and campaign management functionality.
- Oracle One-to-One Fulfillment is used for creation, management, deployment and delivery of invitations and reminders.

For survey administration, these two tabs are only required for targeted (list-based) survey deployments. As these products are documented elsewhere, only their functionality specific to using Oracle Scripting is addressed in this document.

**Administering Survey Campaigns**

From an administration perspective, the survey campaign is a collection of top-level
requirements for executing an information-gathering survey campaign by executing a script in a Web browser. To achieve the goals of the campaign, you must create a survey campaign, and define for each survey campaign at least one cycle and at least one deployment. The first cycle for any survey campaign is created at the time of survey campaign creation. Additional cycles can be defined later (while the survey campaign status is open or active).

Defining deployments is a separate process that can be performed either immediately after survey campaign and cycle creation, or later (while the survey campaign status is open or active).

Use the Survey Campaigns tab to create, modify, or view survey campaigns, cycles, deployments, or to view responses for active or closed survey campaigns.

Tasks

You can perform the following tasks:

- Administering Survey Resources, page 7-1
- Performing Survey Campaign and Survey Resource Searches, page 8-9
- Creating Survey Campaigns and Cycles, page 8-15
- Viewing or Modifying Survey Campaign and Cycle Details, page 8-21
- Cancelling a Survey Campaign from the Survey Campaigns List, page 8-22
- Deleting Survey Campaigns and Cycles, page 8-23
- Adding or Modifying a Cycle for an Existing Survey Campaign, page 8-24
- Defining Deployments, page 8-25
- Viewing or Modifying Deployment Details, page 8-29
- Deleting Deployments, page 8-32
- Viewing Responses Received, page 8-32
- Sending Reminders Manually to List Members, page 8-34

Concepts

See the topics described in the Survey Administration Concepts section of the Oracle Scripting User Guide.
Performing Survey Campaign and Survey Resource Searches

When searching for survey campaigns or survey resources, you can perform simple or advanced searches, and then save your searches, with all the search parameters you entered, for reuse.

For both survey campaigns and survey resources, the methods for searching and saving searches are similar. In both cases, the saved searches are known as views.

**Note:** In this section, the terms "saved search" and "view" are used interchangeably.

Survey campaign views can only be used in survey campaign searches; survey resource views can only be used for survey resource searches.

This section consists of the following topics:

- Survey Campaign and Survey Resource Search Overview, page 8-9
- Performing Simple Searches, page 8-11
- Performing Advanced Searches, page 8-12
- Creating and Personalizing Views, page 8-13
- Using Views, page 8-15

Survey Campaign and Survey Resource Search Overview

The diagram shows an overview of the features available when you search for survey campaigns or survey resources.
Both the initial Survey Campaigns page and the initial Survey Resources page appear as a Simple Search page with two regions:

- Search region
- Results region

You can search for survey campaigns or survey resources using three search pages:
Simple Search, Advanced Search, or Views. You can switch between the search pages by clicking the appropriate Simple Search, Advanced Search, or Views button.

A view is a saved search. For simple or advanced searches that you want to repeat in the future, save them as views, and reuse them as needed.

Each of the search pages contains a Go button - when clicked, it performs the search.

The basic search process is as follows:

1. Select the search page that you want to use.

2. Prepare to perform the search as follows:
   1. For simple searches, enter the search parameter.
   2. For advanced searches, optionally add in extra search parameters from an extensive list, then enter your search parameters.
   3. To use views, invoke a previously saved search or view.

3. Click Go to perform the search.

4. The results appear in the results region.

See Also

- Performing Survey Campaign and Survey Resource Searches, page 8-9

Performing Simple Searches

The Simple Search page enables you to use a key field as a search parameter.

Notes

1. Enter a full or partial value for the key field: Survey Campaign Name for survey campaign searches, or Resource Name for survey resource searches.

2. Click Go to perform the search.
   The results appear in the results region of the page.
   For details of more extensive searches, see Performing Advanced Searches, page 8-12.

Saving Your Search

Whether you perform the search or not, you can click Save Search to save your search as a view, so that you can reuse it later. For details, see Creating and Personalizing Views, page 8-13.
Performing Advanced Searches

The Advanced Search page enables you to search using a more extensive set of search parameters than is available for simple searches. For example, you can add one or more of the following parameters: Base Tech Stack, Created By, Last Updated Date, Prototype, Script Name, Status, and Survey Campaign Name.

You can also specify that all conditions must be satisfied (the default case), or that any single condition is all that is necessary.

Adding Extra Search Parameters

The Advanced Search page contains a set of standard search parameters. You can select further columns from an extensive list to act as extra search parameters, as follows:

1. Click in the Add Another field, and select a column name from the list.
2. Click Add.

The page redisplays with your selected column name, and untitled condition operator and value fields beside it.

Repeat these steps for as many columns as you wish to add to the page as search
Entering Search Conditions and Performing the Search

1. For each search parameter that you want to search on, formulate a condition, with a condition operator and a value, as follows:
   1. Select a condition operator.
      The condition operators "is" and "is not" are available for all columns. In addition, for some fields, you can select "contains", "starts with", or "ends with".
   2. Select or enter a value to complete the condition.

2. Optionally select the radio button to show table data when any condition is met, rather than the default of all conditions.

3. Click Go to perform the search.
   The results appear in the results region of the page.

Saving Your Search

Whether you perform the search or not, you can click Save Search to save your search as a view, so that you can reuse it later. For details, see Creating and Personalizing Views, page 8-13.

See Also

- Performing Survey Campaign and Survey Resource Searches, page 8-9

Creating and Personalizing Views

Generally, you create a view when you decide to save the search parameters for a simple or advanced search for reuse. You can also create a view from scratch, with no previously entered search parameters.

The general view creation/update page is used to create a new view, duplicate a view, or update a view.

Prerequisites

When creating a view:
- In the Simple Search or Advanced Search page, you clicked Saved Search, or, in the Views page, you clicked Personalize, then Create View.

When duplicating a view:
- In the Personalize Views page, you selected a view, then clicked Duplicate.
When updating a view:

- In the Personalize Views page, you selected a view, then clicked the Update icon.

**Entering View Information**

The general view creation and update page is an Oracle Applications Framework page, which enables you to customize your survey campaign or survey resource searches and the layout of the search results as follows:

**General Properties**

1. Name the view, if you are creating or duplicating a view. When updating a view, you can change the view name.

2. Optionally alter the default value, 10, for the number of rows to display in the results region.

3. If you want the current view to be used as the default view each time you log on, check Set as Default.

**Column Properties**

1. Select the columns which you want to appear in the search results. The values in the Columns Displayed list show the default selection of columns.

   Use the Move and Remove links and arrows to move selected columns between the Available Columns list and the Columns Displayed list.

   Use the Up and Down arrows to arrange the sequence of the columns in the Columns Displayed list. The columns as arranged from top to bottom will be displayed from left to right in your search results.

2. If you want to customize the headings for a selected column, or if you want to have totaling on numeric columns, click Rename Columns/Totaling and perform those customizations in the page that appears. Note that you can only select totaling for the end columns of the list.

**Sort Settings**

1. You can select whether you want the results sorted or not. If you decide to have sorted results, you can choose up to three columns to sort by.

**Search Query to Filter Data in your Table**

1. If you came to this page from a simple or advanced search page, this region is where the simple or advanced search parameters appear.

2. You can alter the entries here, and add further search parameters. For each additional search parameter, select a column name from the Add Another list of values, and click Add.
3. Optionally select the radio button to show table data when *any condition* is met, rather than the default of all conditions.

**Saving the View and Optionally Performing the Search**

After entering all the view information, click either Apply or Apply and View Results. The latter option applies the changes, then performs the saved search and displays the results of the search.

**See Also**

- Performing Survey Campaign and Survey Resource Searches, page 8-9

**Using Views**

Use this procedure to invoke a previously saved search.

**Notes**

1. In the Views page, select a View, and click Go.
   The results appear in the results region of the page.

**See Also**

- Performing Survey Campaign and Survey Resource Searches, page 8-9

**Creating Survey Campaigns and Cycles**

The survey campaign is a structure that allows you to define the basic parameters for executing a script in a Web browser. The cycle is a child object of the survey campaign.

To create and save a survey campaign, you must:

- Define a survey campaign name
- Select the base technology stack
- Provide a status
- Identify whether the survey is a prototype
- Define a cycle name

To meet execution requirements, you must also:

- Identify the script to execute at runtime

If you want specific survey resources to display, you must also identify those resources.
Additionally, you must subsequently create a deployment (as a child to the cycle) and activate the deployment.

For more information, see the Guidelines for Creating Survey Campaigns and Cycles, page 8-16.

Prerequisites

To create a survey campaign in the Survey Administration console:

- When selecting a base technology stack, Oracle recommends using the OAF technology stack for all new survey campaigns. Oracle Applications are standardizing on this technology stack, which is why Oracle Scripting is undergoing migration to this technology. The JTT technology stack is deprecated in this release, and will be obsolete in a future release of Oracle Scripting.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Survey Administrator

Guidelines for Creating Survey Campaigns and Cycles

- The fields required to create and save a survey campaign and cycle include: Survey Campaign Name, Base Tech Stack, Status (required to be Open), Prototype status (selected or cleared), and Cycle Name.

- To execute a survey campaign using the JTT technology stack, the following additional fields are required: Questionnaire Script, Header Section, Error Page, and Final Page. OAF survey campaigns require the same fields, with the exclusion of the survey resources.

- You cannot change the base technology stack or the prototype status after a survey campaign is activated. To change either of these fields, you will have to recreate the entire survey campaign and all its child objects.

- The Prototype option is recommended only for test survey campaigns, since its script does not lock, and since an active Prototype survey campaign cannot be converted into a standard locking survey campaign type.

- An appropriate script serving as the survey questionnaire must be deployed to the applications database from Script Author before you can designate this script as the survey questionnaire.
• Any survey resources intended for use with the survey campaign must already be defined, as described in the section Administering Survey Resources, page 7-1.

• Survey campaigns to be executed in the OA Framework technology stack do not require any survey resources. However, if using them, the corresponding physical HTML files for defined survey resources must already be uploaded, or the URL to be used as a resource for error or final pages must already be identified. This process occurs at the time of survey resource definition.

• Survey campaigns to be executed in the deprecated Java Technology Foundation (JTT) technology stack require, at minimum, a header section, error page, and final page resource defined. While the corresponding physical JSP files for defined survey resources need not exist on the server in order to create a survey campaign, they must reside in the appropriate directory in order to execute the survey questionnaire in a Web browser using the JTF technology stack.

Steps:
1. From the Survey Administration console, click the Survey Campaigns tab.

2. Click Create.
   The Create Survey Campaign page appears.

3. Enter the Survey Campaign Name.

4. Optionally enter a Description field.

5. From the Base Tech Stack list:
   • For survey campaigns intended for execution in the Oracle Applications Framework technology stack, select **OA Framework**.
     Oracle recommends using this technology stack for all new survey campaigns.

   • For survey campaigns intended for execution in the deprecated Java Technology Foundation (JTT) technology stack, select **Deprecated - JTT**.
     The JTT technology stack is deprecated in this release, and will be obsolete in a future release of Oracle Scripting.

     **Caution:** Once you specify the base technology stack in this field and save the survey campaign, this information cannot be changed.

6. From the Status list, verify that the survey campaign status is Open.
The Allow Suspend/Resume field applies to the survey campaign, but the Allow Suspend/Resume list of values depends on whether the script associated with the survey campaign is suspendable.

**Note:** Either select the Questionnaire Script - see step 9 - before Allow Suspend/Resume, or reselect the Allow Suspend/Resume value after selecting the Questionnaire Script.

7. Select the Allow Suspend/Resume field.

You can select from the options: Allow Suspend, Always Suspend, Can't Suspend, when the Questionnaire script associated with the survey campaign is suspendable; if the associated script is not suspendable, the only option is Can't Suspend.

The Always Suspend option allows an administrator to designate a survey that, after being started, can only be suspended, and never marked as complete. This allows the same or other users to always be able to resume the survey.

8. If you want this survey campaign to be defined as a prototype, select the Prototype box.

Prototype and non-prototype survey campaigns differ as follows: the survey questionnaire script is locked when a non-prototype survey campaign is activated, but not in a prototype survey campaign. When a questionnaire script is locked, it cannot be modified again. This ensures data consistency for the results of the survey campaign across each respondent's answers.

Designating a survey campaign as a prototype allows survey campaign administrators more freedom to refine requirements for test survey campaigns by modifying the properties of a script (such as questions and branching) and then allows them to deploy the final version to a non-prototype survey campaign, where it is assured that the data will be consistent.

9. In the Activation Requirements area, click the flashlight icon to search for and select a Questionnaire Script field.

**Note:** Selecting the Questionnaire Script may affect the options available for the Allow Suspend/Resume field - see step 7.

10. For OA Framework survey campaigns, continue at step 16.

**Survey Resources for JTT Survey Campaigns**

11. In the Survey Resources area, click the Header Section flashlight icon to search for and select a Header Section resource.
**Note:** Survey resources must be defined before you can associate them with a survey campaign.

For JTT survey campaigns, header section, error page, and final page resources are required. Footer section resources are optional. Physical files corresponding to the logically defined JSP survey resources are not required to create a survey campaign, but must be present in order to execute the campaign in a Web browser.

For more information, see Administering Survey Resources, page 7-1.

**Note:** You can search by either Logical Name - the survey resource name - or Physical Name.

For survey resources that are JSP files, the physical name is the name of the physical JavaServer Page file that must be uploaded to the OA_HTML directory on the applications server prior to survey runtime.

For JTT survey campaigns, only JSP resource types are displayed in the appropriate search pages.

12. Optionally, click the Footer Section flashlight icon to search for and select a Footer Section resource.

13. Click the Final Page flashlight icon to search for and select a Final Page resource.

14. Click the Error Page flashlight icon to search for and select an Error Page resource.

15. For JTT survey campaigns, continue at step 21.

**Survey Resources for OA Framework Survey Campaigns**

**Note:** OA Framework survey campaigns do not require survey resources. However, any survey resources to be associated with an OA Framework survey campaign must have been defined previously. For more information, see Administering Survey Resources, page 7-1.

16. If you do not want a Header Section or a Footer Section resource, continue at step 18.

**Note:** If you select neither a header section nor a footer section
resource, no header section or footer section will appear on the HTML page at runtime.

17. Optionally, to designate a Header Section or Footer Section, in the Survey Resources area, click the appropriate flashlight icon to search and select the corresponding resource.

   **Note**: You can search by either Logical Name - the survey resource name - or Physical Name.

   For survey resources that are HTML files, the physical name is the name of the physical HTML file uploaded to the applications database at the time of resource definition.

   For OAF header and footer sections, only HTML resource types are displayed in the appropriate search pages.

18. If you do not want a Final Page or an Error Page resource, continue at step 21.

   **Note**: If final page or error page resources are not provided, a simple default page for the corresponding function will be displayed by the system at the appropriate time.

19. Optionally, to designate a Final Page or Error Page survey resource, click the appropriate flashlight icon to search and select the corresponding resource.

   **Note**: You can search by either Logical Name - the survey resource name - or Physical Name.

   For survey resources that are HTML files, the physical name is the name of the physical HTML file uploaded to the applications database at the time of resource definition.

   For survey resources designated as a URL for Redirect, the physical name is the specific URL associated with the survey resource. No validation is performed on the specified URL.

   For OAF error page or final page sections, any defined HTML or URL for Redirect survey resource types are displayed in the appropriate search pages.

20. Optionally, for error pages using an HTML resource type only, if you want error information to appear on the top of the designated error page (to help identify the nature of an error encountered at runtime), check the Display Error on Top box.
Specifying the Cycle

21. In the Create Cycle area, in the Cycle Name field, enter an appropriate cycle name for this survey campaign.

22. Click Apply.

   The survey campaign and cycle are created, and all defined fields are saved to the database.

   The Update Survey Campaign page appears.

   This page is similar to the Create Survey Campaign page, but also contains a Deployments area, from which you can define a deployment for the cycle you defined in step 21.

23. To continue from this point to define a deployment, proceed to step 5 of Defining Deployments, page 8-25.

Viewing or Modifying Survey Campaign and Cycle Details

After a survey campaign is created, and before it contains any active deployments, you can view or modify any of its properties except the base technology stack.

After a deployment has been activated, survey campaign and cycle details that you can change include the description, survey resources, and cycle name. If you change the deployment status from active, you can then change the survey campaign status.

For idle or closed survey campaigns, you can change the description, status, questionnaire script, survey resources, and cycle name fields.

Use this procedure to view or modify survey campaign and cycle details.

Prerequisites

A survey campaign must already be created and saved.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Survey Administrator

Steps:

1. Click the Survey Campaigns tab.
2. Search for and retrieve the survey campaigns that you want to view or modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.

3. In the search results list, click Update for the appropriate survey campaign.

4. In the Update Survey Campaign page, view survey campaign details or make changes as desired.

   **Note:** If you want to change the status of an active survey campaign, you must first change the status of any of its active children deployments.

5. The only modifiable property for a cycle is the cycle name. For instructions on how to add or modify cycles, proceed to step 4 of Adding or Modifying a Cycle for an Existing Survey Campaign, page 8-24.

6. Click Apply to save your changes.

**Cancelling a Survey Campaign from the Survey Campaigns List**

Survey campaigns cannot be deleted when their status is Open.

Use this procedure to change the status of an open survey campaign to Cancelled from the Survey Campaigns list.

**Prerequisites**

A survey campaign must already be created and saved, but not yet activated.

**Login**

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Survey Administrator

**Guidelines**

- After a survey campaign is cancelled, its cycle is also cancelled.
- After a survey campaign is cancelled, its status cannot be changed.
Steps:
1. Click the Survey Campaigns tab.
2. Search for and retrieve the survey campaigns that you want to view or modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.
3. In the search results list, select a status of Cancelled for each appropriate survey campaign.
4. Click Apply.

Deleting Survey Campaigns and Cycles
Use this procedure to delete one or more existing survey campaigns and cycles.

Prerequisites
- A survey campaign cannot be deleted if it contains one or more cycles with an active deployment.
- Only survey campaigns with a status of closed or cancelled can be deleted. You cannot delete open or idle survey campaigns.

Login
Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility
Survey Administrator

Steps:
1. Click the Survey Campaigns tab.
2. Search for and retrieve the survey campaigns that you want to delete. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.
3. In the search results list, select each of the survey campaigns that you want to delete, and click Delete.

Note: To delete multiple survey campaigns in one step, all survey
campaigns that you want to delete must appear on the page. If you cannot adjust search criteria to view all relevant survey campaigns, you must search for and delete survey campaigns separately.

When a survey campaign is deleted, its child objects are also deleted.

**Adding or Modifying a Cycle for an Existing Survey Campaign**

One cycle is defined for each survey campaign upon creating the survey campaign. Survey campaigns can contain any number of cycles. Use this procedure to modify the cycle name, or to add a cycle to an existing survey campaign.

**Prerequisites**

A survey campaign and cycle must already be created and saved.

**Login**

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Survey Administrator

**Steps:**

1. Click the Survey Campaigns tab.

2. Search for and retrieve the survey campaigns that you want to modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.

3. In the search results list, click Update for the appropriate survey campaign.

4. To modify the name of an existing cycle, in the Cycles and Deployments area, do the following:
   1. From the View By filter, select Deployment View.
   2. Select the cycle name that you want to modify.
   3. Click Update Name.
      The Update Cycle page appears.
4. In the Cycle Name field, enter the new name that you want to assign to this cycle.

5. Click Apply.

5. To add a cycle to this survey campaign, in the Cycles and Deployments area, do the following:

1. From the View By filter, select Deployment View.

2. Click Add Cycle.
   The Add Cycle page appears.

3. In the Cycle Name field, type an appropriate cycle name to add to this survey campaign.

4. Click Apply.

**Defining Deployments**

A deployment is a detailed set of execution requirements for conducting a survey campaign or establishing a Web script. At least one deployment must be defined for each cycle for a survey campaign.

Cycles can contain any number of deployments.

After a deployment is created, it must be activated (deployed) before a script can be executed in the Scripting Engine Web interface.

Use this procedure to define a deployment for a cycle.

**Prerequisites**

A survey campaign and cycle must already be created.

**Login**

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Survey Administrator
**Steps:**

1. Click the Survey Campaigns tab.

2. Search for and retrieve the survey campaigns where you want to define one or more deployments. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.

3. In the search results list, for an appropriate survey campaign, click Update. The Update Survey Campaign page appears.

4. If more than one cycle is associated with this survey campaign, then in the Cycles and Deployments area, do the following:
   1. From the View By filter, select Deployment View.
   2. From the Cycle Name list, select the appropriate cycle. The Update Survey Campaign page refreshes, showing the deployments specific to the selected cycle.

5. In the Deployments area, click Create. The Create Survey Deployment page appears.

6. In the Deployment Name field, type the name of the deployment you want to create.

7. Verify that the media type listed is WEB. At this time, no other media type is supported.

8. In the Status field, verify that the Open option is selected.

9. In the Deploy Date and Time field, select a deployment start date and time. **Note:** The deployment start date and time cannot be before the current date and time.

10. In the Response End Date and Time field, select the response end date and time for this deployment.

11. In the Deployment Type field:
   - For standard deployments only, verify that the deployment type specified in the Deployment Type field is Standard. If not, select Standard.
Note: Standard deployments - sometimes referred to as "non-list-based" deployments - require no other deployment details.

Proceed to step 24.

- For targeted deployments only, in the Deployment Type field, select Targeted. The Create Survey Deployment page refreshes, displaying additional fields applicable to targeted deployments.

  Note: Targeted deployments - sometimes referred to as list-based deployments - require extra details:
  
  - Detailed information to specify a targeted a list of possible survey respondents - functionality provided by Oracle Marketing
  
  - Details regarding invitations and reminders sent to the targeted list members - functionality provided by Oracle One-to-One Fulfillment.

  Proceed to the next step.

12. In the Hosting Options field, select a hosting option based on your survey campaign requirements, using the following guidelines:

    - Standalone deployments require guest user authentication. These are typically used for targeted survey campaigns, or for surveys or Web scripts that are not associated with self-service Web applications. Upon completion of the script, the Oracle Applications session is terminated. Unless the URL is otherwise customized, the URL for JITT survey campaigns uses the IESSVYMAIN.JSP template, and for OAF survey campaigns uses the OA.JSP template.

    - Menu Based hosting for targeted deployments using the OA Framework base technology stack is not supported.

    - Menu Based deployments require authentication from an existing Oracle Applications session. These are typically used for surveys or Web scripts executed when the user is already logged into an Oracle Applications session and using a self-service Web application; the authentication and database connection information for the current applications session are used to provide the privileges to execute the Scripting Engine Web interface. That application’s the tab-based menus are hosted in the survey or Web script user interface. Upon completion of the script, the Oracle Applications session is maintained.
13. Optionally, if you want to execute the survey using a different Apache Web server or Web server port, then in the Survey URL field, change the survey URL parameters as required.

This field automatically populates with the Web server and port information for the current Oracle Applications session.

If you need to point this to a second Apache Web server (for example, to execute a survey outside the corporate firewall), then type the name of the Web server hostname including domain, port, and reference to HTML bin, ending with a slash. For example, enter:

http://server2.company.com:8888/OA_HTML/

For more information, see the topic Survey URL in the Oracle Scripting User Guide.

14. Click the List Name flashlight icon to search for and select the Oracle Marketing list that identifies the target audience.

15. Click the Invitation Template Name flashlight icon to search for and select the Oracle One-to-One Fulfillment template associated with the desired invitation master document (which in turn is associated with a query).

16. In the Invitation E-mail Subject Heading field, enter the name that you want to appear as the subject line of the outgoing message created using the invitation master document.

For example, enter Please participate in our survey.

17. If no reminders are required, continue at step 22.

18. Click the Reminder Template Name flashlight icon to search for and select the Oracle One-to-One Fulfillment reminder master document.

A template identifies a master document (which in turn is associated with a query). In this case, you want to specify a template associated with the appropriate reminder master document. If survey campaign requirements dictate, this may be the same template used to specify the invitation.

19. In the Reminder E-mail Subject Heading field, enter the name that you want to appear as the subject line of the outgoing message created using the reminder master document.

For example, enter Reminder: survey closes last day of the month!

20. In the Number of Reminders field, enter the integer number which determines how many reminders will be automatically sent to all list members.
21. In the Reminder Interval In Days field, enter the integer number which represents,
in days, the span of time that will pass between reminders to be sent automatically
to all list members.

To determine this value, divide the number of reminders by the duration of the
deployment (in days).

22. In the Maximum Responses Per Person field, enter the integer that determines how
many times an individual (list member) can participate in a survey or execute a
Web script.

This restriction is based on the unique survey URL for a list member, which
includes both the deployment identification code and the unique respondent
identification code.

**Note:** This is a required field. If no maximum applies, type 0 in this
field.

23. Optionally, in the Target Response Percent field, type an integer between 1 and 100.

This value is an administrator-defined target percentage, used in survey reports
accessible by users of Oracle Business Intelligence. Reports compare the target
percentage indicated against the total number of responses received for a
deployment. Thus, the value is provided as a report metric, and is not used to
enforce any survey campaign-level business rules.

24. Click Apply.

To modify deployment details or activate a deployment, proceed to step 6 in
Viewing or Modifying Deployment Details, page 8-29.

### Viewing or Modifying Deployment Details

Use this procedure to view or modify details for an existing deployment, or to activate a
deployment.

If performing this procedure immediately after creating or updating a deployment, start
at step 6.

### Prerequisites

A survey campaign, cycle, and deployment must already be created.
Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Survey Administrator

Steps:
1. Click the Survey Campaigns tab.

2. Search for and retrieve the survey campaigns that you want to modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.

3. In the search results list, click Update for the appropriate survey campaign.

4. In the Cycles and Deployments area, if the cycle with which the desired deployment is associated is not displayed, then from the Cycle Name list, select the appropriate cycle.

5. In the Deployments area, from the Deployment Name column, click the appropriate deployment name.

   The Update Deployment page appears.

   This page has two views.
   • In the deployment view, you can modify deployment information or activate this deployment.
   • In the response view, you can see the results of any responses received for this deployment.


7. If you want to view or modify deployment details, then do the following:
   1. Optionally, to view deployment details specific to targeted deployments (if not already displayed), then in the Deployment Type field, select Targeted.

      The Update Deployment page refreshes, displaying additional fields applicable to targeted deployments. For field details, see Defining Deployments, page 8-25.

   2. Make any changes as appropriate.
3. When satisfied, click Apply.

8. If you want to activate this deployment, click Activate.

   **Note:** This option is only available if the deployment is not already active.

The Update Deployment page refreshes. For an active deployment, the only editable fields include Status and Response End Date and Time.

For active standard deployments, in the Hosting Options area, the Survey Web URL field contains an active hyperlink to the executable deployment, including the message **Please click here to take the survey.**

- For active standard deployments, in the Hosting Options area, the Survey Web URL field contains an active hyperlink to the executable deployment, including the message **Please click here to take the survey.**

- For active targeted deployments, the Survey Web URL field contains the URL of the current Apache Web server session and port, Oracle Applications directory, and the appropriate JSP page based on hosting option. Since each respondent has an identification code included as a parameter in their unique survey URL, targeted deployments cannot list a single survey URL.

- For targeted deployments for which the SUBMIT GROUP FM REQUEST FROM IES concurrent program has not yet executed, only the concurrent request ID appears. Once the fulfillment request is executed and the page is updated, the fulfillment request ID also appears.

- If the fulfillment request ID does not appear, and the Activate button reappears, the concurrent program to submit the fulfillment request has failed.

9. If you want to participate in this survey:

   - For standard deployments, access the URL in the Survey Web URL field.

     **Note:** If you access this link using the same Web browser (for example, to test this deployment), you will invalidate your current Oracle Applications session. This will require a subsequent login to view details in the Survey Administration console.

   - For targeted deployments, access an invitation e-mail message sent from the fulfillment server and access the unique URL it contains.
Deleting Deployments

Use this procedure to delete one or more deployments. Deleting a deployment does not otherwise affect the parent cycle, or its parent object, the survey campaign.

Prerequisites

- A deployment must exist as a child to a parent survey campaign and cycle before you can delete the deployment.
- The deployment must not be active.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Survey Administrator

Steps:

1. Click the Survey Campaigns tab.

2. Search for and retrieve the survey campaigns that you want to modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.

3. In the search results list, click Update for the appropriate survey campaign.

4. In the Cycles and Deployments area, if the cycle with which the desired deployment is associated is not displayed, then from the Cycle Name list, select the appropriate cycle.

5. In the Deployments area, select each deployment that you wish to delete, and click Delete.

Viewing Responses Received

Use this procedure to view individual responses to a script executed in a Web browser.

Prerequisites

- A survey campaign, cycle, and deployment must already exist.
- At least one deployment must be active.
- At least one individual must already have executed the appropriate script in a Web browser. For targeted survey campaign deployments, at least one list member must have responded by taking a survey.
- You must know the specific survey campaign, cycle and deployment for which you want to review individual responses.

**Login**

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Survey Administrator

**Steps:**
1. Click the Survey Campaigns tab.
2. Search for and retrieve the survey campaigns that you want to modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.
3. In the search results list, click Update for the appropriate survey campaign.
4. In the Cycles and Deployments area, if the cycle containing the desired deployment is not displayed, then from the Cycle Name list, select the appropriate cycle.
5. In the View By area, select Response View.
   The Deployments area displays each deployment for the selected cycle, with response-related statistics.
6. You can view responses for a specific deployment from either the deployment view or the response view:
   - From the deployment view, start by clicking the Update icon for the deployment.
   - From the response view, start by clicking the Deployment Name link.
7. In the Update Deployment page, select Response View.
   Individual responses received for this deployment (if any) are listed in the Responses table.
8. In the Responses area, click the icon in the Answer column for a response.

The Survey Answers page appears for this respondent. Below information for the survey campaign, cycle, deployment and the response date, the Answers table appears. This table contains an expandable navigation tree for the selected respondent.

9. To expand or collapse all navigation trees for each panel or question for this respondent, click Expand All or Collapse All at any time, as appropriate.

In the fully expanded view, subsequent navigation trees appear for each panel and question. In the fully collapsed view, only respondent information is visible.

10. When collapsed, click the triangle marked with a plus sign to view respondent answer information hierarchically. The hierarchy, from top to bottom, is respondent, panel name, question in panel, answer choice in question (if relevant), and respondent’s selected answer.

11. For any panel or question, from the Focus column, click the focus icon to focus in on that aspect of the response.

An uncluttered view of the panel or question appears. Navigation links at the top of the table allow you to navigate back to the parent question or panel.

12. To view all the questions in a panel, click the appropriate panel’s navigation tree.

Additional rows appear, one for each question in the panel. Each row contains its own expandable navigation tree to view any answer choices or lookup values included in the question.

13. To view the answer choices available and see which choice the respondent made, click the appropriate question’s navigation tree.

The answer choice selected by this respondent has an entry in the Answer column of the table.

Additional rows appear, one for each question in the panel. For each answer choice or lookup value provided in this question, another row appears. For questions with only one possible answer choice, only one row appears.

---

**Sending Reminders Manually to List Members**

Use this procedure to manually send a reminder message to a specified list member as part of a survey campaign deployment. This procedure results in initiating a fulfillment request to send out the reminder, just as if the reminder were scheduled. This will not interfere with the schedule for any currently scheduled reminders.
**Prerequisites**

- A survey campaign, cycle, and deployment must already exist.
- At least one deployment must be active.
- The active deployment must be targeted (include valid list criteria).
- The active deployment must include reminder information in the deployment definition.
- You must know, or be able to determine, the list member for whom you want to send reminders.

**Login**

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Survey Administrator

**Guidelines**

- A confirmation message when manually sending a reminder does not indicate that the reminder was successfully sent to the list member. Instead, this indicates that the fulfillment request is successfully sent to the fulfillment server.
- To confirm delivery, sign into Oracle One-to-One Fulfillment as a fulfillment administrator.

**Steps:**

1. Click the Survey Campaigns tab.

2. Search for and retrieve the survey campaigns that you want to modify. For details, see Performing Survey Campaign and Survey Resource Searches, page 8-9.

3. In the search results list, click Update for the appropriate survey campaign.

4. In the Cycles and Deployments area, if the cycle containing the desired deployment is not displayed, then from the Cycle Name list, select the appropriate cycle.

5. In the View By area, select either Deployment View or Response View.
You can view responses for a specific deployment from either the deployment view or the response view:

- From the deployment view, start by clicking the Update icon for the deployment.
- From the response view, start by clicking the Deployment Name link.

6. In the Update Deployment page, select Response View.
   Individual responses received for this deployment (if any) are listed in the Responses table.

7. From the Send Reminder column, click the Send Reminder icon for the appropriate list member.
   If successful, a confirmation message appears.

   **Note:** Reminders can only be sent manually for active targeted deployments for which reminder details are established.

---

### Setting Up Invitations and Reminders

**Overview of Invitations and Reminders**

When an enterprise conducts an Oracle Scripting survey campaign using one or more targeted deployments, members of an Oracle Marketing list are sent an invitation to participate in a survey or Web script. Each invitation is an e-mail message in HTML format, sent from the fulfillment engine (a component of Oracle One-to-One Fulfillment).

If enterprise requirements dictate, and a survey deployment is set up accordingly, subsequent e-mail messages can be sent (either to specific list members, manually, or to all list members, on a scheduled basis), reminding them of their eligibility to participate. These are reminders. Invitations and reminders are fulfillment master documents.

When a list member receives the invitation or reminder e-mail message, and enters the URL into an Oracle Applications-compatible Web browser (or clicks the link from an appropriately configured e-mail client), the designated survey questionnaire script executes in the client's Web browser. List members who respond to the request and execute an Oracle Scripting transaction are known as respondents.

Script execution in this manner comprises use of the Scripting Engine Web interface. Based on the intended purpose of the script and the details of the survey deployment, this is referred to either as executing a Web script or taking a survey.

**Administration for Targeted Deployments**

From an administration perspective, Oracle One-to-One Fulfillment master document,
query, and template administration are required for targeted (list-based) survey campaign deployments. When setting these up, each required HTML master document is created, and then associated with a survey list query. The query contains specific structured query language (SQL) statements which obtain from the Oracle Marketing list, at minimum, the party ID and e-mail address of the list member, and generates a functional, unique survey URL. Each master document is then associated with an Oracle One-to-One Fulfillment template.

When a survey administrator designates that the deployment type is targeted, additional deployment parameters can be defined. Among the required deployment details for a targeted deployment, the administrator specifies the Oracle Marketing list, identifies the template for the invitation, and specifies the e-mail subject line for the invitation. Optionally, if reminders are required, then the reminder template, reminder e-mail subject heading, number of reminders, and reminder interval information is specified.

Administration of master documents, queries, and templates is typically a function of a fulfillment administrator. This section includes a discussion of the theory and suggested Oracle One-to-One Fulfillment administration steps required for executing targeted survey deployments.

The Survey Administration console includes an Invitations tab. This tab hosts some functionality from Oracle One-to-One Fulfillment, including the ability to administer master documents, templates, and queries, and to view status and request history.

**Note:** You must have the fulfillment administrator role to access this tab; for more information, see Granting JTF Roles, page 5-14.

The full functionality of Oracle One-to-One Fulfillment can be accessed using the Fulfillment Administration console.

For more information on the fulfillment topics in this section, refer to Oracle One-to-One Fulfillment Implementation Guide.

**Running Targeted Deployments**

When a targeted deployment is activated, a SUBMIT GROUP FM REQUEST FROM IES concurrent request is generated which is scheduled to run at the deployment start date and time. When the start date and time are equal to or past SYSDATE, the Oracle One-to-One Fulfillment Mass Request API is invoked. This API causes information to be sent to the fulfillment server, resulting in the execution of the survey list query. The records returned from the Oracle Marketing list are parsed, and for each list record, the merge data is inserted into an HTML e-mail message which is sent to the appropriate mail server and e-mailed to the list member. As a result, each list member is sent an invitation or a reminder to participate in the survey, including the appropriate survey URL.

This section includes the following topics:

• Oracle One-to-One Fulfillment Terminology, page 8-38
• Fulfillment Activities for Targeted Survey Deployments, page 8-41
• Recommended Order of Steps, page 8-42
• Invitations, page 8-44
• Reminders, page 8-45
• Sample Invitation Master Document, page 8-45
• Sample Reminder Master Document, page 8-46
• Seeded Survey List Query, page 8-47

See Also
• Using the Master Document Editor, page 8-49
• Verifying Status of a Fulfillment Request, page 8-52

Oracle One-to-One Fulfillment Terminology

A Template is a high-level definition of one or more Oracle One-to-One Fulfillment master documents, associated queries, and any related collateral. Templates may also include campaign specifications. From an Oracle Scripting perspective, targeted survey deployments call upon a template that identifies an invitation master document (and its associated query). If reminders are also required for the survey deployment, and the text of the reminder document differs from the invitation, a second template defining the reminder master document and its associated query is required. No collateral is typically associated with a survey campaign.

A Master document is a message sent from Oracle One-to-One Fulfillment. These typically include merge fields populated by an associated SQL query. From a survey perspective, master documents are invitation or reminder messages in HTML format that are sent by e-mail from the fulfillment engine to members of a defined Oracle Marketing list.

Merge fields are data elements in an Oracle One-to-One Fulfillment master document surrounded by merge field delimiters. When a fulfillment request is executed, a query is performed to retrieve the merge data from the table columns or views specified in the query. For each record in the list, these merge fields are replaced with the appropriate data obtained by the query, as a separate HTML document sent to the e-mail server for appropriate routing. For each merge field used in a master document, there must be one corresponding request in the query to retrieve the appropriate data. (The converse is not true; in other words, the query can request information that is not used as a merge field.)

Merge fields in any survey list query must include, at minimum, the survey URL.
Providing that the data is returned by the associated query, other merge fields can be included in the relevant master document if desired. For example, master documents using the seeded survey list query may also include as merge fields the first and last name, e-mail address, and customer ID (referred to in TCA as the party ID) of the list member.

**Queries** are database requests for information constructed in structured query language (SQL). Each Oracle One-to-One Fulfillment master document must have an associated query which obtains information populated into the resulting merged document in placeholders called merge fields.

A query must contain a request for each data element included as a merge field in the master document. The query may contain requests for additional data elements as well (providing the requests are valid), regardless of whether the data elements requested in the query are used. For example, you can construct a single query that requests all information used to populate an invitation master document and a reminder master document, even if they include different merge fields.

A single query can be associated with any number of master documents. Return data from a successfully executed query is merged with the master document. In this process, the master document is replicated once for each row returned. For every replicated copy, each merge field placeholder is replaced with its corresponding data element from the query. The amount of merged master documents will match the number of list records in the Oracle Marketing list, one per list member. Each merged document is then sent using e-mail to the e-mail address of each list member by the fulfillment server.

The **Seeded Survey List Query** is a SQL query entitled *IES Template Query for Targeted Survey Deployments*. This query is seeded with an appropriate installation of Oracle Interaction Center Family Pack R or later release, or Oracle Scripting release 11.5.10 or later. This query will return, for each list member, the following data elements, all of which may be used as a merge field in an appropriate master document:

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Source Table or View</th>
<th>Source Column</th>
<th>Merge Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey URL</td>
<td>IES_SVY_HOSTING_PROF_V</td>
<td>SURVEY_URL</td>
<td>SURVEY_URL</td>
<td>This provides the JSP template used. Data from this column is concatenated with text strings and values from other columns to construct a valid Survey URL.</td>
</tr>
<tr>
<td>Data Element</td>
<td>Source Table or View</td>
<td>Source Column</td>
<td>Merge Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------</td>
<td>------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Survey URL</td>
<td>IES_SVY_DEPLEMENTS_V</td>
<td>SURVEY_DEPLOYMENT_ID</td>
<td>SURVEY_URL</td>
<td>This provides the deployment ID of the active deployment. Data from this column is concatenated with text strings and values from other columns to construct a valid Survey URL.</td>
</tr>
<tr>
<td>Survey URL</td>
<td>IES_SVY_LIST_ENTRIES_V</td>
<td>RESPONDENT_ID</td>
<td>SURVEY_URL</td>
<td>This provides the respondent ID of the list member, which tracks to a party ID. Data from this column is concatenated with text strings and values from other columns to construct a valid Survey URL.</td>
</tr>
<tr>
<td>Email address</td>
<td>AMS_LIST_ENTRIES</td>
<td>EMAIL_ADDRESS</td>
<td>EMAILADDRESSES</td>
<td>Email address of list member. Usually not included in the master document, but passed to the fulfillment server for appropriate routing.</td>
</tr>
</tbody>
</table>
### Survey Campaign Administration Tasks

#### Data Element Source Table or View

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Source Table or View</th>
<th>Source Column Name</th>
<th>Merge Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Party ID</td>
<td>AMS_LIST_ENTRIES</td>
<td>PARTY_ID</td>
<td>CUSTOMER_ID</td>
<td>The party_id of the list member, often referred to as a customer ID.</td>
</tr>
<tr>
<td>First name</td>
<td>AMS_LIST_ENTRIES</td>
<td>FIRST_NAME</td>
<td>FIRST_NAME</td>
<td>Not a required field. The list member's first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>AMS_LIST_ENTRIES</td>
<td>LAST_NAME</td>
<td>LAST_NAME</td>
<td>Not a required field. The list member's last name.</td>
</tr>
</tbody>
</table>

#### Fulfillment Activities for Targeted Survey Deployments

For ease of administration, survey administrators have access to an Invitations tab in the Survey Administration console. This tab gives access to the Oracle One-to-One Fulfillment functions required for performing survey administration for targeted deployments.

From the Invitations tab, survey administrators can administer fulfillment master documents, templates and queries, and verify fulfillment request status and history.

#### Some Functions Not Available to Survey Administrators

Administration of fulfillment servers or fulfillment groups is intended to be performed by a knowledgeable fulfillment administrator. As such, these functions (available in the Fulfillment Administration console using the Server and Group tabs) are excluded from the user interface in the Survey Administration console. Additionally, if fulfillment requests have successfully been sent to the fulfillment server but have failed to execute, a fulfillment administrator is required to determine the cause and to correct the error. A targeted deployment with a status of Active indicates only that the fulfillment request was successfully submitted to the server, and does not indicate successful transmission of the invitation or master document e-mail messages.

Since Oracle One-to-One Fulfillment implementation and functionality is a prerequisite of survey operations, a fulfillment administrator should already exist in the enterprise who has access to the Fulfillment Administration console to perform these administration steps.
Required Tasks

From an Oracle One-to-One Fulfillment perspective, you need to accomplish the following tasks to create and administer invitations and reminders:

- Create and format a master document in HTML
- Insert merge field references into the master document
- Upload the master document to MES
- Create a SQL query to populate merge fields into master document
- Associate the query to a specific master document
- Create a fulfillment template that identifies a master document and its associated query

Recommended Order of Steps

Three Approaches

If you have already created an HTML document to serve as your invitation or reminder master document, you can upload this to MES from the Survey Administration console (Invitations tab > Master Document subtab > Upload). Then you can associate the master document with a query you have created or identified, and then create a template that includes that master document (the query is associated at the master document level).

Alternatively, Oracle One-to-One Fulfillment includes a master document editor. Using this feature from the Survey Administration console (Invitations tab > Master Document subtab > Create and Upload), you can quickly and easily perform most tasks associated with the creation of invitation or reminder master documents and their requisite queries. In sequence, you can create a SQL query, validate the query, create and format a customized master document, insert merge fields identified by the query, and automatically associate the query with the master document. Following this, you simply create a template, associating it with your master document.

The third approach is to combine the strengths of the previous two approaches described above by creating a master document using the master document editor (Invitations tab > Master Document subtab > Create and Upload), but associating it with an existing query (instead of creating a new SQL query as part of the master document creation process). For this approach, you must insert custom merge fields into your master document. Each corresponds to the alias or merge field data returned by the associated SQL query. If you want to take advantage of the seeded survey list query, but do not yet have a master document, this approach is appropriate.
Order of Steps

The recommended order of steps for administering invitations, page 8-44 and reminders, page 8-45 using Oracle One-to-One Fulfillment functionality is as follows:

1. Identify merge fields to be populated in the master document, and identify locations of tables or views in the Oracle Applications database schema from which the merge fields will be populated. At minimum, you must include the survey URL as a merge field.

2. Identify an existing SQL query, or create a SQL query, including a request for any data corresponding to a merge field in the master document. At minimum, the query must include the party ID and e-mail address of the list member, as well as SQL to obtain the appropriate survey URL.
   - If desired, you can use the seeded IES Template Query for Targeted Survey Deployments query, which also includes the first and last names of the list member.
   - Oracle strongly recommends following a defined format for the column aliases and content used for a survey list query. At minimum, syntax from the seeded query indicating column names and aliases for the three required columns (party_id, email_address and the survey URL) must be included in your query to ensure the appropriate data is returned and processed correctly.
   - An example of a query using this format is the seeded IES Template Query for Targeted Survey Deployments. This query includes the three required data elements (party ID, email address, and survey URL), plus the list member's first and last name.
     To create a custom query, Oracle recommends that you copy all of the content of the SELECT clause of the seeded survey list query, and add additional columns to the SELECT clause if required. (If not included in your master document, you can remove the SQL to obtain the list member's first and last names.) Then, add additional constraints to the WHERE clause as needed.
   - A single query can be used for any number of master documents, providing that the query retrieves the data for each required merge field in each master document associated with the query.

3. Create invitation and reminder master documents in HTML using a text editor or HTML tool of your choice, or the Oracle One-to-One Fulfillment master document editor.
   - If using the master document editor with an existing query, specify each merge field as a custom merge field by entering the column or alias name in the Custom Merge field and clicking Insert.
4. Upload master documents to MES.
   • If you have a custom HTML master document, upload it from the Survey Administration console (Invitations tab > Master Document subtab > Upload) or from the Fulfillment Administration console (Template tab > Master Document subtab > Upload).
   • If you created your master document using the master document editor feature of Oracle One-to-One Fulfillment, this step is performed automatically.

5. Associate each required master document with its query.
   • On the Master Document page, locate the appropriate master document, select the existing query from the Query list, and click Update.
   • If defining the query using the master document editor feature of Oracle One-to-One Fulfillment, the association between master document and query is performed automatically.

6. Define templates.
   • One template is required for each master document. If a survey campaign includes invitation and reminder documents with the same text, only one template need be created. If a survey campaign includes invitation and reminder documents with different content, create one template for each master document.
   • To define a template, from the Invitations > Template subtab, click Create, enter a name and optional information, and click Continue.

7. Associate template with the required master document.
   From the View Template page, in the Master Documents area, search for and select the invitation or reminder master documents you want to associate with this template (as requirements dictate). When satisfied, click Update.

References
For more information, refer to Oracle One-to-One Fulfillment Implementation Guide.

Invitations
Typically, an invitation is an HTML message inviting list members to take a survey. The invitation is referred to in Oracle One-to-One Fulfillment as a master document. Using Oracle One-to-One Fulfillment APIs, invitations can be customized by populating data from RDBMS tables or views.

The HTML invitation contains placeholders called merge fields, in which information
from a query is placed by the fulfillment server upon execution. Each invitation must include, at minimum, a unique survey URL. Based on the deployment ID (dID) and respondent ID (rID) numbers, a unique URL is generated for each list member. In this way, if a survey campaign has a business rule to allow list members to only take a survey one time, this rule can be enforced. Other merge fields often used include the list member’s first and last name and identifying information such as customer ID number.

Reminders

If required by a survey campaign, reminders can also be sent to list members. Like the invitation, a reminder is an e-mail message identified in Oracle One-to-One Fulfillment as a master document. It can be the same e-mail message initially sent to list members (in which case, only a single template is required), or it can be a different message (requiring a second template to identify the master document and its associated query).

Reminders typically emphasize the response end date of the specific deployment for that survey campaign. Like invitations, each reminder must include the survey URL as a merge field, and must have a corresponding request for that data field in its associated query.

Unlike invitations, reminders are an optional feature. In addition to being sent automatically (based on reminder requirements defined at the deployment level), reminders can be sent by a survey administrator manually upon request.

If using the same template and master document, you have the option of using a different e-mail message subject. If using a separate e-mail master document as the reminder, you may choose to word it differently to emphasize the deadline.

Since queries can be defined once and used many times, you can use for the reminder master document the same query used by the invitation. This is true even if the reminder requires merge fields not used in the invitation master document. For example, in a reminder you may want to emphasize the deadline by which list members must participate in the survey (this equates to the deployment end date). Even if this information was not included in the original invitation, a single query can be shared among the two HTML documents; the only information returned by the query that is required to be included in the invitation is the survey URL.

Sample Invitation Master Document

The following is a sample invitation master document. Master documents for your enterprise may appear substantially different. For example, this sample includes four merge fields (signified below by open and close guillemet characters, otherwise known as angle brackets).

Upon delivery, for each list member, one e-mail message is generated, containing the first and last name of the list member, their customer number, and the unique survey URL for this deployment. All of these merge fields are included in the seeded query IES Template Query for Targeted Survey Deployments (described in the Seeded Survey List Query section). The only merge field required in the master document is the survey URL.
Sample Invitation Text

Following is the sample text of the e-mail message:

- Dear <<FIRST_NAME>> <<LAST_NAME>>:

  Thank you for your recent order on account <<CUSTOMER_ID>>. We appreciate your business, and hope you enjoyed a positive customer experience.

  To help us evaluate our product offerings and ensure the highest levels of customer service, please take a moment to participate in this survey regarding your recent purchase. Click <<SURVEY_URL>> to begin (or type this URL into your Web browser).

  Sincerely,

  Vision Customer Service

Sample Invitation Code

Following is the HTML code of the above e-mail message master document. Note that the open and close guillemet characters which surround merge fields are designated in the HTML sample using ASCII references.

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 TRANSITIONAL//EN">
<HTML> <HEAD> <META HTTP-EQUIV="Content-Type" CONTENT="TEXT/HTML"> <META NAME="Author" CONTENT="Vision Customer Service"> <TITLE>Customer Service Survey Invitation</TITLE> </HEAD>
<BODY BGCOLOR="WHITE">
  <P>Dear &laquo;FIRST_NAME&raquo; &laquo;LAST_NAME&raquo;:
  
  Thank you for your recent order on account «CUSTOMER_ID». We appreciate your business, and hope you enjoyed a positive customer experience.
  
  To help us evaluate our product offerings and ensure the highest levels of customer service, please take a moment to participate in this survey regarding your recent purchase. Click «SURVEY_URL» to begin (or type this URL into your Web browser).
  
  Sincerely,
  
  Vision Customer Service
</BODY> </HTML>
```

Sample Reminder Master Document

The following is a sample reminder master document. Master documents for your enterprise may appear substantially different. In this sample, the reminder uses three of the four merge fields used in the original invitation, and is associated with the same query. Note, however, that a reminder can include different merge fields, as long as the associated query provides that information.
Sample Reminder Text

Following is the sample text of the e-mail message:

Dear <<FIRST_NAME>> <<LAST_NAME>>,

Several weeks ago, you were sent an invitation to participate in our customer satisfaction survey. At the end of this month, we will complete the survey process, and collate the results to see how to best improve customer satisfaction.

If you would like your opinions to be considered, please click <<SURVEY_URL>> to participate in this online survey using your Web browser.

As always, we appreciate your business and look forward to your opinions to enable us to improve our responsiveness.

Sincerely,

Vision Customer Service

Seeded Survey List Query

As of Oracle Scripting release 11.5.10 or later, or Interaction Center Family Pack R or later, Oracle Scripting provides a new seeded query (IES Template Query for Targeted Survey Deployments) that is included in the list of Oracle One-to-One Fulfillment queries.

Upon processing, this query provides data for the <<FIRST_NAME>>, <<LAST_NAME>>, <<CUSTOMER_ID>> and <<SURVEY_URL>> merge fields, as used in the above master document samples.

Each master document may have its own query. Conversely, the same query can be used any number of times for various master documents. To be successful, the query must contain a structured query language (SQL) request for each merge field in each associated master document. A single query may contain multiple SQL requests, including requests for data that are not used in your master document. The SQL in the query must be properly constructed to return the requested data from tables or views, regardless of whether the data is required for your master document.

Following is the content of the seeded query:

```sql
select
ale.first_name  FIRST_NAME,
ale.last_name  LAST_NAME,
'<a href='||ihp.SURVEY_URL||' dID='||asda.survey_deployment_id
||'rID='||isle.respondent_id'||'> here </a>' SURVEY_URL,
ale.party_id CUSTOMER_ID,
ale.email_address EMAILADDRESS
from
IES_SVY_LIST_ENTRIES_V isle,
```
Oracle strongly recommends following the format used above for the column aliases and content in any survey list query.

To customize your own survey query, Oracle recommends the following:

1. Copy all of the content of the SELECT clause of the seeded survey query.

2. Optionally, if list member names are not required, remove the appropriate SQL code requesting this information.

3. Following the format above, in the SELECT clause, add relevant SQL code to return additional merge field data.

4. Following the format above, in the WHERE clause, add relevant SQL code to impose additional constraints on the return data, if required.

**New Requirements for Enterprises Upgrading to Release 11.5.10 or Later**

Existing Oracle Scripting implementations using targeted survey deployments must modify the query or queries in use when upgrading to this release or later. From release 11.5.10 onward, each survey list query must contain, at minimum, the select clause in the query below. Other fields must be added as necessary.

1. Master documents must be associated with an updated query to ensure continuous, uninterrupted function. If merge fields are restricted to the SURVEY_URL and any or all of the following merge fields (FIRST_NAME, LAST_NAME, and CUSTOMER_ID), you can associate the invitation or reminder master document with the seeded IES Template Query for Targeted Survey Deployments query. No other changes are needed.

2. When creating custom queries, Oracle strongly recommends that you preserve the exact syntax from IES Template Query for Targeted Survey Deployments to ensure that the survey URL will be inserted into the invitation or reminder e-mail message.

3. Master documents that contain merge fields in addition to the three mentioned above will require changes as appropriate. Oracle recommends replacing your current query SELECT statement with the updated language in the seeded query,
and then customizing it to select data for the other merge fields or to add new constraints, as required. Then associate this revised query to each master document as appropriate.

**Using the Master Document Editor**

You can use the Master Document Editor feature of Oracle One-to-One Fulfillment to create a SQL query, create a master document (automatically stored in the MES knowledge repository) to use as an invitation or reminder, associate the query automatically with the master document, and add merge fields enabled by the query to the master document.

Alternatively, if you want to create a new master document but associate it with an existing query, you can create the master document, insert custom merge fields, and then (from the Master Document page) associate the appropriate existing query to a listed master document.

Use the following procedure to create a new master document and associate an existing query with it, or to create a SQL query, create and format a new master document, and include in the master document merge fields from the query.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Survey Administrator or One-to-One Fulfillment Administrator

**Prerequisites**

- A fulfillment server must already exist.
- User must have the JTF_FM_ADMIN role to perform this function.

**Steps:**

1. If using the Fulfillment Administration console, click the Template tab.
2. If using the Survey Administration console, click the Invitations tab.
4. From the Master Document page, click Create and Upload.
The Master Document Editor page appears.

5. In the Master Document Name field, type a unique name for the master document.

6. If you want to define a new master document but associate it to an existing SQL query, continue at step 8.

7. If you want to define a new SQL query, associate the query to this master document, and use merge fields identified in the query in your master document, do the following:
   
   1. In the SQL Merge Field field, click Create Query.
      
      The SQL Editor page appears.

   2. In the Query Name field, type a unique name for this query.

   3. Optionally, in the Query Description field, type a description for this query.

   4. In the SQL Query field, using well-formed structured query language, type or paste the contents for your query. It must include, at minimum, SQL code to obtain a valid survey URL.

      For example, to create a query to obtain a list member's first name, last name, e-mail address, party ID, and valid survey URL, copy the contents of the sample query from Seeded Survey List Query, and paste into this field.

   5. Click Validate SQL and Save.

      The SQL Editor page refreshes. For any merge field that requires a constraint to be defined, you will be directed to enter the constraint value or range.

   6. If prompted, enter constraints for each merge field as appropriate. When finished, click Validate SQL and Save.

      • The Master Document Editor page refreshes.

      • The query criteria you entered is visible in the SQL Query area.

      • All merge fields available based on the query you entered are now accessible in the SQL Merge Field list.

8. If you want the master document to appear in plain text, click Change to Plain text mode.

   For example, if your master document contains no images or character-level formatting, or if the recipients of your master document will not be receiving the merged document in e-mail capable of interpreting HTML format, select plain text mode.
9. If you want the master document to contain formatting you can apply using the master document editor’s rich text format (RTF) formatting tools, keep the default option. To switch modes from plain text mode, select Change to Rich text mode.

10. In the Master Document Body field, type the text for your master document.

11. At each appropriate location in the body of your master document, add merge fields to your master document as appropriate.

   **Note:** At minimum, your invitation or reminder master document must contain at least one merge field to generate a survey URL.

12. If entering merge fields based on a SQL query you created on this page, then do the following:
   1. From the SQL Merge Field list, select the appropriate merge field.
   2. Click Insert.
   3. Fix any spacing errors in the master document resulting from the inclusion of this merge field.

13. If entering custom merge fields, then do the following:
   1. In the Custom Merge Field field, type the precise merge field name for a value returned from a query.
      
      For example, type SURVEY_URL.
   2. Click Insert.
   3. Fix any spacing errors in the master document resulting from the inclusion of this merge field.

   Each merge field appears in the master document body. Merge fields are the fields available from a SQL query.

14. Verify the content and accuracy of your master document.

15. Optionally, if using rich text mode, apply formatting to your master document by selecting text and clicking the appropriate formatting tools.

16. When you have finished, click Save.

   The Master Document Editor page closes. The Master Document page appears. The master document you have just created and uploaded to MES is included in the list.

   If you defined a SQL query for this master document, you have successfully
completed this task.

If you simply defined a master document, you must now associate an existing SQL query with the new master document by completing the steps below.

17. For the appropriate master document, from the Query column, select the query you want to associate to this master document

For example, to associate the seeded query, select IES Template Query for Targeted Survey Deployments.

18. Click Update.

Verifying Status of a Fulfillment Request

The Oracle One-to-One Fulfillment Request Status page (accessed from the Survey Administration console by clicking Invitations tab > Status subtab) indicates the status of fulfillment requests. A request status of Submitted indicates the fulfillment request has been successfully submitted to the fulfillment engine.

**Note:** A successfully submitted request does not necessarily signify that the engine succeeded in delivering the master document in question. This status only indicates that the request was sent to the fulfillment engine as appropriate.

When checking the status of requests in the Request Status page, valid states include Submitted and In Process. If the request remains in process for an undue length of time, or if the status displayed is Stalled, consult with a fulfillment administrator.

To verify that the fulfillment engine successfully completed distribution of a fulfillment request, check for an outcome code of Successful in the Request Summary page. Ascertain the status in the Outcome column from the Survey Administration console by clicking Invitations tab > History subtab.

If any status other than Successful displays in the Request History page, consult with a fulfillment administrator.

References

For specific information on implementing, using, or administering Oracle One-to-One Fulfillment, refer to *Oracle One-to-One Fulfillment Implementation Guide.*

Administering Concurrent Programs for Survey Execution

Concurrent programs are executed using Oracle Concurrent Manager, a Forms-based application built on Oracle Application Object Library (AOL) classes. Concurrent Manager is included in Oracle Applications with an appropriate Rapid Install. Seeded
concurrent programs can be scheduled to execute at certain times, or can be administered to execute in near-real time. To schedule or execute concurrent programs supporting Oracle Scripting’s survey component, you must access Oracle Forms-based applications with a user assigned the iSurvey User responsibility.

Seeded Concurrent Programs for Survey Execution

Oracle Scripting uses three seeded concurrent programs to support survey component operations. The table below briefly describes these programs:

<table>
<thead>
<tr>
<th>Concurrent Program</th>
<th>Survey function supported</th>
<th>Recommended Execution Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUBMIT GROUP FM REQUEST FROM IES</td>
<td>Targeted survey deployments</td>
<td>• Automatically (typical)</td>
</tr>
<tr>
<td>Concurrent Program</td>
<td></td>
<td>• Manually (when Fulfillment Request ID fails to generate)</td>
</tr>
<tr>
<td>Summarize Survey Data</td>
<td>Web interface reports</td>
<td>• Scheduled (typical - set up to execute on a periodic basis or on specific days)</td>
</tr>
<tr>
<td>Concurrent Program</td>
<td></td>
<td>• Manually (on demand when fresh reporting tabulation is desired)</td>
</tr>
<tr>
<td>Update Deployment Status</td>
<td>Survey Administration console table updates</td>
<td>Scheduled (set up to execute on a periodic basis or on specific days, generally once daily)</td>
</tr>
</tbody>
</table>

Tasks

• Scheduling or Executing Concurrent Programs, page 8-54

• Checking Concurrent Program Logs, page 8-59

Concepts

For more information, see the Concurrent Programs Supporting Survey Operations topics in the Oracle Scripting User Guide.
Scheduling or Executing Concurrent Programs

Use the following procedure to schedule or execute concurrent programs supporting survey operations for Oracle Scripting implementations.

Prerequisites

None

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

iSurvey User

References

- For specific details on executing or scheduling concurrent programs, please refer to Chapter 5 of Oracle System Administrator’s Guide.

- For more information, see Seeded Concurrent Programs for Survey Execution, page 8-53.

Steps:

1. From the Navigator, select Survey Administration > Requests > Run and click Open. The Submit a New Request window appears.

2. From the Submit a New Request window, select Single Request and click OK. The Submit a New Request window closes, and the Submit Request window appears.

3. In the Run this Request... area, in the Name field, click the ellipsis points. The Reports window appears, listing the concurrent programs accessible to this responsibility.

4. To execute the Fulfillment concurrent program, from the Reports window, select SUBMIT GROUP FM REQUEST FROM IES and click OK.

   To execute the Summarize Survey Data concurrent program, from the Reports window, select Summarize Survey Data and click OK.
To execute the Update Deployment Status concurrent program, from the Reports window, select Update Deployment Status and click OK.

- The Reports window closes.
- The Name field is populated with the selected report type in the Submit Request window.
- The Parameters window appears and has focus.

5. If scheduling or executing the Update Deployment Status concurrent program, no parameters are required. Proceed to step 7.

6. For other concurrent programs, enter the required parameters as prompted.

   **Note:** You must enter parameter information using the appropriate data type. You cannot use the % wildcard character in this field.


   Optionally, to complete this field, you can search existing information in the database for each parameter. To do this:

   1. Click the ellipsis points next to the parameter field.
      The Longlist window appears, indicating that the displayed list is lengthy.

   2. In the Longlist window, in the Partial Value field, enter search criteria.
      
      **Note:** You can use the % wildcard character in this field.

   3. If you entered valid criteria, the Longlist window closes and the parameter field in the Parameters window is populated with your selection. The corresponding description field of your selection appears next to the field. To re-query, return to step 6.1.

   4. If you entered partial search criteria, refine your search in the resulting window and click OK.
      The Parameters window refreshes, populated with your selection.

   5. After entering all required parameters, click OK.
      The Parameters window closes. The Submit Request window refreshes, populated with your parameter selections.

7. If a default choice to execute the concurrent program is selected in the At these
8. If you want to schedule the concurrent program to execute, in the At these Times... area, click Schedule.
   The Schedule window appears.

9. If there is a saved schedule you want to use:
   1. Click Apply a Saved Schedule.
      The Pre-defined Schedules window appears.
   2. From the Pre-defined Schedules window, select the appropriate schedule.
   3. Click OK.
      The Schedule window refreshes, with the Advanced option selected in the Run the Job... area.
   4. Optionally, to increment date parameters for each execution of the concurrent program, from the Schedule window, select Increment date parameters each run.
   5. Optionally, to save the schedule, from the Schedule window, select Save this schedule.
   6. To save and apply schedule details, from the Schedule window, click OK.

10. If you want to execute the concurrent program as soon as possible, from the Run the Job... area, select As Soon as Possible and click OK.

11. If you want to execute the concurrent program one time at a specified date:
   1. In the Run the Job... area, select Once.
      The Schedule window refreshes, displaying a Run At field.
   2. Click the ellipsis points in the Run At field.
      The calendar window appears.
   3. From the calendar window, specify the date and time to execute the concurrent program, and click OK.
   4. Optionally, to increment date parameters for each execution of the concurrent program, from the Schedule window, select Increment date parameters each run.
5. Optionally, to save the schedule, from the Schedule window, select Save this schedule.

6. To save and apply schedule details, from the Schedule window, click OK.

12. If you want to execute the concurrent program several times periodically:

   1. In the Run the Job... area, select Periodically.
     The Schedule window refreshes, displaying new fields.

   2. In the Start At field, click the ellipsis points.
     The calendar window appears.

   3. From the calendar window, specify the date and time to start executing the concurrent program, and click OK.

   4. If you want the concurrent process to execute periodically for an indefinite period, do not enter a value in the End At field.

   5. To specify an end date, in the End At field, click the ellipsis points.
     The calendar window appears.

   6. From the calendar window, specify the date and time to stop executing the concurrent program, and click OK.

   7. In the Re-run fields, specify the value and interval for the period of time between executions.

   8. In the Apply the Interval... area, determine the criteria for applying the interval.

   9. Optionally, to increment date parameters for each execution of the concurrent program, from the Schedule window, select Increment date parameters each run.

  10. Optionally, to save the schedule, from the Schedule window, select Save this schedule.

  11. To save and apply schedule details, from the Schedule window, click OK.

13. If you want to execute the concurrent program on specific days:

   1. In the Run the Job... area, select On Specific Days.
     The Schedule window refreshes, displaying new fields.

   2. In the Start At field, click the ellipsis points.
The calendar window appears.

3. From the calendar window, specify the date and time to start executing the concurrent program, and click OK.

4. To specify an end date, in the End At field, click the ellipsis points. The calendar window appears.

5. From the calendar window, specify the date and time to stop executing the concurrent program, and click OK.

6. In the Dates of Every Month area, click once on each day of the month in the calendar on which you want to execute the program. To deselect a calendar date, click it again.

7. In the Days of Every Week area, click once on each day of the week on which you want to execute the program. To deselect a week day, click it again.

8. Optionally, to increment date parameters for each execution of the concurrent program, from the Schedule window, select Increment date parameters each run.

9. Optionally, to save the schedule, from the Schedule window, select Save this schedule.

10. To save and apply schedule details, from the Schedule window, click OK.

14. In the Submit Request window, in the Upon Completion... area, check the Save all Output Files box.

15. Optionally, if you want a party to be notified each time the concurrent program is executed, then do the following:

   1. In the Upon Completion... area, click Options. The Upon Completion window appears.

   2. Verify that the Save all Output Files box is checked.

   3. In the Name column, for each party whom you want to notify upon completion, click the ellipsis points and select the individual from the database.

   4. Optionally, to print output files, select a networked printer from the Printer field, and specify the number of copies and default language.

   5. To save Upon Completion information, click OK. The Upon Completion window closes. The Submit Request window refreshes,
displaying the selections you made.

16. To save and submit the concurrent request, in the Submit Request window, click Submit.

   The Decision window appears, providing the request ID of the concurrent request. Note this request number for subsequent tracking.

17. To submit another request, in the Decision window, click Yes, and then enter criteria for the next request in the Submit Request window.

   Otherwise, click No. The Decision window and the Submit Request window close. The Navigator appears.

18. Submit another request for concurrent processing by repeating this procedure, or log out of Oracle Applications by selecting File > Exit Oracle Applications.

### Checking Concurrent Program Logs

Concurrent program logs can provide clues for the failure of the concurrent program. For example, when you activate a survey deployment, the SUBMIT GROUP FM REQUEST FROM IES concurrent request is generated (scheduled to run at the deployment start date and time). If the deploy start date and time are in the past, the concurrent program executes immediately. If this concurrent program fails, the concurrent request ID appears on the Update Deployment page, but no fulfillment request ID appears, and the Activate button reappears. In such an event, check the concurrent program logs to determine potential contributing factors for the failure of this request to execute.

Use this procedure to check concurrent program logs.

**Prerequisites**

None

**Login**

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

iSurvey User
Steps:
1. From the Navigator, select Survey Administration > Concurrent and click Open. The Find Requests window appears.

2. If you want to find only completed requests, select My Completed Requests.

3. If you want to find requests in process, select My Requests in Process.

4. If you want to find all requests generated using your Oracle applications user account, select All My Requests.

5. If you want to find a specific request, select Specific Requests, and enter additional search criteria to find the appropriate request.
   1. To search a concurrent request by ID, type the concurrent request ID in the Request ID field.
      For example, for a failed SUBMIT GROUP FM REQUEST FROM IES concurrent request, obtain the concurrent request ID from the Update Deployment page and type this value.
   2. To search a concurrent request by name, type the name of the concurrent request in the Name field.
      For example, type SUBMIT GROUP FM REQUEST FROM IES.
   3. To search a concurrent request by date submitted, in the Date Submitted field, click the ellipsis points, and specify the appropriate date using the calendar control.
   4. To search a concurrent request by date the request was completed, in the Date Completed field, click the ellipsis points, and specify the appropriate date using the calendar control.
   5. To search a concurrent request by the request status, from the Status list, select the appropriate status.
      For example, select Suspended.
   6. To search a concurrent request by the request phase, from the Phase list, select the appropriate phase.
      For example, select Inactive.
   7. To search a concurrent request based on the Oracle Applications account of the individual requesting the request, in the Requestor field, click the ellipsis points, and search for and select the appropriate user name.
For example, select Inactive.

6. Select the Include Request Set States in Query option.

7. Optionally, to sort records returned, from the Order By list, select order criteria.
   For example, to sort by concurrent program name, select Name.

8. After entering your search criteria, click Find.
   The Requests window appears, populated with the results of your query.

9. Optionally, to ensure you are accessing the correct record, do the following:
   1. Click on the row of the appropriate record and then click View Details.
      The Request Detail window appears for the selected request.
   2. To close the Request Detail window, click OK.

10. To view the message log, click on the row of the appropriate record and then click View Log...
    A new Web browser window will open, displaying the message log for the selected concurrent program.
This chapter covers the following topics:

- Introduction
- Administering Campaigns in Oracle Marketing
- Creating a Campaign
- Creating a Campaign Schedule
- Associating a Script to a Campaign Schedule
- Associating a Script to a Campaign
- Administering Campaigns in Oracle Sales Online
- Assigning Agents to a Campaign Schedule
- Assigning Campaign Schedules to Agents
- Administering Lists in Oracle Marketing
- List Creation Overview
- Creating a List
- Identifying Record Sources for a List
- Importing Record Sources
- Manually Selecting List Entries as Record Sources
- Using Oracle Discoverer Workbook to Define Record Sources
- Adding Records to a List
- Generating a List
- Marketing Campaigns as an Oracle Applications Dependency
Introduction

Oracle Scripting interacts with various components in Oracle E-Business Suite. Although Scripting can be executed alone, it is typically used in combination with various other applications. For example, Scripting is typically launched from an Oracle business application. If using Oracle Scripting from Oracle TeleSales, you must first administer campaigns in Oracle Marketing and Oracle Sales Online.

Additionally, in order to execute survey campaigns using the survey component of Oracle Scripting, Oracle Marketing lists are required.

The following Oracle Marketing and Oracle Sales Online administration tasks are included in this document to provide a single location for campaign administration and list administration information required for Oracle Scripting.

This section includes the following topics:

• Administering Campaigns in Oracle Marketing, page 9-2

• Administering Campaigns in Oracle Sales Online, page 9-11

• Administering Lists in Oracle Marketing, page 9-15

Administering Campaigns in Oracle Marketing

To launch a specified script from Oracle TeleSales, you must perform campaign administration steps in Oracle Marketing.

Note: The administrative tasks described here for campaign management are performed in previously existing components of the Oracle Marketing user interface, accessible from the Campaign tab.

Campaign schedules can now also be created using the Campaign Workbench tab, a new feature as of Oracle Marketing release 11.5.10 that streamlines some tasks. The Campaign Workbench provides an alternate method to create campaign schedules. From this UI you can also associate scripts with a campaign schedule. You cannot associate scripts to a campaign (this can only be done from the Campaign tab).

For specifics on using the Campaign Workbench, refer to Oracle Marketing User Guide.

Tasks

You can perform the following tasks:

• Creating a Campaign, page 9-3
Creating a Campaign

Use this procedure to create a campaign in Oracle Marketing.

Prerequisites

None

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Oracle Marketing Super User

Steps:
1. From the Oracle Marketing administration console, click the Campaign tab.
   The Campaigns page appears, displaying a summary view table of any existing campaigns.

2. Click Create.
   The Create Campaign page appears.

3. In the Setup Type field, perform the following:
   1. Type your search criteria for a setup type and click the search icon.
      Note: You can use the % wildcard for database searches.

For example, to create a campaign, type Campaigns and click the search icon.
Setup type is determined by the business application with which the campaign is used. Select a setup type of Campaigns if using Oracle TeleSales.
The Campaign Selector page appears, listing results matching your search criteria.
2. Optionally, refine your search. You can use the % wildcard character anywhere on this page.

3. In the Setup Name list, click the appropriate hyperlink.
   - If using Oracle TeleSales as your business application, click Campaigns.

   The Campaign Selector page closes, and the Create Campaign page refreshes, listing the item you selected.

4. In the Name field, type a name for this new campaign.
   For example, type TestCampaign.

5. Optionally, in the Program field, perform the following:
   1. Type your search criteria for a setup type and click the search icon.

      The Program Selector page appears, listing results matching your search criteria.

   2. Optionally, refine your search. You can use the % wildcard character anywhere on this page.

   3. In the table of programs, click the appropriate hyperlink.

      The Program Selector page closes, and the Create Campaign page refreshes, listing the item you selected.

6. If creating a campaign for use with other applications, you can optionally enter the Source Code.

7. Optionally, from the Business Unit list, select a business unit.

8. In the version field, type a version number.

   When creating a campaign with the same name as an existing campaign, only one version is active at a time. This field allows you to designate the new version as active.

9. Optionally, from the Purpose list, select a purpose for the campaign.

10. Optionally, in the Start Period field, perform the following:
    1. Type your search criteria and click the search icon.

        The Period Selector page appears, listing results matching your search criteria.

    2. Optionally, refine your search. You can use the % wildcard character anywhere on this page.
3. In the period list, click the appropriate hyperlink.

   The Period Selector page closes, and the Create Campaign page refreshes, listing the item you selected.

11. Optionally, to enter an end period, in the End Period field, repeat step 10.

12. In the Start Date field, perform the following:

   1. Click the Date Picker widget.

      The Select a Date window appears.

   2. Using the controls, navigate to the appropriate month and year if required. Then, click on the appropriate date.

      The Select a Date window closes, and the Create Campaign page refreshes, listing the item you selected.

13. To enter an end date, in the End Date field, repeat step 12.

14. From the Currency list, ensure the appropriate currency is displayed. If not, select it from the list.

15. Optionally, from the Priority list, select a priority for the campaign.

16. In the Owner field, ensure the appropriate owner name is displayed. If not, type the appropriate search criteria and select the appropriate owner from the list.

   The current username populates this field by default.

17. Optionally, if a global campaign, select Global.

18. In the Country field, ensure the appropriate country is displayed. If not, type the appropriate search criteria and select the appropriate country from the list.

19. Optionally, if a confidential campaign, select Confidential.

   A confidential Campaign cannot be viewed by people outside of the team.

20. From the Language list, ensure the appropriate language is displayed. If not, type the appropriate search criteria and select the appropriate language from the list.

21. Optionally, if you intend to use this campaign as a template on which to build other campaigns, select Template.

22. Optionally, in the description text area, type a description of this campaign.

23. Review your campaign parameters and modify as required. When satisfied, click Create.
The Create Campaign page refreshes, becoming the Campaign Details page. A confirmation that a new item has been created appears on the top of the page.

24. If required, make any changes at this time and click Update to save your work.

Creating a Campaign Schedule

Use this procedure to create a campaign schedule in Oracle Marketing.

Prerequisites

A campaign must already exist to which you want to associate a schedule.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Oracle Marketing Super User

References

- Assigning Agents to a Campaign Schedule, page 9-12
- Assigning Campaign Schedules to Agents, page 9-13

Steps:

1. From the Oracle Marketing administration console, click the Campaign tab.
   The Campaigns page appears, displaying a summary view table of any existing campaigns.

2. Click the campaign for which you want to create a campaign schedule.
   For example, click TestCampaign.
   The Campaign Details page appears.

3. From the side panel, click the Execution hyperlink.
   The Campaign Details - Campaign Schedule page appears.

4. Click Create.
   The Create Campaign Schedule page appears.
5. From the Setup Type field, select the appropriate setup type.
   • For example, for campaign schedules to be used with Oracle Advanced
     Outbound Telephony, select Direct Marketing - Telemarketing.
   • If using a custom setup type to avoid the budget approval step, select the
     custom setup type.
     The Activity Type and Activity fields will auto-populate.

6. In the Name field, type a name for this new campaign schedule.
   For example, type TestCampaignSchedule.

7. From the Language list, ensure the appropriate language is displayed. If not, select
   the appropriate language from the list.

8. In the Coordinator field, ensure the appropriate campaign schedule coordinator
   name is displayed. If not, enter the appropriate search criteria and select the
   appropriate coordinator from the list.
   The current username populates this field by default.

9. Optionally, in the Source Code field, type a unique source code if not already
   populated. To use the source code of the parent campaign, select Use Parent Source
   Code.

10. In the Activity and Activity Type lists, ensure the values specified by the campaign
    schedule setup type are displayed.

11. Optionally, in the Marketing Medium field, enter the appropriate search criteria
    and select the appropriate marketing medium from the list.

12. From the Currency list, ensure the appropriate currency is displayed. If not, select it
    from the list.

13. From the Time Zone list, ensure the appropriate time zone is displayed. If not, select it
    from the list.
    This time zone setting should match the time zone for the geographic location
    where the campaign schedule activity takes place.

14. In the Start Date field, perform the following:
    1. Click the Date Picker widget.
       The Select a Date window appears.
   2. Using the controls, navigate to the appropriate month and year if required.
      Then, click on the appropriate date.
The Select a Date window closes, and the Create Campaign Schedule page refreshes, listing the item you selected.

15. Optionally, to enter an end date, in the End Date field, repeat step 14.

16. Optionally, in the Start Time fields, select the appropriate hour, minute, and AM/PM designation from the list.

17. Optionally, in the End Time fields, select the appropriate hour, minute, and AM/PM designation from the list.

18. Optionally, from the Objective list, select the appropriate objective for this campaign schedule.

Objectives may not appear in the list of values, based on previous selections.

19. Optionally, from the Priority list, select the appropriate priority for this campaign schedule.

20. Optionally, in the description text area, type a description of this campaign schedule.

21. Ensure that the Do Not Use Trigger option is selected. When this option is selected, no values appear in the Trigger Condition list.

22. Optionally, to enter approval conditions, in the Execute After Approval by field, search for and select an appropriate approving authority.

23. Optionally, in the Send Notification to field, search for and select the users whom you want to be notified of the approval.

24. If using notifications, in the Subject field, enter an e-mail message subject for the approval notification.

25. If you want to use an e-mail template for the notification, in Template field, search for and select the appropriate template.

26. Review your campaign schedule parameters and modify as required. When satisfied, click Create.

27. The Create Campaign Schedule page refreshes, becoming the Campaign Schedule Details page.

28. If required, make any changes at this time and click Update to save your work.
Associating a Script to a Campaign Schedule

Use this procedure to associate a particular deployed Script Author script to a campaign schedule for use in a business application. Thereafter, this association is applied to all users of the campaign schedule.

Prerequisites

- A valid campaign and campaign schedule must be defined.
- At least one appropriate script must be deployed from Script Author to the applications database.
- If custom code is referenced in the script, that code must be available to the Scripting Engine at runtime.
- You must know whether the script is an inbound or outbound script.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Oracle Marketing Super User

Steps:

1. From the Oracle Marketing administration console, click the Campaign tab.
   The Campaigns page appears, listing a summary view table containing all existing campaigns created by the current user.

2. From the Name field in the table, select the appropriate campaign.
   Note: This campaign must contain the campaign schedule under which your target group resides.
   The Campaign Details page appears.

3. From the side panel, click Execution.
   The Campaign Details - Campaign Schedule page appears, displaying a summary view table of all campaign schedules associated with the selected campaign.
4. From the Name field in the table, click the campaign schedule to which you want to associate a script.
   The Campaign Schedule Details page appears.

5. From the side panel, click Collaboration.
   The Campaign Schedule Details - Contact Points page appears, displaying the contact points table, which lists any existing Oracle Scripting script associated to the selected campaign schedule.

6. From the Type list, select Inbound Script or Outbound Script, as appropriate.

7. In the Name field, search for and select the name of the specific script you want to associate.
   The Campaign Schedule Details - Contact Point page refreshes, populated with the selected values.
   To save the selected values, click Update.
   The Campaign Schedule Details - Contact Point page refreshes, indicating that the selected script is now associated with the campaign schedule.

8. If you wish to associate any other script with this campaign schedule, repeat steps 6 and 7 above.

**Associating a Script to a Campaign**

Use this procedure to associate a particular deployed Script Author script to a campaign for use in a business application. Thereafter, this association is applied to all users of the campaign.

**Prerequisites**

- A valid campaign must be defined.
- At least one appropriate script must be deployed from Script Author to the applications database.
- If custom code is referenced in the script, that code must be available to the Scripting Engine at runtime.
- You must know whether the script is an inbound or outbound script.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On
Responsibility
Oracle Marketing Super User

Steps:
1. From the Oracle Marketing administration console, click the Campaign tab.
   The Campaigns page appears, listing a summary view table containing all existing campaigns created by the current user.

2. From the Name field in the table, select the appropriate campaign.
   The Campaign Details page appears.

3. From the side panel, click Collaboration.
   The Campaign Details - Contact Point page appears, displaying a table listing any existing Oracle Scripting scripts associated to the selected campaign.

4. From the Type list, select Inbound Script or Outbound Script, as appropriate.

5. In the Name field, search for and select the name of the specific script you want to associate.
   The Campaign Schedule Details - Contact Point page refreshes, populated with the selected values.

6. To save the selected values, click Update.
   The Campaign Details - Contact Point page refreshes, indicating that the selected script is now associated with the designated campaign.

7. If you wish to associate any other script with this campaign, repeat steps 5 and 6.

Administering Campaigns in Oracle Sales Online
To associate agents with campaign schedules or vice versa, you must perform campaign administration steps in Oracle Sales Online.

Tasks
You can perform the following tasks:

- Assigning Agents to a Campaign Schedule, page 9-12
- Assigning Campaign Schedules to Agents, page 9-13
Assigning Agents to a Campaign Schedule

Use this procedure to assign one or more agents to a campaign schedule in Oracle Sales Online.

Prerequisites

None

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Sales Online Super User

Steps:

1. From the Oracle Sales Online administration console, click the Administration tab.
   
   **Note:** To enable you to access this tab, your Oracle Applications account must be a member of a valid sales group. If the required group does not yet exist, it should be created prior to importing the administrator as a CRM resource. Groups and group membership are administered in CRM Resource Manager.

2. Click the Sales subtab.

3. From the side panel, under Call Center, click Agent Assignments.
   
   The Resource Assignment page appears.

4. In the Schedule Name area, click Go.
   
   The Valid Campaign Schedules page appears.

5. If the campaign schedule you want to assign does not appear, then in the Campaign Schedule Name field, search for and select the appropriate campaign schedule.
   
   For example, type TestCampaignSchedule and click Search.
   
   The Valid Campaign Schedules page refreshes, showing a list of valid campaign schedules that meet your search criteria.

6. In the Valid Campaign Schedules page, in the Select column, select one or more
appropriate valid campaign schedules and click Ok. The Resource Assignment page refreshes, listing the valid campaign schedules you selected.

7. Under the Assign To heading, select Resource.

8. From the Current Resource Assignments area, click Add Resource. The Resource Assignment page refreshes. The Current Resource Assignments table includes one or more rows, with text fields under the Resources column.

9. In the Resource field, perform the following:
   1. Type search criteria for an agent (by agent’s last name) and click Go. The Resources Selector page appears, displaying results of your search.
   2. Optionally, refine your search. You can use the % wildcard character anywhere on this page.
   3. In the resources list, click the appropriate hyperlink. The Resources Selector page closes, and the Current Resource Assignments list on the Resource Assignment page refreshes, listing the specified agent name you selected.

10. Repeat the previous step as required for all agents. When satisfied, click Update.

11. If necessary, repeat steps 5 through 10 for each campaign schedule you want to assign.

Assigning Campaign Schedules to Agents

Use this procedure to assign one or more campaign schedules to agents in Oracle Sales Online.

Prerequisites

None

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.
Responsibility

Sales Online Super User

Steps:

1. From the Oracle Sales Online administration console, click the Administration tab.
   
   Note: To enable you to access this tab, your Oracle Applications account must be a member of a valid sales group. If the required group does not yet exist, it should be created prior to importing the administrator as a CRM resource. Groups and group membership are administered in CRM Resource Manager.

2. Click the Sales subtab.

3. From the side navigation bar, under Call Center, click Campaign Assignments. The Campaign Assignment page appears.

4. In the Assign To area, select Resource and click Go. The Resources page appears.

5. If the resource you want to assign is not in the Resources list, then in the Resource Name field, perform the following:
   
   1. Type search criteria for an agent (by agent's last name) and click Search. The Resources page refreshes, displaying results of your search.
   
   2. Optionally, refine your search. You can use the % wildcard character anywhere on this page.
   
   3. In the Select column, select one or more appropriate valid resources and click Ok. The Campaign Assignment page refreshes, listing the valid resources you selected.

6. Click Apply. The Campaign Assignment page refreshes.

7. Under the Current Campaign Assignments heading, click Add Campaign. The Campaign Assignment page refreshes. The Current Campaign Assignments table includes one or more rows, with text fields under the Name column.
8. In the Name field, perform the following:

1. Type search criteria for a campaign schedule and click Go.
   The Valid Campaign Schedules selector page appears, displaying results of your search.

2. Optionally, refine your search.
   You can use the % wildcard character anywhere on this page.

3. In the campaign schedules list, click the appropriate hyperlink.
   The Valid Campaign Schedules selector page closes, and the Current Campaign Assignments list on the Campaign Assignment page refreshes, listing the schedules you selected.

9. Repeat the previous step as required for all campaign schedules. When satisfied, click Update.
   Successful assignment of a campaign schedule to an agent is indicated by a confirmation message at the top of the page.

**Administering Lists in Oracle Marketing**

*Note:* The administrative tasks described herein for list management are performed in previously existing components of the Oracle Marketing user interface, accessible from the Audience tab.

Oracle Marketing release 11.5.10 and later includes an Audience Workbench tab, from which list administration can be performed. For specifics on using the Audience Workbench, refer to *Oracle Marketing User Guide*.

Using the Survey component of Oracle Scripting, lists created with the list management features of Oracle Marketing are used as the contact sources for executing the survey campaign using e-mail as the media channel. The list must already exist at the time you define a deployment for a survey campaign. The list can be created from the Audience tab of the Survey Administration Console, or the Audience tab of the Marketing Administration Console. These lists are passed to Oracle One-to-One Fulfillment. Oracle One-to-One Fulfillment uses a master document (an electronic mail message in HTML format), and an associated query, to merge variables into the message at time of execution. The combination of e-mail master document and the query are referred to in Oracle One-to-One Fulfillment as a template. Upon execution of a concurrent request, the Fulfillment engine executes the query. For each list member, the data retrieved from the query is merged into a copy of the master document, personalizing the HTML invitation or reminder with unique data.
At minimum, an invitation or reminder master document template includes as merge field variables each list member’s e-mail address, and the survey URL. For list-based surveys, the URL contains a parameter to uniquely identify each respondent. This respondent identification code (rID) ties each response to its originating list member.

Typically, some other data from the Oracle Marketing list (for example, title of address, first name, last name, organization, organization address information, country, and so forth) are used in the master document as a merge field variable to personalize the e-mail message. From a survey perspective, the only merge field variables required are respondent e-mail address and survey URL. The minimum set of merge fields that are required in the Oracle Marketing list may be larger, and require certain fields, based on the method of populating the list with records and the specified list type.

The merged HTML documents are then sent to the electronic mail server designated by Oracle One-to-One Fulfillment. When the message is sent out by the mail server, all list members with valid e-mail addresses receive the message as an invitation (or reminder) to participate in a Web-based survey. Clicking on a hyperlink or otherwise accessing the unique survey URL contained in the invitation results in a Scripting Engine interaction in the Web interface as the respondent participates in the survey.

This model is only possible with one or more valid lists, which must be created and defined using Oracle Marketing functionality.

This section includes the following topics:

- List Creation Overview, page 9-16
- Creating a List, page 9-17
- Identifying Record Sources for a List, page 9-19
- Adding Records to a List, page 9-30
- Generating a List, page 9-32
- Marketing Campaigns as an Oracle Applications Dependency, page 9-34

**List Creation Overview**

There are various uses for lists, and correspondingly various ways to identify records to load into an Oracle Marketing list. The list creation itself is a simple process resulting in a list object, at first an empty container awaiting records. Thereafter, you must identify a record source, add the records to the list, and generate the list.

This document assumes the Marketing Administration Console is used for these steps. However, the list management features of Oracle Marketing are also accessible from the Survey Administration Console under the Audience tab, which corresponds to the Audience tab in the Marketing Administration Console. Each appropriate subtab or side panel link required for Oracle Marketing administration can be accessed from
either administrative console. If administering lists from the Survey Administration
Console, the survey administrator must also be assigned the appropriate marketing
responsibility.

Creating a List
Use this procedure to define a list in Oracle Marketing. Until record sources are
subsequently defined for the list, it will remain in Draft status.

Prerequisites
You must know the list type and source type before creating a list. For more
information, see Oracle Marketing product documentation.

Login
Log into Oracle applications using the CRM Home Page login, or the Single Sign-On
login if implemented.

Responsibility
Oracle Marketing Super User

Guidelines
• List types are not enforced by all applications. Manual lists can have each list entry
manually designated from existing records. For all other lists, including lists that
will be populated by Oracle Discoverer workbook, use Standard. Suppression lists
contain list entries that other lists can use to filter out or suppress, effectively
creating a stop-list mechanism that can be used for various other lists. Suppression
lists are generally not used as lists of contacts to execute a campaign.

• A list source type is a concept used by Oracle Marketing to define how fields from
the database map to the columns of a list entry, and which fields will be populated.
A list entry, stored in the table AMS_LIST_ENTRIES, has many data fields. Two
typical source types are Persons and Organization Contacts. These list source types
define whether a set of list entries are contacts in an organization (in which case
certain fields related to an organization are required, such as Organization,
Organization Contact, and Country) or are persons (no organization information is
necessary, but FIRSTNAME and LASTNAME are required). For the Organization
Contacts source type, the PARTY_ID field contains the name of the organization,
and the P_CONTACT_PARTY_ID field contains the name of the individual.
However, for the Persons source type, the PARTY_ID field contains the name of the
individual, and the P_CONTACT_PARTY_ID field is null.
Steps:
1. From the Oracle Marketing administration console, click the **Audience** tab.
   The Organization page appears.

2. Click the List subtab.
   The Lists page appears.

3. Click Create.
   The Create List page appears.

4. In the Name field, type a name for your list.

5. From Type list, select Standard or Manual.
   This field cannot be modified after the list is saved.

6. From the Source Type list, select the source type you want to use with your list.
   This field cannot be modified after the list is saved.
   Two typical source types for a list are Persons and Organization Contacts. These map to fields in the TCA architecture. Other source types can be added in Oracle Marketing if necessary (for example, from HR, the Employees source type). For more information, see Guidelines, page 9-17.

7. If the appropriate person is not populated in the Owner field, do the following:
   1. In the Owner field, type your search criteria and click the search icon.
      You can use the % wildcard search character if it is the second or subsequent character in your search string. For exact title matches, enter search criteria using the syntax <Lastname>, <Title> <Firstname>. For example, to obtain the record Mr. George Washington, type Washington, Mr. George and click the search icon.

   2. In the Resource Selector page, refine your search criteria if necessary.

   3. From the resulting list on the Resource Selector page, click the name of the appropriate owner.
      The Resource Selector page closes. The Create List page refreshes, containing the selected value.

8. Optionally, in the Description field, type a description or purpose for this list.

9. Click Create.
   The Create List page refreshes, becoming the List - Main page.
If successful, at the bottom of the page, confirmation messages appear, indicating that the record has been created and updated.

**Identifying Record Sources for a List**

You must identify record sources to populate lists with list entries. Oracle Marketing lists can be populated in one of three ways:

- Importing a list from a flat file of comma-separated values.
- Manually building a list from existing records in other Oracle Marketing lists or in the TCA architecture.
- Using Oracle Discoverer Workbook from Oracle Marketing to identify list details and conditions to serve as a query to generate a list from the TCA architecture.

**Tasks**

You can perform the following tasks:

- Importing Record Sources, page 9-19
- Manually Selecting List Entries as Record Sources, page 9-25
- Using Oracle Discoverer Workbook to Define Record Sources, page 9-26

**Importing Record Sources**

Use this procedure to import record sources into an Oracle Marketing list. Data types that can be imported include:

- Event registrations
- Leads
- Organizations, Contacts, Addresses
- Persons, Addresses

**Prerequisites**

- An Oracle Marketing list must already exist.
- You must have a flat file available on your computer's local file system or network, or available using the file transfer protocol.
**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Oracle Marketing Super User

**Guidelines**

- When you select an import type, you determine which fields, at minimum, are required to be included in the list. Note that fields in addition to those marked by an asterisk may be required, due to varying business rules related to the purpose for the list.

Based on import type, the following fields are required:

<table>
<thead>
<tr>
<th>Import Type</th>
<th>Intended Use</th>
<th>Required Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Registrations</td>
<td>Event Registrations</td>
<td>• Event Source Code</td>
</tr>
<tr>
<td>Leads</td>
<td>Leads</td>
<td>• Address1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Customer Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• First Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Last Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Promotion Code</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Source System</td>
</tr>
<tr>
<td>Organizations, Contacts, Addresses</td>
<td>Organizations, Contacts, Addresses</td>
<td>• Organization Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Party ID</td>
</tr>
</tbody>
</table>
### Import Type | Intended Use | Required Fields
--- | --- | ---
Persons, Addresses | Lists of persons only | • Person First Name  
 |  | • Person Last Name  
Persons, Addresses | Lists of persons and their addresses | • Person First Name  
 |  | • Person Last Name  
 |  | • Country  
Any import type to be used with the survey component of Oracle Scripting | Targeted survey campaigns | • Survey URL  

- If creating lists for use with the survey component of Oracle Scripting, you must include the survey URL as a field.
- When specifying additional details, if the description import type is a rented list, you must supply either an expiration date, a number of uses, or both.
- If the source set in the Additional Details page is Purchased List, the records from your import file will be added to the Customer Master list. This may also be true for the Others source type, based on your configuration.

**Steps:**
1. From the Oracle Marketing administration console, click the Audience tab.
2. Click the Import subtab.
   The Imports page appears.
3. Click Create.
   The Import: Introduction page appears.
4. From the Import Wizard list, select the type of record source you want to import, and click Next.
   See the Guidelines, page 9-20 for information on record source types.
   The Import Step 1a: Definition page of the import wizard appears.
5. In the Name field of the import wizard, type a name for the record source you want to import.

6. Optionally, in the description field, type a description of this record source.

7. In the Source File area, designate the location of the record source you want to import, and provide details on how the record source is organized.
   1. Optionally, from the Character Set list, select a character set if different from the default selection.
   2. To locate a file on your computer's file system, select the Client option. To locate a file elsewhere on the network, click Server. To use the file transfer protocol to obtain the list, click FTP.

3. Click Go.
   The Import List window appears.

4. From the Import List window, click Browse....
   The Choose File window appears.

5. Navigate to the appropriate comma-separated or ZIP file, select it, and click Open.
   The Choose File window closes. The Import List window refreshes, with the path and file name of your selection populating the appropriate text field.

6. From the Import List window, click Submit.
   The Import List window closes. The Definition page refreshes, with your selection populating the appropriate text field.

7. From the Column Delimiter list, ensure the appropriate delimiter type is selected.
   For example, if using comma-separated values, ensure Comma is selected.

8. From the Field Enclosed By list, ensure the appropriate field symbol used in the import file is selected.
   Fields in the import list can be separated by commas, double quotation marks, semicolons, or single quotation marks. Select the choice that reflects the symbol used to enclose each field within each record in the source list you want to import.

9. If the list record source contains file headers such as column definitions, check the File Header Exists box. Otherwise, clear this box.
   If you select this option, the first row of the import file will display as field
names in the Source Fields area when mapping fields. Otherwise, the fields in the Source Fields area appear as Field1, Field2, Field3, etc.

10. Optionally, if merging lists or otherwise removing duplication, perform the following:
   • In the Remove Duplications Using Rule field, enter search criteria for rules to remove duplicate records in the list, and click the search icon. The DeDuplication Rule LOV window appears.
   • In the DeDuplication Rule LOV window, refine your search criteria if necessary.
   • From the resulting list, click the name of the appropriate rule. The Definition page refreshes, containing the selected value.

11. Optionally, select the Use Word Standardization option.

8. Click Next.

For record sources of the lead or event registration import types, the Import Mapping page of the import wizard appears. Proceed to step 11.

For record sources of the Organizations, Contacts, Addresses import type or the Persons, Addresses import type, the Import Step 1b: Additional Details page of the import wizard appears.

9. Optionally, in the provided fields, enter additional information about the record source you want to import.
   If the description import type is a rented list, you must supply either an expiration date, a number of uses, or both.

10. Click Next.

The Import Mapping page of the import wizard appears. From here you can import existing mappings, designate new mappings, and view records in the record source you want to import in the Preview field.

11. To map fields using an existing mapping, in the Load Existing Mapping field, search for and select the appropriate existing mapping. Verify that the required fields (fields preceded with an asterisk in the Target Fields column) are all included in the mapping, and make changes if required.
   Optionally, you can save or rename a mapping.

12. To create a new mapping, establish a match between the source fields from your record source and the target fields derived from the Oracle TCA architecture. Match
each set of fields in the order used in your record source. This order (as well as the first few records in your record source) is displayed in the preview field below.

For example, if the first entry in the Preview Count window is George, click Field1 or PERSON_FIRST_NAME in the Source Fields list and Person First Name Target Fields list.

13. Click the right arrow to confirm the first field mapping.

In the Mapping: Source to Target column, the correlation you designated between the field in your record source and the field in the TCA architecture appears.

14. Repeat steps 12 and 13 above for each source field you want to include in your list, until complete.

- Each field designated in the final target mapping must have a corresponding record in the Target Fields list.

- The converse is not true. You may exclude from the final mapping some fields in the source fields list, as long as they are not required fields as designated by an asterisk in the Target Fields list. Data from excluded fields will not become part of the list. If you exclude some source fields in your final target mapping, your list may not pass validation used by applications such as Oracle Advanced Outbound Telephony.

15. Click Next.

If successful, a confirmation appears on the Import Step 3: Review page of the import wizard. If required fields are missing, click Cancel and add them to the record source for each record for subsequent importation. If fields are mismapped, click Restore to clear the mapping page and remap until successful.

16. For two import record source types (both Organizations, Contacts, Addresses and Persons, Addresses), you can automatically generate the list during the import process. To do this, click the Generate a List upon Import box.

   **Note:** If you select this option, you do not need to perform the task described in Generating a List, page 9-32.

17. Click Import.

   The Confirmation page appears, displaying a confirmation note stating that the list has been submitted for processing.

18. If you want to import another record source, click New Import. Otherwise, click Finish.
Manually Selecting List Entries as Record Sources

Using the Add List Entries - Contact Search page, you can search for existing records in the TCA architecture or from an existing Oracle Marketing list, and add them as a list entry on a specified list. You can search by person information, address, organization information, or you can find records for a specified organization based on the individual’s relationship to the organization.

Use this procedure to manually select list entries from existing records in the TCA architecture or from an existing Oracle Marketing list.

Prerequisites

- An Oracle Marketing list must already exist.
- The list entries you want to create must already exist.
- You must have information from which to query records to add list entries to the Oracle Marketing list.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Oracle Marketing Super User

Steps:

1. From the Oracle Marketing administration console, click the Audience tab.

2. Click the List subtab.
   The Lists page appears.

3. From the Name column of the lists list, click the appropriate hyperlink to select the existing Oracle Marketing list to which you want to add entries.
   For example, click TestList.
   The Lists - Main page appears.

4. From the side panel, click Entries.
   The List Entries page appears.
5. Click Add to List.
   The Add List Entries - Contact Search page appears.

6. Enter your search criteria and click Search.
   The Add List Entries - Search Results page appears, with a list of all records that
   match your search criteria.

7. Refine your search criteria if necessary.

8. In the Select column of the Add List Entries - Search Results page, mark each
   appropriate record that you want to include as a list entry in the selected list.
   
   **Note:** All list entries must have valid e-mail addresses in order to
   receive invitations or reminders to participate in a survey.

   
   **Note:** For testing purposes, Oracle recommends that you add
   yourself as a list entry. Ensure a valid e-mail address is associated
   with your list entry record.

9. Click Add to List.
   The Confirmation List Entries page appears. The designated contacts are added to
   the specified list.

10. Make any changes if required, and click Update.
    Once the list is generated, it can be used in a survey campaign deployment.

11. Click Return to List Entries to verify that the selected entries were added to the
    appropriate list.

12. Make any changes if required, and click Update.
    For example, add an e-mail address to any missing list entries, and click Update.

## Using Oracle Discoverer Workbook to Define Record Sources

Oracle Discoverer is interface software available from the Marketing Administration
Console that allows users to view and select records from complex database structures
without requiring knowledge of those structures or knowledge of Structured Query
Language (SQL). Discoverer generates workbooks, which are lists of records similar in
design to a spreadsheet. Workbooks may then be used to generate Oracle Marketing
lists or to provide a SQL statement for a segment.

Use this procedure to create an Oracle Discoverer workbook from Oracle Marketing.
Using the folders provided in the Oracle Discoverer layer of Oracle Marketing to define record sources for a list provides access to many data fields in the TCA. The workbook parameters are executed when the list is generated.

**Prerequisites**

- Oracle Discoverer must be appropriately implemented and configured for use in Oracle Marketing.

- You must have the appropriate responsibility and requisite group roles and membership to access the Discoverer component. For more information, see Oracle Marketing product documentation.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Oracle Marketing Super User

**Steps:**

1. From the Oracle Marketing administration console, click the Audience tab.

2. Click the Discoverer subtab.
   
   Oracle Discoverer application launches in a separate browser window. The Open Workbook window appears.

3. Click Create a new workbook.
   
   The Open Workbook window refreshes with added display information options.

4. Ensure the Table display option is selected.

5. Click Next.
   
   The Select Items window appears.

6. From the Available list, select the appropriate list management option.
   
   For example, select Marketing Online Organization List Management.
   
   The Select Items window refreshes, showing folders appropriate to the option you selected. You can drill down into each folder by clicking the plus sign.

7. From the folder area of the Available list, select the appropriate folder.
For example, for a list based on organizations, select Organization Contact List Details, or for a person or address list, select Marketing Online Person List Management.

8. Click the plus sign preceding the folder to display the folder’s contents. The Select Items window refreshes, showing fields in the database associated with your selection.

9. Select Mandatory Identifier and click the select arrow between the Available list and the Select list to move that field to the Select list.

10. Add to the select list all other mandatory fields.
    Include in the select list all fields preceded with the word "Include." Other fields may be mandatory, based on the purpose for the list.
    For example, for an organization list, you must also select the Party Site Identifier, Email Address, Person First Name, Person Last Name, and Person Title fields.

11. Review your field selections. When satisfied, click Next.

12. Click Next.
    The Table Layout window appears. No data is required for this window.

13. Click Next.
    The Format window appears. No data is required for this window.

14. Click Next.
    The Conditions window appears.

15. Optionally, enter any conditions by doing the following:
    1. From the Conditions window, click New.
        The New Conditions window appears.
    2. Optionally, in the name field, type a name for the new condition.
    3. Optionally, in the description field, enter a description for the new condition.
    4. In the Formula area, start defining the condition. From the Item list, select the appropriate item for which you want to create a condition.
        Each field in the Item list is preceded by its parent list management option and a period. For example, the Mandatory Identifier is named Organization Contact Details List.Mandatory Identifier.
    5. In the Formula area, from the Condition list, select the condition operator.
For example, select the equal sign.

6. In the Formula area, in the Values list, type a new value, or select Create Calculation... to create a calculation, Select Item... to select an item, or New Parameter... to define a new condition parameter.

For example, type an organization ID.

7. If your condition is case-sensitive, ensure the Match case option is selected. If not, click to clear this option.

8. Check your condition parameters. When satisfied, click OK.

The New Conditions window closes.

To add additional conditions, repeat 15.1 through 15.8 of this step.

16. Click Next.

The Sort window appears.

**Note:** Do not include any sort conditions in your workbook. Generation of a list of list type Standard remains in Draft status if (a) a Sort condition is included in the workbook, or (b) if all the required fields (Party Id, Mandatory Identifier, One of the Include fields, Title, email Address, First name, Last Name) are not included in the workbook.

17. Click Next.

The Calculations window appears.

18. Optionally, add a calculation. When finished, click Next.

The Percentages window appears.

19. Optionally, add a percentage. When finished, click Next.

The Totals window appears.

20. Optionally, add a total. When finished, click Next.

The Parameters window appears.

21. Optionally, add a parameter.

22. Click Finish.

The Parameters window closes. After processing, your new workbook displays.

23. From the File menu, select Save As..., type a name for your workbook, and click
24. To exit Oracle Discoverer, from the File menu, select Exit.

Adding Records to a List

After creating a list and identifying record sources, records must be added to the list. Use this procedure to add records to a list in Oracle Marketing.

Note: If you selected the Generate a List upon Import box when importing records of source type Organizations, Contacts, Addresses or Persons, Addresses, this procedure is not required.

Prerequisites

- An Oracle Marketing list must already exist.
- Record sources must already be identified.

Login

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

Responsibility

Oracle Marketing Super User

Guidelines

- When designating an order for list selection, each record source in the list must contain a unique number. The lowest numbered record source will be used first.

- The first record source must be of type "include" so that records will be included in the list. Designate all record sources to include prior to designating record sources to exclude.

- The Source Types (Organization Contacts or Persons) should be the same for all the items (lists, workbooks, segments) used in the operation (Include, Exclude, or Intersect) and the main list that you’ve created.

- If one of the list sources is a suppression list or another list of type "exclude,” designate this last in the list selection page, to ensure that records to be included will exist in the set from which exclusions are to occur.
• When designating the operation type, use the following criteria:
  Use Include to add all entries in the record source to the list. Include is a required
  operation for the first record source to be used.
  Use Exclude to remove from the final list any entries in the specified record source.
  Exclude is generally used to remove a set of entries from a larger record source that
  is included in the list.
  Use Intersect to designate a second or subsequent primary list criteria. The list
  sources to be included must be listed prior to the record source designated as an
  Intersect record source. For example, to intersect a record source of people making
  over $100,000 with a record source of people living in Montana, the resulting list
  will contain entries for people living in Montana who make more than $100,000.
  Thus, incorporation order is crucial, as other criteria must precede the Intersect
  designation.

• When designating record source types, use the following criteria:
  If adding records from an existing import list, select Import List.
  If adding records using an existing SQL statement, select SQL.
  If adding records using an existing marketing segment, select Segment.
  If adding records from an existing Discoverer Workbook, select WorkBook. Select
  the Type.

Steps:
1. From the Oracle Marketing administration console, click the Audience tab.
2. Click the List subtab.
   The Lists page appears, displaying a summary view table of all existing lists.
3. From the table, click the name for the list into which you want to add records.
   The List - Main page appears.
4. From the side panel, click Selections.
   The List Selections page appears.
5. In the first row:
   1. Type an integer designating the order in which you want the first record source
      to be incorporated into the list. The lowest numbered record source will be used
      first. For more information, see Guidelines, page 9-30.
   2. From the Operation list, select an operation type. Operations available are
      Include, Exclude and Intersect. For more information, see Guidelines, page 9-30.
3. From the Type list, select a record source type. Valid record source types include Import List, List, SQL, Segment, or Workbook. For more information, see Guidelines, page 9-30.

4. In the Name field, search for and select the name of the record source you want to use to provide record entries to this list.

5. If an Include operation, in the Dedupe Rank field, type a deduplication rank for the record source.
   A deduplication rank determines which record to retain when a user removes duplicate records after the list has been generated. Deduplication occurs only during an Include operation, in which cases it is a required parameter.

6. Optionally, if an Include operation, in the Percent of Records field, type an integer designating the percentage of records in the record source you want to include in the list.
   For example, if the named record source contains ten thousand records and you only wish to import one thousand, type 10 in this field.

6. Repeat step 5 for each additional record source you want to include, exclude, or intersect to compose this list.

7. Review your list selection criteria. When satisfied, click Update.
   The List - Selection page refreshes, displaying a confirmation message.

**Generating a List**

After creating a list, identifying, and adding record sources to the list, the list must be generated to populate the list with all required records. Use this procedure to generate a list prior to executing a survey using the list.

**Note:** If you selected the Generate a List upon Import box when importing records of source type Organizations, Contacts, Addresses or Persons, Addresses, this procedure is not required.

**Prerequisites**

- An Oracle Marketing list must already exist.
- Record sources must already be identified.
- Record sources must already be added to the list.
- The AMS Marketing Approvals Process concurrent program needs to be running in order to generate Standard Lists (from a workbook, from SQL, or from import lists) and to change their status to Available. Otherwise, the list status will be trapped in Generating status. For Manual Lists, there is no requirement to run this process. For more information, refer to Oracle Marketing product documentation.

**Login**

Log into Oracle applications using the CRM Home Page login, or the Single Sign-On login if implemented.

**Responsibility**

Oracle Marketing Super User

**Steps:**

1. From the Oracle Marketing administration console, click the Audience tab.

2. Click the List subtab.
   - The Lists page appears, displaying a summary view table of all existing lists.

3. From the table, click the name for the list which you want to generate.
   - The List - Main page appears.

4. From the side panel, click Generation.
   - The List - Generation page appears.

5. If you want to generate the list now, click Generate immediately.

6. If you want to schedule a time and date to generate the list in the future:
   1. Click Generate at a future time.
   2. Using the date control widget, specify the target date on which to generate the list
   3. Using the hour, minute, and AM/PM lists, specify the time to generate the list on the specified date.
   4. From the time zone list, specify the appropriate time zone.
   5. From the Generation Type, confirm that the selected type is appropriate. If not, select the appropriate generation type from the list.
7. Click Update.

The List - Generation page refreshes to display a confirmation message.

Marketing Campaigns as an Oracle Applications Dependency

A campaign can be generally described as a focused effort to achieve a particular goal from a targeted population over a specific period of time for a particular business purpose.

Marketing campaigns are the vehicle for putting information about an organization’s products, services, offers, and messages in front of customers and potential customers. Campaigns are created and administered in Oracle Marketing and used by various Oracle business applications. Although sometimes referred to as a marketing campaign, Oracle Marketing campaigns can also be used for sales, telesales, service, teleservice, and for any business purpose.

From an Oracle Scripting perspective, there is another type of campaign that meets the general definition: a survey campaign. This is the collection of business requirements required to execute a script as a survey in a Web browser using the Scripting Engine Web interface. Survey campaigns are created using the Survey Administration console. These will always be referred to specifically as survey campaigns.

Campaigns are a fundamental entity for Oracle Marketing, and campaign attributes are prerequisites or dependencies for various Oracle business applications. For example:

- To specify a particular script to launch when clicking the View Script button in Oracle TeleSales, a campaign must be defined, campaign schedules associated with the campaign must be defined (including a script associated with the schedule), and agents must be assigned to the schedule or vice versa.

- The same set of campaign administration steps is required:
  - To specify a specific script to launch automatically in Oracle TeleSales upon call delivery to the agent
  - To specify a specific script to launch automatically upon start of interaction in Oracle TeleSales

- Campaigns are also required in order to associate Oracle Marketing lists. These lists are sets of customer contact information derived from records in the Oracle Applications Trading Community Architecture (TCA).

- Oracle Advanced Outbound Telephony requires use of campaign schedules created using Oracle Marketing. Each campaign schedule can be targeted for different execution channels. For example, a marketing campaign can have a campaign schedule associated with it targeted for e-mail execution, and another campaign schedule associated with the campaign for telephony execution.
This chapter covers the following topics:

- Overview of Verification
- Script Author Tasks
- Creating a Hello World Graphical Test Script
- Oracle Creating a Hello World Wizard Test Script
- Using the Regression Test Script
- Survey Administration Console Tasks
- Scripting Engine Tasks
- Apache Web Server Servlet Verification URLs
- Scripting Engine Agent Interface Verification
- Scripting Engine Web Interface Verification Tasks
- Executing a Script in the Web Interface
- Testing Display Server for UNIX Environments
- Viewing Server Message Logs

Overview of Verification

Implementation verification tasks may differ, based on which components you implement and use at the enterprise.

At minimum, every implementation requires you to create or obtain a functional script and deploy it to your environment using Script Author. Oracle recommends creating or obtaining a simple test script without custom Java and a script that includes references to custom Java.

Only scripts to be executed in the Web interface (whether executed as surveys, or as scripts executed in a Web browser from an integrated self-service Web application)
require you to perform survey resource and survey campaign administration steps.

You must execute all scripts in the Scripting Engine to verify your implementation. Because there are fewer environmental factors affecting success, Oracle recommends first verifying test scripts in the Scripting Engine agent interface, even if your implementation only requires you to execute scripts in the Scripting Engine Web interface. If your enterprise requires scripts to be executed in a Web browser, then, after testing in the agent interface, you should test your scripts in the Web interface.

Other verification tasks specific to your Oracle Applications operating system or environment may apply.

This section includes the following topics:

- Script Author Tasks, page 10-2
- Survey Administration Console Tasks, page 10-36
- Scripting Engine Tasks, page 10-38
- Testing Display Server for UNIX Environments, page 10-42
- Viewing Server Message Logs, page 10-42

**Script Author Tasks**

All implementations must be verified using one or more scripts. Oracle recommends first testing your implementation with the Scripting Engine agent interface, using a simple script with no associated custom Java. Step-by-step instructions to create and deploy a Hello World graphical test script, page 10-3 using Script Author’s standard visual tools is provided in this section for this purpose. If using the Script Wizard feature of Script Author, follow the instructions provided to create the Hello World wizard test script.

Testing a simple script with no associated custom Java by executing it in the Scripting Engine agent interface verifies that:

- A script can be launched in the designated environment, independent of the technical considerations related to custom Java.

- You eliminate certain environmental variables as the cause of problems if this test succeeds and the subsequent test (launching and executing a script that calls custom Java methods or other custom commands) fails.

- Script Author is compiling and deploying scripts successfully.

- Scripting User or Scripting Agent responsibility functions appropriately.

If your implementation requires custom Java, you must test a script that references
custom Java. Oracle recommends using the regression test script posted on My Oracle Support and Oracle iSupport for that purpose. If you can successfully execute the regression test script, you quickly verify that:

- A script with custom Java methods associated with it can be launched in the designated environment.
- The Apache Web server can locate and interpret the custom Java classes.
- Your environment is correctly set up to deploy custom Java to the database, map custom Java to scripts, and make the appropriate methods available at runtime.
- Pending the appropriate configuration of environmental factors, a customized script will function properly in your environment.

**Tasks**

You can perform the following tasks:

- Creating a Hello World Graphical Test Script, page 10-3
- Creating a Hello World Wizard Test Script, page 10-22
- Using the Regression Test Script, page 10-35

**Creating a Hello World Graphical Test Script**

**Prerequisites**

- To create or deploy scripts using the Script Author Java applet, you must use the Scripting Administration console - to do this, you must have access to an Oracle Applications account with the Scripting Administrator responsibility.
- All implementation tasks must be accomplished.

**Steps:**

Follow the steps below.
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Oracle Applications HTML Login</td>
<td>Log into Oracle applications using the CRM Homepage login (or the Single Sign-On login, if implemented) as a user with the Scripting Administrator responsibility.</td>
<td>The Scripting Administration console appears.</td>
</tr>
<tr>
<td>2</td>
<td>Scripting Administration console</td>
<td>From the Home tab, click Launch Script Author.</td>
<td>A new browser window opens, Oracle JInitiator launches, and the Script Author Java applet appears in a separate window.</td>
</tr>
</tbody>
</table>
| 3    | File menu or Script Author Toolbar | Create a new script using one of the following methods:  
  • From the Script Author File menu, select New.  
  • From the Script Author toolbar, click the New Script icon. | The new script window appears, with options for starting a new graphical script or a new wizard script. |
<p>| 4    | New Script window | From the New Script window, click Graphical script. | A new, untitled script appears within Script Author's visual layout region (the &quot;canvas&quot;), including a start node. |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Script Author</td>
<td>Optionally, adjust the view of the script from the Script Author toolbar. For example:</td>
<td>The view of the script on the canvas adjusts per your request.</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td>• To display a 100% view of the canvas, click the Zoom to 100% icon.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To zoom in or out as required to display the entire script in the current window, click the Zoom To Fit Graph In Window icon.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For a closer or further view of the canvas, click the Zoom In or Zoom Out icon, respectively.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Script Author</td>
<td>Click the Panel Insertion Mode icon (the blue sphere) from the toolbar to indicate you wish to insert a new panel.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Script Author</td>
<td>Click <em>once</em> in the canvas below the start node. This action places a panel icon (shown as a blue sphere) into the canvas.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td></td>
<td>canvas</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Until you switch to another toolbar object or switch to toggle selection mode (performed in the next step), the current toolbar object remains selected and will continue to place objects (in this case, panels) on the canvas each time the mouse is clicked in the work area. If you prefer to disable this feature, click to clear the sticky mode option under the File menu. The option to disable sticky mode is retained only for the duration of the current Script Author session. If you prefer this option, you must select it each time you launch Script Author.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>Script Author Toolbar</td>
<td>Click the Toggle Selection Mode icon from the toolbar to turn off the panel insertion mode.</td>
<td>Script Author Toolbar</td>
</tr>
</tbody>
</table>

**Note:** If you clear the sticky mode option as described in the step above, selecting Toggle Selection Mode will not be required. However, when using the same toolbar tool repeatedly (when dropping multiple objects, or drawing multiple branches of the same type), you will be required to select the desired object from the toolbar each time, which is not required when sticky mode is enabled.

| 9    | Script Author canvas | Right-click the panel that you just added to the script. The Script Author displays a drop down menu with the following options: Edit, Edit Blob Name, and Edit Blob Properties. | Script Author canvas                |

**Note:** If the menu displayed shows only two options, Edit and Edit Blob properties, then you have not correctly selected the Panel object. Left-click to close the menu and re-select the Panel object.
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Panel Properties window</td>
<td>Select the Edit Blob Properties option from the menu created by right-clicking on the new panel. The Script Author displays the Panel[n] Properties window. <strong>Note:</strong> The Script Author automatically assigns numbering to each new panel created (represented by [n] above) to enforce unique panel names. When you type a value in the Name field of the panel properties (such as &quot;Hello&quot;) and apply the change, the value you entered replaces the [n] as the new name of the panel you have just created. For example, Panel5 Properties becomes PanelHello Properties. For the sake of simplicity, the name of each new panel (the value of [n]) will be excluded in these instructions, and the window will be referred to generically as the Panel Properties window.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>11</td>
<td>Panel Properties window</td>
<td>In the Panel Properties window, input the following values in the prescribed fields: Name: Overwrite the default &quot;Panel[n]&quot; entry and type hello. From this point on, only the values you should enter will be provided. In each case, overwrite the default entry. Comments: <em>Leave blank</em> Label: Greeting</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>12</td>
<td>Panel Properties window</td>
<td>Click Apply in the Panel Properties window. <strong>Note:</strong> Clicking the Apply button saves the values entered or changed (just as if you had clicked the Ok button), but leaves the window open for additional work.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>13</td>
<td>Panel Properties</td>
<td>Click the Answers property displayed on the left pane of the Panel Properties window. The right pane of the window changes to display a text area which will list any questions - also known as answer definitions - that you define for the script.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Panel Properties</td>
<td>Click the Add button, which is immediately below the Answers text area. The Answer Entry Dialog window appears.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Answer Entry</td>
<td>Provide the following values for the fields in the Answer Entry Dialog window:</td>
<td>Answer Entry Dialog window</td>
</tr>
<tr>
<td></td>
<td>Dialog window</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default for Distinct Branching: Selecting this check box is optional. Panels which do not use distinct branching are not required to enable this property.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name: helloAnswer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UI Type: Button</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Label for Reporting: <em>Leave blank</em></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Panel Properties</td>
<td>From the bottom of the Answer Entry Dialog window, click the Edit Data Dictionary button. The application displays the Edit Data Dictionary dialog.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Edit Data</td>
<td>Select the Lookups tab.</td>
<td>Edit Data Dictionary dialog</td>
</tr>
<tr>
<td></td>
<td>Dictionary dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Lookup values are referred to in the Script Wizard as answer choices.</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Edit Data</td>
<td>On the Lookups tab, click the Specify lookups radio button. The Lookups list and its corresponding Add button enable. This list is currently empty.</td>
<td>Edit Data Dictionary dialog</td>
</tr>
<tr>
<td></td>
<td>Dictionary dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Lookup entry</td>
<td>Click the Add button. The application displays the Lookup entry dialog.</td>
<td>Lookup entry dialog</td>
</tr>
<tr>
<td></td>
<td>dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>20</td>
<td>Lookup entry dialog</td>
<td>In the Lookup entry dialog, assign the following values to the fields: Display Value: Continue Value: Continue Click Ok to close the Lookup entry dialog and return to the Edit Data Dictionary dialog. Click Ok to close the Edit Data Dictionary dialog and return to the Answer Entry Dialog window.</td>
<td>Lookup entry dialog</td>
</tr>
<tr>
<td>21</td>
<td>Panel Properties window</td>
<td>Click Ok to close the Answer Entry Dialog window. The answer that you have defined now appears in the Answers text area in the Panel Properties window. It should appear as an entry with the name Answer:helloAnswer (default).</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>22</td>
<td>Panel Properties window</td>
<td>Click Ok to close the Panel Properties window. On the canvas below the start node, the panel (for which you have just configured name and answer properties) appears.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>24</td>
<td>Panel layout editor Toolbar</td>
<td>When the panel layout editor opens, representative controls for any answers you have defined appear on the page, with room above for text. Click once in the text entry area. From the toolbar, click the Set Spoken Text Font icon. Then enter the following text: Hello, World! <strong>Note:</strong> The text is formatted as “Spoken Text,” allowing one-click formatting to provide an easy visual clue. For agents, this is typically text that would be read to a customer during an interaction. For scripts run in the Web interface as a survey, this is an easy way to emphasis text or use one of two preexisting formats.</td>
<td>Panel layout editor Toolbar</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>25</td>
<td>Panel layout editor or Unsaved Changes dialog</td>
<td>Save the panel text you have created and exit the panel layout editor. You can do this by selecting Save and then Exit (both from the File menu), or you can simply exit the panel layout editor and click the Yes button when the Unsaved Changes dialog asks if you would like to save the changes you have made.</td>
<td>Panel layout editor or Unsaved Changes dialog</td>
</tr>
<tr>
<td>26</td>
<td>Script Author Toolbar</td>
<td>Select the Group Insertion Mode icon from the toolbar.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>27</td>
<td>Script Author canvas</td>
<td>Click once on the canvas, below the hello panel. The Script Author will place a Group object into the script at the insertion point.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td>28</td>
<td>Script Author Toolbar</td>
<td>Click the Toggle Selection Mode icon from the toolbar to turn off the Group Insertion mode.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>29</td>
<td>Script Author canvas</td>
<td>Double-click the newly-added group. The Group Properties dialog is displayed.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td>30</td>
<td>Group Properties dialog</td>
<td>Fill out the fields in the Group Properties dialog in the following manner: Name: WrapUpGroup Comments: Enables the Disconnect button Note: The comment is not required.</td>
<td>Group Properties dialog</td>
</tr>
<tr>
<td>31</td>
<td>Group Properties dialog</td>
<td>Click Apply in the Group Properties dialog.</td>
<td>Group Properties dialog</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>32</td>
<td>Group Properties</td>
<td>Click the Shortcut property from the items on the left pane of the Group Properties dialog. The right pane is re-written and a new field appears. You must fill it out as follows: Shortcut: WrapUpShortcut</td>
<td>Group Properties dialog</td>
</tr>
<tr>
<td></td>
<td>dialog</td>
<td><strong>Note:</strong> This Shortcut name must appear <em>exactly as typed here, with upper and lowercase text and no spaces.</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For scripts run in the agent application, the Scripting Engine associates the Disconnect button with any group containing the Shortcut property of WrapUpShortcut.</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>Group Properties</td>
<td>Click OK in the Group Properties dialog. The dialog closes and the new group appears on the canvas below the hello panel.</td>
<td>Group Properties dialog</td>
</tr>
<tr>
<td></td>
<td>dialog</td>
<td>A new group represents a second graph. The original graph on which the hello panel and the WrapUpGroup group reside is referred to as the Root Graph.</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Script Author</td>
<td>From the Script Author canvas, click once on the WrapUpGroup icon to select it. The selection markers will appear.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td></td>
<td>canvas</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Script Author</td>
<td>Click the Go Down Into Child Graph icon from the toolbar. You will now see the child graph of the new group, which contains only a start node.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Script Author</td>
<td>Click the Panel Insertion Mode icon from the toolbar and click once in the child graph below the start node.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Script Author</td>
<td>Click the Toggle Selection Mode icon from the toolbar to turn off the Panel Insertion mode.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>38</td>
<td>Script Author</td>
<td>Double-click the new panel to display the Panel Properties window. Click on the Properties property from the items on the left pane of the Panel Properties window, and enter the following values in the prescribed fields: Name: goodbye Comments: <em>Leave blank</em> Label: Last panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>canvas</td>
<td></td>
<td>Script Author canvas</td>
</tr>
<tr>
<td>39</td>
<td>Panel Properties</td>
<td>Click Apply in the Panel Properties window.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Panel Properties</td>
<td>Click the Answers property displayed on the left pane of the Panel Properties window. The right pane of the dialog changes to display a text area which will list any answers you define for the script.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>Panel Properties</td>
<td>Click the Add button to define your answer in the Answer Entry Dialog window.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td></td>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Answer Entry</td>
<td>Provide the following values for the fields in the Answer Entry Dialog window: Default for Distinct Branching: <em>checkmark</em> Name: goodbyeAnswer UI Type: Button Label for Reporting: <em>Leave blank</em></td>
<td>Answer Entry Dialog window</td>
</tr>
<tr>
<td></td>
<td>Dialog window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>43</td>
<td>Panel Properties window</td>
<td>From the bottom of the Answer Entry Dialog window, click the Edit Data Dictionary button. The application displays the Edit Data Dictionary dialog.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>44</td>
<td>Edit Data Dictionary dialog</td>
<td>On the Lookups tab, click the Specify lookups radio button.</td>
<td>Edit Data Dictionary dialog</td>
</tr>
<tr>
<td>45</td>
<td>Lookup entry dialog</td>
<td>Click the Add button. The application displays the Lookup entry dialog.</td>
<td>Lookup entry dialog</td>
</tr>
<tr>
<td>46</td>
<td>Lookup entry dialog</td>
<td>In the Lookup entry dialog, assign the following values to the fields:</td>
<td>Lookup entry dialog</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display Value: Finish</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value: Finish</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Ok to close the Lookup entry dialog and return to the Edit Data Dictionary dialog.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Ok to close the Edit Data Dictionary dialog and return to the Answer Entry Dialog window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Ok to close the Answer Entry Dialog window.</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Panel Properties window</td>
<td>Click Apply in the Panel Properties window.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>48</td>
<td>Panel Properties window</td>
<td>Click the Panel Layout property displayed on the left pane of the Panel Properties window. The right pane of the dialog changes to display the Panel Layout details, including a button from which you can import HTML, and a Panel Layout Editor button.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>49</td>
<td>Panel Properties window</td>
<td>Click Panel Layout Editor. The panel layout editor for the panel appears.</td>
<td>Panel Properties window</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>50</td>
<td>Panel layout editor Toolbar</td>
<td>In the panel layout editor dialog, click once in the text entry area. From the toolbar, click the Set Spoken Text Font icon. Then enter the following text: Goodbye, World! Press Enter to continue to the next line, and then click the Set Instruction Font icon. In the Text entry area, type the following text:[Click the Finish button.] <strong>Note:</strong> Instructional text is intended to provide instructions to the end user of the script.</td>
<td>Panel layout editor Toolbar</td>
</tr>
<tr>
<td>51</td>
<td>Panel layout editor or Unsaved Changes dialog</td>
<td>Save the panel text you have created and exit the panel layout editor. Click Ok to save and close the Panel Properties window. The goodbye panel is now visible below the start node of this child graph.</td>
<td>Panel layout editor or Unsaved Changes dialog</td>
</tr>
<tr>
<td>52</td>
<td>Script Author Toolbar</td>
<td>From the Script Author toolbar, click the Termination Point Insertion Mode icon. On the canvas, below the goodbye panel, click once to insert a termination node. <strong>Note:</strong> A termination node is required for each graph in a script, and exits the graph.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>53</td>
<td>Script Author Toolbar</td>
<td>From the Script Author toolbar, select the Default Branch Mode icon. When over the canvas, the cursor turns into a cross-hairs symbol, indicating that you can begin drawing a line to define flow from one object to another within the canvas.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>54</td>
<td>Script Author canvas</td>
<td>With the cursor displayed as a cross-hairs symbol, click on the start node and drag to draw an arrow between the start node and the goodbye panel. Release the mouse. The two objects are connected.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td>55</td>
<td>Script Author canvas</td>
<td>With the cursor displayed as a cross-hairs symbol, again click on the canvas, this time connecting the goodbye panel and the termination node. If you have disabled sticky mode, you must again select the Default Branch Mode icon from the toolbar to accomplish this step. You have now completed a syntactically correct graph. Return to the root graph to complete this script.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td>56</td>
<td>Script Author Toolbar</td>
<td>From the Script Author toolbar, select the Go up to parent graph icon. The canvas now displays the root graph.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>57</td>
<td>Script Author Toolbar</td>
<td>From the Script Author toolbar, click the Termination Point Insertion Mode icon. On the canvas, below the WrapUpGroup object, click once to insert a termination node. <strong>Note:</strong> For the root graph, the termination node indicates the completion of the script.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>58</td>
<td>Script Author Toolbar</td>
<td>From the Script Author toolbar, select the Default Branch Mode icon. Connect the start node to the hello panel, the hello panel to the WrapUpGroup object, and the WrapUpGroup object to the termination node with default branches.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>59</td>
<td>Script Author Toolbar</td>
<td>Click the Toggle Selection Mode icon from the toolbar to turn off the Default Branch insertion mode.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>60</td>
<td>Script Author Toolbar</td>
<td>Using click-and-drag techniques, select all the objects on the canvas (start node, hello panel, termination node, and Default branches). From the lower Tools menu, select the Align Selected Objects Vertically icon. All highlighted items will align vertically, presenting a neat graph on the canvas.</td>
<td>Script Author Toolbar</td>
</tr>
<tr>
<td>61</td>
<td>Script Author File Menu or Script Author Toolbar or keyboard</td>
<td>At the File menu, select Save to save your work. This command can also be executed by selecting the Save Script (disk) icon in the toolbar or by entering Ctrl-S from the keyboard (Command-S for the Macintosh OS).</td>
<td>Script Author File Menu or Script Author Toolbar or keyboard</td>
</tr>
<tr>
<td>62</td>
<td>Script Chooser dialog</td>
<td>In the resulting Script Chooser menu, you can save the script to your local file system or publish it to the applications database. Fill in the following: Location: Select the directory in which you wish to save the Script Author file. <strong>Note:</strong> For location, Oracle recommends a child directory of the Script Author directory, for example (your path may differ): &quot;[OraHome]\oracle\apps\ies\author\scripts&quot; File Type: Select the default Oracle CRM script file (.SCRIPT, .SCR) option. File name: helloWorldTestScript.script Click the Save button to save the file in the selected directory.</td>
<td>Script Chooser dialog</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>63</td>
<td>Script Author canvas</td>
<td>Even though you have saved and named your script in your operating system’s file system, you still need to assign a name to the script which will be recognized from a database perspective. Right-click on any unpopulated section of the canvas to display two options, Edit and Edit Blob Properties, and select Edit Blob Properties to open the [Script Name] Properties dialog. You can also open this dialog by selecting Script Properties from the File menu. <strong>Note:</strong> If the dialog displayed shows three options: Edit, Edit Blob Name, and Edit Blob Properties, then you have not correctly selected the Script properties dialog, but properties for another object. The global script itself is the Binary Large Object (Blob) for which you want to modify properties. In this case, left-click to close the menu and re-select the Script Properties following one of the methods above.</td>
<td>Script Author canvas</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>64</td>
<td>Global [Script Name] Properties dialog</td>
<td>In the resulting global [Script Name] Properties dialog (which should currently be named something like Untitled1 Properties), fill in the following: Name: helloWorldTestScript</td>
<td>Global [Script Name] Properties dialog</td>
</tr>
</tbody>
</table>

Comments: Graphical hello world test script, built using Script Author visual layout tools.

Script language: As appropriate for your environment. For example, AMERICAN for American English.

Click the Ok button to save the global script properties and return to the canvas.

**Note:** For the Name field, fill in a name under which this script will be deployed to the database. Oracle recommends using the same name as that you assigned to the .SCRIPT file in the file system, if practical.

Do not assign a file extension to this name.

For the Comments field, you may elect to fill this in with information you will find helpful to identify this particular script or script version. This field is for information only and is not processed in any way.

For the Script language field, enter the language in which this script is developed, based on the FND_LANGUAGES table of the Oracle database. For this example, ensure this field reads AMERICAN for American English.
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>Tools menu or Check Syntax Script Author Toolbar icon</td>
<td>Select Syntax Check from the Tools menu, or click the Check Syntax icon in the Script Author toolbar. Assuming all the syntax in your script is correct, a status line at the bottom of the Author will display the message &quot;Syntax check successful, with no errors.&quot; If the syntax check fails, correct any errors and check the syntax of the script again until successful.</td>
<td>Tools menu or Check Syntax Script Author Toolbar icon</td>
</tr>
<tr>
<td>66</td>
<td>File Menu or Script Author Toolbar or keyboard</td>
<td>At the File menu, select Save again, to ensure you save the Global Script properties you assigned. <strong>Note:</strong> The method used to save the document is not important. You may elect to click the Save icon in the Script Author toolbar or enter Ctrl-S from the keyboard (Command-S for the Macintosh OS).</td>
<td>File Menu or Script Author Toolbar or keyboard</td>
</tr>
<tr>
<td>67</td>
<td>Script Author Tools menu or Script Author Toolbar</td>
<td>From the Tools menu, select Deploy Script, or from the Script Author toolbar, click the Deploy Script to Database icon. Upon successful deployment, a status message appears on the bottom of the Script Author frame, &quot;Deployment to database successful.&quot;</td>
<td>Script deploys, as indicated by status message</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>68</td>
<td>Forms-based applications</td>
<td>To launch this script in the agent interface, you must perform the following actions:</td>
<td>Forms-based applications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Log into Oracle applications using the Personal Homepage login (or the Single Sign-On login, if implemented) with the appropriate responsibility to launch a script.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, to launch the script in standalone mode, the user must have the Scripting User or Scripting Agent responsibility.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• From the Navigator, select Scripting Demo Form and click Open.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Script Chooser window appears. This window is entitled Oracle Scripting.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the Script Chooser, select the appropriate script name and language.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, select helloWorldTestScript/AMERICAN.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Launch the script by clicking Start Scripting.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>69</td>
<td>Forms-based applications</td>
<td>To launch this script as a survey in a Web browser, you must perform the following actions:</td>
<td>Forms-based applications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Log into Oracle applications using the Personal Homepage login (or the Single Sign-On login, if implemented) with a user that has the Survey Administrator responsibility</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Define header section, footer section (optional), error page and final page survey resources.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, you can create references to seeded test survey resources in the Survey Resources tab. These are named IESSVYTESTHEADER.JSP, IESSVYTESTERROR.JSP and IESSVYTESTTHANKU.JSP.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If using the footer section, provide the test header section resource name for this field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create a survey campaign, cycle, and standard (non-list-based) deployment. The survey campaign must identify a deployed 11.5.6 or later test script.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Activate the deployment. When the Survey Web URL field is populated with a hyperlink, note the deployment ID (dID) by placing the cursor over the hyperlink and viewing the full survey URL in the Web browser status field. The format of the survey URL should be as follows:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>http://&lt;server&gt;..&lt;domain&gt;:&lt;port&gt;/OA_HTML/&lt;hosted or standalone survey jsp&gt;? dID=xx</td>
<td></td>
</tr>
</tbody>
</table>
Step | Perform From | Action | Result
--- | --- | --- | ---
• | | Enter the survey URL in a Web browser to launch the script in the Scripting Engine Web interface. | 
• | | Execute the script by participating in the survey to completion. | 

---

Oracle Creating a Hello World Wizard Test Script

<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Oracle Applications HTML Login</td>
<td>Log into Oracle applications using the CRM Homepage login (or the Single Sign-On login, if implemented) as a user with the Scripting Administrator responsibility.</td>
<td>The Scripting Administration console appears.</td>
</tr>
<tr>
<td>2</td>
<td>Scripting Administration console</td>
<td>From the Home tab, click Launch Script Author.</td>
<td>A new browser window opens, Oracle JInitiator launches, and the Script Author Java applet appears in a separate window.</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 3    | Script Author File Menu or Script Author Tools Menu or keyboard or Script Author Toolbar | Start the Script Wizard using one of the following methods:  
From the File menu:  
1. Select New.  
2. In the resulting New Script window, click Wizard Script.  
From the Tools menu:  
1. Select Wizard.  
2. In the Choose Create or Edit window, select Create Wizard Script and click Next.  
From the keyboard:  
1. Click ALT + T to select the Tools menu.  
2. Type W to select the Wizard option.  
3. Using the Tab key to navigate through wizard page options and the space bar to select the active option, in the Choose Create or Edit window, select Create Wizard Script and then select Next.  
From the Script Author toolbar:  
1. Click Script Wizard.  
2. In the Choose Create or Edit window, select Create Wizard Script and click Next. | The Script Wizard launches. The Define Script Properties window appears |
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Script Wizard - Define Script Properties window</td>
<td>Provide the following global script properties to this wizard script. Global script properties are properties that apply to the entire script, rather than a particular panel.</td>
<td>The wizard script is assigned global script properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Script Name: helloWorldWizardScript</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description: Hello world test script, built using Script Author Script Wizard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Language: AMERICAN</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>When complete, click Next.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Script Wizard - Define Panel Information for Panel Default Panel 1</td>
<td>Provide panel information for the first panel.</td>
<td>Panel, question, and answer choice properties generally appear at the top of each wizard page to assist you in navigating through the creation or editing process. For this new wizard script, until you click Next, none of these properties are defined. A temporary name (Default Panel 1) is automatically supplied by the wizard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Panel Name: hello</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Panel Text: Overwrite the default “Enter text here” entry and type Hello, World!</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>From this point on, only panel text values will be provided. In each case, overwrite the default text.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Panel Text Style: Spoken Text</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Text Alignment: Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Question Alignment: Left</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Exit Panel Sequence: Go to the next panel in sequence</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>When complete, click Next.</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>6</td>
<td>Script Wizard - Question Manager for Panel hello</td>
<td>After defining panel properties, if relevant, you must define question properties for each question in the panel. This is performed from the Question Manager. Since the only function for panel hello is to display panel text and a Continue button, you do not need to define any questions for this panel. Unlike when using Script Author's visual layout tools, the wizard will automatically create the Continue button to route the runtime user to the destination specified using the Exit Panel Sequence property. Based on the panel properties established in the previous step, this script at runtime will display the next panel you define. To save this one-panel script and exit, click Save, and proceed to step 18. To continue learning how to create panels, define answer types and questions, and determine panel branching, from the set of navigation buttons to the right of the Question Manager window, select Panel Manager and continue this procedure.</td>
<td>Upon selecting Panel Manager, the Panel Manager window appears.</td>
</tr>
<tr>
<td>7</td>
<td>Script Wizard - Panel Manager for Script helloWorldWizardScript</td>
<td>Once you have one or more panels defined, from the Panel Manager window you can see a list of existing panels and their status. From this window you can also create new panels, edit the properties of existing panels, copy existing panels, and delete existing panels. If more than one panel is listed here, you can also move panels higher and lower in sequence. From the set of navigation buttons to the right of the Panel Manager window, select Create.</td>
<td>Define Panel Information window appears for new panel.</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>9</td>
<td>Script Wizard - Question Manager for Panel goodbye</td>
<td>After defining panel properties, if relevant, you must define question properties for each question in the panel. This is performed from the Question Manager. For this panel you will create a question. From the set of navigation buttons to the right of the Question Manager window, select Create.</td>
<td>The Script Wizard progresses to the define question main properties window.</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 10   | Script Wizard - Define Question Main Properties | Questions have three main properties. These are similar to properties in a graphical script created using the Answer Entry dialog.  

The question name identifies this question. This is identical to the name property in a graphical script.  

The question label identifies this script to reporting features accessible through Oracle Discoverer. This is equivalent to the Label for Reporting property in a graphical script.  

The type identifies the answer control displayed at runtime. Wizard scripts can contain a text box (text), text area, radio button, drop-down list, checkbox group, multi-select list, or a password field. This is equivalent to the UI type property in a graphical script.  

Question Name: measureSuccess  
Question Label: script successful?  
Type: Dropdown  
When complete, click Next. | The Script Wizard progresses to the answer manager window. |
| 11   | Script Wizard - Answer Manager for measureSuccess Question | The answer manager provides wizard script developers the opportunity to provide answer choices to a specific question. (Answer choices are referred to as lookup values when using graphical scripts.) In this case, you will create three answer choices for the measureSuccess question you created.  

From the set of navigation buttons to the right of the Answer Manager window, select Create. | The Script Wizard progresses to the define answer choice window. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Script Wizard - Define Answer Choice for Untitled</td>
<td>The question types supported by wizard scripts include those questions that can accept only a single answer (text box, text area, password field, drop-down list or button), and those that can accept more than one answer choice (multi-select question types, including checkbox group and multi-select list question types). For text question types (text box, text area or password field answer choices), as well as checkbox group and multi-select list choices, a null answer (no input provided by end user at runtime) is also supported. Radio buttons, drop-down lists, multi-select lists, and checkbox groups must have answer choices provided by the script developer in order to display answer choices at runtime. Answer choices have two properties: the <code>answer value</code> (which is passed to the database) and the <code>answer label</code> (the answer choice viewed by the script end user). This is equivalent to lookup type value and display value fields in the data dictionary of the graphical Script Author. For this question, which will ask the script end user to determine the level of success for this test script, provide three answer choices. For the first set of answer choices, enter the following: Answer Value: Overwrite the default &quot;Untitled&quot; entry and type Unsuccessful. From this point on, only an answer value will be provided. In each case, overwrite the default text. Answer Label: Overwrite the default &quot;Untitled&quot; entry and type</td>
<td>The Script Wizard refreshes the answer manager, showing the single answer choice currently defined for this question.</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>13</td>
<td>Script Wizard - Answer Manager for measureSuccess Question</td>
<td>You must now configure another answer choice to display at runtime for this question.</td>
<td>The Script Wizard progresses to the define answer choice window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the set of navigation buttons to the right of the Answer Manager window, select Create.</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Script Wizard - Define Answer Choice for Untitled</td>
<td>For the second answer choice, enter the following:</td>
<td>The Script Wizard refreshes the answer manager, showing the two answer choices currently defined for this question.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Answer Value: Moderately successful</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Answer Label: Moderately successful</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the question “Should this be the default answer for this question,” select Yes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This version of the script will use the panel level defaults. Select Go to next default panel.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>When complete, click Next.</td>
<td></td>
</tr>
</tbody>
</table>

Unsuccessful.

From this point on, only an answer value will be provided. In each case, overwrite the default text.

You can also set a default answer choice selection. This will default in the appropriate answer control at runtime, although defaults can be changed at will.

For the question “Should this be the default answer for this question,” select No.

This version of the script will use the panel level defaults. Select Go to next default panel.

When complete, click Next.
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Script Wizard - Answer Manager for measureSuccess Question</td>
<td>You must now configure the third and final answer choice to display at runtime for this question. From the set of navigation buttons to the right of the Answer Manager window, select Create.</td>
<td>The Script Wizard progresses to the define answer choice window.</td>
</tr>
<tr>
<td>16</td>
<td>Script Wizard - Define Answer Choice for Untitled</td>
<td>For the third answer choice, enter the following: Answer Value: Very successful Answer Label: Very successful For the question “Should this be the default answer for this question,” select No. If you choose Yes, you will be reminded that this will overwrite the selection of Moderately successful as the default answer choice for this question. This version of the script will use the panel level defaults. Select Go to next default panel. When complete, click Next.</td>
<td>The Script Wizard refreshes the answer manager, showing all three answer choices defined for this question.</td>
</tr>
<tr>
<td>17</td>
<td>Script Wizard - Answer Manager for measureSuccess Question</td>
<td>You have now finished defining two panels, the second containing a single question with three answer choices. At this point, save your work. Click Save.</td>
<td>The Script Wizard progresses to the save script window.</td>
</tr>
<tr>
<td>18</td>
<td>Script Wizard - Save Script helloWorldWizardScript</td>
<td>From the save script window, for the prompt Do you want to save the script with a different name, select No. When complete, click Next.</td>
<td>The Script Wizard progresses to the continue with script save window.</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| 19   | Script Wizard - Continue With Script Save | You can choose one of the following save options:  
  - To save the current wizard script and continue editing it, select Save and continue editing.  
  - To save the wizard script in the database without deploying it, close the wizard tool, and view the Script Author canvas, select Save and exit.  
  - To save the wizard script, deploy it to the database, close the wizard tool, and view the Script Author canvas, select Save, deploy and exit.  
  Select the last option, Save, deploy and exit.  
  When complete, click Next. | The Script Wizard progresses to the create graphical script copy window. |
| 20   | Script Wizard - Create Graphical Script Copy | From this window, by clicking Yes you can view the wizard script you have completed, using Script Author’s visual tools. However, the script displayed is a copy of the wizard script. Any changes made in the resulting graphical script will not be reflected in the original wizard script, which will still be accessible to open, edit, view and deploy from the Script Wizard.  
  Select Yes and click Next. | The Script Wizard progresses to the script is complete window. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Script Wizard - Script is Complete for helloWorldWizardScript</td>
<td>Click Finish to exit the wizard and return to the Script Author canvas. The wizard script then deploys to the database per your request, and the flow you created appears on the Script Author canvas. Note that this graphical copy is entitled &quot;Copy of helloWorldWizardScript.&quot; At this point, you have the option of saving this graphical copy of the wizard script to the database or your local file system. Since you can always open the wizard script and graph a copy to use with Script Author’s graphical tools, select File &gt; Close to close the graphical Script Author without saving. In the resulting Select an Option window, click No to exit without saving.</td>
<td>Copy of helloWizardScript appears on the Script Author canvas. After closing the script, the graphical Script Author user interface appears, with no script open.</td>
</tr>
<tr>
<td>Step</td>
<td>Perform From</td>
<td>Action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>22</td>
<td>Script Author File Menu or Script Author Tools Menu or keyboard or Script Author Toolbar</td>
<td>Start the Script Wizard again, using one of the following methods:</td>
<td>The Script Wizard launches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the File menu:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select Open.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the resulting Open Script window, click Wizard script.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the Tools menu:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select Wizard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the Choose Create or Edit window, select Edit Wizard Script and click Next.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the keyboard:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click ALT + T to select the Tools menu.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Type W to select the Wizard option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Using the Tab key to navigate through wizard page options and the space bar to select the active option, select Edit Wizard Script and click Next.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>From the Script Author toolbar:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click Script Wizard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the Choose Create or Edit window, select Edit Wizard Script and click Next.</td>
<td></td>
</tr>
</tbody>
</table>
Scroll down through the list of existing wizard scripts if necessary to locate the appropriate script. Scripts are listed by global script name and include last revised date and script language. For any wizard script in the list, you can perform the following:

- To modify any panel, question, or answer choice details, select the appropriate script from the list, and from the wizard function buttons to the right of the wizard scripts table, click Edit.

- To retain the original wizard script but to make a copy of the script to modify, select the appropriate script from the list and click Copy.

- To delete the wizard script from the database, select the appropriate script from the list and click Delete.

  Caution: This will permanently delete the selected script. Unless you have made a copy of this wizard script, you will not be able to modify, edit, or execute this script after deletion.

- To create a graphical copy of this script for viewing or modification with the Script Author’s visual editing tools, select the appropriate script from the list and click Graph. This will close the Script Wizard.

- To deploy a saved wizard script to the database, select the appropriate script from the list and click Deploy.

<table>
<thead>
<tr>
<th>Step</th>
<th>Perform From</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>Script Wizard - Script Manager</td>
<td>Scroll down through the list of existing wizard scripts if necessary to locate the appropriate script. Scripts are listed by global script name and include last revised date and script language. For any wizard script in the list, you can perform the following:</td>
<td>The selected function will execute.</td>
</tr>
</tbody>
</table>
Using the Regression Test Script

Oracle provides a regression test script for the purpose of testing Oracle Scripting implementations and functionality. This script contains references to custom Java. Custom Java classes, compiled into JAR files, are included in the package and must be managed accordingly.

Prerequisites

- To create or deploy scripts using the Script Author Java applet, you must use the Scripting Administration console - to do this, you must have access to an Oracle Applications account with the Scripting Administrator responsibility.
- All implementation tasks must be accomplished.

References

Creating a Hello World Graphical Test Script, page 10-3

Steps:

To use the regression test script, perform the following:

1. Download and unzip the regression test script files.

   The regression test script is accessible from My Oracle Support Note 124522.1. To locate this, enter the document ID in the Search field in My Oracle Support. From the support document titled Oracle Scripting Regression Testing Scripts, download the associated ZIP archive and unzip this package. Included are a Script Author file, a compiled Java class file, and a packaged Java archive.

2. Using the Script Author Java applet, open the Script Author file. Note the global script name (File > Script Properties) and change this if necessary to prevent overwriting any existing script with the same name in your environment.

3. Deploy the regression test script to the database from the Script Author Java applet (Tools > Deploy Script).

   You can view deployed scripts from the Scripting Administration console (Administration tab > Deployed Scripts subtab).

4. Upload the custom Java archive file to the Oracle Applications database from the Scripting Administration console (Administration tab > Jar Listings subtab).

5. Map the script to the custom Java archive from the Scripting Administration console (Administration tab > Jar Mapping subtab).
The regression test script is now appropriately deployed, and can be tested using any Scripting Engine interface. To test using the Web interface, survey campaign requirements must be established using this script.

## Survey Administration Console Tasks

To verify your implementation for scripts to be executed in the Scripting Engine Web interface, you must establish survey campaign requirements. Steps to perform for implementations that require scripts to be executed in an Oracle Applications 12-compatible Web browser are described below.

### Prerequisites

- To use the Survey Administration console, you must have access to an Oracle Applications account with the Survey Administrator responsibility.

- All implementation tasks must be accomplished. For enterprises using Oracle Applications on the UNIX platform, you must have a display X Server set up.

- To access the Invitations tab in the Survey Administration console, you must be a member of a fulfillment group and have the JTF_FM_ADMIN role.

- To establish invitations and reminders for targeted (list-based) survey operations, functioning invitation and reminder master documents and their associated queries must exist for Oracle One-to-One Fulfillment.

- Invitations and master documents must be associated with Oracle One-to-One Fulfillment templates, as appropriate.

- To establish list information in a deployment, you must have a corresponding, accurate list of 150 or fewer records created in Oracle Marketing.

### Steps:

1. Identify existing physical survey resources or create physical survey resources to use with your script in the Web interface.

   Physical resources are the actual HTML or JSP files that display at runtime. In the case of a URL for redirect, this file typically already exists, loaded on a Web site accessible to the Apache Web server at runtime.

   For OAF survey campaigns, survey resources are not required. If you do not associate section resources with a survey campaign, no header section or footer section appears at runtime. If you do not associate page resources, application defaults are used for the error page or final page, as appropriate, at runtime.

   Physical survey resources will be required if you choose to associate survey
resources with an OAF survey campaign. No seeded HTML resources are available.

For JTT survey campaigns, you can use seeded JSP test resources to test your implementation, or you can customize your own resources based on these seeded resources. These seeded JavaServer page files (IESSVYTESTHEADER.JSP, IESSVYTESTTHANKU.JSP, IESSVYTESTERROR.JSP and IESSVYMENUBASEDERROR.JSP) are located in $OA_HTML in your environment. For error pages with a hosting type of menu-based, use the appropriate seeded resource (IESSVYMENUBASEDERROR.JSP).

2. Using the Survey Administration console, define survey resources (Survey Resources > Create).

OAF survey campaigns do not require any resources to be associated in order to execute a script in a Web browser.

- If using HTML survey resources, upload the physical HTML files into the database at the time of survey resource definition.

- If using URLs for redirect, define each URL.

For JTT survey campaigns, as a minimum, you must define a header section, error page, and final page resource.

- For JTT survey campaigns, upload to the $OA_HTML directory on the APPL_TOP the physical JSP files which correspond to survey resource definitions.

- For assistance or to obtain the correct privileges, consult with your systems administrator or your Web server administrator.

3. Using the Survey Administration console, create a survey campaign (Survey Campaign > Create). Identify the script you want to use as your survey questionnaire or Web script (for example, the Hello World or regression test script). For survey resources, reference the resources identified in steps 1 and 2 above.

- The base technology stack you select for a survey campaign cannot be changed once the survey campaign is saved. For verification purposes, select the technology stack appropriate for script execution at runtime. This determines the way the script is processed in a Web browser at runtime.

- You may choose to create a prototype survey campaign for verification. Prototype survey campaigns are identical to standard survey campaigns, except that the script used as the survey campaign questionnaire is not locked. Locking the script protects the integrity of the data collected during the course of a survey campaign. Designating the script as a prototype provides you with flexibility; in the event that one test script is not functioning, you can change the script associated with the survey campaign without needing to recreate the
survey campaign and all its dependent objects. This characteristic can only be selected or cleared while a survey campaign status is Open.

4. Within an existing survey campaign, create a cycle (as a child to the survey campaign).
   - To create a cycle from the Create Survey Campaign page, type a name in the Cycle Name field prior to clicking Create.
   - Alternatively, from the Update Survey Campaign page, in the Cycle and Deployments area, click Add Cycle, and in the Add Cycle page, type a name in the Cycle Name field and click Apply.

5. Create a deployment as a child to an existing survey campaign and cycle. From the Update Survey Campaign page, in the Deployments area, click Create.
   - For deploy date, use a date prior to or equal to SYSDATE. The time portion of the date and time string will be ignored for this parameter only.
   - For standard deployments, after providing click Create.
   - For targeted deployments, select Targeted from the Deployment Type list and click Go. In the expanded Create Survey Deployment page, include all required parameters, and click Create.

Only enter list and reminder information if you have a corresponding, accurate list created in Oracle Marketing and you have functioning invitation and reminder master documents associated with a fulfillment template using Oracle One-to-One Fulfillment functionality.

6. Activate your deployment by clicking Activate in the Update Deployment page. For appropriate deployment types, note the survey URL.

7. If scripts will be executed using the Using an Oracle Applications 12-compatible Web browser, access the survey URL (from an invitation or reminder, if a targeted survey campaign), and execute your script in the Scripting Agent Web interface. Test all paths in the script to ensure the implementation is successful.

8. Using an Oracle Applications 12-compatible Web browser, access the survey URL. If a targeted survey campaign, access the URL from an invitation or reminder. Test your script in the Scripting Engine Web interface. Test all paths in the script to ensure the implementation is successful.

**Scripting Engine Tasks**

To verify that the Scripting Engine will execute scripts, you can execute servlet tests
designed to ensure scripts will execute in the Apache mid-tier architecture.

Then, test a simple script with no custom Java (such as Hello World), and a script containing custom Java (such as regression test), using the Scripting Engine.

**Note:** Oracle recommends that all implementations test first using the agent interface. Implementations using the Web interface must then also perform the appropriate verification steps.

Each Oracle Scripting implementation includes at least one custom script. Oracle recommends, at minimum, that the first script used at an enterprise is developed by Oracle consultants or partners. In addition to testing the recommended Hello World and regression test scripts, it is recommended that you completely test your custom script prior to putting that script into production.

If custom Java is required, you must create and test your custom methods, compile and package your Java archive appropriately, and deploy the Java archive to your environment. To test these methods from Oracle Scripting, your script must contain valid references to the code, and must also be deployed to your environment.

This section includes the following topics:

- Apache Web Server Servlet Verification URLs, page 10-39
- Scripting Engine Agent Interface Verification, page 10-40
- Scripting Engine Web Interface Verification Tasks, page 10-41

### Apache Web Server Servlet Verification URLs

#### Script Servlet Verification

To execute Oracle Scripting in the agent application using the Apache Mid-Tier architecture, the Scripting Servlet must be operational.

The following URL can be used to verify that the Scripting Servlet is properly configured and operational:


A message of "up and running..." indicates success. This message must be obtained to assure that scripts can be executed appropriately.

#### Apache JServ Servlet Verification

The following URL can be used to verify that the Apache JServ servlet engine is configured and operational:
http://<servername>.<domain>:<Apache Web server port>/<servlet_zone>/IsItWorking

A message of "Yes, It's working! Congratulations, Apache JServ/<version> is working!" indicates success. Note, however, that this servlet may have been removed by system administration and is not necessarily an indication of whether the Scripting Servlet will function.

AOL Test Servlet Verification

The following URL can be used to verify that the AOL test servlet is configured and operational:


A message of "Hello World! From AOL oracle.apps.fnd.test.HelloWorldServlet" indicates success. Note, however, that this servlet may have been removed by system administration and is not necessarily an indication of whether the Scripting Servlet will function.

Scripting Engine Agent Interface Verification

Execute a script without custom Java using the Scripting Engine agent interface. For example, execute the Hello World test script to test your implementation. Then, execute a script that references custom Java using the Scripting Engine agent interface. For example, execute the regression test script to test your implementation.

**Note:** Since testing for all customized scripts is recommended at the lowest HTML interpretation engine available, steps for implementing the Scripting Engine for the agent interface are recommended to be performed for all implementations.

Prerequisites

- To verify scripts using the Scripting Engine agent interface, you must have access to an Oracle Applications account with the Scripting User or Scripting Agent responsibility. This is recommended for all implementations.

- All implementation tasks must be accomplished.

Steps:

1. Using the Scripting Engine agent interface, log into Oracle applications using the Personal Homepage login (or the Single Sign-On login, if implemented) as a user with the Scripting User or Scripting Agent responsibility.
2. From the Script Chooser, select and execute the regression test script in the Scripting Engine agent interface. Test all paths in the script to ensure the implementation is successful.

Scripting Engine Web Interface Verification Tasks

Once you can execute a script in the Web interface (based on an existing survey campaign deployment), you have verified your implementation.

Tasks

You can perform the following tasks:

• Executing a Script in the Web Interface, page 10-41

Executing a Script in the Web Interface

Prerequisites

• To verify scripts in the Scripting Engine Web interface, survey campaign requirements must be established by a survey administrator.

• Survey resources referenced by the appropriate survey campaign must exist in $OA_HTML.

• A guest user account must already be established by an Oracle CRM applications system administrator.

• Advanced JTF properties must be set up by an Oracle CRM applications system administrator.

• You must have access to a survey URL for an active survey campaign deployment.

• For targeted survey deployments, you may require a survey URL with a unique respondent ID.

Steps:

1. Using an Oracle Applications 12-compatible Web browser, access the survey URL for the survey deployment you wish to test.

2. Execute your script in the Scripting Agent Web interface. Test all paths in the script to ensure the implementation is successful.

Performing any verification task other than testing the Guest User requires you to
also perform all Survey implementation steps. These are in addition to Scripting Engine implementation tasks for all implementations and those required for the Web interface, since testing a script in the Web interface requires a survey campaign to be defined and deployed.

**Note:** Since testing for all customized scripts is recommended at the lowest HTML interpretation engine available, steps for implementing the Scripting Engine for the agent interface are recommended to be performed for all implementations.

## Testing Display Server for UNIX Environments

Implementations of Oracle Scripting using UNIX servers require a display server to be set up to process graphics in order to view reports generated under the Reports tab of the Scripting Administration console.

**Note:** Interaction Center Family Pack P and later implementations no longer require a functional display server for a survey respondent to participate in a survey.

**Note:** Interaction Center Family Pack Q and later implementations no longer require a functional display survey for the Survey Administration console.

You can verify that the display server is appropriately configured by accessing a seeded JSP test page and viewing the resulting message. The following URL can be used to verify that the display server is properly configured and operational:

```
http://<servername>.<domain>:<Apache Web server port>/OA_HTML/iestestdisplayserver.jsp
```

### References

For more information on the display server, see Setting Display Server for UNIX Environments, page 4-38.

### Viewing Server Message Logs

Use this procedure to view message logs for Oracle Scripting.
Prerequisites

- As of Interaction Center Family Pack R or later or release 11.5.10 or later, the FND: Diagnostics system profile must be set to Yes (typically at the user level) in order to access message logs.

- You must view message logs from an Oracle Applications framework application such as the Survey Administration console.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Survey Administrator

References

For specifics on the profiles required for viewing FND server logs, see Information, Error and Debug Logging Profile Options, page A-8.

Steps:

1. From the Survey Administration console, click **Diagnostics**.

   The Diagnostics page appears.

2. Select **Show Log** and click **Go**.

   The Search page appears. This is where you define criteria for message logs you want to view.

3. In the Parameters area, if you want to view message logs generated for the Oracle Applications user account under which you are currently logged in, then in the User ID field, leave the default value.

   If you want to view message logs generated for a different user, you must first obtain the FND User ID of the appropriate user. For more information, see Finding the FND User ID Value of a Defined User.

4. In the Session ID field:
   - If you do not want message logs to be restricted to any session, then delete any value appearing in this field.
• If you want to view message logs for your current session, then leave the default value.

• If you know the session ID for a different session for which you explicitly want to view message logs, type this value.

5. Optionally, in the Message Text field, enter any message text you want to find.

6. Optionally, in the Begin Date field, select a date from which message logs were generated.

7. Optionally, in the End Date field, select the last date for which you want to retrieve message logs.

8. In the Categories area, clear any logging levels for which you do not want to view message logs.
   These are listed in sequence from least amount of information (and most critical) to most information.
   For example, clear all values except Unexpected and Error.

9. In the Module field, if you want to restrict message logs to a particular product or set of Java classes, enter your filter criteria.
   For example, to restrict message logs to all messages logged for Oracle Scripting, enter IES% or ies%. To restrict messages to the Scripting Engine component, enter IES.ENGINE% or ies.engine%.
   Include the percent (%) sign, which designates that you want to see all logs in the designated category.

10. Optionally, in the Sequence area, define a sequence.

11. Click Go.
   After processing, the Search field refreshes. Message logs meeting the specified criteria appear in the Results area.

12. If you want to export the message logs, click Export.

13. If you want to return to the Survey Administration console, click Return to Application.
This chapter covers the following topics:

- Introduction
- Integration by Component
- Integration by Technology Stack
- Prebuilt Integration with Oracle Applications
- Integrating with Oracle TeleSales
- Launching Any Deployed Script from Oracle TeleSales
- Launching a Specific Script from Oracle TeleSales
- Effects of OTS Profile Settings for Oracle Scripting
- Parameters Passed to the Scripting Blackboard
- Integrating with Oracle TeleService
- Launching Any Deployed Script from Oracle TeleService
- Launching a Specific Script from Oracle TeleService
- Obtaining Values in a Script from Oracle TeleService
- Creating Service Requests in Oracle TeleService from Oracle Scripting
- Integrating with Oracle Marketing

Introduction

There are various ways to view integration of Oracle Scripting. Since Oracle Scripting consists of several components, you can consider integration from this perspective. Since Scripting involves technologies using applications built with Oracle Forms Developer (referred to as Oracle Forms-based applications) and applications using Java Server Pages (JSP) technology built on HTML, you can consider integration by technology stack. Finally, Scripting includes pre-built integration, while also allowing
custom integration with Application Program Interfaces (APIs). Integration can also be described from this perspective. Each is described in turn below.

This section includes the following topics:

- Integration by Component, page 11-2
- Integration by Technology Stack, page 11-7
- Prebuilt Integration with Oracle Applications, page 11-13

Integration by Component

Oracle Scripting consists of Script Author, Scripting Engine, Scripting Administration console, and Survey Administration console. Each has different integration considerations.

This section includes the following topics:

- Script Author, page 11-2
- Scripting Engine, page 11-3
- Scripting Administration Console, page 11-6
- Survey Administration Console, page 11-6

Script Author

The Script Author is the component of Oracle Scripting used to create, modify and deploy scripts. As of Oracle Applications release 11.5.8 (CRM Family Pack P), Script Author is a Java applet that is launched from an existing Oracle Applications session.

To launch Script Author, log into Oracle applications using the CRM Homepage login (or the Single Sign-On login, if implemented) as a user with the Scripting Administrator responsibility, and click Launch Script Author from the Home tab of the Scripting Administration Console. Oracle JInitiator launches in a separate browser window, and then Script Author opens in a separate applet window on the client. Since the connection is established and associated with a specific database and applications instance, using the Script Author Java applet allows script developers to open, save, and deploy scripts to and from that database instance. Database connection information is not required to be specified to save commands to the command library or to import library commands into a script.

The Script Author Java applet replaces a standalone Script Author Java application available in prior releases which required a Windows operating system on the client. Using the standalone application also required the client to be on the same side of the firewall as the applications database, and necessitated apps database user access to deploy scripts or otherwise access the database.
The Script Author applet can be used on the same computer as any other Oracle Application, but as a Java applet is not in itself integrated with other applications.

**Scripting Engine**

The Scripting Engine is the runtime component of Oracle Scripting. Scripts created using Script Author are executed in one of two following interfaces:

- Scripting Engine Agent Interface, page 11-3
- Scripting Engine Web Interface, page 11-4

**Scripting Engine Agent Interface**

The first of the Scripting Engine's two interfaces is the agent interface, which is a set of Java components wrapped in an Oracle form. Users of the agent interface are typically interaction center agents. The Scripting Engine agent interface provides enterprises with a method of scripting interactions with customers or prospects and integrating desktop workflow between various applications.

Integration with the Scripting Engine agent interface occurs in three ways:

- Scripts can be launched from integrated Forms-based business applications (Oracle TeleSales and Oracle TeleService).

  **Note:** In previous releases, scripts could also be launched from Oracle Collections.

- Scripts can get, create, or update records in the applications database or in custom tables.

- Scripts can get or set information from any open Oracle form in Oracle TeleService, using the Script Author Forms commands `setValueInForm` and `getValueFromForm`.

- Using custom Forms commands, scripts may get and set information from some other Forms-based applications.

The agent interface is intended to be used in combination with integrated Oracle E-Business Suite applications to take full advantage of the contact handling, sales, or service features of those applications. Interaction centers leveraging business applications and the Scripting Engine agent interface therefore have the full benefit of interaction center communications.

Agents can also execute scripts in "standalone" mode, without accessing other applications. In the standalone model, integration is typically limited to reading or writing to the Oracle applications database. Login to an Oracle Applications session is still required. Execution of scripts in standalone mode is not supported by Oracle.
Scripting Engine Web Interface

The Scripting Engine Web interface executes scripts in any Oracle Applications 12-certified Web browser. Scripts executed in the Web interface rely on survey campaign information administered using the Survey component.

Self-Service Web Application Integration

The Scripting Engine Web interface is integrated with self-service Web applications such as Oracle iSupport. After using the application, customers can be surveyed regarding their self-service Web application experience by clicking on a hypertext link provided in the application interface. This links to a URL for an activated survey campaign deployment.

With customization to add the valid URL of any activated survey deployment, any Oracle self-service Web application is integrated with the Scripting Engine Web interface.

Targeted Deployment Integration with Oracle Marketing and TCA

For execution of targeted survey deployments, HTML invitations and reminders are sent from Oracle One-to-One Fulfillment to list members of Oracle Marketing lists, inviting those members to participate in a survey or Web script by accessing a valid survey URL. The survey URL includes a JSP template parameter, defining how the script executes in a Web browser at runtime. It also identifies the deployment (dID), and each individual potential respondent (using the parameter rID).

Additional information is also appended to the survey URL, which makes that information available to the Scripting blackboard during execution of the script. Parameters passed include the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Blackboard Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>apps user ID</td>
<td>IES_FND_USER_NAME</td>
<td>User name for the current apps session.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If deployment is standalone, this is the ID of the apps guest user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If deployment is menu-based, this is the ID of the logged-in apps user.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Blackboard Key</th>
<th>Description</th>
</tr>
</thead>
</table>
| parent party ID   | P_PARTY_ID             | • If contact type is an organization, this is the party ID of the organization.  
• If contact type is a person, this is the party ID of the person. |
| contact party ID  | P_CONTACT_PARTY_ID     | • If contact type is an organization, this is the party ID of the contact person within the organization.  
• If contact type is a person, this value is null. |

**Guidelines**

- These parameters are only passed for targeted deployments.
- The apps user ID identifies the apps-level guest user if the hosting option is standalone. If it is menu-based, this parameter holds the Oracle Applications user name of the person currently logged in when the script is executed.
- The parent party ID and the contact party ID are data items from the trading community architecture (TCA).
- The parent party ID and the contact party ID are passed from columns stored in the AMS_LIST_ENTRIES table within the Oracle Applications schema.
  - The parent party ID column in AMS_LIST_ENTRIES, PARENT_PARTY_ID, is stored in the blackboard as blackboard key P_PARTY_ID.
  - The contact party ID column in AMS_LIST_ENTRIES, PARTY_ID, is stored in the blackboard as blackboard key P_CONTACT_PARTY_ID.
- Because TCA accounts for contacts that are either the primary party or a contact within an organization, you must understand how TCA handles data differently for each situation. For example, P_PARTY_ID could either be the name of a person or of an organization. Accordingly, CONTACT_PARTY_ID will be null when both fields are not required (when the contact type is a person).
• If the party type of a selected contact is an organization, then the P_PARTY_ID parameter holds the name of the organization. In this case, the name of the specific contact person within the organization is stored in the parameter P_CONTACT_PARTY_ID.

• If the party type of a selected contact is person, then the P_PARTY_ID parameter holds the name of the person. In this case, the parameter P_CONTACT_PARTY_ID is null.

### Scripting Administration Console

The Scripting Administration console is an HTML administration console built on the deprecated JTT technology stack. This console is accessed by logging into Oracle HTML-based applications using an Oracle Applications user account with the Scripting Administrator responsibility. Using the Scripting Administration console, script administrators can launch Script Author as a Java applet, administer deployed scripts and custom Java archive files, and view panel footprint reports.

There is no integration between this component and other Oracle Applications. Like other HTML applications, users with multiple responsibilities can access other application functionality by changing the current responsibility for the authenticated Oracle Applications session.

### Survey Administration Console

The Survey Administration console is an HTML administration console built on the Oracle Applications framework. Using the Survey Administration console, survey administrators create, administer, and deploy survey campaigns and monitor progress in existing survey campaign deployments.

The Survey Administration console integrates directly with Oracle Marketing and Oracle One-to-One Fulfillment by hosting tabs from those HTML-based applications in the administration console. These tabs are the Audience tab and the Invitations tab, respectively.

### Same Restrictions Apply

The same business rules, prerequisites, and requirements for accessing the user interface of integrated applications also apply to the survey administrator.

For example, to access the Invitations tab, the user requires not only the Survey Administrator responsibility, but also must be assigned the JTF_FM_ADMIN_ROLE role. For more information, see Granting JTF Roles, page 5-14.

The invitations tab provides access from the survey administration console to the same application pages that you can access using the Template, Query, and Status subtabs in the Fulfillment Administration console. Note that a fulfillment administrator is still required to set up fulfillment servers, groups, and to monitor fulfillment requests.
In addition to survey-specific functionality, the survey administration console provides access to an Audience tab. This tab displays the same content that you can see in the Oracle Marketing user interface under the Audience tab (for Oracle Marketing releases prior to 11.5.10) or the Audience Workbench tab (for Oracle Marketing release 11.5.10 and later). To access this tab from the Survey Administration console, the Oracle Applications user account must have a sales group ID and a sales role. These are administrative setup steps required to be performed by a user with the CRM Resource Manager responsibility. You can also configure the Survey Administrator responsibility to bypass this requirement. For this procedure, see Bypassing the Sales Resource Group Membership Requirement, page 5-13.

**Integration by Technology Stack**

This section includes the following topics:

- HTML-Based Integrated Applications, page 11-7
- Forms-Based Integrated Applications, page 11-11

**HTML-Based Integrated Applications**

This section includes the following topics:

- Oracle Self-Service Web Applications, page 11-7
- Oracle One-to-One Fulfillment, page 11-10
- Oracle Marketing, page 11-10

**See Also**

- Forms-Based Integrated Applications, page 11-11

**Oracle Self-Service Web Applications**

Using self-service Web-based applications such as Oracle iSupport, customers can launch a script in the Scripting Engine Web interface, and execute it using a Web browser.

*Note:* While this section describes application functionality within context of Oracle iSupport, scripts in this interface can be hosted in any Oracle self-service Web application.

When Oracle Scripting is integrated with self-service Web applications such as Oracle iSupport, users log into the application using an Oracle Applications 12-certified Web browser and a user with the appropriate responsibility.
Users then access a page in the UI with one or more hypertext links. These links are created through application customization, in which an application administrator previously customized the UI to include, within the code for each hypertext link, a valid survey URL for an active standard survey campaign deployment.

From this page, the application user clicks the hypertext link. The page refreshes, displaying the survey questionnaire’s first panel as an HTML page in the same Web browser instance. If the survey campaign details specify a survey resource header section or footer section, these appear on each HTML page of the script.

Each page (corresponding to a single script panel) contains one or more question controls, including at minimum a submit button (typically labeled Continue). Clicking the Continue button progresses the script to the next panel, which appears as a separate HTML page.

If an error results, or when the script is complete, the survey resources designated as the error page or final page display, as appropriate.

**Hosting Options and Technology Stacks**

There are two hosting options for survey deployments: Menu Based and Standalone.

For deployments designated as menu-based, the navigational menus (tabs) of the self-service Web application are retained at the top of each page throughout. These are also referred to as hosted surveys or Web scripts. In all cases, hosted deployments use the Oracle Applications authentication information for an existing session. After a hosted survey is completed, the user can continue to use the application from which a script is launched in the Web browser.

For deployments set as standalone, the Oracle Applications session (always required in order to execute a script) is initiated using a guest user. The only privilege granted to the guest user is to execute the Web script or survey specified by the survey campaign. After the script completes its execution and the final page is displayed, the Oracle Applications session is de-authenticated.

For standard (non-list-based) Web scripts or surveys using the Oracle Applications framework, the session will always be hosted, if the survey URL is selected from an authenticated Oracle Applications session. This is because all Scripting Engine Web interface transactions using the Oracle Applications framework use the same JavaServer page, OAJSP, as the template from which to execute all scripts. Upon completion of the script in the Web browser, the Oracle Applications session is still valid, and you can return to other functions in that application.

In contrast, targeted (list-based) Web scripts or surveys do not support the menu-based hosting option if using the Oracle Applications framework. Regardless of the hosting option selected, the applications guest user will initiate the Oracle Scripting session. Even if the user is logged into an Oracle self-service Web Application when a link to an active targeted survey URL is selected, the menus from any open self-service Web application will not be hosted in the Web browser at script runtime. Upon completion of the script, any active Oracle Applications session will expire; you can do no additional work in the open application without logging back into the application.
If the Base Tech Stack setting for the survey campaign is Deprecated - JTT, you can control whether a script executed in a Web browser is hosted in the self-service Web application’s UI (and the session remains open upon script completion), or whether guest user authentication is used to run the script, and the applications session is terminated upon script completion. This hosting option (and the Oracle Scripting session authentication method) is determined by the JSP template parameter used in the survey URL. If the survey URL includes IESSVYMENUBASED.JSP, then the application uses the authentication of the existing Oracle Applications session. If the survey URL includes IESSVYMAIN.JSP., then the guest user Oracle Applications account is used to authenticate a new session, and is restricted to executing a script only. Upon completion of the script in the Web browser, the Oracle Applications session is terminated.

When defining targeted survey campaign deployments, there is a hosting options list selection. For JTT survey campaigns, when the survey administrator selects Standalone, the JSP template parameter IESSVYMAIN.JSP is used, and when the administrator selects Menu Based, the IESSVYMENUBASED.JSP template is added to the survey URL.

As indicated above, for an OAF deployment, even if Standalone is selected, if the survey URL is clicked from a valid Oracle Applications session, it will be hosted in the application’s user interface.

To force a script to execute using guest user authentication using the Oracle Applications framework (in other words, to force it to execute with a standalone hosting option), copy the survey URL and paste it into a separate Web browser session with no current authentication and no valid cookie to a current authenticated session. For example, if you are using Oracle Applications with Netscape Communicator in an application such as Oracle iSupport, copy the survey URL, paste it into the Address field of a different supported Web browser (such as Microsoft Internet Explorer). Then the session will use the seeded guest user account for authentication. At the end of any session using the guest user, the Oracle Applications session will be terminated.

For more information, see the Survey URL topic in the Oracle Scripting User Guide.

For hosted surveys using the OA framework, you can redirect the user to any URL defined as a survey resource, upon script completion in the Web browser.

For hosted surveys using the JTT framework, you can designate the page listing survey links as the Final page survey resource, if you define it as a survey resource. As a script user, after you complete the Web script or survey, you return to the page from which you launched the survey script. Other links on that page can be customized as desired by Oracle iSupport administrators.

For hosted surveys using the JTT framework, you can use the test resource IESSVYMENUBASEDTESTERROR.JSP (seeded with Oracle Applications) as the basis for your error page. Some customization is required.

**Guidelines**

- From the user interface of Oracle iSupport or another hosted self-service Web application, the user clicks a hypertext link for an active survey URL. The survey or
Web script starts in the current Web browser window, preserving the menu structure.

• The survey is expected to be completed in order to deliver reliable information. Abandoned survey responses are tracked but not displayed in most reports.

• Upon completion of the script, you can continue working in the hosted application, as the Oracle Applications session remains valid.

Oracle One-to-One Fulfillment

Oracle One-to-One Fulfillment provides enterprises with an automated method for sending information to its customers. Interaction center agents use Oracle One-to-One Fulfillment directly or through automated applications such as Oracle Marketing. Agents often receive customer requests for information, literature, and other correspondence. These requests include product and service inquiries, pricing questions, billing inquiries, and general customer care issues. Agents can immediately fulfill these requests using e-mail to automatically deliver predefined fulfillment items to identified customers.

Oracle One-to-One Fulfillment is set up and maintained by a Fulfillment administrator, who must configure and run a Fulfillment Server to monitor fulfillment requests, and a Fulfillment Email Server (a logical channel for the output device that delivers electronic documents to customers).

From an Oracle Scripting perspective, Oracle One-to-One Fulfillment can be used to deliver “invitation” and “reminder” master documents (HTML documents) using electronic mail, inviting identified parties to participate in a survey campaign by visiting a defined URL.

The parameters required for integration with Oracle One-to-One Fulfillment for inviting potential respondents via e-mail to participate in a survey are included in the deployment details section of the Survey Administration console.

The Survey Administration console also includes an Invitations tab, which hosts Oracle One-to-One Fulfillment functionality. Survey administrators that need to access this tab must be assigned the JTF_FM_ADMINROLE role. For more information, see Granting JTF Roles, page 5-14.

References

• Granting JTF Roles, page 5-14

• Survey Administration Console, page 11-6

Oracle Marketing

Oracle Marketing is a tool used to create and manage marketing and sales campaigns, assign scripts to particular campaign schedules, assign agents to specific campaigns, etc. You can create lists of customers in Oracle Marketing, and invite them using e-mail.
Integrating Oracle Scripting

(using Oracle One-to-One Fulfillment "invitation" and "reminder" master documents) to participate in a survey campaign by visiting a defined URL.

The parameters required for integration with Oracle Marketing to use existing marketing lists as the source for sending e-mail invitations and reminders are included in the deployment details section of the Survey Administration console.

The Survey Administration console also includes an Audience tab, which hosts Oracle Marketing functionality. The Oracle Applications user account for survey administrators that need to access this tab must have a sales group ID and a sales role. For more information, see Bypassing the Sales Resource Group Membership Requirement, page 5-13.

References

• Bypassing the Sales Resource Group Membership Requirement, page 5-13

• Survey Administration Console, page 11-6

Forms-Based Integrated Applications

Oracle Forms-based E-Business Suite applications that integrate with Oracle Scripting include Oracle TeleSales and Oracle TeleService.

Note: Oracle Collections was integrated with Oracle Scripting in earlier releases.

From an interaction in these integrated business applications, an agent can launch a script in the Scripting Engine agent interface. Each business application supports at least two models: (1) allowing the agent to select any script from a list of deployed scripts for that instance, and (2) specifying a particular script to launch upon a particular condition or action. No additional configuration is required to enable the first model. To enable launch of a particular script, specific setup steps are required, which vary by application. Each of these is discussed in the section for integrating the particular business application. For more information, see Oracle Scripting Implementation Guide and the implementation guide for each specific application in question.

To execute scripts in the agent interface, the agent’s Oracle Applications account must have the correct responsibility associated with it to launch the business application in question. The table below indicates, by application, responsibilities which may be required, and from which form in the application the script can be launched.

<table>
<thead>
<tr>
<th>Business Application</th>
<th>Required Responsibility</th>
<th>Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle TeleSales</td>
<td>TeleSales Agent</td>
<td>eBusiness Center</td>
</tr>
</tbody>
</table>
Other responsibilities for a particular business application may also have access to execution of scripts. The ones listed in the table above are established for agent-level privileges. For more information, consult the product documentation for the appropriate application.

Each of these Oracle Forms-based business applications are typically used by interaction center agents for sales or service, respectively. The functionality of these business applications can be greatly extended and customized by creating and using scripts launched from the appropriate business application.

### Guidelines

- After logging into the appropriate business application, no specific Scripting responsibilities are required for an agent to launch a script.
- These scripts are launched in the Scripting Engine agent interface in a separate window.
- If choosing from the full list of deployed scripts, the agent must select the appropriate script name and language from the Script Chooser list.
- The script is expected to be completed prior to returning to the business application.
- If the script commits changes to the customer information in the database, these changes *will not* be reflected in the business application until a fresh request for customer information from the database is made from the business application.
- Individual implementation, setup, or configuration steps may be required in order to access the business applications listed above. For example, membership in a sales or telesales group (for Oracle TeleSales) is required. Other conditions may apply for each application. These steps are outside the scope of this document. For more information, refer to the appropriate documentation for the relevant business application.

### References

For relevant information regarding Oracle Forms-based applications, refer to *Oracle Applications Developer’s Guide*. Specifically, refer to the section Menus and Function Security.
Prebuilt Integration with Oracle Applications

Interaction centers using the Scripting Engine agent interface can not only interact with customers but can also integrate desktop workflow between various applications. Oracle Scripting is intended to be used in combination with integrated Oracle E-Business Suite applications (Oracle TeleService and Oracle TeleSales) to take full advantage of the service and sales features of those applications, respectively. In terms of prebuilt integration, scripts can be launched from any of these customer-facing, interaction-based business applications. Additionally, Oracle TeleSales automatically sends values for a selected customer to the Scripting blackboard for use in a script interaction.

**Note:** Oracle Collections was integrated with Oracle Scripting in earlier releases.

Oracle Marketing is seeded with several Oracle Scripting building block scripts. These enable users of Oracle Marketing to authenticate customers, register for an event, create leads, and so on.

This section includes the following topics:

- Integrating with Oracle TeleSales, page 11-13
- Integrating with Oracle Marketing, page 11-26

Integrating with Oracle TeleSales

This section includes the following topics:

- Launching Any Deployed Script from Oracle TeleSales, page 11-14
- Launching a Specific Script from Oracle TeleSales, page 11-14
- Parameters Passed to the Scripting Blackboard, page 11-18

See Also

- Associating a Script to a Campaign, page 9-10
- Associating a Script to a Campaign Schedule, page 9-9
Launching Any Deployed Script from Oracle TeleSales

Steps:
1. From the Navigate To menu, select All Scripts.
   The Oracle Scripting window (commonly referred to as the Script Chooser) appears.
2. From the Script Chooser, select a script name and language.
3. Click Start Scripting.
   The script will launch in a separate window.

Launching a Specific Script from Oracle TeleSales

From Oracle TeleSales, you can launch in the Scripting Engine agent interface a designated script deployed to your Oracle Applications instance, leveraging Oracle Marketing campaign information.

There are three models for launching this designated script:
• Automatic launch of a specific script when a call is received.
• Automatic launch of a specific script when an interaction is started in the eBusiness Center.
• Launch of a specific script based on explicit agent request (agent clicks View Script button).

Oracle Marketing Campaign Administration Requirements

To designate the specific script to launch from Oracle TeleSales using any of these models requires the script to be designated at the campaign schedule level. As a prerequisite of launching a designated script, you must administer campaigns in Oracle Marketing. Oracle Marketing requirements include the following:
• A valid campaign.
• A valid campaign schedule associated with the campaign.
• An inbound or outbound script associated with the campaign schedule.
• Agents must be associated to the campaign schedule, or campaign schedules must be assigned to agents.

For more information on these steps, see Oracle Marketing product documentation or
the topic Administering Campaigns in Oracle Marketing, page 9-2.

Obviously, there is no explicit action to be taken by the agent for automatic launch of a script. Based on the type of automatic launch (on call delivery or on start of interaction), when the event or condition is met, the script launches in a separate window. The procedure below applies to launching a specified script from the eBusiness Center at a time chosen by the agent.

Specific profile settings are required to accomplish each method of launching a specified script. These are described in the guidelines below.

Prerequisites

- At least one appropriate script must be deployed from Script Author to the applications database.
- If custom code is referenced in the script, that code must be available to the Scripting Engine at runtime.
- A campaign must exist in Oracle Marketing with a valid campaign schedule, and the agent using the appropriate business application must be associated with the campaign schedule associated with the campaign.
- The specific deployed script must be associated to either the campaign schedule from Oracle Marketing in order to launch without accessing the Script Chooser.
- System profiles must be set according to the guidelines indicated.
- Oracle TeleSales sends a set of values for the selected customer to the Scripting blackboard when a script is launched from the eBusiness Center. In order to receive those values and use them in a script, the agent must be in an active Oracle TeleSales transaction with a customer selected in the eBusiness Center.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

TeleSales Agent

Guidelines

- As indicated above, campaign administration of Oracle Marketing is required.
- For any model of launching scripts from Oracle TeleSales, set the OTS: Scripting
Installation profile to Yes.

- For any model of automatically launching a specified script, also set the OTS: Script Launch on Interaction profile to Yes.

- For Oracle TeleSales to launch a script upon delivery of the call to the agent desktop only, also set the OTS: Script Launch on UWQ Delivery profile to Yes.

- For more information about the OTS profile options relevant to Oracle Scripting, see Effects of OTS Profile Settings for Oracle Scripting, page 11-16.

**Steps:**

1. Ensure a customer is selected in the eBusiness Center.

2. Ensure a campaign is selected in the Overview tab.
   
   The selected campaign, or a campaign schedule associated with the campaign, must have a script associated with it.

3. From the Navigate To menu, select View Script, or from the Overview tab, click View Script.
   
   The script will launch in a separate window.

**Effects of OTS Profile Settings for Oracle Scripting**

The following table describes the effects of the OTS profile settings for Oracle Scripting:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Setting</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>OTS: Script Launch on UWQ Delivery</td>
<td>Yes</td>
<td>Automatic launch of a specific script in a separate window when a call is received in Oracle TeleSales.</td>
</tr>
<tr>
<td>OTS: Script Launch on UWQ Delivery</td>
<td>No or Null</td>
<td>No script launches on call delivery.</td>
</tr>
<tr>
<td>OTS: Script Launch on Interaction</td>
<td>Yes</td>
<td>When an Oracle TeleSales interaction starts, the specified script automatically launches in a separate window.</td>
</tr>
</tbody>
</table>
### Integrating Oracle Scripting

**Profile Option** | **Setting** | **Result**  
--- | --- | ---  
OTS: Script Launch on Interaction | No or Null | No script launches on start of interaction.  
OTS: Scripting Installation | Yes | This setting allows scripts to be launched from Oracle TeleSales.  
OTS: Scripting Installation | No | Regardless of other profile settings, if set to no, scripts will not launch from Oracle TeleSales.  

---

#### Launching a Specified Script on Call Delivery to Agent Desktop

**Profile Option** | **Setting**  
--- | ---  
OTS: Script Launch on UWQ Delivery | Yes  
OTS: Script Launch on Interaction | Yes  
OTS: Scripting Installation | Yes  

#### Launching a Specified Script Automatically on Start of Interaction

**Profile Option** | **Setting**  
--- | ---  
OTS: Script Launch on UWQ Delivery | No or null  
OTS: Script Launch on Interaction | Yes  
OTS: Scripting Installation | Yes  

#### Launching a Specified Script When Agent Clicks View Script
<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>OTS: Script Launch on UWQ Delivery</td>
<td>No or null</td>
</tr>
<tr>
<td>OTS: Script Launch on Interaction</td>
<td>No</td>
</tr>
<tr>
<td>OTS: Scripting Installation</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Parameters Passed to the Scripting Blackboard

Oracle TeleSales integrates with Oracle Scripting by passing parameters from a current Oracle TeleSales interaction to the Scripting Blackboard each time a script is launched from Oracle TeleSales. The parameters passed are listed in the table below, and mostly relate to the Trading Community Architecture.

### Trading Community Architecture

The Oracle Trading Community Architecture (TCA) is a data model that provides a virtual representation of the community in which that business is conducted. This model includes parties and related party entities.

A party is defined as a person, organization, relationship, or collection of parties that can enter into business relationships with other parties. TCA is used by Oracle Applications to store sets of information in the database about our customers. If an individual is a customer, the party type is Person. If an organization or enterprise is a customer, then the party type is Organization. Relationships or groups further define specific individuals or groups of individuals as contacts within an organization. The TCA model is valuable because, with strategies to store and access information in specified tables and columns and business rules to govern these, the same database schema is used despite whether the business relationship is business-to-business (B2B) or business-to-consumer (B2C).

The following list shows the parameters currently being sent by Oracle TeleSales to the Scripting blackboard:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDRESS_ID</td>
<td>Location ID</td>
<td>For PARTY_TYPE of RELATIONSHIP, Address ID is not related to a given PARTY_ID</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AST_RESOURCE_ID</td>
<td>Resource ID</td>
<td>This resource ID is derived from the global variable AST_RESOURCE_ID from Oracle Marketing.</td>
</tr>
<tr>
<td>CAMPAIGN_ID</td>
<td>Source Code ID</td>
<td>If a campaign is associated with a campaign schedule, this is the ID associated with the campaign source code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Otherwise, this value is null.</td>
</tr>
<tr>
<td>CAMPAIGN_NAME</td>
<td>Campaign name</td>
<td>If a campaign is associated with a campaign schedule, this is the name of the campaign.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Otherwise, this value is null.</td>
</tr>
<tr>
<td>CAMPAIGN_SOURCE_CODE</td>
<td>Source Code</td>
<td>If a campaign is associated with a campaign schedule, this is the source code associated with the campaign.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Otherwise, this value is null.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you do not provide a source code in Oracle Marketing, a unique code is generated by the system.</td>
</tr>
<tr>
<td>CONTACT_ID</td>
<td>Person Party ID</td>
<td>Contact ID if the selected contact is a party type of person. Otherwise, this value is null.</td>
</tr>
<tr>
<td>CUST_ACCOUNT_ID</td>
<td>Account ID</td>
<td>The account ID for this party.</td>
</tr>
<tr>
<td>INTERACTION_ID</td>
<td>Interaction ID</td>
<td>The interaction ID from the eBusiness Contact Center for the interaction record of the given party type.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>P_PARTY_ID</td>
<td>Party ID of the account owner.</td>
<td>For an individual, the Person ID of the selected party. For a relationship customer, the organization party ID will be passed.</td>
</tr>
<tr>
<td>PARM.PARTY_ID</td>
<td>Party ID of the account owner.</td>
<td>For an individual, the Person ID of the selected party. For a relationship customer, the organization party ID will be passed.</td>
</tr>
<tr>
<td>PARTY_CONTACT_ID</td>
<td>Organization Party ID</td>
<td>Contact ID if the selected contact is a party type of organization. Otherwise, this value is null.</td>
</tr>
<tr>
<td>PARTY_ID</td>
<td>Party ID of the account owner.</td>
<td>For an individual, the Person ID of the selected party. For a relationship customer, the organization party ID will be passed.</td>
</tr>
<tr>
<td>PARTY_TYPE</td>
<td>Party type</td>
<td>Identifies the party relationship: person, organization, or relationship.</td>
</tr>
<tr>
<td>TMANI</td>
<td>ANI</td>
<td>This parameter (automatic number identification or ANI) indicates the billing number from which an inbound call originates. This is sometimes referred to as the caller ID.</td>
</tr>
</tbody>
</table>
Parameter | Description | Comments
--- | --- | ---
TM_DNIS | DNIS information | This parameter indicates the number from which an inbound call originates. The Dialed Number Identification Service (DNIS) parameter indicates which number for an inbound call was dialed by the caller. DNIS information is often used for call routing or to separate campaigns and functions.

Obsolete Parameters

The following parameters are no longer supported using this model:

Parameter | Description | Comments
--- | --- | ---
COLLATERAL_ID | Obsolete | Not applicable in this release.
EVENT_ID | Obsolete | Not applicable in this release.
LEAD_ID | Obsolete | Not applicable in this release.
OPP_ID | Obsolete | Not applicable in this release.
P_RESOURCE_ID | Obsolete | Not applicable in this release.
SOURCE_FORM_ID | Obsolete | Not applicable in this release.
SOURCE_FORM_FUNCTION | Obsolete | Not applicable in this release.

Guidelines

- Values are passed each time a script is launched from the eBusiness Center.
- Any parameters not available from the integrated Oracle business application will be null in the Scripting Blackboard.
• A customer must be selected in Oracle TeleSales in order to receive some or all values into the script.

• If a script relies on values passed from Oracle TeleSales for critical processing, the script should include a test for a null value before attempting the process. If a null value is found, the script should include panels to collect the required information at runtime, populating them with the appropriate blackboard answer keys to ensure the script can continue its processing.

• If a blackboard value retrieved into a script is subsequently changed in the business application before the script is completed, the updated value will not display in the script. If the script is completed and started again, the updated value will be retrieved into the script.

Integrating with Oracle TeleService

This section includes the following topics:
• Launching Any Deployed Script from Oracle TeleService, page 11-22
• Launching a Specific Script from Oracle TeleService, page 11-23
• Obtaining Values in a Script from Oracle TeleService, page 11-25
• Creating Service Requests in Oracle TeleService from Oracle Scripting, page 11-26

Launching Any Deployed Script from Oracle TeleService

Using Oracle TeleService, you can launch a script of your choice in the Scripting Engine agent interface from the full set of scripts deployed to your Oracle Applications instance.

Prerequisites

• At least one appropriate script must be deployed from Script Author to the applications database.

• If custom code is referenced in the script, that code must be available to the Scripting Engine at runtime.

• System profiles must be set according to the guidelines indicated below.

• If the script being called uses any Forms commands from any TeleService form, that form must be open and appropriately populated with information in the Contact Center for those values to be made accessible to the script.
Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Customer Support

Guidelines

- For Oracle TeleService to launch a script upon delivery of the call to the agent desktop, the following profile must be set:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Care: Automatically Launch a Script for Identified Callers</td>
<td>&lt;global script name&gt;</td>
</tr>
</tbody>
</table>

Note: In some cases, this profile option display value may be Customer Care: Default Contact Center Script.

Steps:

1. Ensure a customer is selected in the Contact Center.

2. From the Tools menu, select Script, or click on the Script icon in the toolbar.
   The Oracle Scripting window (commonly referred to as the Script Chooser) appears.

3. From the Script Chooser, select a script name and language.

4. Click Start Scripting.
   The script will launch in a separate window.

Launching a Specific Script from Oracle TeleService

Using Oracle TeleService in a media-enabled environment, you can automatically launch a designated script in the Scripting Engine agent interface. As soon as a call is delivered to the Oracle TeleService Contact Center, if at least one of three parties is identified, the designated script launches in a separate window. In the event that a party is not identified (the TeleService screen pop is blank), the script is not launched.
Only one of three possible parties (organization, person, or relationship) is required to launch the script, as identified by the HZ_PARTIES table in the Oracle Applications schema.

There is no explicit action to be taken by the agent for automatic launch of a script other than appropriate setup, as indicated in the guidelines below.

Prerequisites

- Oracle TeleService must be media-enabled.

- To launch a designated script automatically, the calling party (rel party) must be identified.

- At least one appropriate script must be deployed from Script Author to the applications database.

- If custom code is referenced in the script, that code must be available to the Scripting Engine at runtime.

- System profiles must be set according to the guidelines indicated below.

- If the script being called uses any Forms commands from any TeleService form, that form must be open and appropriately populated with information in the Contact Center for those values to be made accessible to the script.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

Customer Support

Guidelines

- For Oracle TeleService to launch a script upon delivery of the call to the agent desktop, the following profile must be set:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Care: Default Contact Center Script</td>
<td>&lt;global script name&gt;</td>
</tr>
</tbody>
</table>
Steps:
1. From the Navigator, select Contact Center and click Open.
   The Contact Center window opens.
2. When a call is received, the designated script launches in a separate window.
3. Complete interaction within the script before returning to the Contact Center.

Obtaining Values in a Script from Oracle TeleService

In addition to being able to launch a script from Oracle TeleService, Oracle Scripting can retrieve values from the TeleService Contact Center using Forms commands in Script Author. Upon execution of the Forms command at script runtime, the Contact Center retrieves the appropriate contact information, and passes this information on to Scripting.

Some typical Forms commands used to pass values from Oracle TeleService to Oracle Scripting are listed in the table below:

<table>
<thead>
<tr>
<th>Forms Command</th>
<th>Value Passed to Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetInteractionId</td>
<td>Interaction ID</td>
</tr>
<tr>
<td>GetCustomerId</td>
<td>Account ID/Party ID</td>
</tr>
<tr>
<td>GetCustAccountId</td>
<td>Customer Account ID</td>
</tr>
<tr>
<td>GetCustomerType</td>
<td>Customer Type</td>
</tr>
<tr>
<td>GetContactId</td>
<td>Contact ID</td>
</tr>
<tr>
<td>GetContactPointId</td>
<td>Contact Point ID</td>
</tr>
<tr>
<td>GetContactPointType</td>
<td>Contact Point Type</td>
</tr>
<tr>
<td>GetContactType</td>
<td>Contact Type</td>
</tr>
<tr>
<td>GetPrimaryFlag</td>
<td>Primary Flag</td>
</tr>
</tbody>
</table>
References

• For more information on Forms commands, see the Forms Commands section of the Oracle Scripting Developer’s Guide.

• A script can also be associated with a Relationship Plan. For information on relationship plans, refer to Oracle TeleService Implementation Guide.

Creating Service Requests in Oracle TeleService from Oracle Scripting

Oracle Scripting integrates with Oracle Forms-based applications. To create a service request by calling a PL/SQL package from Scripting, the following fields must be populated:

• SR Type

• SR Status

• SR Severity

• Summary

• Group Owner (see guidelines)

• Individual Owner (see guidelines)

Guidelines

• If set to "Yes", the Oracle TeleService profile option, Service: Group Owner Mandatory, requires the user to enter a group owner when creating a service request.

• If set to "Yes", the Oracle TeleService profile option, Service: Default Group Owner for Service Requests, requires either the group owner or an individual owner to be entered when creating a service request. This profile takes precedence over the Service: Group Owner Mandatory profile option, if set.

• The usage of a CRM resource must be defined as "Support" for the resource to be available in the Service Request tab in Oracle TeleService. This usage is set when the resource is defined using Oracle CRM Resource Manager.

Integrating with Oracle Marketing

Oracle Marketing is seeded with several Oracle Scripting building block scripts. These robust seeded scripts are supported and maintained by the Oracle Marketing team, and
are documented in *Oracle Marketing Implementation Guide*.

These new building block scripts expand the offering previously available to include scripts for business-to-consumer (B2C) functions in addition to the business-to-business (B2B) functions provided by the Oracle Scripting building block scripts. The Oracle Marketing scripts also take advantage of changes to the APIs used to create leads and events that were introduced in Oracle Marketing release 11.5.9. The API changes included in the new scripts will not be reflected in the original set of Oracle Scripting building block scripts.

Additionally, they replace completely the lead creation and event registration functionality previously accessible using the Oracle Scripting Building Block scripts.

<table>
<thead>
<tr>
<th>Building Block Script</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMSCAUTH.SCR</td>
<td>Customer Authentication</td>
</tr>
<tr>
<td>AMSERB2B.SCR</td>
<td>B2B Event registration (supersedes Oracle Scripting building block script ISEVENT.SCR)</td>
</tr>
<tr>
<td>AMSERB2C.SCR</td>
<td>B2C Event registration</td>
</tr>
<tr>
<td>AMSERWCA.SCR</td>
<td>Event registration with customer authentication</td>
</tr>
<tr>
<td>AMSLDB2C.SCR</td>
<td>B2C Lead creation</td>
</tr>
<tr>
<td>AMSLDB2B.SCR</td>
<td>B2B Lead creation (replaces Oracle Scripting building block script IESLEAD.SCR)</td>
</tr>
<tr>
<td>AMSLDWCA.SCR</td>
<td>Lead creation with customer authentication</td>
</tr>
<tr>
<td>AMSDATACQ.SCR</td>
<td>Data acquisition</td>
</tr>
</tbody>
</table>

These scripts are seeded with Oracle Marketing in current releases, and can be downloaded from the applications server from the product top directory ($AMS_TOP/scripts). Oracle suggests that users first transfer the files to a local directory, then launch Script Author, open each relevant building block script, modify as required, and deploy to the specific instance.

The Java code needed by the Marketing scripts is also delivered as part of the Marketing 11.5.9 release, so developers do not need to create any custom Java in order to use the Java methods.
This chapter covers the following topics:

- Common Implementation Errors
- Common Verification or Execution Errors
- Survey Deployment and Fulfillment Troubleshooting
- User Interface Discrepancies
- Log Files and Error Messages
- Unsupported Functions

Common Implementation Errors

This section includes the following topics:

- Responsibility Names Can Differ, page 12-1
- Survey Implementation Errors, page 12-2

Responsibility Names Can Differ

If you cannot locate a responsibility name as described in the Oracle Scripting Implementation Guide or other Oracle documentation, your environment may have been customized, or may be using a specific installation type. In some Oracle Applications environments, responsibility names differ based on installation choices. Oracle Applications can be installed in one of three configurations:

1. If you cannot locate a responsibility name as described in the Oracle Scripting Implementation Guide or other Oracle documentation, your environment may have been customized, or may be using a specific installation type. In some Oracle Applications environments, responsibility names differ based on installation choices. Oracle Applications can be installed in one of three configurations:
2. Test installation: installed for testing applications and database functionality.


Test and Production installations do not include the sample database.

For example, production instances use the name Scripting User for the responsibility to launch a script in the Scripting Engine agent interface in stand-alone mode. However, environments using the Vision installation call the same responsibility Scripting Agent, Vision Enterprises. In both environments, the responsibility key will be IES, and the responsibility ID may be identical.

For information on finding a responsibility ID, see Finding Application and Responsibility ID Values, page 5-18.

Survey Implementation Errors

This section includes the following topics:

• General Implementation Errors, page 12-2

• If You Cannot See the Survey Administration Console, page 12-2

• Troubleshooting Fulfillment Administrator Role Assignment, page 12-3

General Implementation Errors

The responsibility for administering the Survey component of Oracle Scripting is known to Oracle Applications as Survey Administrator. Do not confuse the Survey Administrator responsibility (required for administering survey campaigns) with the iSurvey User responsibility (required for executing or scheduling concurrent programs).

When you are logged into Oracle Applications as a system administrator and are searching for responsibilities in Forms-based applications, it is recommended to search using the percent wildcard character, for example "%SURVEY%", because:

• Searching under "iSurvey" will only result in finding the iSurvey User responsibility, which does not have the required administrative privileges to access the Survey Administration console.

• Searching under "Survey" will only result in finding the Survey Administrator responsibility, which does not have the required privileges to administer, schedule, or run concurrent programs.

If You Cannot See the Survey Administration Console

If you cannot successfully view the Survey Administration console:

• Check that the Web server and database are up and running in your environment.
• Check that the User ID and Password used to access Oracle HTML-based applications have been created in Oracle Forms administrative screens by a user with the System Administrator responsibility, and that the user has been assigned the Survey Administrator responsibility.

• Check that the appropriate profile settings have been established for the application at the site level, and for the application at the user level (the User Name in Forms-based applications matches the User ID and Password you used to access the Oracle CRM HTML-based application).

**Troubleshooting Fulfillment Administrator Role Assignment**

**If You Cannot See Fulfillment Page**

If you can successfully enter the Survey Administration console, but cannot view the Fulfillment page:

• Check that Oracle One-to-One Fulfillment has been implemented appropriately and the Fulfillment server is up.

• Check that you appropriately assigned the JTF_FM_ADMIN role.

• Check that after moving the JTF_FM_ADMIN role into the Assigned Roles list, you clicked Update.

• Ensure that all the Oracle One-to-One Fulfillment (fm.db) objects in the database are valid.

If you can successfully enter the Fulfillment tab, displaying a Fulfillment sub-tab and displaying the Master Document page, you have verified that:

• You have appropriately assigned the Fulfillment Admin role to the Survey administrator user.
  • Oracle One-to-One Fulfillment is implemented in your environment.

**Common Verification or Execution Errors**

This section includes the following topics:

• Script Author Errors, page 12-4

• Scripting Engine Agent Interface Errors, page 12-5

• Panel Text Errors, page 12-7

• Debug Statements Not Appearing from Custom Java Code, page 12-9
**Script Author Errors**

This section includes the following topics:

- Script Author Deployment Errors, page 12-4
- Script Author Script Verification, page 12-4

**Script Author Deployment Errors**

**Problem**
Deploying a script to the database with the Author fails.

**Solution 1**
The tablespace for the IES_DEPLOYED_SCRIPTS table may not be large enough. Particularly indicative is the scenario in which previous scripts were deployed to the database without difficulty. To resolve, increase the size of the tablespace (usually named USER_DATA) to an appropriate size (based on database usage and other installed applications). Consult your database documentation for details.

**Solution 2**
Connection to the Oracle Applications database instance has failed because the database is down. Check with the database administrator.

**Script Author Script Verification**

When testing a script, it is not enough to ensure the script will launch in the appropriate interface (in the Java interface for agents, or in a Web browser for surveys). You must also test each path in the script to ensure all commands are functioning as expected. It is important to ensure each component is functioning on its own and in consonance with all others. From the standpoint of the script itself, one must test:

- The "call guide" or "survey" (the script document developed with Script Author)
- All custom Java methods developed to support the script
- All PL/SQL procedures attached as commands to panels, blocks, branches, etc.
- All Blackboard commands
- All Forms commands
- All Constant commands
- All Delete actions
**Scripting Engine Agent Interface Errors**

This section includes the following topics:

- Troubleshooting Applet Security and Signing, page 12-5
- Load Balancing Environments with Multiple Apache JServ Instances, page 12-5
- Session Timeout Issues, page 12-7

**Troubleshooting Applet Security and Signing**

**Problem**

A yellow bar appears on the bottom of all Forms windows that reads Warning: Applet Window.

This is a security configuration issue. From a Scripting perspective, you cannot launch Scripts after logging into Forms-based applications.

**Solution 1 (Client)**

This may be an indication that the proper security certificate has not been installed on the client JInitiator. Improper security configuration on the client can lead to a variety of problems in Oracle Scripting. Among them, the ability to copy and paste to and from fields in Scripting will be disabled. Be sure to properly configure applet security on each client machine. First, empty your Oracle JInitiator cache and try logging in again. If the yellow bar reappears, uninstall and re-install Oracle JInitiator.

**Solution 2 (Server)**

This may be an indication that the Applications JAR files have not been signed properly on the server. For more details on proper security configuration, consult your Oracle Applications installation documentation.

**Load Balancing Environments with Multiple Apache JServ Instances**

**Problem 1**

While in the middle of running a script in the agent interface, users will occasionally (and seemingly randomly) receive errors indicating that their sessions have expired.

**Note:** This error message can also indicate a legitimate issue if the user has been idle for a long time. For more information, see Setting Session Idle Timeout Values for Apache JServ, page 4-22.

**Problem 2**

While in the middle of taking a survey, users will occasionally (and seemingly randomly) get a browser page with the error message "Incorrect URL" after clicking the Submit button on a survey page.

**Cause**

Oracle Scripting is a stateful application. As with all stateful HTTP applications on
load-balanced Apache/JServ environments, the load balancer must be configured to route requests from one client to the same Apache/JServ for the duration of the session. Otherwise, the Scripting Engine will not be able to find the user session’s state, and will fail, as described above. This behavior is applicable to Oracle Scripting releases 11.5.6 and later. This is applicable both for Scripting Engine implementations executing scripts in Oracle Forms (the agent interface) in the Apache mid-tier architecture, and for implementations for executing surveys in a Web browser (the Web interface). This information is not applicable to implementations executing scripts in the agent interface in the Caching Architecture.

Note that this issue is caused by incorrect load balancer configuration, not by Oracle Scripting.

Solution

Scripting Engine operations in the Apache mid-tier architecture for agent script and survey execution can be set in many different mid-tier configurations, ranging from a single Apache/JServ on a single mid-tier server to many mid-tier server machines, each running many Apache and JServ instances. In fact, it is this flexibility which allows Scripting to easily scale to handle a large number of concurrent users, simply by adding mid-tier server machines and Apache/JServ instances as necessary. In environments with multiple Apache/JServ instances spanning multiple mid-tier server machines, a load balancer must be used, so that requests to a single virtual URL can be appropriately distributed to a physical machine and an Apache/JServ on that machine. Load balancers can be either hardware or software components. There are a large variety of vendors who make such components. Because the Scripting Engine is a stateful application, there is a required implementation step when implementing Scripting in an environment with multiple, load-balanced Apache/JServ instances. When configured for only stateless HTTP applications (e.g. iStore), a load-balanced Apache/JServ environment can simply distribute each incoming client request to any Apache/JServ. With a stateful HTTP application like Scripting, the application must maintain individual user sessions and the state of each user session in Scripting is stored in the servlet session in the JServ. Thus, when the first client request is received to establish a Scripting user session, that request can be routed to any Apache/JServ. But each subsequent request for the same user must be routed to the same Apache/JServ as the first, or the application will not find the user session state, and the application will error out.

Load balancers have support for ensuring that client requests for stateful applications get routed to the same JServ. One vendor, Cisco Systems, refers to this as “stickiness.” Regardless of the vendor of the load balancer, the implementor must ensure that a load-balanced environment running Scripting is configured to redirect client requests to the same JServ.

For more information on proper configuration of a load balancer, please consult with a networking professional familiar with your environment and your specific load balancer or refer to your vendor’s load balancer documentation.
Session Timeout Issues

Problem
During an Oracle Scripting transaction in the agent interface, the following error message appears:

Error: Your Scripting transaction has expired due to inactivity. Please close the Scripting window and restart the script. Also, please contact your system administrator to increase the Apache JServ session idle timeout setting.

This requires the agent to close the Scripting Engine agent interface window, launch the script again, and recapture all information from the expired session.

Cause
In the Scripting Engine agent interface (when using the Apache mid-tier architecture only), the Scripting servlet runs in an Apache JServ. Every Apache JServ has a session idle timeout setting that controls how long a servlet session can be idle before it is automatically timed out (expired and terminated) by the Apache JServ. This behavior ensures that abandoned sessions in the servlet are not left to consume resources unnecessarily. When a servlet session is active in the JServ, but is idle (has received no client requests) for longer than the specified idle timeout setting, the JServ will automatically time out or expire the session.

Solution
The behavior exhibited by the application in the problem description above differs based on patch level. Regardless, all data from the expired session will be lost. Recovery requires ending the script manually by closing the window, and starting a new script session.

To avoid such problems, consider extending the session idle timeout setting. For more information, see the topic Setting Session Idle Timeout Values for Apache JServ in Oracle Scripting Implementation Guide.

Panel Text Errors

This section includes the following topics:

- Cascading Style Sheet Information Ignored at Runtime, page 12-7
- JavaScript Imported into Panel Text Ignored or Displaying Incorrectly, page 12-8

Cascading Style Sheet Information Ignored at Runtime

Problem
When taking a JTT-based survey, styles designated in a cascading style sheet included in panel text or JSP resources are ignored.

Cause
Neither the agent interface nor the Web interface of the Scripting Engine support the
use of cascading style sheets (CSS) in panel layout HTML.

For executing scripts as surveys, any style sheet used in survey resources other than the default CSS specified in JTF properties will be ignored. The agent interface will ignore any style sheets referenced in panel layout HTML.

**Solution**

Format panel text using the panel layout editor. Alternatively, export panel text and generate formatting on a character or paragraph tag level rather than applying styles.

For JSP resources, use styles referenced in JTFUCSS.CSS only, or specify in JSP code the desired formatting on a character or paragraph tag level.

**JavaScript Imported into Panel Text Ignored or Displaying Incorrectly**

**Problem:**

At script runtime, JavaScript imported into panel text HTML is ignored or displays incorrectly.

**Cause 1**

The Scripting Engine agent interface does not support the use of JavaScript or JScripts.

**Solution 1**

Do not include JavaScript or JScript scripts in panel text HTML for any script intended to be executed in the Java-based agent interface.

**Cause 2**

The Scripting Engine Web interface uses the Web browser to interpret code. Oracle Applications 12-certified Web browsers such as Netscape Navigator and Microsoft Internet Explorer interpret JavaScript (and JScript) scripts differently.

**Solution 2**

The following solutions are recommended:

1. Build JavaScript or JScript scripts carefully, using certified scripting language experts.

2. To ensure compatibility with all browsers, it is recommended to include a savvy browser detection scheme in any scripts used, to supply appropriate rendering in JScript or JavaScript as required by the end user’s browser client.

3. Recognize that using scripts within customized panel content is customization. As with all custom code, such issues are not supported by Oracle.

4. Many custom JavaScripts are required to be included within the `<HEAD>` and `</HEAD>` tags of any HTML page. Ensure the script is appropriately referenced in custom panel HTML.

5. Microsoft FrontPage does not allow the inclusion of any content after the `</HTML>` tag. When editing panel text containing any embedded values, ensure that the HTML editor has not removed embedded value codes. One workaround is to create
embedded values after otherwise customizing panel layout content.

Debug Statements Not Appearing from Custom Java Code

Problem
Prior to upgrading to the Apache mid-tier architecture, certain debug statements or messages appeared in the Java console that are no longer visible.

Cause
The JVM executing code is located on the Apache Web server whereas before the messages were "printed" to the client's Java console.

Solution
To view debugging messages in the Apache Mid-Tier architecture, change any Java code using "System.out.println" to "System.err.println". This will result in the messages being written to the jserv error logs.

Survey Deployment and Fulfillment Troubleshooting

The following are troubleshooting tips specifically regarding undelivered invitation or reminder master documents for list-based survey campaigns. Invitations and reminders are HTML master documents sent by Oracle One-to-One Fulfillment to invite a list member (or to remind an already invited list member) to participate in a survey campaign.

Background
When you click Deploy for a list-based survey deployment, a concurrent request is generated which is scheduled to run at the deploy date and time (specified when defining a deployment). The purpose of this concurrent program is to make a request to Oracle One-to-One Fulfillment to send out e-mail invitations to the target population specified by the list.

Upon selecting Deploy, the status of the deployment changes from "Open" to "Active." If the status of the corresponding parent objects (cycle and survey campaign) status were "Open," the status of each will change to "Active."

As soon as the page refreshes, the corresponding concurrent request ID is immediately visible in the Deployment Detail page. You can use this concurrent request ID to monitor the fulfillment request submission through the Oracle Forms-based interface associated with the iSurvey User responsibility.

When the request executes, either it will succeed or fail to complete.

- **Successful Request**: A successful request is indicated in the Request Detail form as Phase: Complete, Status: Normal. Such a status indicates that the *request was*
executed, but *does not necessarily indicate* that the Fulfillment request has successfully been received by the fulfillment server. This distinction is important because it helps determine how to fix any emerging problem. Additional information is available in the Requests list by clicking View Log on the appropriate request. If a request was executed but there was an internal error, the log may indicate the presence of such an error. For example, if the survey administrative user deploying the survey is not associated with a fulfillment group, this is indicated in the log.

- **Request Not Completed:** A failed request is indicated in the Request Detail form as Phase: Complete, Status: Error. Such a status indicates that the request has been executed but was not completed. See below for more information.

If the request is successful, a fulfillment request ID is generated. This is visible from the Survey Administration console in the Deployment Detail screen, immediately above the concurrent request ID.

This request can be tracked using the Fulfillment tabs within the Survey Administration console, using this fulfillment request ID. If necessary, the same ID can be used by a fulfillment administrator, accessing the full functionality of Oracle One-to-One Fulfillment by logging into the Fulfillment Administration console.

Once a fulfillment request has been successfully submitted to Oracle One-to-One Fulfillment, there is no communication with the Survey Administration console regarding any possible problems in executing that fulfillment request. If necessary, obtain the fulfillment request ID from the Deployment Detail page of the Survey Administration console, and attempt to remediate using Oracle One-to-One Fulfillment debugging techniques.

**Fulfillment Request Failure Signs**

In Concurrent Manager, a fulfillment request that is not completed can be detected in the Request Detail form as Phase: Complete, Status: Error.

Additional information to help determine why a request failed may be visible by clicking View Log in the Request form.

In the Survey Administration console, when deploying a list-based survey, the status is set to "Active" upon a successful request to Concurrent Manager. However, if the status of the deployment changes back to "Open," this may indicate a failure to execute the fulfillment request.

Once a Fulfillment request has been successfully submitted to Oracle One-to-One Fulfillment, the Fulfillment Engine then needs to process it. Only successful processing by the Engine results in an e-mail message being sent out and the subsequent receipt of respondent data for a list-based survey campaign.

**Query Failure**

The Fulfillment Engine will fail if the query associated with the master document fails.
Therefore, once a fulfillment request ID is generated, use Oracle One-to-One Fulfillment debugging methods to troubleshoot the failure point within Oracle One-to-One Fulfillment.

**Troubleshooting Recommendations**

- Log into Oracle applications and check the Phase and Status of the concurrent request. Additional information to help determine why a request failed may be visible by clicking View Log in the Request form of the Concurrent Manager.

- Failure may indicate Oracle One-to-One Fulfillment implementation, configuration issues, or invalid Oracle One-to-One Fulfillment packages.

- You may also need to check Oracle One-to-One Fulfillment configuration, implementation, or that the Fulfillment server is functioning.

- For Oracle One-to-One Fulfillment information, refer to *Oracle One-to-One Fulfillment Implementation Guide*.

**Problem 1**

You have successfully executed a concurrent program, and a Fulfillment request has been successfully submitted to Oracle One-to-One Fulfillment. However, once the deployment date and time have passed, no survey responses are allowed (deployment is not valid, is not active, or you are using an invalid URL).

**Solution 1**

Check the Survey Administration console to see if the response end date has already passed or the status has changed from Active to Closed or Cancelled.

**Solution 2**

Check the invitation to see if the URL in the e-mail link is in the appropriate format as indicated below:

```
```

- where dID = the deployment ID and rID = the unique respondent ID

  If the URL associated with the hyperlink is incorrect, you must fix the query associated with the Oracle One-to-One Fulfillment master document in the template used for that survey. Then you must resubmit the request using Concurrent Manager.

**Solution 3**

Check the Fulfillment Administration console to determine if there is a Fulfillment
Problem 2

If the Fulfillment request indicates Phase: Completed, Status: Error, you can resubmit the request. To resubmit it:

1. Copy the parameters from the Request Detail form.

2. Return to the Navigator.


4. Select "Single Request" from the Submit a New Request dialog and click OK.
   The Submit Request form will appear.

5. In the Names field, enter "SUBMIT GROUP FM REQUEST FROM IES" and press Tab.
   You can enter partial criteria and use the % wildcard character, if desired.
   The Parameters dialog will appear.

6. One at a time, enter the parameters you copied from the failed request, and click Submit.
   There are 9 parameters, each separated by a comma. If nothing appears before a comma, that parameter is null and can be left blank.

7. After clicking submit, a dialog will appear with a request ID. Copy the request ID and use this to track your request.

   Note: The deployment detail page will still indicate the original request ID. This will not be updated; ensure you use the new request ID to track your request.

User Interface Discrepancies

Oracle Applications is a rich, full-functioned, constantly evolving software suite. It is the only available software suite that offers the world’s most proven and scalable database, a commonly implemented applications server, mature back-end ERP functionality such as human resources and financials, and cutting-edge front-office customer-facing CRM applications, of which Oracle Scripting is just one offering. Considering the scope of its function, Oracle Applications is necessarily complex, and patching takes experienced administrators, careful attention to detail, and adherence to requirements indicated in readme and about documents.

As indicated in our Send Us Your Comments section, Oracle welcomes your input,
including any corrections you feel are appropriate to this document. Note, however, that if you see discrepancies between the application user interface and the procedures documented herein, there are several potential causes. These include, but are not limited, to the following:

- Applications patch level.
- User interface changes occur from release to release.
- Technology Stack patch level.
- Underlying technology components

### Log Files and Error Messages

Problems encountered with Oracle Scripting may differ in origin based on the component being used and the source of the error. Oracle Scripting includes various tools to help users and administrators detect and eliminate problems.

Oracle Scripting includes four primary components, most of which have one or more subcomponents for which information and problems are reported either to a message log (typically stored as log files in the database) or as an entry in a debug console.

### Components and Subcomponents of Oracle Scripting

- **Script Author** includes a Java applet and a servlet.

- **The Scripting Engine** is executed on the middle tier (the Apache Web server), and may encounter problems at that level. Further, the Scripting Engine is comprised of an agent interface (a Java client, in which the script executes as Java on the agent's client workstation, wrapped in an Oracle Form) and a Web interface (an Oracle Applications 12-compatible Web browser, in which the script executes in the browser's main window). The Scripting Engine hosts a PL/SQL integration layer, in which database operations execute and the results can be displayed as determined by the script.

- **The Survey Administration console** is an HTML application using the Oracle Applications Framework (OAF) technology stack. This component is used to administer survey campaigns, a prerequisite in order to execute scripts using the Scripting Engine Web interface.

- **The Scripting Administration console** is an HTML application using the Oracle CRM Technology Foundation (JTT) technology stack. This component is used to administer files supporting Oracle Scripting (deployed scripts, custom Java for scripts, and script/Java mappings).

Problems encountered with Oracle Scripting can be detected and debugged by
determining the source of the error and tracking down the appropriate informational message. Based on the source of the problem or the interface experiencing difficulties, error, informational, or debug messages may be located as follows:

<table>
<thead>
<tr>
<th>Component</th>
<th>Subcomponent</th>
<th>Configuration</th>
<th>How to View Logs</th>
<th>Runs on Client Desktop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Author</td>
<td>Java Applet</td>
<td></td>
<td>Script Author Debug Console</td>
<td>Yes</td>
</tr>
<tr>
<td>Script Author</td>
<td>Servlet</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Scripting Engine</td>
<td>Apache mid-tier</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Scripting Engine</td>
<td>Forms/Java Client</td>
<td>IES : Debug Mode profile</td>
<td>Java Client Debug Console and Jinitiator Console</td>
<td>Yes</td>
</tr>
<tr>
<td>Scripting Engine</td>
<td>HTML Client</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Scripting Engine</td>
<td>Forms PLSQL Integration Layer</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Scripting Engine</td>
<td>Survey Runtime</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Survey Administration console</td>
<td>N/A</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
<tr>
<td>Survey Administration console</td>
<td>N/A</td>
<td>Four AFLOG profiles</td>
<td>Log Viewer</td>
<td>No</td>
</tr>
</tbody>
</table>

**Configuration Guidelines**

Various system profiles control the logging of error and informational messages.

IES : Debug Mode profile (set to Debug off or Debug on) controls display at runtime of informational and error messages for Scripting Engine operations. When enabled, these messages are displayed in a Java-based Debug console that appears (in a separate
window) when a script is executed in the Scripting Engine agent interface.

IES : Debug Mode (set to Debug off or Debug on) controls display at runtime of informational and error messages for Scripting Engine operations. These messages are logged to the FND_LOG_MESSAGES database table in the Oracle Applications schema, and are typically viewed by accessing Diagnostics. Generally set to Debug off unless troubleshooting specific issues.

- Problems with the Script Author Java applet are displayed in the Syntax tab of the Script Author Java applet. Clicking on any specific error displays an error message in the Debug pane, which appears immediately below the graphical Script Author canvas (the visual work area). This is accessed by a user with the Scripting Administration responsibility.

- Status and error information about Scripting Engine mid-tier operations, the Scripting Engine HTML client, PL/SQL information passed between the database and the Scripting Engine, scripts executed in the Scripting Engine Web interface, and transactions in the Scripting Administration console and the Survey Administration console is recorded to server logs in the Applications Common Logging infrastructure. These logs are viewed by users of an OA Framework HTML application when the FND: Diagnostics profile is set to Yes. These logs are accessed when the user selects the Diagnostics global button or link.

- Error messages for the Scripting Engine Web interface are recorded both to the Oracle JInitiator console, and the "Engine Debug console". The Oracle JInitiator console is visible if the Show Java Console option is enabled in the Oracle JInitiator Properties window. If Oracle JInitiator is installed on your computer, you can access these properties by selecting Start > Programs > JInitiator Control Panel. The Engine Debug console is accessed.

This section includes the following topics:

- Oracle Scripting Execution Errors and Error Logging, page 12-15

Oracle Scripting Execution Errors and Error Logging

When executing the Scripting Engine, any resulting errors are stored in various places and viewed differently based on the genesis of the error.

This section includes the following topics:

- Errors in the Scripting Engine Agent Interface, page 12-15
- Errors in the Scripting Engine Web Interface, page 12-16

Errors in the Scripting Engine Agent Interface

- When an agent is running a script, if an error occurs on the client end (from the
Forms client), this error is written to the JInitiator Java console.

To view the JInitiator Java console, select the Show Java Console option in the Basic tab of the Oracle JInitiator Properties dialog accessed from the JInitiator Control Panel (typically Start > Programs > JInitiator Control Panel [Version]).

- If an error occurs in the servlet or session, this error is written to the IES server logs.
  For example, if an action calls a Java method that does not exist, this is a server error.

**Errors in the Scripting Engine Web Interface**

When a respondent is taking a survey, errors are distinguished by the two components of the JSP layer:

1. The Scripting HTML client, which takes the script and renders HTML.

2. The survey-specific layer that wraps the output to the HTML client in survey-specific functionality (such as checking Deployment IDs for a valid deployment URL).

In general:

- Any errors in the Scripting Engine session or generic HTML client layer are logged, in detail, in the IES server log.
  A summarized version of the error is passed back and displayed by the Web browser.

- Any errors occurring in the survey-specific layer are displayed by the Web browser.
  If you have set the JTF debug mode on, survey-specific debug messages, as well as other debug information, will be logged in JTF-specific server logs.

From a Survey perspective, the Scripting Engine is a set of Java classes on the middle tier that receives requests from the JSP layer (including the message to launch a script), and processes them. All business logic as determined by the survey questionnaire script, custom code or database calls, and respondent actions are evaluated by the Scripting Engine, which passes processing information to the JSP layer to interpret, which in turn sends information to the Web browser to display. Scripting Engine errors are automatically stored in the server and can be viewed with the CRM HTML-based server log viewer, regardless of the debug mode.

Errors in the interpretation of the survey questionnaire script, custom code or database calls, and respondent actions will automatically store error messages in the server and can be viewed with the CRM HTML-based server log viewer. These errors are written to the server logs regardless of debug being on or off. Additional informational messages are also stored in the server logs when debugging mode is enabled.
JSP Layer Errors
The Java Server Pages layer includes a survey functionality component and an HTML client component in the middle tier. When a request to process a URL linked to a particular survey campaign deployment is received in the middle tier, it is evaluated by the survey processing component. This component receives the request, processes it, and validates it. If there is an error (such as invalid deployment ID, invalid URL or invalid date due to an expired or inactive deployment), the survey processing component generates an error message to be sent to the Web browser. The error message is displayed in the Web browser as an error page. Viewing the source of the page from the browser may provide additional information regarding the error, such as stack trace messages useful for troubleshooting.

If valid, the request is sent to the HTML client component, which sends a request to the Scripting Engine. The HTML client component serves as a broker between processing occurring in the Scripting Engine and the survey processing component, which passes information to the Web browser to display.

Unsupported Functions
This section describes functionality that is not supported with Oracle Scripting.
This section includes the following topics:
• Panel Layout Editor Formatting Limitations, page 12-17

Panel Layout Editor Formatting Limitations
Problem
In Script Author, you have correctly formatted an embedded value to provide a blackboard value in a panel at runtime. There is no other content in the panel (other than the Continue button). In other panels, the same procedure was effective, while at runtime in this case, no value appears (only the Continue button).

Cause
In the Script Author, you cannot include in panel layout an embedded value only, with no other content.

Attempting to include only an embedded value (with no other characters) in the panel layout will result in the blackboard value not appearing in the panel at runtime.

Solution
As a work-around, you must include at least one character (a space character is acceptable) before and after the embedded value, and highlight these additional characters also when establishing the embedded value.
Oracle Scripting Profile Options

This appendix covers the following topics:

• Setting profile options
• Finding Responsibility ID Values
• Oracle profile options
• Current IES Profile Options
• Information, Error and Debug Logging Profile Options
• Additional Required Profile Options

Setting Profile Options

Use the following procedure to set any profile option.

Prerequisites

Before making Oracle Forms settings, ensure that all Oracle Applications server processes are up and running. In particular, if you stopped concurrent managers before applying Oracle Applications patchsets, restart them now by changing to $COMMON_TOP/admin/scripts, and executing adcmctl.sh <APPS user name/APPS password> start.

Login

Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility

System Administrator
Steps

1. From the Navigator, navigate to Profile > System.
   The Find System Profile Values window opens.

2. Check the level(s) at which you want to set the profile option. The available levels are listed below:
   - **Site**: If you select this level, the profile will apply to the entire site. Individual profiles with a different value designated at any other level will take precedence.
   - **Application**: If you select this level, choose the application from the Application LOV for which you want to set the profile option.
   - **Responsibility**: If you select this level, choose the responsibility from the Responsibility LOV for which you want to set the profile option.
   - **User**: If you select this level, choose the user from the User LOV for whom you want to set the profile option.

3. In the Profile field, enter the profile name, such as IES: Architecture Type, or a wildcard search criterion such as IES%.

4. Click Find.
   The System Profile Values form opens with the results of your search.

5. Verify or set the profile option(s) at the levels that you selected.

Finding Responsibility ID Values

You must know the APPLICATION_ID value for Oracle Scripting and the RESPONSIBILITY_ID value for the Survey Administrator responsibility before you can set the required Oracle CRM Technology Foundation (JTT) profile options for users with these responsibilities.

**Note**: The APPLICATION_ID value for the seeded Scripting User (or Scripting Agent) responsibility is 519. The RESPONSIBILITY_ID value for Survey Administrator is 21685. However, in some scenarios, the responsibility identification may differ, based on environmental factors.

Use the following procedure to find the APPLICATION_ID value and RESPONSIBILITY_ID value of a responsibility.
Prerequisites
None

Login
Log into Oracle applications using the Personal Home Page login, or the Single Sign-On login if implemented.

Responsibility
System Administrator

Steps
1. From the Navigator, navigate to Security > Responsibility > Define.
   The Responsibilities form opens.
2. Choose View > Find. Search for the responsibility, highlight it, and click OK in the search window.
   The Responsibilities form is populated with the record for the responsibility that you chose.
3. With your cursor in any field of the record, choose Help > Diagnostics > Examine.
   The Examine Field and Variable Values window opens.
4. In the Examine Field and Variable Values window, choose APPLICATION_ID from the Field LOV.
   The Value field in the Examine Field and Variable Values window is populated with the value of APPLICATION_ID.
5. In the Examine Field and Variable Values window, choose RESPONSIBILITY_ID from the Field LOV.
   The Value field in the Examine Field and Variable Values window is populated with the value of RESPONSIBILITY_ID.

Oracle CRM Technology Foundation (JTT) Profile Options
This section summarizes the Oracle CRM Technology Foundation (JTT) profile options that you need to set when implementing Oracle Scripting. Most of these are set at the site level.

Listed in the table below are the system profile name, a description of the function or purpose of the profile setting, recommended level settings, and a sample value.
Note: See FindingResponsibilityIDValues, page A-2 if you need to find the APPLICATION_ID and RESPONSIBILITY_ID values for a responsibility.

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Description</th>
<th>Recommended Level Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JTF_PROFILE_DEFAULT_APPLICATION</td>
<td>Default application ID (519=Oracle Scripting)</td>
<td>Site</td>
<td>519</td>
</tr>
<tr>
<td>JTF_PROFILE_DEFAULT_BLANK_ROWS</td>
<td>Number of blank rows on HTML forms (can be set to any integer &gt; 0)</td>
<td>Site</td>
<td>3</td>
</tr>
<tr>
<td>JTF_PROFILE_DEFAULT_CSS</td>
<td>Default Oracle CRM Technology Foundation Cascading Style Sheet</td>
<td>Site</td>
<td>jtfucss.css</td>
</tr>
<tr>
<td>JTF_PROFILE_DEFAULT_CURRENCY</td>
<td>Default currency. Enter the currency code in all uppercase letters.</td>
<td>Site</td>
<td>USD</td>
</tr>
<tr>
<td>JTF_PROFILE_DEFAULT_NUM_ROWS</td>
<td>Number of default rows (records) displayed on HTML summary tables (can be set to any integer &gt; 0)</td>
<td>Site</td>
<td>10</td>
</tr>
<tr>
<td>JTF_PROFILE_DEFAULT_RESPONSIBILITY (application level only)</td>
<td>Default responsibility ID (21685=Survey Administrator)</td>
<td>Application</td>
<td>21685</td>
</tr>
</tbody>
</table>

Current IES Profile Options

This section summarizes the current Oracle Scripting (IES) profile options that you need to set when implementing the Scripting Engine and the Survey components of Oracle Scripting. Set the profile options in this section at the site level.
Listed in the table below are the system profile name, any seeded lookup values, a description of the function or purpose of the profile setting, and recommended settings.

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Category</th>
<th>Lookup Values</th>
<th>Description</th>
<th>Recommended Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>IES: Architecture Type</td>
<td>Architecture</td>
<td>Apache Mid Tier/Servlet Architecture</td>
<td>Determines mode of Oracle Scripting operations.</td>
<td>Apache Mid Tier/Servlet Architecture</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Three Tier Mode</td>
<td>1. Use Apache Mid Tier for all new implementations.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Caching Architecture</td>
<td>2. Never set to Three Tier Mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Use Caching Architecture only if upgrading existing caching architecture implementations.</td>
<td></td>
</tr>
<tr>
<td>IES: Debug Mode</td>
<td>Debug</td>
<td>Debug off, Debug on</td>
<td>Controls display at runtime of client-side informational and error messages for Scripting Engine operations. When enabled, these messages are displayed in a Java-based Debug console that appears (in a separate window) when a script is executed in the Scripting Engine agent interface. Server-side message logs are controlled by FND profiles. See Information, Error and Debug Logging Profile Options, page A-8 for more information.</td>
<td>Generally set to Debug off unless troubleshooting specific issues. When troubleshooting specific issues, enable at the Responsibility or User level for best results.</td>
</tr>
<tr>
<td>Profile Option Name</td>
<td>Category</td>
<td>Lookup Values</td>
<td>Description</td>
<td>Recommended Setting</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>IES : Display Suspend Button on Script Frame</td>
<td>Runtime UI Settings</td>
<td>False, True</td>
<td>When set to True, the Scripting Engine agent interface displays a Suspend button on the bottom of the script frame. This button is hidden if the profile is set to False (or remains null). When this button is clicked by an agent during script runtime, the current script interaction is suspended. (Requires Suspendable global script property option to be enabled.)</td>
<td>False unless using Oracle Scripting in standalone mode</td>
</tr>
<tr>
<td>Profile Option Name</td>
<td>Category</td>
<td>Lookup Values</td>
<td>Description</td>
<td>Recommended Setting</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IES : Dropdowns</td>
<td>HTML UI Dropdown</td>
<td>True</td>
<td>By default, Oracle Scripting displays a text string &quot;- select one - &quot; at runtime for questions with a data type of drop-down list. Although &quot;- select one -&quot; appears in the list, this is a null value. Business rules for a drop-down list require the user to select one value for this question, resulting in a blackboard value other than null for each such question. Setting this profile to False suppresses the null value with the &quot;- select one -&quot; one string in the Scripting Engine Web interface. For Web browsers only, the first answer choice in the list will appear as the selected value, unless another answer choice has been designated as a default answer.</td>
<td>Set to False to prevent &quot;- select one -&quot; string from displaying for scripts displaying in HTML UI. Leave null or set to True to ensure this string remains in both interfaces. When null or set to True, user action will be required at runtime to select an option from the list, as a null value is not acceptable for the drop-down list question UI type.</td>
</tr>
<tr>
<td>Default Null Choice in HTML UI</td>
<td>Options</td>
<td>False</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IES : Initial Script Frame Size</td>
<td>Runtime UI Settings</td>
<td>1280 X 1024</td>
<td>Controls the initial size of the Scripting Engine window frame, in pixels, in the Forms/Java agent user interface.</td>
<td>Prior to the introduction of this profile option, the initial size of the Oracle Scripting window in the agent interface was 800 X 600 pixels by default. Change as required to accommodate various monitor resolutions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>800 X 600</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Maximized</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1024 X 768</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile Option Name</td>
<td>Category</td>
<td>Lookup Values</td>
<td>Description</td>
<td>Recommended Setting</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>IES: Scripting</td>
<td>Runtime UI</td>
<td>Display</td>
<td>Determines in Scripting Engine Java agent interface whether a single panel</td>
<td>At the discretion of the implementing enterprise.</td>
</tr>
<tr>
<td>Panel Display</td>
<td>Settings</td>
<td>Multiple Panels at a time in Scripting window</td>
<td>is visible upon script execution or whether multiple panels are displayed with active panel having focus.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Single Panel</td>
<td>at a time in Scripting window</td>
<td></td>
</tr>
<tr>
<td>IES: Survey</td>
<td>Survey Resources</td>
<td>On</td>
<td>Determines whether survey resources for OAF surveys are cached at runtime. If no value is set, caching occurs by default (same behavior as setting to On).</td>
<td>Set to Off to avoid caching. Set to On or leave null to cache survey resources for OAF surveys.</td>
</tr>
<tr>
<td>Resources Caching</td>
<td></td>
<td>Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IES: Proxy Server</td>
<td>Connectivity</td>
<td>None</td>
<td>Name of Proxy server (required if proxy server used for Scripting Engine agent interface only).</td>
<td>Syntax: http://&lt;servername&gt;.&lt;domain&gt;:&lt;Apache Web server port&gt;/&lt;servlet_zone&gt;</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IES: Proxy Server</td>
<td>Connectivity</td>
<td>None</td>
<td>Port of Proxy server (required if proxy server used for Scripting Engine agent interface only).</td>
<td>N/A</td>
</tr>
<tr>
<td>Port</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Information, Error and Debug Logging Profile Options**

This section summarizes the system profile options that affect the logging of server-side informational, error, and debug messages in the Oracle Applications Logging Framework for OAF technology stack applications.

*Client-side* message logs are controlled by the IES : Debug Mode profile. See Current IES Profile Options, page A-4 for more information.
Listed in the table below are the system profile name, any seeded lookup values, the level available for setting the system profile, a description of the function or purpose of the profile setting, and recommended settings.

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Lookup Values</th>
<th>Level</th>
<th>Description</th>
<th>Recommended Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>FND: Diagnostics</td>
<td>Yes</td>
<td>Site</td>
<td>Causes a Diagnostics link to appear in the HTML UI when set to Yes. This provides access to the log messages captured using the Oracle Applications Logging Framework.</td>
<td>Generally set to No unless specific user has need to access server logs. Generally recommended only for administrators or trusted users. For this reason, recommended to set at User level.</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Responsibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FND: Debug Log Enabled</td>
<td>Yes</td>
<td>Site</td>
<td>Controls display at runtime of informational and error messages for Scripting Engine operations when set to Yes. These messages are logged to the Oracle Applications Logging Framework server logs.</td>
<td>Generally set to No unless troubleshooting specific issues. Recommended to set at User level to avoid heavy system load.</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td>Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Responsibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FND: Debug Log Filename</td>
<td>Null</td>
<td>Site</td>
<td>When defined, saves log messages (at the level determined by the FND: Debug Log Level profile setting) in a text file. Leave this value null to record log messages to database log files.</td>
<td>Generally, do not provide a filename unless directed to do so by Oracle Support Services for specific problem remediation. File size can quickly grow to an unmanageable size that may cause performance issues.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Responsibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile Option Name</td>
<td>Lookup Values</td>
<td>Level</td>
<td>Description</td>
<td>Recommended Setting</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FND: Debug Log Level</td>
<td>Statement</td>
<td>Site</td>
<td>Controls the level and degree of log messages captured, decreasing the amount of information by the order listed (Statement level logging captures the most information; Unexpected captures the fewest messages).</td>
<td>Generally, set this profile option to Error at the Application level for application Scripting to capture error-level message logs. For diagnosing specific errors, set this profile to Statement at the User level for the Oracle Applications user account experiencing problems. Use in combination with FND: Debug Log Module for specific problem diagnosis.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Responsibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Event</td>
<td>Site</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exception</td>
<td>Site</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Error</td>
<td>Site</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unexpected</td>
<td>Site</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FND: Debug Log Module</td>
<td>None</td>
<td>Site</td>
<td>Determines the module for which messages are logged.</td>
<td>Generally, set to ies% at the Site level to log messages coming from all IES (Oracle Scripting) Java classes. To diagnose specific problems, set at the user level with more specific criteria. For example, to debug issues with the Scripting Engine, set to ies.engine%. This value is not case-sensitive. Ensure the % is included, to capture all messages included in the designated class.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Application</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Responsibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>User</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile Option Name</td>
<td>Lookup Values</td>
<td>Level</td>
<td>Description</td>
<td>Recommended Setting</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------</td>
<td>-------</td>
<td>-------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Guest User Password or GUEST_USE R_PWD</td>
<td>None</td>
<td>Site</td>
<td>Determines the Oracle Applications user account and password considered as the applications-level guest user.</td>
<td>Only required when logging for guest user must be enabled. Generally set to GUEST/&lt;password&gt;.</td>
</tr>
</tbody>
</table>

### Additional Required Profile Options

This section summarizes additional profile options that you need to set when implementing the Scripting Engine and the Survey components of Oracle Scripting. Set the profile options in this section at the site level.

Listed in the table below are the system profile name, any seeded lookup values, the level available for setting the system profile, a description of the function or purpose of the profile setting, and recommended settings.

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Lookup Values</th>
<th>Level</th>
<th>Description</th>
<th>Recommended Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apps Servlet Agent</td>
<td>None</td>
<td>Site</td>
<td>Identifies servlet zone of Apache Web server JServ used for Scripting Engine agent interface only. May be set at site level if one Apache server listener used. If different settings required for multiple applications, set at application level.</td>
<td>Syntax: http://&lt;server name&gt;.&lt;domain&gt;:&lt;Apache Web server port&gt;/&lt;servlet_zone&gt;</td>
</tr>
<tr>
<td>ICX: Language</td>
<td>None</td>
<td>Site</td>
<td>Establishes default language for the Internet Cartridge Exchange (ICX) settings for Web-based transactions</td>
<td>As appropriate</td>
</tr>
<tr>
<td>Profile Option Name</td>
<td>Lookup Values</td>
<td>Level</td>
<td>Description</td>
<td>Recommended Setting</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>-------------</td>
<td>-------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>FND: Migrated To JRAD</td>
<td>No</td>
<td>Application</td>
<td>Enables searches in the Survey Administration console.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Oracle Discoverer Workbooks

This appendix covers the following topics:

• Introduction
• Implementing Survey Analysis Discoverer Workbooks
• Survey Workbook Descriptions

Introduction

Analysis and reporting for data received from survey campaigns has been enhanced. In previous releases of Oracle Scripting, three survey-related reports were accessible from the Survey Administration console. Beginning with Oracle Scripting release 11.5.9 (Interaction Center Family Pack Q or later), Oracle provides six predefined sets of reporting criteria to provide analysis information for the effectiveness of Oracle Scripting scripts executed as survey campaigns.

Oracle Discoverer is a tool which enables report builders and analysts to create, modify, and execute ad hoc queries and reports. Casual users can view and navigate through pre-defined reports and graphs. Oracle Discoverer provides a business view (referred to as the end user layer or EUL) to hide the complexity of the underlying data structure. It enables users to focus on solving business problems instead of data access issues.

When scripts are executed as survey campaigns, return information for each deployment is stored in transaction tables in the IES schema of the Oracle Applications database. These transaction tables provide reporting data for three of the six survey analysis workbooks. Executing the Summarize Survey Data Concurrent Program (for details, see the topic Summarize Survey Data Concurrent Program in the Oracle Scripting User Guide) moves relevant information into tables that summarize survey data from individual responses. These summary tables provide reporting data for the remaining three survey analysis workbooks. A matrix containing a list of the workbooks, a description of each, and the tables or views accessed by each workbook is provided below in Survey Workbook Descriptions, page B-19.

To view survey data using Oracle Discoverer workbooks, Oracle Applications users
who are assigned a particular responsibility (based on the implementation) log into Oracle Discoverer User Edition and select the appropriate workbook from the database. The Oracle Applications user and responsibility must be granted administrative privileges to the end user layer as part of implementation. If you do not have access to the Oracle Scripting survey analysis workbooks, or do not have the appropriate privileges to access the workbooks, consult your Oracle Discoverer administrator, or perform the implementation steps described in this document.

Within the Survey Analysis business area are six pre-defined Oracle Scripting survey summary workbooks. Workbooks are lists of records, similar in design to a spreadsheet, that gather requirements for a Structured Query Language (SQL) database query. The columns in a workbook use ordinary business terms, shielding end users from requiring knowledge of the underlying relational database structure. When the query associated with each workbook is executed, users are prompted for parameters, after which the workbook builds and executes SQL statements which provide the requested information, which can range from simple to complex. The return data generated from the workbooks can be exported to a spreadsheet, allowing managers to create additional ad hoc reports on any data items available within a survey.

Using Oracle Discoverer, you therefore generate survey reports derived from survey data stored in one of two locations: in IES transaction tables within the Oracle Applications database schema, or summarized and compiled for analysis in survey summary tables following execution of the appropriate concurrent program.

Oracle Discoverer administrators can tailor existing workbooks to refine reporting information, or create new workbooks, using the Discoverer Plus or Discoverer Desktop components.

Oracle Discoverer employs an end user layer (EUL). An EUL is a metadata repository that allows users to view and select records from complex database structures without requiring knowledge of those structures or knowledge of Structured Query Language (SQL). The EUL consists of one or more business areas. Each business area contains folders (equivalent to tables and views) and each folder contains items (equivalent to columns in the table or view). Business areas are visible through Oracle Discoverer Administration Edition.

The EUL also contains workbooks. Workbooks are visible through Oracle Discoverer User Edition. Workbooks contain the specific data needed for various analysis tasks. Workbooks belong to business areas. Similar in appearance to a spreadsheet, a workbook references data in tables and views, and may have a query associated with it.

For the purpose of Oracle Scripting survey analysis, six workbooks are provided to generate specific reporting data on various survey-related activities. Each has a query associated with it which, when appropriately executed, provides an ad-hoc report on the appropriate parameters.

As part of post-installation steps for an Oracle Applications implementation, two EULs are created. Oracle Scripting reports are accessed through the Oracle Business Intelligence System (BIS) EUL.

This implementation guide contains the required steps to implement Oracle Discoverer
workbooks to generate survey analysis reports for Oracle Scripting.

Use of Oracle Discoverer workbooks for survey reporting requires upgrade or installation of Oracle Applications 11.5.9 or later. Manual post-installation steps are required to import the survey reports into the EUL. This is accomplished using a shell script or by importing the workbooks into the Oracle Discoverer 4i Admin Edition. If you have not already imported these workbooks as part of the post-installation steps for Oracle Applications 11.5.9, you can do so by following the detailed steps provided in this appendix.

This section includes the following topics:

- Implementing Survey Analysis Discoverer Workbooks, page B-3
- Survey Workbook Descriptions, page B-19

## Implementing Survey Analysis Discoverer Workbooks

To implement Oracle Discoverer workbooks for Oracle Scripting survey reporting, the following tasks are required:

Perform the following to implement Oracle Scripting survey reporting using Oracle Discoverer workbooks:

- Stage loader files (EEX files that provide the Oracle Scripting survey analysis business area, including workbooks) in preparation for import.

- Verify the accessibility of the BIS EUL to your Oracle Discoverer Administration Edition user. If BIS EUL is not accessible to your user, create an EUL.

- Import loader files (EEX files that provide business area and workbooks) into the EUL.

- Assigning User and Responsibility Privileges to the EUL.

EULs are created by Oracle Discoverer administrators. These users have access to Oracle Discoverer Administrative Edition with database administrator (DBA) privileges. These users must also have access to Oracle Discoverer User Edition (client/server version).

The EUL stores metadata for Oracle Discoverer. Oracle Scripting administrators that want to view the Oracle Discoverer reports must access the BIS EUL. If the BIS EUL has not been created, perform the procedure Creating an End User Layer. If this EUL exists and you have access to it from Oracle Discoverer, you may omit this procedure from your implementation steps.

### Prerequisites

Prerequisites for implementing Oracle Discoverer reporting for survey analysis include the following:
• Oracle Scripting Release 11.5.9 or later

• Oracle Applications patched to release 11.5.9 or later, equivalent to Interaction Center Family Pack Q or later

• Windows NT server with Oracle Discoverer 4i Administration Edition

Oracle Discoverer 4i Administration Edition and the corresponding adupdeul utility to import EEX files run only on Windows NT. If using Oracle Discoverer workbooks for reporting on Oracle Scripting survey activities, you must have at least one NT server with Discoverer Admin Edition installed. This may be a separate server, providing that it can communicate with the applications database.

• Appropriate patching of Oracle Discoverer, including Oracle Discoverer Patch 1834171

Tasks

This section includes the following tasks:

• Staging Oracle Discoverer EEX Files for Import, page B-4

• Creating an End User Layer, page B-6

• Assigning End User Layer Implementation Privileges, page B-8

• Importing Oracle Discoverer Objects into an End User Layer, page B-10

• Assigning Responsibility and Business Area Privileges, page B-12

• Assigning Workbook Privileges, page B-14

• Verifying the End User Layer, page B-16

• Viewing Oracle Scripting Survey Reports, page B-17

References

• Oracle Discoverer Plus User's Guide Oracle Discoverer 4.1

• Oracle Discoverer 4i Plus User's Guide Oracle Discoverer 4.1

• Oracle Discoverer Administration Edition Administration Guide Oracle Discoverer 4.1

Staging Oracle Discoverer EEX Files for Import

Oracle Discoverer workbooks are created in Discoverer User Edition and can be saved as Discoverer export (EEX) files. The Discoverer files that provide Oracle Scripting
survey workbook reports must be imported by an Oracle Discoverer Administrator before they are accessible to Discoverer users.

After installation of Oracle Applications, these files are installed on the appl_top in the following directory in your Oracle Applications server file structure:
$AU_TOP/discover

In order for these files to be imported during implementation, you must either map a network drive on the administration client to the appl_top where the EEX files are installed, or you copy the EEX files to the Discoverer administration server.

The appropriate EEX files to import include the following:

- bixiescmpgnrsflo.eex
- bixieslsthdrsflo.eex
- bixiesqstnsflo.eex
- bixiessrvysvflo.eex
- bixsvyqsfrwbo.eex
- bixiescrsstbrwbo.eex
- bixieslstsmmrflo.eex
- bixiesrmndrsvflo.eex
- bixiessvylstnflo.eex
- bixsvyqstxwbo.eex
- bixiescyclsvflo.eex
- bixiessmlstntflo.eex
- bixiesrspntrsflo.eex
- bixsvycmpswbo.eex
- bixiesdplcrssflo.eex
- bixiesnswrsflo.eex
- bixiessmmrystflo.eex
- bixsvydpwdwbo.eex
Creating an End User Layer

Perform the following to create an EUL for Oracle Discoverer. This is not required if you have access to the BIS EUL.

Prerequisites

You must have access to Oracle Discoverer Administration Edition on a Windows NT server. This software can be installed on your client or you can access a remote server using software such as Citrix.

Responsibility

Oracle RDBMS DBA privileges

Steps

1. Log into Oracle Discoverer User Edition as an Oracle RDBMS user with database administrator (DBA) privileges.
   
   For example:
   
   **Username:** sysadmin: System Administrator (case-sensitive)
   
   **Password:** sysadmin
   
   **Connect:** mydatabaseinstance

2. Click Connect.
   
   Upon connection, if no EUL exists accessible to your user account, the following message appears:

   Oracle Discoverer Administration Edition:

   You do not have access to any End User Layers (EUL). You must create at least one EUL to which you have access to use Discoverer. Do you want to create an EUL now?

   Click Yes.

   The EUL Manager Wizard appears.

3. In the first window of the EUL Manager, click Create an EUL...
The Create EUL Wizard appears.

4. Complete the EUL Wizard options as follows:

   In the Who will own the new EUL area:
   • Select the **Select an existing user** option.
     Since you are using the same user, you are not prompted for a password.
   • Check **Grant access to PUBLIC**.
   • Check **New EUL is for use by Oracle Applications users ONLY**.
     **Note:** Selection of this last criteria is essential for application security and to ensure supportability.

   In the EUL connection information area:
   • In the User field, type the name of the user.
   • In the Password field, type the user's password.
   • In the Confirm Password field, retype the user's password.
   Click **Next**.
   The Create EUL Wizard Step 2 window appears.

5. Complete the EUL Wizard Step 2 options as follows:
   • From the Schema list, select the APPS schema.
   • In the Password field, type the apps level password.
   • Click **Next**.
   The Create EUL Wizard Step 3 window appears.

6. Complete the EUL Wizard Step 3 options as follows:
   • From the default tablespace list, select an appropriate tablespace into which EUL data will be inserted.
   • From the temporary tablespace list, select an appropriate tablespace into which data is temporarily stored.
     **Note:** Choosing the wrong tablespace can greatly impact performance. If you don't know which tablespace is
appropriate for the default or temporary tablespace, consult your database administrator.

- Click **Finish**.
  
  A series of progress indicators appears.

7. An Oracle Discoverer Administration Edition message appears, indicating that the EUL has been created successfully. Click **OK**.

8. Optionally, if you want to install tutorial information, click **Yes**. Otherwise, click **No**.

9. An Oracle Discoverer Administration Edition message appears, asking whether you want to connect as the owner of the new EUL that you have just created. Click **No** if you want to exit Oracle Discoverer Administration Edition.

To proceed with the next procedure:

- Click **Yes**.

The Load Wizard appears.

- Click **Cancel** to close the load wizard window, and proceed to step 2 of Assigning End User Layer Implementation Privileges, page B-8.

### Assigning End User Layer Implementation Privileges

This procedure is only required if you have created a new EUL. Perform this procedure to assign administrative privileges for this EUL to a specific Oracle Applications user and responsibility (required in order to complete the implementation).

**Prerequisites**

- You must have access to Oracle Discoverer Administration Edition on a Windows NT server. This software can be installed on your client or you can access a remote server using software such as Citrix.

- You must be the owner of the EUL.

- You must have created or imported an Oracle Discoverer EUL.

**Responsibility**

Oracle RDBMS DBA privileges
Guidelines

- For implementations with access to the seeded SYSADMIN Oracle Applications user account, using this account is appropriate.

- For other implementations, designate a user as appropriate. This user must be assigned administrative privileges to this EUL.

Steps

1. Log into Oracle Discoverer Administrator Edition as an Oracle RDBMS user with database administrator (DBA) privileges. This must be the same user that created or imported this EUL.

2. From the Tools menu, select Privileges.

   The Privileges window appears with the Privileges tab selected.

3. From the user and responsibility drop-down list, select the appropriate user for whom you want to assign administrative access to this EUL.

   - Ensure the User box is checked.

   - Optionally, you can clear the Responsibility box to reduce the amount of records appearing in this list.

   For implementations with access to the seeded SYSADMIN Oracle Applications user account, selecting SYSADMIN is appropriate. Otherwise, ensure the user you select has the appropriate responsibility assigned.

4. From the Privileges list, select all options and click Apply.

   The selected user is granted administrative access to the EUL.

5. From the user and responsibility drop-down list, select the appropriate responsibility for which you want to assign administrative access to this EUL.

   - Ensure the Responsibility box is checked.

   - Optionally, you can clear the User box to reduce the amount of records appearing in this list.

   For implementations using the seeded SYSADMIN Oracle Applications user account in step 3 above, select the System Administrator responsibility.

   For other implementations, any responsibility is appropriate (including System Administrator), as long as the user selected in step 3 already has this responsibility.

6. From the Privileges list, select all options and click Apply.
The selected responsibility is granted administrative access to the EUL.

7. Click **OK** to save your work and exit the Privileges window.

8. From the **File** menu, select **Exit** to exit Oracle Discoverer Administration Edition.

All remaining implementation or use steps in this document should be performed by the user and responsibility for which administrative access to this EUL is granted.

**Importing Oracle Discoverer Objects into an End User Layer**

This procedure is required for all enterprises that want to implement Oracle Scripting survey analysis capabilities.

Perform the following to import Oracle Discoverer objects (a business area and workbooks) into an end user layer. Use the BIS EUL if accessible to your user. Otherwise, use the EUL you created.

**Prerequisites**

- You must have access to Oracle Discoverer Administration Edition on a Windows NT server. This software can be installed on your client or you can access a remote server using software such as Citrix.

- This user must have administrative privileges to this EUL. For implementations with access to the BIS EUL and the seeded SYSADMIN Oracle Applications user account, using this account is appropriate.

- If you have access to the BIS EUL but do not have access to the seeded SYSADMIN Oracle Applications user account, perform the procedure described in Assigning End User Layer Implementation Privileges, page B-8 in order to designate an appropriate user and responsibility with administrative access to the appropriate EUL.

**Responsibility**

Use the responsibility for which EUL administrative privileges are assigned. See prerequisites above for more information.

**Steps**

1. Log into Oracle Discoverer User Edition as an Oracle Applications user with administrative privileges to this EUL.

   For example:

   **Username:** sysadmin:System Administrator (case-sensitive)
   
   **Password:** sysadmin
Connect: mydatabaseinstance

2. Click Connect.

   The Load Wizard appears.

3. From the Load Wizard window, select Open an existing business area.

   The Load Wizard: Step 1 window refreshes, listing all business areas accessible to your user account.

4. In the business area selection list, if Survey Analysis appears, you do not need to import any EEX files.

   In the business area selection list, if the Survey Analysis business area is not listed, you must import the Oracle Discoverer export (EEX) files for use with Oracle Scripting survey reporting.

5. From the Load Wizard window, select Cancel.

   The Load Wizard window closes.

6. Optionally, close the Administration Tasklist window, which is not required.

7. From the File menu, select Import.

   The Import Wizard: Step 1 window appears.

8. From the Import Wizard window, click Add...

   The Open window appears.

9. In the Open window, navigate to the directory in which the Oracle Scripting EEX files have been staged in preparation for import.

   In this release, there are 22 EEX files required for Oracle Scripting survey reports.

10. Select all required EEX files and click Open to add them to the list.

    The Open window closes. The EEX files to import are now listed in the Import Wizard: Step 1 window.

11. Click Next.

    The Import Wizard: Step 2 window appears.

12. In the Import Wizard: Step 2 window, set the following options:

    • In the If two objects match then what action should occur area, select Refresh the object and check Preserve display related properties.

    • In the How should two objects be matched up area, select Match objects by
identifier.

- In the Should the current user take ownership of imported workbooks area, select Always take ownership of imported workbooks.

13. In the Import Wizard: Step 2 window, click Next.

The Import Wizard: Step 3 page appears.

14. In the Import Wizard: Step 3 page, click Start to begin importing the selected EEX files.

15. When the importation completes, click Finish.

The Import Wizard closes.

In the Data tab of the Discoverer Administration Edition work area, the business area you imported appears as an expandable navigation tree.

Each business area contains folders (equivalent to tables and views) and each folder contains items (equivalent to columns in the table or view).

If enabled, the Administration Tasklist also appears.

16. From the File menu, select Exit to exit Oracle Discoverer Administration Edition.

Assigning Responsibility and Business Area Privileges

The user and responsibility established in Assigning End User Layer Implementation Privileges, page B-8 has full administrative access to this EUL.

Perform this procedure to designate a user and responsibility for using Oracle Discoverer User Edition to generate and view workbooks, without administrative access.

For implementations with access to the seeded SYSADMIN Oracle Applications user account, performing this step allows you to have Oracle Discoverer survey analysis workbook users who do not have unrestricted access to Oracle Applications.

This procedure results in assigning permissions to access the workbooks to a specific responsibility. Following this procedure, assign the designated responsibility to workbook user accounts

Prerequisites

- You must have access to Oracle Discoverer Administration Edition on a Windows NT server. This software can be installed on your client or you can access a remote server using software such as Citrix.

- This user must have administrative privileges to this EUL. For implementations with access to the BIS EUL and the seeded SYSADMIN Oracle Applications user
account, using this account is appropriate.

Responsibility

Use the responsibility for which EUL administrative privileges are assigned.

Steps

1. Log into Oracle Discoverer User Edition as an Oracle Applications user with administrative privileges to this EUL.
   
   For example:
   
   **Username:** sysadmin: System Administrator (case-sensitive)
   **Password:** sysadmin
   **Connect:** mydatabaseinstance

2. Click **Connect**.
   The Load Wizard appears.

3. From the Load Wizard window, select **Cancel**.
   The Load Wizard window closes.

4. Optionally, close the Administration Tasklist window, which is not required.

5. From the Tools menu, select **Privileges**.
   The Privileges window appears with the Privileges tab selected.

6. From the user and responsibility drop-down list, select the appropriate responsibility for which you want to assign user access to the appropriate set of workbooks.
   - Ensure the Responsibility box is checked.
   - Optionally, you can clear the User box to reduce the amount of records appearing in this list.
     
     For implementations using a responsibility specifically created for this purpose, ensure you select the new responsibility. For example, if you created a responsibility called **Survey Analysis**, select this responsibility.

7. From the Privileges list, select the User Edition box.
   The checkbox options below the User Edition category enable.

8. From the User Edition category, select all options and click **Apply**.

9. Click **OK** to save your work and exit the Privileges window.
10. From the Tools menu, select Security.
    The Security window appears with the business area to user tab selected.

11. In the business area to user tab of the Security window, in the Business area list, select Survey Analysis.
    
    **Note:** If the Survey Analysis business area is not listed, perform the procedure described in Importing Oracle Discoverer Objects into an End User Layer, page B-10. If you still do not see the Survey Analysis business area, consult your Oracle Discoverer administrator.

12. Ensure the appropriate business area is selected.

13. From the Available users/responsibilities list, select the appropriate Oracle Applications responsibility for which you have granted user edition privileges in step 6 above, and click the right arrow.
    The selected responsibility appears in the Selected users/responsibilities list.

14. When satisfied with your selections, click **Apply** and then **OK**.
    The Security window closes.
    You have now granted permission for any user with a specific responsibility to open the Oracle Discoverer User Edition tool and to access the Survey Analysis business area. You must perform the next procedure to grant this responsibility permission to open the appropriate workbooks.

15. From the **File** menu, select Exit to exit Oracle Discoverer Administration Edition.

### Assigning Workbook Privileges

Perform this procedure to grant to a specific responsibility the privileges to open the appropriate workbooks for survey analysis.

This step must be performed for all implementations for which the procedure in Assigning Responsibility and Business Area Privileges, page B-12 was performed.

**Prerequisites**

- You must have access to Oracle Discoverer Administration Edition on a Windows NT server. This software can be installed on your client or you can access a remote server using software such as Citrix.

- This user must have administrative privileges to this EUL. For implementations with access to the BIS EUL and the seeded SYSADMIN Oracle Applications user
account, using this account is appropriate.

- This user must be the administrative user who imported the workbooks.

Responsibility

Use the responsibility for which EUL administrative privileges are assigned.

Steps

1. Log into Oracle Discoverer User Edition as an Oracle Applications user with administrative privileges to this EUL who is also the owner of the workbooks.
   For example:
   Username: sysadmin:System Administrator (case-sensitive)
   Password: sysadmin
   Connect: mydatabaseinstance

2. Click Connect.
   The Workbook Wizard appears.

3. From the Workbook Wizard window, select Cancel.
   The Workbook Wizard window closes.

4. From the File menu, select Manage Workbooks > Sharing.
   The Share Workbooks window appears with the Workbook to user tab selected.

5. From Workbook drop-down list, select the first workbook.
   The list of values in the Workbook list include all six workbooks in the Survey Analysis business area.

6. In the Users area, from the Available list, select the responsibility for which User Edition privileges were granted in the previous procedure and click Add.
   The selected responsibility appears in the Shared list in the Users area.

7. Click OK.
   The Share Workbooks window closes.

8. Repeat steps 4 through 7 for each workbook in Survey Analysis business area.

   Implementation of the survey analysis workbooks is now complete. Perform the next procedure to view survey analysis workbooks.
Verifying the End User Layer

After all implementation steps described above have been performed, you can verify an Oracle Discoverer User Edition’s access to the Oracle Scripting reports available in the Survey Analysis business area.

Perform this procedure to verify the implementation.

**Note:** This step is optional, to assist in troubleshooting.

**Prerequisites**

- Oracle Scripting-specific workbooks must already be imported.
- Your username should have the responsibility for which the User Edition privilege, business area privilege, and privilege to view survey analysis workbooks have been granted.
- You must have access to Oracle Discoverer User Edition (client/server edition).
- You must know the Oracle database username who owns the EUL.

**Responsibility**

The appropriate responsibility varies, based on implementation choices.

**References**

- The topic Summarize Survey Data Concurrent Program in the Oracle Scripting User Guide
- Survey Workbook Descriptions, page B-19

**Steps**

1. Log into Oracle Discoverer User Edition as an Oracle Applications user with the appropriate responsibility to view survey analysis workbooks.
   
   For example:
   
   **Username:** anyuser:Survey Analysis (case-sensitive)
   
   **Password:** yourpassword
   
   **Connect:** mydatabaseinstance

2. Click **Connect**.
   
   The Workbook Wizard appears.
3. From the Workbook Wizard window, select **Cancel**.
   The Workbook Wizard window closes.

4. From the Tools menu, select **Options...**
   The Options window appears.

5. Click the **EUL** tab.

6. From the Select a default EUL list, ensure the Oracle database user that created the EUL appears.

7. Click **OK**.

8. From the File menu, select **Open**.
   The Open Workbook window appears.

9. Click Database and then click **Open**.
   The Open Workbook from Database window appears.
   All workbooks for which this responsibility has permissions appear in the list.

10. Select the appropriate workbook and click **Open**.

11. If the Workbook in Other Database Account window appears, select **Open the workbook in the current database account** and click **OK**.

12. An Oracle Discoverer message will appear asking for confirmation to run the query for the selected workbook.
   You have completed the verification. Since you do not need to execute the query, click **No**.

13. From the **File** menu, select **Exit** to exit Oracle Discoverer Administration Edition.

---

**Viewing Oracle Scripting Survey Reports**

Once implemented, Oracle Discoverer User Edition users with the appropriate responsibility can generate Oracle Scripting survey reports using the workbooks imported into the Survey Analysis business area.

Perform this procedure to view Oracle Discoverer workbooks in the Survey Analysis business area and generate fresh reports.

**Prerequisites**

- Oracle Scripting-specific workbooks must already be imported.
• Your username should have the responsibility for which the User Edition privilege, business area privilege, and privilege to view survey analysis workbooks have been granted.

• You must have access to Oracle Discoverer User Edition (client/server edition).

• Three workbooks require the Summarize Survey Data concurrent program to be executed prior to generating workbooks, to ensure current data. These include the BIX: Survey Campaign Summary Report, the BIX: Survey Deployment Detail Report, and the BIX: Survey Question Frequency Report.

Responsibility
The appropriate responsibility varies, based on implementation choices.

References
• The topic Summarize Survey Data Concurrent Program in the Oracle Scripting User Guide
• Survey Workbook Descriptions, page B-19

Steps
1. Log into Oracle Discoverer User Edition as an Oracle Applications user with the appropriate responsibility to view survey analysis workbooks.
   For example:
   Username: anyuser:Survey Analysis (case-sensitive)
   Password: yourpassword
   Connect: mydatabaseinstance

2. Click Connect.
   The Workbook Wizard appears.

3. From the Workbook Wizard, select Open an existing Workbook.
   The Workbook Wizard window refreshes, showing workbook location options.

4. Select Database.
   The Workbook Wizard window closes. The Open Workbook from Database window appears.
   All workbooks for which this responsibility has permissions appear in the list.

5. From the Open Workbook from Database window, select the appropriate workbook and click Open.
6. If the Workbook in Other Database Account window appears, select **Open the workbook in the current database account** and click **OK**.

7. An Oracle Discoverer message appears asking for confirmation to run the query for the selected workbook. To execute the query, click **Yes**. To view the workbook without data, click **No**.

   **Note:** To run the query at a later time, select **Sheet > Refresh Sheet**.

Click **Yes**.

The Parameter Wizard appears.

For specific guidance on workbook parameters, refer to the detailed workbook descriptions in Survey Workbook Descriptions, page B-19.

8. Select the appropriate parameters and click **Finish** to execute the query.

The query executes, populating the workbook with data.

   **Note:** Three workbooks (BIX: Survey Campaign Summary Report, BIX: Survey Deployment Detail Report, and BIX: Survey Question Frequency Report) require the Summarize Survey Data concurrent program to be executed prior to generating workbooks, to ensure current data. For any of these workbooks, if a query is executed **prior to the execution of the concurrent program**, and no data is available, the report will appear displaying column headings only. If the concurrent program had been previously executed, but not recently, stale data will appear in the workbook.


**Survey Workbook Descriptions**

The following table indicates the name of each workbook, its filename, and a description of each workbook.
<table>
<thead>
<tr>
<th>Workbook Name</th>
<th>File Name</th>
<th>Description</th>
<th>Tables or Views Accessed by Workbook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey Question Frequency</td>
<td>bixsvyqsfr wbo.eex</td>
<td>This report provides answer frequency data for each survey deployment, showing only non-text fields. This report can be used to show how people have responded to survey questions at a summary level for each survey deployment. It provides a table of all non-text questions, plus the frequency of responses for all the questions.</td>
<td>ies_svy_ques_data_v</td>
</tr>
</tbody>
</table>
| Survey Question Detail | bixsvyqsdts wbo.eex | This report provides the detailed response for each survey that has been completed. It compiles all answers that each respondent has provided. It is sorted by response date. | ies_svy_surveys_all  
ies_svy_cycles_all  
ies_svy_deplyments_all  
ies_svy_response_entries  
ies_question_data  
ies_questions  
ies_question_types  
ies_panels  
ies_answers.ies_svy_list_entries_v  
ies_ams_list_entries_v |
<table>
<thead>
<tr>
<th>Workbook Name</th>
<th>File Name</th>
<th>Description</th>
<th>Tables or Views Accessed by Workbook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey Question Text</td>
<td>bixsvyqstxwbo.eex</td>
<td>This report provides detail solely on the text data type fields (text field, text area, and password field) collected within a survey. This is useful for providing a collection of comments provided by survey respondents for specific questions.</td>
<td>ies_svy_surveys_all, ies_svy_cycles_all, ies_svy_deplements_all, ies_svy_response_entries, ies_question_data, ies_questions, ies_question_types, ies_panels, ies_answers.ies_svy_list_entries_v, ies_ams_list_entries_v</td>
</tr>
<tr>
<td>Survey Campaign Summary</td>
<td>bixsvycmpswbo.eex</td>
<td>This report provides Summary information on each Survey Campaign, with totals provided at the survey campaign and cycle level. It allows you to get an overview of how many surveys have been sent out, whether there have been errors with the surveys, and the response ratio.</td>
<td>ies_svy_summary_stats_v, ies_svy_reminders_v</td>
</tr>
<tr>
<td>Survey Deployment Detail</td>
<td>bixsvydpldwbo.eex</td>
<td>This report provides detail information on each deployment, with totals provided at the cycle and deployment level.</td>
<td>ies_svy_summary_stats_v, ies_svy_reminders_v</td>
</tr>
</tbody>
</table>
Survey Cross Tabulation

Workbook Name | File Name | Description | Tables or Views Accessed by Workbook
---|---|---|---
Survey Cross Tabulation | bixiescrsst | This report allows the administrator to select a specific survey deployment, and then cross-tabulate the results from two different questions. You can select a question and a target value from one question and use that as the establishing criteria for reporting on a different response. For example, you can select all survey records in which the answer to the Overall Satisfaction question is “3 - somewhat satisfied,” and then for that set of records, display the responses for a second question (such as “would you use this service again”). | ies_svy_surveys_v
| | | | ies_svy_deployments_v
| | | | ies_svy_cycles_v
| | | | ies_questions
| | | | ies_answers
| | | | ies_question_data
| | | | ies_svy_response_entries

This section includes the following topics:

- Survey Question Frequency Workbook, page B-22
- Survey Question Detail Workbook, page B-24
- Survey Question Text Workbook, page B-25
- Survey Campaign Summary Workbook, page B-26
- Survey Deployment Detail Workbook, page B-28
- Survey Cross Tabulation Workbook, page B-30

**Survey Question Frequency Workbook**

This report provides answer frequency data for each survey deployment, showing only non-text fields. This report can be used to show how people have responded to survey questions at a summary level for each survey deployment. It provides a table of all non-text questions, plus the frequency of responses for all the questions.

**Survey Question Frequency Workbook Columns**

The following table lists column headings for this workbook and a description of each column.
<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Name</td>
<td>Name of the survey campaign.</td>
</tr>
<tr>
<td>Cycle Name</td>
<td>Name of the cycle, in alphabetical order.</td>
</tr>
<tr>
<td>Deployment Name</td>
<td>Name of the deployment, in alphabetical order.</td>
</tr>
<tr>
<td>Panel Name</td>
<td>Name of the panel. These appear in the order in which the panels displayed in the script.</td>
</tr>
<tr>
<td>Question Name</td>
<td>Name of the question. These appear in the order in which the question was asked in the survey questionnaire.</td>
</tr>
<tr>
<td>Available Answers</td>
<td>Answers for each question. These appear in the order in which they are listed for the question.</td>
</tr>
<tr>
<td>Selected Answers</td>
<td>The answers that have been selected by survey respondents. Excludes abandoned survey responses. In other words, if a respondent did not answer even a single question in a survey questionnaire, then that survey transaction is excluded from these totals. If a respondent answered one or more questions, with null values for any other question, then the responses are included in these totals.</td>
</tr>
<tr>
<td>Total Answers per Question</td>
<td>The total number of responses for the question (sum of all the selected answers). Excludes aborted surveys.</td>
</tr>
<tr>
<td>Answer Frequency</td>
<td>Percentage of answers for this question. Calculated only for data types of radio buttons, check boxes, and drop-down lists. It is not valid for text fields or text areas.</td>
</tr>
</tbody>
</table>

**Selection Criteria**

- When executed, this workbook selects a specific survey campaign, and can use wild card characters on the survey campaign’s cycles and deployments. For instance, users can see all cycles and all deployments for a particular survey campaign, or users can select for a specific deployment. If users select multiple cycles and deployments, the workbook sorts by cycle, then deployment, in alphabetical order.

- Excludes aborted survey responses (those with 0 answers). Only for abandoned (1 or more answers) and completed survey responses.
**Sort Criteria**

Survey campaign
Cycle name/ID
Survey deployment (breaks to a new page for each survey cycle, each deployment)
- Panel name
  - Questions listed in the order in which they appear in the panel

**Calculations**

- Calculates the total answers for each question for each deployment
- Calculates the answer frequency for each question for each deployment
- For each deployment, provides a sub-total which shows the total number of survey responses that were evaluated in this report

**Survey Question Detail Workbook**

This report provides the detailed response for each survey that has been completed. It compiles all answers that each respondent has provided. It is sorted by response date.

**Survey Question Detail Workbook Columns**

The following table lists column headings for this workbook and a description of each column.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit Date</td>
<td>Date the response was entered - RESPONSE_COLLECTED_DATE</td>
</tr>
<tr>
<td>Response ID</td>
<td>Survey Respondent ID</td>
</tr>
<tr>
<td>First Name</td>
<td>Contact’s first name from the AMS List Entries table (for targeted survey deployments only). Blank if standard (non-list-based) deployment.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Contact’s first name from the AMS List Entries table (for targeted survey deployments only). Blank if standard (non-list-based) deployment.</td>
</tr>
<tr>
<td>Panel Name</td>
<td>Name of the panel. These appear in the order in which the panels displayed in the script.</td>
</tr>
</tbody>
</table>
### Survey Question Text Workbook

This report provides detail solely on the text data type fields (text field, text area, and password field) collected within a survey. This is useful for providing a collection of comments provided by survey respondents for specific questions.

### Survey Question Text Responses Workbook Columns

The following table lists column headings for this workbook and a description of each column.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit Date</td>
<td>Date the response was entered - RESPONSE_COLLECTED_DATE</td>
</tr>
<tr>
<td>Survey respondent ID</td>
<td>RESPONSE_ID</td>
</tr>
<tr>
<td>Column Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Panel Name</td>
<td>Name of the panel. These appear in the order in which the panels displayed in the script.</td>
</tr>
<tr>
<td>Question Name</td>
<td>Name of the question. These appear in the order in which the question was asked in the survey questionnaire.</td>
</tr>
<tr>
<td>Answer</td>
<td>The survey respondent’s selected answer to the question.</td>
</tr>
</tbody>
</table>

**Selection Criteria**

- Must select a specific survey deployment.
- Can select a specific Response Collected Date range
- Excludes abandoned surveys (those with 0 answers)

**Sort Criteria**

Submit Date
- Panel name
  - Questions listed in the order in which they appear in the panel.

**Calculations**

Total responses evaluated.

**Survey Campaign Summary Workbook**

This report provides Summary information on each Survey Campaign, with totals provided at the survey campaign and cycle level. It allows you to get an overview of how many surveys have been sent out, whether there have been errors with the surveys, and the response ratio.

**Survey Question Detail Workbook Columns**

The following table lists column headings for this workbook and a description of each column.
<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey Campaign Name</td>
<td>Survey Campaign Name</td>
</tr>
<tr>
<td>Cycle Name</td>
<td>Name of Survey Cycle</td>
</tr>
<tr>
<td>Deployment Name</td>
<td>Name of Survey deployment</td>
</tr>
<tr>
<td>Deployment Status</td>
<td>Status of the deployment. Status types include Open, Pending, Error, Active, Cancelled or Incomplete. For a description of each status, see the Deployment Status topic in the description of Deployments in the Oracle Scripting User Guide.</td>
</tr>
<tr>
<td>Number of Targeted Respondents</td>
<td>For targeted deployments, the total number of survey targets in a list. For standard deployments, the sum of abandoned and completed surveys (represents the number of opportunities to get survey feedback).</td>
</tr>
<tr>
<td>Number of Survey Errors</td>
<td>Number of surveys that could not be delivered to list member because of e-mail address or server errors.</td>
</tr>
<tr>
<td>Number Surveys Aborted</td>
<td>Number of surveys that have been opened, but no answers have been recorded.</td>
</tr>
<tr>
<td>Number Abandoned</td>
<td>Number of surveys that have been opened, but for which no answers were provided.</td>
</tr>
<tr>
<td>Number Surveys Completed</td>
<td>Number of surveys that have one or more answers.</td>
</tr>
<tr>
<td>Response Ratio</td>
<td>Completed responses divided by total number of invitations.</td>
</tr>
</tbody>
</table>

**Selection Criteria**

- Can select survey campaign name to get a report on a specific survey campaign.
- Can also selectively report on survey campaigns by using wildcard search characters.

**Sort Criteria**

Survey campaign
--- Cycle
----- Deployment
Calculations

- Number of survey errors
- Number of opportunities
- Number of abandoned surveys
- Number of completed surveys
- Response ratio
- Totals for Opportunities, Errors, Abandons, Completed (rolled up at cycle level)
- Totals for Opportunities, Errors, Abandons, Completed (rolled up at survey campaign level)

Survey Deployment Detail Workbook

This report provides detail information on each deployment, with totals provided at the cycle and deployment level.

Survey Deployment Detail Workbook Columns

The following table lists column headings for this workbook and a description of each column.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Name</td>
<td>Name of the survey campaign.</td>
</tr>
<tr>
<td>Cycle Name</td>
<td>Name of the cycle, in alphabetical order.</td>
</tr>
<tr>
<td>Deployment Name</td>
<td>Name of the deployment, in alphabetical order.</td>
</tr>
<tr>
<td>Deployment Status</td>
<td>Status of the deployment. Status types include Open, Pending, Error, Active, Cancelled or Incomplete. For a description of each status, see the Deployment Status topic in the description of Deployments in the Oracle Scripting User Guide.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date for a deployment. This will be blank at the survey campaign and cycle levels, which do not have start dates.</td>
</tr>
<tr>
<td>End Date</td>
<td>The deployment end date for a deployment. This will be blank at the survey campaign and cycle levels, which do not have end dates.</td>
</tr>
<tr>
<td>Column Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>List Name</td>
<td>Name of list used to send invitation or reminder master documents.</td>
</tr>
<tr>
<td>Number of Invitations Sent</td>
<td>The number of survey invitations sent. This value will be blank for standard (non-list-based) survey deployments.</td>
</tr>
<tr>
<td>Number of Reminders Sent</td>
<td>The number of survey reminders sent. This value will be blank for standard (non-list-based) survey deployments.</td>
</tr>
<tr>
<td>Number Surveys Completed</td>
<td>Number of surveys that have one or more answers.</td>
</tr>
<tr>
<td>Number of Abandoned Surveys</td>
<td>Number of surveys that have been opened, but for which no answers were provided.</td>
</tr>
<tr>
<td>Number of Errors</td>
<td>Number of surveys that could not be delivered to list member because of e-mail address or server errors.</td>
</tr>
<tr>
<td>Response Ratio</td>
<td>Completed responses divided by total number of invitations</td>
</tr>
</tbody>
</table>

**Selection Criteria**

- Can select from survey campaign name, cycle name, and deployment name.
- Can use % wildcard search character.
- Can select by deployment status (Active, Pending, Open, Closed).

**Sort Criteria**

Survey campaign
--- Cycle
------ Deployment
------- Deployment Status

**Calculations**

- Number of Invitations Sent
- Number of Reminders Sent
- Number of survey errors
• Number of opportunities
• Number abandoned surveys
• Number completed surveys
• Response ratio
• Totals for Opportunities, Errors, Abandons, Completed - At Deployment level
• Totals for Opportunities, Errors, Abandons, Completed - Rolled up at Cycle level
• Totals for Opportunities, Errors, Abandons, Completed - Rolled up at Survey Campaign level

Survey Cross Tabulation Workbook

This report allows the administrator to select a specific survey deployment, and then cross-tabulate the results from two different questions. You can select a question and a target value from one question and use that as the establishing criteria for reporting on a different response. For example, you can select all survey records in which the answer to the Overall Satisfaction question is "3 - somewhat satisfied," and then for that set of records, display the responses for a second question (such as "would you use this service again").

Survey Deployment Detail Workbook Columns

The following table lists column headings for this workbook and a description of each column.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Question</td>
<td>The question that is to be used as the primary selection</td>
</tr>
<tr>
<td>Cross Tab Question</td>
<td>The question that is cross tabulated against the selection question</td>
</tr>
<tr>
<td>Selection Question Choices</td>
<td>The available answers under the selection question</td>
</tr>
<tr>
<td>Cross Tab Answers</td>
<td>The available answers under the cross tab question</td>
</tr>
<tr>
<td>Cross Tab Answer Frequency</td>
<td>The frequency at which each answer was chosen for this particular selection question and cross tab question</td>
</tr>
<tr>
<td>Cross Tab Answer Ratio</td>
<td>The percentage of the individuals who had responded with a particular value under the selection question</td>
</tr>
<tr>
<td>Column Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cross Tab Answer</td>
<td>The percentage of individuals who had this particular value for their selection question, out of all people surveyed.</td>
</tr>
<tr>
<td>Percentage</td>
<td></td>
</tr>
</tbody>
</table>

**Selection Criteria**

- Must select a specific Survey Deployment
- Select a specific question and answer pair as the primary selection criteria
- Select the cross-tabulation question and answer definitions
- Excludes aborted surveys (those with 0 answers)

**Sort Criteria**

Sort by the answers in the Selections Question Choices column, then by the Cross Tab Answers column

**Calculations**

- Percentage of respondents who had each specific response for the cross-tabulation question.
- Total ratio of respondents out of the entire deployment who had the specific question/answer pair. For instance, if selecting for an age range of between 40-50, this would show the percentage of total respondents for the entire survey who were in this age range.
**action**
A Script Author command that executes at runtime upon evaluation of the object containing the action. Actions can be associated with branches, or with blocks if designated as an API block. See also pre-action and post-action.

**answer collection**
The recording of end user responses ("answers") to all question controls ("questions") during a script transaction. Answer collection is performed by the Scripting Engine for a script executed in either the agent interface or the Web interface, when the Answer Collection option is selected as a global script property. Answers are collected in the IES_QUESTION_DATA table in the Oracle Applications schema. Script end user responses are collected for each "question" or answer definition designated as collectable.

**answer definition**

**answer UI type**
See question user interface type, page Glossary-9.

**answer user interface type**
See question user interface type, page Glossary-9.

**argument**
Data provided to a function or method for use in its calculations and processing. Arguments are passed to the function or method by listing them in parentheses in the function or method name. In a Java method, these are also called parameters.

**best practice Java method**
Oracle Applications includes Java methods written specifically for Oracle Scripting to quickly enable frequently requested script runtime functionality. Class files containing these "best practice" Java methods are included in APPS.ZIP, each in the package oracle.apps.ies.bestpractice.<Class Name>. 
**best practice survey**
Oracle provides some pre-built survey questionnaire scripts flows to serve as examples of how to customize scripts specifically intended for use as survey questionnaires. Aspects of these scripts can also be used in scripts to be executed in the agent interface. Best practice survey scripts are placed on the APPL_TOP in the directory $IES_TOP/scripts during installation or patching of Oracle Scripting. These are provided on an as-is basis. Use of best practice surveys requires customization and is not supported.

**blackboard**
Virtual memory space in Oracle Scripting where information is stored in key/value pairs. This information is only retained for the duration of a single Scripting interaction.

**building block**
A portion of a Script Author script that contains functionality integrating with other Oracle Applications. Building blocks typically contain one or more API and typically perform a task-based operation such as creating a service request, registering for an event, and so forth. Building blocks are not intended to be used as standalone scripts, but are expected to be imported into a script and modified as appropriate. These are provided on an as-is basis. Use of building blocks requires customization and is not supported. Building block script components are created and supported by application development teams. As of this release, building block scripts are available from the Oracle Scripting and Oracle Marketing product teams. For information on building blocks, refer to *Oracle Scripting Developer’s Guide* or product documentation for the specific Oracle application.

**campaign**
A focused effort to achieve a particular goal from a targeted population over a specific period of time for a particular business purpose. Also see marketing campaign, page Glossary-6.

**class**
A set of related objects that share common characteristics. In Java, a class contains a set of methods.

**collectable**
A boolean property of a Script Author question or answer definition within a panel. This option is selected by default in the general tab of the data dictionary of each specific question defined. Individual answers can be designated as uncollectable by clearing the collectable option. When answer collection is enabled at the global script level, all script end user responses provided in a script session will be saved for questions designated as collectable. Also see answer collection, page Glossary-1.
**CRM Resource Manager**

Oracle CRM Resource Manager is a responsibility included with a Rapid Install of Oracle CRM Applications so that HRMS person types (most often, employees) required by Oracle products can be created. It does not have the full functionality of HRMS. Note that if HRMS is installed, HRMS employees must be created using that tool and cannot be created with CRM Resource Manager.

**cycle**

A cycle is a repeatable survey event, utilizing the same script. Multiple cycles will also allow the same survey to be given through different media types, when supported. Multiple cycles are typically used to measure the same characteristics at a different moment in time.

**deployed scripts**

Deployed scripts are syntactically correct Script Author scripts that are executable using the Scripting Engine. The only method to deploy a script is to use Script Author (either using the Tools > Deploy Script command from a graphical script, or the Save, Deploy, and Exit command from the Script Wizard). When a script is deployed it is written to the IES_DEPLOYED_SCRIPTS table of the applications database. Deployed scripts that are selected as the survey questionnaire for a valid survey campaign can be executed in a Web browser using the Scripting Engine Web interface.

**deployment**

A deployment is the lowest and most granular set of requirements for a survey campaign. A deployment is associated with a specific survey and cycle, and identifies specific response start and end dates. List-based deployments identify Oracle Marketing lists and Oracle One-to-One Fulfillment templates. Deployments must be set to active status (they must be "deployed") before a survey campaign commences.

**deployment ID**

An identification number for each deployment in a particular instance. This is created upon setting a deployment to Active status. All respondents in a particular deployment will have the same deployment ID.

**dID**

See deployment ID, page Glossary-3.

**error page**

An error page is a survey resource that displays when the Scripting Engine encounters an error in processing a script in the Web interface (during execution of a survey or Web script in a Web browser). Survey resources defined for execution in the JTT technology stack are JSP files. Survey resources for execution in the OAF technology stack are either HTML files or (for error page or final page resources) URLs accessible to
Oracle Applications at runtime, which redirect the end user to the designated location on the Internet or intranet. Error page resources are mandatory for JTT survey campaigns. If no specific error page is defined for an OAF survey campaign, a simple error page will be automatically generated by the application.

In the JTT technology stack, scripts executed from self-service Web applications can use the seeded test error page for menu-based scripts (IESSVYMENUBASEDTESTERROR.JSP), whereas surveys or Web scripts launched using the guest user may use error pages based on the seeded error page for non-hosted scripts, IESSVYTESTERROR.JSP.

**final page**

A final page is a survey resource that displays after the Scripting Engine processes the last panel in the flow of a script executed in the Web interface (during execution of a survey or Web script in a Web browser). Survey resources defined for execution in the JTT technology stack are JSP files. Survey resources for execution in the OAF technology stack are either HTML files or (for final page or error page resources) URLs accessible to Oracle Applications at runtime, which redirect the end user to the designated location on the Internet or intranet. When a file is used as the final page instead of a URL for redirect, it typically includes a thank-you message to the script end user, and indicates that the survey or Web script has ended successfully. Final pages often contain a hypertext link to the enterprise’s home page or to the next logical destination for the end user (based on the purpose of the script). Final page resources are mandatory for JTT survey campaigns. If no specific final page is defined for an OAF survey campaign, a simple final page will be automatically generated by the application.

**footer section**

A footer section is a survey resource that, if associated with a survey campaign, displays at the bottom of each page (except the error page or final page) when a script is executed in a Web browser. Since each page represents a panel, the footer appears immediately below panel content (typically, below the Continue button). The footer section may reference corporate logos or other standardized graphics in GIF or JPEG format. If so, these graphics need to be stored on a directory accessible to the Web server and referenced appropriately in the footer section code. Survey resources defined for execution in the JTT technology stack are JSP files. Survey resources for execution in the OAF technology stack are HTML files. Footer section resources are the only optional survey resources for JTT survey campaigns. If no specific footer section is defined for any survey campaign (regardless of technology stack), no footer will appear on each page at runtime.

**footprinting**

Footprinting is the recording in the Oracle Applications database of the names of each panel in a script transaction that is visited during a script transaction, and the duration of time (in milliseconds) prior to the activation of the next panel. This feature can
provide useful script tuning data. The default for this property is true. When enabled (or when the Answer Collection property is true), this data is saved in the IES_PANEL_DATA table in the Oracle Applications schema.

**graphical script**
A script contains the business rules, text and graphics to progress the script end user from panel to panel at runtime. Runtime scripts are executed using any interface of the Scripting Engine component of Oracle Scripting. A graphical script is created using the graphical tools of the Script Author, the authoring and development component of Oracle Scripting. Graphical scripts can also be created by graphing a wizard script. At runtime, scripts display panels containing questions, answers, and graphics. Each panel includes a Continue button. The graphical script end user progresses through each panel. The flow of the script is controlled by business rules built using the standard Script Author graphical tools, including associated custom code, and may be a rigid flow or may change dynamically, based on the end user's responses. Graphical scripts are created, edited and deployed using the Script Author Java applet, and can be listed, deleted, or associated with custom Java from the Scripting Administration console.

**header section**
A header section is a survey resource that, if associated with a survey campaign, displays at the top of each page (panel) when a script is executed in a Web browser (except the error page or final page). Immediately below the header section, the content of the current panel appears. The header section may reference corporate logos or other standardized graphics in GIF or JPEG format. If so, these graphics need to be stored on a directory accessible to the Web server and referenced appropriately in the footer section code. Survey resources defined for execution in the JTT technology stack are JSP files. Survey resources for execution in the OAF technology stack are HTML files. Header section resources are mandatory for JTT survey campaigns. If no specific footer section is defined for an OAF survey campaign, no information appears above panel content for each page at runtime.

**invitation**
An e-mail message master document, inviting potential survey respondents (identified in an Oracle Marketing list) to participate in a survey. Each e-mail message contains a customized URL, from which the invited list member can respond to the specified survey.

**JRAD**
Java Rapid Application Development, an Oracle proprietary technology stack also referred to as Oracle Applications Framework (OAF). This is the technology upon which the Survey Administration console is built.

**JTA**
Java Technology Applications, an Oracle proprietary technology stack referring to CRM
Common Application Components.

**JTF**
Java Technology Framework, an Oracle proprietary technology stack referring to CRM Foundation products. Oracle applications using underlying CRM Foundation technology are further divided into the CRM Applications Foundation technology stack (known as JTA) and CRM Technology Foundation (JTT) technology stack.

**JTT**
Java Technology Tools, an Oracle proprietary technology stack referring to CRM Common Application Components. This is generally referred to as the Oracle CRM Technology Foundation technology stack.

**list**
A list is a set of records in Oracle Marketing that contains records for individuals or organizations, and contact information (at minimum, an e-mail address) for each. From an Oracle Scripting perspective, the relevance of a list is to serve as the source for potential survey respondents for a targeted survey campaign deployment. Each record represents one individual who will receive an invitation (an HTML document sent using Oracle One-to-One Fulfillment) to participate in the questionnaire. List members may also receive reminders (also HTML documents) to participate in a survey, which includes the survey end date. Lists are built using Oracle Marketing’s list management feature. Use of targeted (list-based) surveys requires Oracle Marketing and Oracle One-to-One Fulfillment.

**list member**
Any individual included in a list built using Oracle Marketing’s list management feature. All list members are potential survey respondents.

**marketing campaign**
A marketing campaign is a collection of requirements created in Oracle Marketing for the purpose of executing specific business rules of a marketing effort within an enterprise or interaction center. It is the primary organizational unit of a focused marketing effort. Campaigns define the marketing effort and, through association with other units, define schedules for execution and target populations for the effort. One marketing campaign must have at least one campaign schedule associated with it, and may have many. Campaign schedules can be targeted for different execution channels (such as e-mail, telephony, or traditional postal service mail). Each campaign schedule has a target group (list or lists created using Oracle Marketing to define the target population for the campaign). The marketing campaign is used by several Oracle Applications, including Oracle TeleSales, Oracle Collections, and Oracle Advanced Outbound Telephony.
master document

A master document is a message template used in Oracle One-to-One Fulfillment. Master documents typically include merge fields populated by an associated SQL query. Upon execution of the query, a copy of the master document is created for each list member, containing the data returned by the query. This creates a personalized message. From a survey perspective, master documents are invitation or reminder messages in HTML format that are sent by e-mail from the fulfillment engine to members of a defined Oracle Marketing list. Master documents are required for targeted survey deployment operations. Master documents and their associated queries are associated with specific Oracle One-to-One Fulfillment templates.

merge field

Merge fields are data elements in an Oracle One-to-One Fulfillment master document surrounded by open and close guillemet (for example, <<merge_field>>). When a fulfillment request is executed, specified table columns or views are queried. For each list member record, the master document is replicated, with the actual data returned from the query embedded or merged in the master document replicate in place of the merge field. List-based surveys require at minimum one merge field (the survey URL that the recipient must access to participate in the survey). Merge fields must correspond to data returned from a query.

method

A task that can be performed with specific data items or properties. A Java method can be a function (resulting in a return value) or a procedure.

Oracle HRMS

Oracle HRMS is a full-featured enterprise human resources management system. It is an Oracle application using Oracle Forms technology to manage human resources used by other Oracle applications.

panel

A panel is the primary object of a script, which contains the information that is displayed by the Scripting Engine (in the panel presentation area or browser window) at runtime. Each panel must contain at least one question and may contain as many as needed. Each question in a panel displays a corresponding question user interface control (button, checkbox, text area, drop-down, and so forth) with which the script end user enters a response at runtime. Panels are created and edited using the Script Wizard or graphical tools.

Panels in wizard or graphical scripts may contain static panel text, and one or more questions. Questions of the appropriate type that are explicitly defined in a wizard script may include question-level validation commands. In addition, panels in graphical scripts may contain graphic images, dynamic text using embedded values, and validation, database or cursor lookup, or other commands (at the panel level or the
If the purpose of a wizard script panel is simply to provide information to the end user, then it can automatically generate a question called Continue, which displays a Continue button at runtime. Panels created with graphical tools must contain one or more questions, for which the properties of each must be explicitly defined.

Whether built with the Script Wizard or in a graphical script, a panel is the only Script Author object to display at runtime in both interfaces (groups, blocks and branches simply contain information for processing a script).

**PHP**

Personal home page. Accessed when logging into Oracle Self Service applications, the personal home page lists the responsibilities available to the logged in Oracle Applications account in two categories: Self Service, to access self-service applications, and Applications, for access to other Oracle applications.

**post-action**

A Script Author command that executes immediately following the evaluation of the object with which the post-action is associated, and prior to evaluation of the next object in the flow of the script. Post-actions can be associated with panels, blocks, groups, or the global script. See also action and pre-action.

**pre-action**

A Script Author command that executes prior to the evaluation of the object with which the pre-action is associated. Pre-actions can be associated with panels, blocks, groups, or the global script. See also action and post-action.

**prototype**

Prototype is a boolean characteristic of survey campaigns. Prototype survey campaigns are identical to standard survey campaigns, except that the script used as the survey campaign questionnaire is not locked. The purpose is to allow survey campaign administrators more freedom to refine requirements for survey campaigns, including modification to the script for the designated survey campaign. You can exclude prototype survey campaigns from survey campaign lists by selecting the "Exclude prototypes" option. This characteristic can only be selected or cleared while a survey campaign status is Open.

**published scripts**

Published scripts are stored in the IES_DEV_SCRIPTS table of the applications database, and are not executable. All wizard scripts are published scripts. To publish a graphical script you must be explicitly save it to the database from Script Author, by selecting File > Save As and selecting the Database tab. Published wizard scripts are always syntactically valid; graphical scripts can be published as works in progress, regardless of their contents.
query
A specific statement of request for information to be returned in the form of records from the database. Queries are constructed in structured query language (SQL). For targeted survey deployments, each Oracle One-to-One Fulfillment master document must have an associated query which obtains information populated into the resulting document in placeholders called merge fields. A query must be valid to return any of the requested information.

question
In Script Author, a question is the property of a panel which results in the appearance of a question user interface (UI) control in the panel at runtime. All panels must contain at least one question and may contain any number. Questions may have commands associated with them in Script Author to validate responses at runtime, or to provide default user responses. When viewed from a graphical script, each question has a data dictionary associated with it, in which information (answer choices, commands) is stored.

question control
See question user interface type, page Glossary-9.

question UI type
See question user interface type, page Glossary-9.

question user interface type
The choice of user interface (UI) type selected by the script developer for a question in a panel determines the kind of control that displays at runtime with which the end user can provide input. The full range of question UI types supported by Oracle Scripting include text fields, text areas, radio buttons, checkboxes, buttons, drop-down lists, password fields, checkbox groups and multi-select list boxes. All nine are available in graphical scripts. Wizard scripts do not support the single check box or button question UI types. Each question supports only one question UI type. Once selected in a graphical script, the question user interface type cannot be changed (you must delete the entire question control and add a new one). Panels in graphical scripts that require the button UI type cannot contain any other questions. Some question UI types allow null or open-ended input (text fields, text areas, password fields, checkbox, checkbox group, multi-select list boxes). Others require end user input at runtime (radio buttons, buttons, drop-down lists) unless a default answer choice is associated with that question.

reminder
An e-mail message master document, reminding potential survey respondents (already invited to take a survey) of the appropriate URL to access to respond to the survey. Reminders often include information such as the last day the recipient may participate
in the survey. Using the same master document, reminders can be sent in a batch process on a predefined schedule, or can be sent manually for any individual list member.

**respondent**

An individual responding to a request for information (in the form of participating in a survey questionnaire or Web script). For targeted survey deployments, respondents are list members who respond to an invitation sent by e-mail to participate in the survey.

**respondent ID**

A unique identification number for each list-based respondent in a particular instance. The URL for a list member includes as parameters both the deployment ID common to all participants in a given deployment and each list member's unique respondent ID.

**rID**

See respondent ID, page Glossary-10.

**responsibility**

A responsibility is a level of authority that allows a user to access specific functionality and data in Oracle Applications. Responsibilities are assigned by a user with the System Administrator responsibility.

**sample**

The population from which information is solicited by survey.

**script**

A script is a miniature program built using the Script Author component of Oracle Scripting and executed at runtime using the Scripting Engine component of Oracle Scripting. The purpose of a script is to facilitate the flow of information between an enterprise and other parties. Each script enforces business rules programmed into it by script developers. Scripts consist primarily of panels with at least one question each; at runtime, script end users must click the Continue button in each panel to progress through the script. Graphical scripts also may contain groups and blocks. By design, scripts either enforce a rigid flow, or employ carefully constructed logic to route the end user through different potential paths in a script, to appropriate panels, based on responses to earlier script questions. Script Author provides the ability to create two kinds of scripts: wizard scripts, page Glossary-13 and graphical scripts, page Glossary-5. Regardless of creation method, after deployment a script can be executed in any interface of the Scripting Engine. Executing a script in a Web browser requires the creation and activation of a survey campaign deployment.

A script contains the business rules, text and graphics to progress the script end user from panel to panel. Scripts are created using the Script Author component of Oracle Scripting. At runtime, scripts are executed using any interface of the Scripting Engine.
component of Oracle Scripting. The same script can be executed in the agent interface, or (after creating and deploying a survey campaign) executed in a Web browser as a survey questionnaire or Web script accessed from a self-service Web application. Scripts are further qualified by type. See graphical script, page Glossary-5 and wizard script, page Glossary-13.

**script information area**

The script information area is a programmable feature of the Script Author in which script developers can place information that appears as a header in any script executed in the Scripting Engine agent interface at runtime. The script information area is a global script property and appears in every session of a script executed in the agent interface when this information is defined. It is referred to in the Script Author user interface as the Static Panel. You can access this area by selecting File > Script Properties > Static Panel, or by right-clicking on an empty area of the canvas and selecting Edit Blob Properties > Static Panel.

**static panel**

See script information area, page Glossary-11.

**survey campaign**

A survey campaign is the collection of requirements needed to execute a script in a Web browser using the Scripting Engine Web interface. This is the super class that references the global script. A survey campaign must have information for at least one cycle and at least one deployment. Survey campaigns are created using the Survey Administration console. As prerequisites to creating a survey campaign, you must create and deploy from Script Author the script containing questions and answer choices, and you must define survey resources.

**survey questionnaire**

Set of questions built using the Script Author component of Oracle Scripting for execution in the Scripting Engine as a survey questionnaire, typically to gather feedback, obtain market data, tabulate opinion, measure satisfaction, or otherwise collect data directly from specific (customers, employees, prospects) or non-specific target populations. A survey questionnaire script is physically identical to a script executed in the agent interface, although it may be customized to take advantage of sophisticated HTML interpretation available to Web browsers.

**survey resource**

Survey resources provide functionality to scripts executing in the Scripting Engine Web interface. Survey resource definition is accomplished from the Survey Administration console Survey Resources tab > Create, and must be defined before they can be used in a survey campaign. The four survey resource types include header section, footer section, error page, and final page resources. Header and footer sections appear in each page of the Web browser, just above or below panel contents, respectively. Error page
resources are displayed when an error condition occurs during script execution in a
Web browser. Final page resources are displayed after the Scripting Engine processes
the last panel in the flow of a script. For survey campaigns defined in the JTT
technology stack, survey resources are JSP files, and all resources except the footer page
are mandatory. For survey campaigns defined in the OAF technology stack, survey
resources are HTML files. For OAF survey campaigns, error page or final page
resources can also be URLs accessible to the Web server at script runtime, which
redirect the script end user to the specified URL during an error or upon completing the
script, respectively.

Physical JSP survey resources corresponding to survey resource definitions must be
uploaded manually into the $OA_HTML directory on the applications server and are
served by the Web server as appropriate. For OAF survey resources, the HTML files
corresponding to the survey resource definition are uploaded to the database at the
time of survey resource definition.

For JTT survey campaigns, you can use seeded JSP test resources to test your
implementation, or you can customize your own resources based on these seeded
resources. These seeded JavaServer page files (IESSVYTESTHEADER.JSP,
IESSVYTESTTHANKU.JSP, IESSVYTESTERROR.JSP and
IESSVYMENUBASEDERROR.JSP) are located in $OA_HTML in your environment. For
error pages with a hosting type of menu-based, use the appropriate seeded resource
(IESSVYMENUBASEDERROR.JSP).

**survey respondent**

See respondent, page Glossary-10.

**SYSDATE**

This refers to the current systems date of the database. When creating records in a
database the SYSDATE is typically time-stamped as creation date, and SYSDATE is also
used as a default setting for creating responsibilities from an Oracle Applications
perspective.

**template**

Oracle One-to-One Fulfillment’s term for a group of master documents and any
collateral. Templates may also include campaign specifications. Templates are
identified with a survey campaign at the deployment level to identify invitation and
reminder master documents and their associated queries. Only required for targeted
(list-based) survey deployments. No collateral is typically associated with a survey
campaign.

**trading community architecture (TCA)**

The trading community architecture is a customer model designed to support complex
trading communities. The entire Oracle E-Business Suite uses the TCA customer model,
providing a common model for customer data in all Oracle business applications. TCA
strives to model all relationships within a trading community, supporting
business-to-business (B2B) and business-to-consumer (B2C) models equally.

**Uniform Resource Locator (URL)**

A specific string of characters that identifies resources located on the Web. Also known as Uniform Resource Identifiers (URIs), these provide navigation to documents, images, downloadable files, services, electronic mailboxes, and other resources to Web browser users with one click. Full URLs include access methods or protocols such as HTTP or FTP, generally proceeded by a colon and two slashes, and then the full location. Nested directory levels are represented by additional slashes.

**Web script**

A Script Author script executed in a Web browser from an Oracle self-service Web application such as Oracle iSupport or Oracle iStore is referred to as a Web script. Like all scripts executed in the Scripting Engine Web interface, this requires as a prerequisite an active survey deployment. The URL for this deployment is then embedded in the self-service application as a hyperlink. When the end user selects the link, a new Web browser window opens, the user’s current Oracle applications validation information is used to authenticate the script session, and the script executes in the new browser window. Web scripts are a valuable resource to provide scripted information to Web application users or to solicit feedback to the enterprise regarding the application user’s experience.

**wizard script**

A wizard script is a script created using the Script Wizard feature of the Script Author, the authoring and development component of Oracle Scripting. Like graphical scripts, wizard scripts are executed in any Scripting Engine interface. At runtime, they display panels containing questions, answers, and graphics. Each panel includes a Continue button required to be clicked by the script end user at runtime to progress through each panel. The flow of the script is controlled by business rules built using the Script Wizard. Based on the choices of the script developer, the end user’s flow through the script may be rigid (the same panels are seen regardless of how the user answers) or may change dynamically (demonstrating different flows based on the end user’s responses). Wizard scripts can be listed, created, copied, edited, deployed, or converted to a graphical script only from the Script Wizard feature of the Script Author.